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Introduction
Target Audience and Purpose
The "Reference Guide" is targeted to system administrators who operate DeploymentManager (hereafter, DPM)
and explains DPM operations on the screen, tools, maintenance-related information, and troubleshooting.

Document Structure
1
2
3
4
5
6
7
8
9
10
11

Web Console: Explains the names and the outline of the DeploymentManager Web Console.
Management: Explains users, licenses, and the configuration of DPM Server in the Management view.
Operations: Explains the operations of DeploymentManager.
Monitor: Explains viewing the status for managed machines and logs on the DPM.
Image Builder: Explains Image Builder, which is a tool for registering images.
PackageDescriber: Explains PackageDescriber, which is a tool for creating packages and registering
them on the Package Web Server.
Other Tools: Explains tools used by DPM.
DPM Command Line: Explains command lines which control the DPM.
Maintenance: Explains the maintenance information of DPM.
Precautions: Explains precautions about DPM.
Troubleshooting: Explains the method to handle error informations of DPM.

Appendices
Appendix A
Appendix B
Appendix C
Appendix D
Appendix E
Appendix F
Appendix G
Appendix H
Appendix I

Service List
Event Log
Error Information
Network Port and Protocol List
Log Files Output by DPM
Procedure to Check the Version of Each Component
Glossary
Procedure to Log in Web Console Using LDAP Server
Revision History
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DeploymentManager Manual Organization
DPM manuals are structured as described below.
The name of each manual is described in this manual according to the "Name in this Manual".
Name of Manual
DeploymentManager
Ver6.2 First Step Guide

Name in this Manual
First Step Guide

DeploymentManager
Ver6.2 Installation Guide

Installation Guide

DeploymentManager
Ver6.2 Operation Guide

Operation Guide

DeploymentManager
Ver6.2 Reference Guide

Reference Guide

Role of Manual
Intended for DPM users. Provides a product
overview, and describes the various
functions, the method of the system design,
operating environment and so on.
Intended for system administrators who
install DPM. Explains tasks such as how to
install, upgrade, and uninstall DPM.
Intended for system administrators who
operate DPM. Describes the environment
setup procedure for the operation and the
operational procedure based on an actual
flow.
Intended for system administrators who
operate DPM. Explains DPM operations on
the screen, tools, maintenance-related
information, and troubleshooting. This guide
is a supplement to the Installation Guide and
the Operation Guide.

The latest information of DPM can be obtained from the following product site:
http://www.nec.com/masterscope/deploymentmanager/index.html
The Reference Guide is not included in the installation media, and is only available on the product site.
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Documentation Guidelines
The following describes important points regarding the notation used in this manual.
・ The notation used for DPM products is as follows:
Notation in this Manual
Product Name
DPM unbundled product
DeploymentManager Ver6.2
SSC product
DeploymentManager Ver6.2 for SSC(*1)
*1
This is a product that is bundled with SigmaSystemCenter and VirtualPCCenter.
・ The screen images in this manual are based on the DPM unbundled product. The license related displays
are only for the DPM unbundled product. They are not displayed for SSC products.
・ Product versions are expressed as follows.
Common description for DPM Ver6.2: DPM Ver6.2
Specific description for DPM Ver6.2x: DPM Ver6.2x
* x means revision number.
・ The installation media included with the DPM product is called "Installation media" in this manual.
・ IPv4 address is described as "IP address" and IPv6 address is described as "IPv6 address".
・ 32bit OS is described as "x86" and 64bit OS is described as "x64".
・ In Windows OS, the folder path in which DPM is installed or the registry key is described by those of x86.
When you use x64, replace as the following if there is no notice in particular.
DPM installation folder
・ (x86):C:\Program Files\NEC\DeploymentManager
・ (x64):C:\Program Files (x86)\NEC\DeploymentManager
・ (x86):C:\Windows\system32
・ (x64):C:\Windows\SysWOW64
Registry key
・ (x86):HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager
・ (x64):HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager
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・ The meaning of each icon used in this manual is as follows:
Icon
Explanation
Important items.
These are items you need to be careful when you operate DPM not depending on
the using environment.
Cautionary items.
These are items you need to be careful in the specific environment or operations.
Supplementary items.
These are informations to use DPM more conveniently.
・ The displays and procedures of DPM may differ according to the operating system used. In the case of
Windows OS, this document is based on Windows Server 2008 and Windows 7, in principle. Replace when
you use DPM on the OS except Windows Server 2008 and Windows 7. (There are some descriptions based
on the OS except Windows Server 2008 and Windows 7.)
Example)
The procedure for checking the DPM version differs by operating system as follows:
- For Windows Server 2012/Windows 8:
1) In Windows desktop, set the mouse pointer in the upper right (or the lower right) and select Settings
from the charm.
2) Settings screen appears. Select Control Panel -> Program -> Programs and Features.
- For Windows Server 2008/Windows 7/Windows Vista:
From the Start menu, click Control Panel -> Programs and Features.
* When "Version" is not displayed, perform the following procedure 1) and 2).
1) Right-click Name in the center of the screen, and select More.
2) In the Choose Details screen, select the Version check box and click OK.
- For an OS other than the above
1) From the Start menu, click Control Panel -> Add or Remove Programs. (or Add or Remove
Applications)
2) Select the applicable component, and click Click here for support information.
・ About Windows Server 2003 R2 or Windows Server 2008 R2, follow explanation of Windows Server 2003 or
Windows Server 2008 unless Windows Server 2003 R2 or Windows Server 2008 R2 is specified explicitly.
・ In descriptions of operation procedures, arbitrary names to be specified by the user(instance name of the
database and so on) are described in bold and italics as follows: Instance Name.
Example)
・ Restart the following service.
SQL Server(Instance Name)
・ In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
・ The description of SQL Server in this manual is based on SQL Server 2012 SP1 Express that is included in
the installation media. Replace it when you use the product except SQL Server 2012 SP1 Express.
Example)
DPM database path
•For SQL Server 2012 SP1 Express x86:
C:\Program Files\Microsoft SQL Server\MSSQL11.Instance Name\MSSQL\Binn
•For SQL Server 2008 R2 SP1 Express x86:
C:\Program Files\Microsoft SQL Server\MSSQL10_50.DPMDBI\MSSQL\Binn
•For SQL Server 2005 Express Edition x86:
C:\Program Files\Microsoft SQL Server\MSSQL.x\MSSQL\Binn
* x means the number of the instance.
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・ Please execute following procedures when Finish DPM related tasks appears in this document.
•If a scenario is running, wait until the scenario ends.
•If an automatic update is being executed, wait until it ends.
•If you are operating the Web Console or the DPM tools, please end them.
・ 1MByte is calculated as 1024KByte.
1GByte is calculated as 1024MByte
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1.

Web Console

This chapter explains each name and the overview of DPM Web Console.

1.1. Web Console Overview
You can perform various operations using the Web Console, such as machine operations and group
management and so on.
The Web Console is comprised of the following 9 components.

Title Bar

Main Window

Main menu
Configuration menu

Tree View
Operation menu

Group Box
Action Menu
Action Link
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(1) Title Bar
The title bar is displayed at the top of the Web Console.
The title bar is organized from the account management function and the main menu.
•Account Management Function
You can configure log in users and manage them.
Item
User Name
(Authority)
Account

Logout

Description
Displays the user name and authority for login user.
You can change the password for the user who is logged in, display a notification
dialog or set the number of items to display in the group box.
See Section 1.1.2, "Account" for details.
Logs out from the DPM.

•Main Menu
You can switch the contents of tree view and main window by clicking each menu.
Item
Management

Operations
Monitor

Description
The Management view is the view that you use for the DPM initial
configuration/the environment configuration such as managing DPM users
and authority, user lists, license management and the configuration for DPM
Server and so on.
The Operations view is the view that you use for normal operations such as
adding a new group or machine, or executing a scenario and so on.
The Monitor view is the view that you use for monitoring information
necessary to operate the DPM such as scenario execution status or
automatic update execution status and so on.

(2) Tree View
When you click the main menu, it will switch the tree view.
When you click a tree view icon, detailed information about that icon will be displayed in the main window
and the configuration and operations for that icon will be displayed in the Configuration menu and the
Operation menu.
(3) Main Window
This is the DPM main window. Detailed information is displayed about the icon selected in the tree view.
•Group Box
The group box indicates the box that displays the detailed information and the lists displayed in the main
window. You can click the name of the column in the group box to display " " (ascending
order/descending order) and sort the items.
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•The items that are displayed in the group box are shown in the table below.
Display Count
Select the number of items such as user lists, managed machines,
and so on that will be displayed in the group box.
"Action" Link
Indicates the links in each group box where you can perform
operations on the selected resource in the group box.
You do this by selecting the checkbox in the left column of the group
box to select the resource target for the operation and then clicking
on the Action link.
"Action" Menu

Indicates the menu where you can select from the Machine
Individual Operations in each group box, and you can perform
operations on the selected resource in the group box.
You do this by selecting the checkbox in the left column of the group
box to select the resource target for the operation and selecting the
Action menu.
Checkbox
Select the item that is the operation target from the Action link/Action
menu.
If you select the check in the top checkbox, you can select all of the
users or managed machines and so on on the corresponding page.
The following will be shown if the number of the items exceeds the specified Display Count.
<
Moves to the previous page.
>
Moves to the next page.
<<
Moves to the initial page.
>>
Moves to the last page.
(Text box)
Enter the number of the page.
Go
Moves to the page set in the text box.
(4) Configuration Menu, Operation Menu
These are the menus for configuration/operation for the target resource. The menu content will differ
depending on the authority (Administrator, Operator, or Observer) of the user. See Section 2.2, "User Icon"
regarding the user authority.
The operations performed with this menu can be performed for the resource selected from the icons in the
tree view.
A notification dialog box will be displayed if the operation cannot be performed.
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 When you use a short cut key peculiar to the browser as F1 key and so on, it
may affect the action of Web Console.
 There is a case that you operate to obtain a list and create a folder for all folders
and files on the Management Server. When there is a folder or a file that a
problem occurs by such an operation, it is recommended that you change from
"Local System Account" which is default logon account, to other account which
has administrative authority, about the following service and configure the
account restriction for the account.
- DeploymentManager API Service
 Refresh in the Operation menu refreshes the same as pressing the F5 key.
However, if the F5 key is pressed while you are operating the screen, it will
move to the first screen of the Operations/Management/Monitor view. If you
click Refresh in the Operation menu, the current screen will be refreshed.
When you operate on the screen, a password cab be requested and a
confirmation message can be displayed by the guard parameter setting.
See Section 2.7.2, "Guard Parameter Setting" regarding the settings screen.

1.1.1.

DeploymentManager Login

When the DPM Web Console is started, DeploymentManager Login screen appears. Please start the DPM
Web Console in the following procedure.
When you log in Web Console by using the user account of LDAP server,
configure in advance by seeing Appendix H, "Procedure to Log in Web Console
Using LDAP Server."
(1) Select All Programs from the Start menu and select Internet Explorer.
(2) By entering either of the following URL in the address field of the browser, start Web Console. (The same
page appears by any URL.)
http://HOST/DPM/
http://HOST/DPM/Login.aspx
http://HOST/DPM/Default.aspx
In Host, enter DNS name or IP address of the Management Server connected by the Web Console.
Upper case and lower case are not distinguished.
 When a character, which is not recommended in Windows (except
alphanumeric characters and "-"(hyphen)), is included, specify IP address in the
address filed of Web browser.
If you specify DNS name, it may fail to start the Web Console.
 When the port used by Web Service (IIS) is changed from the default value (80),
specify URL including changed port number as the following.
http://HOST:Port Number/DPM/
When you access from the same machine with DPM Server, "localhost" can be
specified in HOST.
http://localhost/DPM/
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(3) The DPM Web Console is started and DeploymentManager Login screen appears.

DeploymentManager Login
User Name
(Required)
Password
(Required)
Remember User Name

Login

Enter the user name.
Enter the password.
If you select the checkbox, you can omit entering the user
name from the next time you log in.
If you delete the cookies using Internet Explorer's Internet
Options, the check will be removed and it will be
necessary to re-enter the user name.
You can log into the DPM by clicking Login after the user
name and password are entered.
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1.1.2.

Account

In the Account Setting screen, you can change the password of the user being logged in and configure whether
to display the notice dialog.
(1) On the Web Console, click Account in the title bar.
(2) The Account Setting screen appears in the main window.

Account Setting
Change Password

Old Password
(Required)
New Password
(Required)

Confirm New Password
(Required)
Show Notice Dialog

If you select the Change Password checkbox, you can
change the password. By default, the checkbox is not
selected.
Enter the currently used password.
Enter the new password. The number of characters
allowed is 1 - 128 single-byte characters. A character can
be any single-byte alphanumeric characters or any of the
following symbols:
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
Re-enter the same password for confirmation.
When you select the Show Notice Dialog checkbox, you
can configure the Notice Dialog display.
If this is selected, the Notice Dialog will be displayed the
next time the Web Console is started. Also, this screen will
be displayed if you press the F5 key in an arbitrary
window.
By default, the checkbox is selected.
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The Count Of Lines
Displayed Per Page
(Required)

OK
Cancel

2.

This is for setting the number of items that will be
displayed on one page for pages such as Machine List
where the list is displayed on multiple pages.
Up to 999 items can be displayed on one page.
The number setting can be set by entering the number of
items.
Enter single-byte number characters separated by
commas to set the number.
The default value is "20, 50, 100".
If it is configured with multiple numbers, it will be displayed
using the selection of the number configured in the
Display Count of the group box.
Furthermore, the first number that is entered into the
textbox will be the default value.
Example) If "50, 20, 100" is entered, "50" will be the
default value.
Saves the setting on the Account Setting screen and
returns to the previous window.
Returns to the previous window without saving the setting
from the Account Setting screen.

Management

This chapter explains the configuration of uses, licenses, and DPM Server, managed by Management view.

2.1. Management View
You can configure the information necessary to use DPM, such as DPM user and authority management, user
lists, license management and DPM Server configuration and so on in the Management view.
When you click Management in the title bar, it will switch to the Management view. The Management Function
List group box appears in the main window.
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2.2. "User" Icon
You can manage the accounts of the users who are using DPM with the User icon.
You can access the User icon from the User icon at the tree view of the Management view or from User in the
Management Function List group box displayed in the Management view.
Click the User icon to display the User List group box in the main window. See Section 2.3, "User List" regarding
the screen.
It is necessary to configure the authority for each user account. The usable range of DPM is limited by the type of
the authority.
The three types of authority are listed below.
Administrator

You can perform all of the operations such as DPM configuration, changes,
machine operation or group management and so on from the Management,
Operations and Monitor views.
The Administrator can change any user's password.
You can perform management and so on for machines, machine groups and
scenario groups from the Operations and Monitor views.
You cannot perform DPM Server management, user or authority management
or license management in the Management view.
You can only see the machine operating status and so on in the Operations or
Monitor views.
You cannot perform operations in the Management, Operations or Monitor
views.

Operator

Observer

User Account
Administrator

Management View
You can operate and see

Operator

You can only see some of
the screens(*1)

Observer

You can only see some of
the screens(*1)

Operations View
You can operate and
see
You can operate and
see

Monitor view
You can operate
and see
You can operate
and see

You can only see

You can only see

*1
You can only see the following screen.
•Base Information of the Management Server (See Section 2.7, "Base Information about the Management
Server" for details.)
•Detail Setting of the Management Server (See Section 2.7.1, "Detail Setting" for details.)



See Section 2.3.2, "Edit User" regarding changing the authority or password.
The user(deployment_user) is already created at the time of the installation
to execute the processing from SSC and use DPM Command Line. Also,
there are the following restrictions for this user.
•Login from the Web Console by the user is not available.
•This user cannot be deleted.
The initial password for this user is "dpmmgr". When executing DPM
Command Line, please specify the password of "deployment_user".

18

2.3. User List
You see a list of the users registered with DPM in the User List group box. The User List group box appears in
the main window when you click the User icon.

User List
Display Count
"Action" Link

(Checkbox)
User Name

Authority
Description
Edit

Select the Display Count to be displayed in the user list.
When you click Delete User, the user with a check in the
checkbox on the left side will be removed.
Multiple users can be deleted collectively by multiple
checks.
If you select the top checkbox, all users in the list will be
selected.
Displays the user name. This cannot be edited.
Confirm the login status with the icon.
:Logged in
(grey):Logged off
Displays the user's authority.
See Section 2.2, "User Icon" regarding the authority.
Displays the user description.
You can edit the user information. Click the " " icon to
display the Edit User screen in the main window. See
Section 2.3.2, "Edit User" regarding the Edit User screen.
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2.3.1.

Add User

Add the users who will use DPM.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) Click the User icon in the tree view. Or, you can click User in the Management Function List group box
displayed in the main window.
(3) The Configuration menu for the User icon will be displayed. Then click Add User.
(4) The Add User screen will be displayed in the main window and you can configure each item.
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Add User
User Name
(Required)

Authority
(Selection required)

Password
(Required)

Confirm Password
(Required)
Description

OK
Cancel

Enter the new user name to be added.
The number of characters that can be entered is 1 - 32
single-byte characters. The allowed characters are
alphanumeric characters.
The following symbols cannot be used.
\/<>*:;,+=?"
The alphabet characters are case sensitive.
Select the authority for the user. The three types of
authority for the users are listed below.
•Administrator
•Operator
•Observer
Enter the password for the user.
The number of characters that can be entered is 1 - 128
single-byte characters. The allowed characters are
single-byte alphanumeric characters and following
symbols.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
The alphabet characters are case sensitive.
Re-enter the same password as confirmation.
You can enter the user's description.
Up to 128 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric
characters.
This entry is optional.
The user is added and it returns to the previous window.
It returns to the previous window without adding the user.

There is no limit on the maximum number of users you can add.

2.3.2.

Edit User

Edit the users registered in the DPM.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) Click the User icon in the tree view. Or, you can click User in the Management Function List group box
displayed in the main window.
(3) When the User List group box appears, click the Edit User Icon (
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) for the user to be edited.

(4) The Edit User screen will be displayed in the main window. Then edit each item.

Edit User
User Name
Authority

Change Password

Password

Confirm Password
(Required)
Description

OK
Cancel

Display the user name. This cannot be edited.
Displays the user's authority. The authority can be
changed from the list box.
The authority will become effective from the next login.
If you select the Change Password checkbox, you can
change the password. By default, the checkbox is not
selected.
The changed password will be reflected immediately.
Enter the password to be set.
The number of characters that can be entered is 1 - 128
single-byte characters. Any single-byte alphabet and
numeric characters or any of the following symbols can be
entered.
!"#$%&'()*+,-./:;<=>?@[\]^_`{|}~
The alphabet characters are case sensitive.
Enter the same password as you entered in Password.
The user description is displayed and can be edited.
Up to 128 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric
characters.
Saves the setting on the Edit User screen and returns to
the previous window.
Returns to the previous window without saving the setting
from the Edit User screen.
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2.3.3.

Delete User

Delete a user registered to DPM.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) Click the User icon in the tree view. Or click User in the Management Function List group box displayed in
the main window.
(3) Select the checkbox in the left column of the User to be Deleted on the User List group box that is
displayed in the main window.
(4) When you click the Action link for Delete User, a confirmation dialog will be displayed.
(5) Click OK.
A deleted user that is already logged in or one who deletes yourself will stay
active until you log off or the Web Console times out.

2.4. "License" Icon
You can manage licenses registered with DPM with the License icon.
You can access the License icon from the License icon at the top of the Management view tree view or from
License in the Management Function List group box displayed in the Management view main window. Click
the License icon to display the License Information group box and the Registration License List group box in
the main window. See Section 2.5, "Detailed Information of Registration License" regarding the screen.
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2.5. Detailed Information of Registration License
Click the License icon to display the License Information group box and the Registration License List group
box in the main window.
In the License Information group box, the status of license use is displayed.
In the Registration License List group box, a list of the licenses, which are registered in DPM, is displayed.

License Information
Total Number of License
Using License Number
Balance License Number
Registration License List
Display Count
"Action" Link
(Option Button)
License Name
License Key
Registration day

Displays the number of registered licenses.
Displays the number of licenses which are already used.(the
number of registered managed machines)
Displays the number of remaining licenses.
Select the Display Count to be displayed in the registered
license list.
When you click Delete License Key, the selected license
will be deleted.
Select the license to delete.
Displays the license key name.
Displays the license key.
Displays the date the license key was registered.

If using SSC bundled product, it is not necessary to register the DPM license so the
License icon will not be shown on the Management view.
See the SigmaSystemCenter Installation Guide about registering licenses for SSC
bundled product.

2.5.1.

Add License Key

Add the DPM license key.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) Click the License icon in the tree view. Or, you can click License in the Management Function List group
box displayed in the main window.
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(3) The Configuration menu for the License icon will be displayed. Then click Add License Key.
(4) The Add License Key screen will appear in the main window. Then enter the license key and click OK.

Add License Key
License key
(Required)

OK
Cancel

2.5.2.

Enter the license key. Enter upper and lower case letters
correctly.
•A license is required for each of the machines which are
introduced, operated and managed by DPM.
See Section 2.3, "DeploymentManager Product Line and
Licenses" in First Step Guide for information regarding
the license.
•If you do not register the license key, you can only
register up to 10 machines, and the trial period will be up
to 30 days. You cannot use DPM if you exceed the 30
day period.
The license is added and it returns to the previous
window.
It returns to the previous window without adding the
license.

Delete License Key

Delete the DPM license key.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) Click the License icon in the tree view. Or, you can click License in the Management Function List group
box displayed in the main window.
(3) Select License to Delete from the Registration License List group box that is displayed in the main
window.
(4) When you click the Action link for Delete License Key, a confirmation dialog will be displayed.
(5) Click OK.

2.6. "DPM Server" Icon
You can configure the DPM environment such as behavior of DPM Server and Folder for Image and so on using
the DPM Server icon. You can access the DPM Server icon from the DPM Server node at the top of the
Management view tree view or from DPM Server in the Management Function List group box displayed in the
Management view main window.
Click the DPM Server icon to display the Base Information group box in the main window. See Section 2.7,
"Base Information about the Management Server" regarding the screen.
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2.7. Base Information
Server

about

the

Management

Base information about DPM Server is displayed in the Base Information group box. The Base Information
group box appears in the main window when you click the DPM Server icon.

Base Information
Product Name
Product Version
IP Configuration
IP Address
Web Site
Comment
Protocol
IP Address:TCP Port

2.7.1.

Displayed as Deployment Manager.
Displays the DPM version.
The Management Server IP address is displayed. If there
are multiple IP addresses, then all will be displayed.
Displays a description of the Web site information.
Displays the communication protocol for connecting to
the Web site.
Displays the Web site's IP address and port number.

Detail Setting

The configuration of the Management Server can be confirmed or changed.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Or, you can click DPM Server in the Management Function
List group box displayed in the main window.
(3) The Configuration menu for the DPM Server icon will be displayed, then click Detail Settings.
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(4) Each item can be configured using each of the General, Scenario, Network and DHCP Server tabs on the
Detail Setting screen which is displayed in the main window.
See from Section 2.7.1.1, "General Tab" to Section 2.7.1.4, "DHCP Server Tab" about each screen.

2.7.1.1.

"General" Tab

In the General tab, you can view and configure license information, server information, server configuration,
Folder for Backup Image, and Folder for Image.
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Overview
License Information
License Count

Server Information
Computer Name
IP Address

Server Setting
Check the completion of
a scenario by the
communication with
DPM Client

Upgrade DPM Client
automatically

Image Setting
Folder for Backup Image

Displays the number of licenses that are registered in
DPM Server. This cannot be edited. The "License" will not
be displayed for SSC bundles product.
(The DPM license is included with SSC)
The Management Server machine name is displayed. This
cannot be edited.
Set IP address to connect with managed machines.
If you want to specify IP address explicitly, specify IP
address in the list box. (IP addresses, which are set in all
LAN boards on the Management Server, are displayed in
the list box.)
Select ANY when IP address to use for connections is
arbitrary.
The default is ANY.(*1)
You can monitor the scenario completion in real time by
selecting the Check the completion of a scenario by
the communication with DPM Client checkbox. You can
confirm scenario completion by communication between
DPM Server and DPM Client.
If you do not install DPM Client, do not select this.
By default, this is selected.
For SSC product, select this surely.
If the Upgrade DPM Client automatically checkbox is
selected, when DPM Client is started, it will communicate
with DPM Server and if DPM Client version is different
from that on the server, it will be automatically upgraded to
the same version as that on the server.
If you do not install DPM Client, do not select this.
By default, this is selected. (For SSC product, this is not
selected by default.)
For SSC product, do not select this surely.
Set the Folder for Backup Image.
Select the folder using the Browse button or the path can
be specified by direct input.
The number of characters that can be entered is 1 - 80
single-byte characters.
The alphanumeric characters, single-byte spaces.
The following symbols cannot be used.
/*?<>"|:
The default is "C: \DeployBackup".
Set the Folder for Backup Image as a folder that is
confirmed to have sufficient free space.
This is optional.(*2)(*3)
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Folder for Image
(Required)

Set a folder where OS, applications and service packs
and so on can be saved for remote install using DPM.
Select the folder from Browse button or the path can be
specified by direct input.
The number of characters allowed is 1-254 single-byte
characters.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
/*?<>"|:
The default is "C: \Deploy".
Set the Folder for Image as a folder that is confirmed to
have sufficient free space.(*2)(*4)

Default Value of Deploy-OS
Default Value of
Deploy-OS(IA32)

OK
Cancel

Set the default value of Deploy-OS.
Deploy-OSs, which are installed in DPM Server, are
displayed in the list box.
The default is "ia32_110331_26".
This configuration is also applied to the managed machine
that "Use Default Value" is specified.
For details about the configuration of the managed
machine, see Section 3.5.5, "Register Managed
Machine."
Saves the setting on the Detail Setting screen and
returns to the previous window.
Returns to the previous window without saving the setting
from the Detail Setting screen.

*1
 When you changed IP address, change IP address configured in Image Builder (Remote Console).
The configuration can be run by selecting Start menu -> All Programs -> DeploymentManager ->
Image Builder.
 Be careful of the following if an IP Address except ANY is selected.
If multiple IP addresses are assigned to one LAN board, please configure the first IP address visible
in the OS. DPM Server may not operate properly if another IP address is configured.
 Restart the following services if the network information (IP address is changed or the number of IP
address is increased/decreased) is changed on the OS.
•DeploymentManager PXE Management
•DeploymentManager PXE Mtftp
When DPM Client communicates at the next time, it detects the change of IP address of the
Management Server, and it is automatically reconfigured to connect to the changed IP address. In
this case, the Management Server, whose IP address was changed, and DPM Client need to be
connected.
 The LAN board of the all target managed machines needs to be connected to one LAN board of the
Management Server when the IP Address is set to ANY and it is transmitted using multicast with a
remote update scenario.
 Configure the IP Address to other than ANY (the IP address configured by the used LAN board)
when a restore scenario is executed with multicast option.
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*2
 If you change the Folder for Backup Image, change the image file location of already created
backup and restore scenarios and the following scenarios created by default:
•System_Backup
•System_Restore_Unicast
 You cannot specify the following folders as the location for the Folder for Backup Image or the
Folder for Image.
•Using the same folder for the Folder for Backup Image and the Folder for Image
•The subfolder of the Folder for Image
•The Windows system folder
•A folder used by another application
•Directly under the drive
Example) "D: \"
•Network drives(You can specify an image file in the network directly for one scenario.)
And if you change the Folder for Backup Image or the Folder for Image, do not do any steps except
those described in the User's Guide (directly editing or removing and so on using Explorer).
*3
If you change the Folder for Backup Image, the backup image files will not be automatically moved to
the changed location. You will need to move the files manually.
*4
 Grant access that will allow access with full control on the Folder for Image by the user that performs
the DPM operations or the account (the default is local system account (SYSTEM)) used by each
service with the name that start with "DeploymentManager" on the Management Server.
 If the exports folder that is under the Folder for Image is configured as an NFS shared folder, take
the following steps when changing the Folder for Image.
1) Remove the NFS shared folder configuration from the exports folder.
2) Change the Folder for Image from the Detail Setting screen.
3) Configure the exports folder under the Folder for Image as an NFS shared folder.
 Specify an empty folder if you are setting up an existing folder as the new Folder for Image.
 When the large size images as OS image are registered in Folder for Image, it takes time to change
Folder for Image and the timeout may occur on the Web Console. Before changing Folder for
Image, check the size of the folder and change the following timeout value of DPM Server and IIS as
necessary.
If the timeout occurred, wait until the processing of changing folder is completed. After the completion
of the processing, you need to log in on the Web Console again.
(1) The timeout value of DPM Server
Change the timeout value in the following file.
<DPM Server installation folder>\WebServer\App_Data\Config\MgrServerList.xml
Item:TimeOut
The default is 1200(seconds).
If you change the timeout value, you need to restart IIS.
(2) The timeout value of IIS
Change the timeout value in the following procedure.
(Explains the procedure of IIS7.0 (Windows Server 2008) as an example.)
Configure the timeout value at 4 places in the step 6), 9), and 11) of the procedure. The smallest
value of them will be valid as the timeout. Therefore, it is recommended that values of 4 places
are the same.
The timeout occurs in 20 minutes in the default configuration.
The configuration will be valid promptly.
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start
menu.
2) Internet Information Services (IIS) Manager is displayed.
Select Application Pools on the left side of the screen.
3) Select DeploymentManagerPool in Application Pools on the center of the screen and click
Stop in Application Pool Tasks on the right of the screen.
4) Click Default Web Site on the left of the screen and click Stop in Manage Web Site on the
right side of the screen.
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5) Click DPM directly under Default Web Site on the left side of the screen, select Session
State in ASP.NET on the center of the screen, and click Open Feature in Actions on the
right of the screen.
6) Specify the timeout value in Cookie Settings -> Time-out (in minutes) (Default: 20 minutes)
in the Session State screen on the center of the screen and click Apply in Actions on the
right of the screen
7) .Click DPM directly under Default Web Site on the left side of the screen and select
Authentication in IIS on the center of the screen and click Open Feature in Actions on the
right of the screen.
8) Select Forms Authentication in the Authentication screen on the center of the screen and
click Edit... in Actions on the right of the screen.
9) Edit Forms Authentication Settings screen appears. Specify timeout value in
Authentication cookie time-out (in minutes) (Default: 30minutes) and click OK.
10) Click Application Pools on the left side of the screen and select DeploymentManagerPool
in Application Pools on the center of the screen. Click Advanced Settings in Edit
Application Pool on the right side of the screen.
11) Advanced Settings screen appears. Specify the timeout value in the following 2 places and
click OK.
・ Process Model - Timeout in idle status(minute) (The default is 20 minutes)
・ Recycle - Periodic Interval (minute) (The default is 1740 minutes)
12) Click Start in Application Pool Task on the right side of the screen.
13) Click Default Web Site on the left of the screen and click Start in Manage Web Site on the
right side of the screen.
 End Image Builder temporarily before changing the Folder for Image and then start it again after
changing the folder.
If you change IP Address or Folder for Image, each service of DPM is restarted.
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2.7.1.2.

"Scenario" Tab

You can configure the scenario timeout time in the Scenario tab.

Scenario
Timeout Setting (*1)
Hardware Setting
(Required)

Linux Installation
(Required)

OK
Cancel

Set the default value for the timeout for distributing floppy
disk image of BIOS/Firmware update (Scenario HW
Setting tab).
This can be configured in one minute increments from "1"
to "9999" minutes.
The default value is "10" minutes.
Set the timeout for installing the Linux OS (Scenario OS
tab).
This can be configured in one minute increments from "1"
to "9999" minutes.
The default value is "120" minutes.
Saves the setting on the Detail Setting screen and
returns to the previous window.
Returns to the previous window without saving the setting
from the Detail Setting screen.

*1
 The scenario timeout is the time from the start of the scenario to the timeout. A scenario execution
error will occur when the scenario has not completed after the time specified for each item has been
exceeded.
 If you set both the HW Setting tab and the OS tab on the Add Scenario screen, each timeout will be
valid for the execution times for Hardware Setting and Linux Installation.
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2.7.1.3.

"Network" Tab

You can configure the remote power operation and configure the number of machines for simultaneous
execution of a scenario in the Network tab.
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Network
Remote Power Control Setting
Remote Power On Set the execution interval for remote power ON for each
Interval
machine by batch execution of remote power ON.
(Required)
This can be configured in one second increments from "1" to
"99" seconds.
The default value is "2" seconds.
Remote Power On Set the wait time for a response from the machine for a remote
Timeout
power ON or scenario execution time. This can be configured in
(Required)
one minute increments from "0" to "99" minutes.
The default value is "10" minutes.
If this is set to 0, then it will continue waiting for a response from
the managed machine (The timeout of the remote power ON
will not occur).(*1)
Scenario Execution Setting
Machines For
Set the maximum number of machines on which scenarios are
Simultaneous
executed simultaneously. This can be set from "1" to "1000"
Execution
machines. The default value is "5" machines. (*2)
(Required)
OK
Saves the setting on the Detail Setting screen and returns to
the previous window.
Cancel
Returns to the previous window without saving the setting from
the Detail Setting screen.
*1
If you perform remote power ON or a scenario on multiple managed machines, the default value of the
Remote Power On Timeout may cause a timeout error.
In principle, set the Remote Power On Timeout to be greater than the following value.
(Remote power on interval) * (the number of scenario executing machines) + (the managed machines
startup time).
Furthermore, a remote power ON error will occur if there is no response within the time. Increase this
value if it can be powered ON but a power ON error occurs.
*2
 The following action will be done if simultaneous execution was done for machines more than the
value that was set for the Machines For Simultaneous Execution.
The type of the scenario

The action for machines over Machines For
Simultaneous Execution

Backup or restore(unicast
distribution)

Scenarios will be executed on the number of machines
set as Machines For Simultaneous Execution and
other managed machines will wait. Then, when running
scenarios have completed, the scenario will be
executed sequentially on the waiting managed
machines.
If you power on the managed machines that are waiting
for execution of the scenario manually, the scenario will
be executed on those machines although the number
of machines on which scenarios are executed exceeds
Machines For Simultaneous Execution.

Remote update(unicast
distribution)

Scenarios will be executed on the number of machines
set as Machines For Simultaneous Execution and
other managed machines will wait. Then, when running
scenarios have completed, the scenario will be
executed sequentially on the waiting managed
machines.

Restore(multicast
distribution)

Scenarios will be executed on the number of machines
set as Machines For Simultaneous Execution and
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other managed machines will wait. Then, when all
running scenarios have completed, scenarios will be
executed on the number of machines set as Machines
For Simultaneous Execution newly out of waiting
managed machines. After that, the same action will be
done repeatedly until scenarios on all managed
machines are executed.
Remote update
(multicast distribution)

Scenarios will be executed up to the specified number
of Machines For Simultaneous Execution. Errors will
occur on the other machines. In such a case, remove
the scenario execution error and execute the scenario
again.
See Section 3.8.8, "Error Cancellation" about removing
the error.

 A maximum value of Machines For Simultaneous Execution is 1000 machines, but the load on the
network will increase as the number of scenarios concurrently running increases.
 The number of machines on which scenarios and automatic updates can be executed simultaneously
is up to 1000 machines. Therefore, even if both of the number of machines set here and the number
of machines for automatic update simultaneous execution (Management view –> DPM Server icon
–> Automatic Update Setting in the Configuration menu –> Maximum Number Of Machines For
Automatic Update (1-1000)) are set to 1000 machines, the number of machines on which scenarios
are executed simultaneously may be less than 1000.

2.7.1.4.

"DHCP Server" Tab

You can configure whether to use a DHCP server in the DHCP Server tab.
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DHCP Server
Use A DHCP Server
DHCP Server is installed
on the machine
DHCP Server is installed
on an another machine
Do Not Use A DHCP Server
OK
Cancel

Select this to use a DHCP Server.
Select this if the DHCP Server is running on the same
machine as DPM Server.
Select this if the DHCP Server is running on a different
machine than DPM Server.
Select this not to use a DHCP server.
Saves the setting on the Detail Setting screen and
returns to the previous window.
Returns to the previous window without saving the setting
from the Detail Setting screen.

See Appendix B, "For Customers Who Cannot Easily Install a DHCP Server" in
First Step Guide about operating without setting up a DHCP server.

2.7.2.

Guard Parameter Setting

You can set the guard parameters. By setting the guard parameters, you enter the password of the login user or
warning messages are displayed when operating, and you can prevent operation misses.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Then click Guard Parameter Setting.
(4) A screen appears that requires entry of the password. Enter the password.
Enter the password that is the password for the login user.
(5) The Guard Parameter Setting screen appears. Then select Password, Warning or None and click OK.
These become effective immediately after setting. The DPM services do not need to be restarted.
The operation of the Password, Warning or None selected from the Guard Parameter Setting screen is
shown in the table below.
Setting
Password
Warning
None

Description
A password entry screen will be displayed at the time of each operation, and
you cannot operate it if the correct password is not entered.
A confirmation message will be displayed as a warning at the time of each
operation.
Nothing will be displayed at the time of each operation.
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The default guard parameter settings are those in the above figure.
Guard Parameter Setting
Add Machine
Delete Machine
Add Group

Set the Add Machine guard parameters.
Set the Delete Machine guard parameters.
Set the Add Group guard parameters.

Delete Group
Add Scenario

Set the Delete Group guard parameters.
Set the Add Scenario guard parameters.

Edit Scenario

Set the Edit Scenario guard parameters.

Delete Scenario

Set the Delete Scenario guard parameters.

Assign scenario

Set the Assign Scenario guard parameters

Remove Scenario
Assignment
Execute Scenario

Set the Remove Scenario Assignment guard
parameters
Set the Execute Scenario guard parameters.

Scenario Execution Stop

Set the Scenario Execution Stop guard parameters.

Power ON/Shutdown

Set the Power ON/Shutdown guard parameters

Package Download Setting

Set the Package Download Setting guard parameters.

Automatic Update Setting

Set the Automatic Update Setting guard parameters.

Set Automatic Update Time
by the Batch
OK
Cancel

Set the Set Automatic Update Time by the Batch
guard parameters.
Saves the setting on the Guard Parameter Setting
screen and returns to the previous window.
Returns to the previous window without saving the
setting from the Guard Parameter Setting screen.
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2.7.3.

Package Download Setting

You can add, edit, or delete the Package Web Server or package automatic downloads.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Download Setting screen appears in the main window. Then set each item.

Package Download Setting
Proxy
Address

Port
(Required)

Set the IP address or the host name of the proxy if
accessing the Package Web Server using a proxy.
The number of characters that can be entered is up to 127
single-byte characters.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
\*?
The default is blank.
Set the proxy port number if accessing the Package Web
Server using a proxy.
This can be set in the range of "1 - 65535".
The default value is "80."
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Download Automatically

Left List Box

Right List Box

Package Web Server
Display Count
"Action" Link

(Checkbox)
Server Address

Server ID

Download

When you select the Download Automatically checkbox,
you can set the timing for package automatic downloads.
By default, the checkbox is not selected. (*1)
Set the cycle and day of the week for the automatic
download. You can select from the following.
•Every Hour
•Everyday
•Sun - Sat (Sunday - Saturday)
Set the time for the automatic download. You can select
from the following.
•If you select Every Hour
10 minute increments from "0" to "50" minutes
•If you select Everyday
Hourly increments from "0:00" to "23:00"
•If you select either of Sun - Sat (Sunday - Saturday)
Hourly increments from "0:00" to "23:00"
Select the Display Count to be displayed in the Package
Web Server list.
When you click Add, Add Package Web Server screen
appears and you can add a Package Web Server. About
the method to add, see Section 2.7.3.1, "Add Package
Web Server."
When you click Delete, you can delete the Package Web
Server which is selected in the left check box. When you
select multiple Package Web Servers, you can delete
them collectively.
All Package Web Servers will be selected if you select in
the top checkbox.
Displays the address of the Package Web Server.
If multiple Package Web Servers are registered, they will
be displayed in ascending order.
When you click the displayed address, the base
information for the Package Web Server will be displayed
in the main window.
Displays the Package Web server identifier.
When a package is downloaded to the Management
Server, the server ID will be attached in front of each
package's ID number.
Displays whether the Package Web Server is the target of
automatic downloads.

Proxy

Displays whether a proxy is used when downloading a
package from the Package Web Server.

Latest Download
Information

Displays success/fail of the download or the time of the
latest download.

Edit

Edit the Package Web Server. Click the " " icon to
display the Edit Package Web Server screen in the main
window. For the edit screen, see Section 2.7.3.2, "Edit
Package Web Server."
Saves the setting on the Package Download Setting
screen and returns to the previous window.

OK
Cancel

Returns to the previous window without saving the setting
of the Package Download Setting screen.
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*1
DPM Server does not acquire the latest system time until the next download, so if you change the
Windows system time after you set the automatic download, the download may not be performed as
scheduled.




You can temporarily delete the package that was automatically downloaded
to the Management Server using the package delete function of Image
Builder.
However, if you do not delete the corresponding package from the Package
Web Server, it will be downloaded again at the set time of the automatic
download.
If a package is deleted from the Package Web Server using
PackageDescriber, the package on the Management Server will be deleted
at the time the next automatic download is performed.

You cannot change the package download setting during automatic download.

2.7.3.1.

Add Package Web Server

Add a Package Web Server.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Web Server group box appears in the main window. Click Add in the Action link.
(5) The Add Package Web Server screen appears in the main window. Set each item.
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Add Package Web Server
Server ID
(Required)

Address
(Required)

Set the Package Web Server ID.
The number of characters allowed is 1 - 7 single-byte
characters. A character can be any single-byte alphabet
and numeric characters or any of the following symbols.
_"local" (case insensitive) is already reserved and cannot
be used.
Set the URL of the Package Web Server.
Up to 255 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
\*?
The default is blank.

Port
(Required)

Set the Package Web Server port number. This can be set
in the range of "1 - 65535." The default value is "80."

Use Proxy

A proxy will be used when accessing the Package Web
Server if the Use Proxy checkbox is selected.
Do not set user authentication to the proxy server when
using a proxy server. By default, the checkbox is not
selected.

Select Automatic
Download Target

The package will be regularly downloaded from the
Package Web Server when the Select Automatic
Download Target checkbox is selected.
By default, the checkbox is not selected.(*1)

User Authentication

If the User Authentication checkbox is selected, user
authentication will be performed when the Package Web
Server is accessed.
Select this when user confirmation is required to access
the Package Web Server. When you select the User
Authentication, the User Name and Password entry is
enabled and User Name is a required entry item.
By default, the checkbox is not selected.
Enter the basic authentication user name set in the IIS.
The number of characters allowed is 1 - 63 single-byte
characters. Only single-byte alphanumeric characters can
be used.
Enter the basic authentication password set in the IIS.
The number of characters allowed is 1 - 63 single-byte
characters.
Only single-byte alphanumeric characters can be used.
This entry is optional.
Saves the setting on the Add Package Web Server
screen and returns to the previous window.
Returns to the previous window without saving the setting
from the Add Package Web Server screen.

User Name
(Required)

Password

OK
Cancel
*1

The Management Server does not acquire the latest system time until the next download, so if you
change the Windows system time after you set the automatic download, the download may not be
performed as scheduled.
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2.7.3.2.

Edit Package Web Server

Edit a Package Web Server.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) Once the Package Web Server group box appears in the main window, click the Edit icon(
Package Web Server to be edited.

) for the

(5) The Edit Package Web Server screen appears in the main window. Edit each item.
You can also display the Package Web Server screen using the following steps.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Or, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Web Server group box appears in the main window. Click the Server Address.
(5) The Configuration menu for the Package Web Server appears. Click Edit Package Web Server.
(6) The Edit Package Web Server screen appears in the main window. Edit each item.
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Edit Package Web Server
Server ID
Address
(Required)

Port

Use Proxy

Select Automatic
Download Target

The Package Web Server ID is displayed. This cannot be
edited.
The URL of the Package Web Server can be edited.
Up to 255 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric
characters. The following symbols cannot be used.
\*?
The Package Web Server port number can be edited. This
can be set in the range of "1 – 65535". The default value is
"80."
A proxy will be used when accessing the Package Web
Server if the Use Proxy checkbox is selected. Do not set
user authentication to the proxy server when using a proxy
server.
The package will be regularly downloaded from the
Package Web Server when the Select Automatic
Download Target checkbox is selected.

Change User Authorize

When the Change User Authorize checkbox is selected,
the User Authentication checkbox is enabled.

User Authentication

Select the User Authentication checkbox when user
authentication is required to access the Package Web
Server.
When you select this, entry of User Name and Password
is enabled.
Edit the basic authentication user name set in the IIS.
The number of characters allowed is 1 - 63 single-byte
characters.
Only single-byte alphanumeric characters can be used.
Edit the basic authentication password set in the IIS.
The number of characters allowed is 1 - 63 single-byte
characters.
Only single-byte alphanumeric characters can be used.
This entry is optional.

User Name
(Required)

Password

OK

Saves the setting on the Edit Package Web Server
screen and returns to the previous window.

Cancel

Returns to the previous window without saving the setting
from the Edit Package Web Server screen.

2.7.3.3.

Delete a Package Web Server

Delete a Package Web Server.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Or, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Web Server group box appears in the main window. Then select the left column of the
Package Web Server to Delete and click the Action link for Delete.
(5) The confirmation dialog box appears. Click OK.
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You can also delete the Package Web Server using the following steps.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Web Server group box appears in the main window. Click the Server Address.
(5) The Configuration menu for the Package Web Server appears. Click Delete Package Web Server.

(6) The confirmation dialog box appears. Click OK.

2.7.3.4.

Base Information about the Package Web Server

Displays the base information about the Package Web Server.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting.
(4) The Package Web Server group box appears in the main window. Then click the Server Address link.
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(5) The Base Information group box for the Package Web Server appears in the main window.

Base Information
Server ID
Address
Port
Use Proxy
Target of Auto Download
User Authorize
User Name

Displays the ID of the Package Web Server.
Displays the address of the Package Web Server.
Displays the port number used by the Package Web
Server.
Displays "Yes" if a proxy server is used and "No" if a proxy
server is not used.
Displays "Yes" if it is target of auto download and "No" if it
is not target of auto download.
Displays "Used" if user authentication is set and "Unused"
if user authentication is not set.
Displays the user name.
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2.7.4.

Automatic Update Setting

Set the automatic update.
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view.
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the
main window. Then click DPM Server.
(3) The Configuration menu for the DPM Server icon appears. Click Automatic Update Setting.
(4) The Automatic Update Setting screen will be displayed in the main window and you can configure each
item.
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Automatic Update Setting
Maximum Number Of
Machines For Automatic
Update(1-1000)
(Required)

Set the upper limit on the number of machines that can do
automatic updates at the same time.
The Maximum Number Of Machines For Automatic
Update is not a group unit; this is for all of the machines
that are registered to the Management Server.
This can be set in the range of "1-1000" units. The default
value is "5" machines.(*1)
The Maximum Transfer
When you select The Maximum Transfer Rate checkbox,
Rate (1-500MB/min)
you can control the transfer rate when transferring the
automatic update files.
The maximum transfer rate is set as the maximum data
volume in MByte that will transfer in 1 minute. This can be
set in the range of "1 - 500." The default value is "500"
MByte/minute.
By default, the checkbox is not checked.
Automatic Update During The New Group's Registration
Set the default value for the automatic update function for
Automatic Update
the new group.
•Constantly Off
•ON At Startup
•OFF At Startup
The default is OFF At Startup.
The following setting values will be disabled if the setting
is Constantly Off.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval(Min.)
When you set the automatic update function to
Constantly Off, the managed machine will not request
not applied packages to the Management Server. (*2)
Automatic Update Time
Set the default value for the automatic update time for the
new group.
Left List Box
Set the day for performing the automatic update. You can
select from the following.
•Everyday
•Sunday - Saturday(Sun. - Sat)
The default is blank.
Right List Box
Select hourly increments from "0:00" to "23:00." If you
select blank in the left list box, the setting time will be
disabled.
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Application Timing

Retry Count

Retry Interval(Min.)

OK
Cancel

Set the default value for the automatic update
application timing for the new group.
•Immediately
•At Next Startup
•Show Confirmation
The default is At Next Startup.
If the application Timing setting is Immediately or At
Next Startup, the screen will not be displayed on the
managed machines.(*3)
Set the default value of retry count which is set when a
new group is added.
The connection is retried up to the number which is set
here.
This can be set in the range of "0 – 5" times. The default
value is "1" time.
Set the default value for the Retry Interval (Min.) for the
new group.
This can be configured in five minute increments from
"5" to "30" minutes. The default value is"5" minutes.
Saves the setting on the Automatic Update Setting
screen and returns to the previous window.
Returns to the previous window without saving the
setting from the Automatic Update Setting screen.

*1
The number of machines on which automatic updates and scenarios can be executed simultaneously is
up to 1000 machines. Therefore, even if both of the number of machines set here and the number of
machines for scenario simultaneous execution (Management view –> DPM Server icon –> Detail
Setting in the Configuration menu –> Network tab -> Machines For Simultaneous Execution in
Scenario Execution Setting group box) are set to 1000 machines, the number of machines on which
automatic updates are executed simultaneously may be less than 1000.
*2
The example of the automatic update setting and action
•If the automatic update is ON At Startup and the automatic update time is set to Everyday 12:00, an
automatic update will be performed when the managed machine starts up and at 12:00 every day.
•If the automatic update is Off At Startup and the automatic update time is set to Wednesday 12:00,
an automatic update will be performed each week on Wednesday at 12:00. An automatic update will
not be run on the managed machine at start up.
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*3
Selection and action of the Application Timing are shown in the table below.
Selection
Action
Immediately
Applies the package immediately.
The status of the managed machine will change to Applying
A Package(Automatic Update).
At Next Startup
Applies the package at the next start up.
The status of the managed machine will change to Waiting
For Restart(Automatic Update).
Show Confirmation
The following screen will be displayed on the managed
machine.
Click to Execute Immediately or Run at Next startup.

Automatic updates will not be performed for machines registered to a new
machine group. It must be added to a group to perform an automatic update.
A package that has the priority Highest or High at the time of creation is sent
with automatic update. See Section 5.5, "Package Registration/Modification" or
Section 6.2, "Create Package" for details.
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3.

Operations

This chapter explains the operation of DPM in the Operations view.

3.1. "Operations" View
Functions such as information settings, information display and information management (add, edit or delete) for
the various resources (machine, scenario, or image and so on) are provided in the Operations view.
When you click Operations in the title bar, it will switch to the Operations view. The Summary Information
group box appears in the main window.

3.2. "Resource" Icon
You can manage resources used by the DPM with the Resource icon.
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Summary Information
Resource Type
Machines
Scenario Executing

Scenario Execution
Error

Scenario Execution
Stop

Scenarios

Images
HW Images

OS Images

Packages

Backup Images

When you click Machines, the Group List screen
appears.
When you click Scenario Executing, the machines with
normal status will be displayed on the Monitor view Scenario Execution List screen. See Section 4.3,
"Scenario Execution List" regarding the screen.
When you click Scenario Execution Error, the machines
with error status will be displayed on the Monitor view Scenario Execution List screen. See Section 4.3,
"Scenario Execution List" regarding the screen.
When you click Scenario Execution Stop, the machines
with error status will be displayed on the Monitor view Scenario Execution List screen. See Section 4.3,
"Scenario Execution List" regarding the screen.
When you click Scenarios, the Group List group box
appears. See Section 3.10, "Scenario Icon" regarding the
screen.
When you click Images, the Image List screen appears.
See Section 3.16, "Images Icon" regarding the screen.
When you click HW Images, the HW Image list is
displayed in the Image List group box. See Section 3.17,
"Image Detailed Information" regarding the screen.
When you click OS Images, the OS Image list is displayed
in the Image List group box. See Section 3.17, "Image
Detailed Information" regarding the screen.
When you click Packages, the Package list is displayed in
the Image List group box. See Section 3.17.1, "Package
Image Detailed Information" regarding the screen.
When you click Backup Images, the Backup Image is
displayed in the Image List group box. See Section
3.17.3, "Backup Image Detailed Information" regarding the
screen.
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3.3. "Machines" Icon
You can manage machine groups and managed machines in the Machines icon.
You can access the Machines icon from the Machines icon at the top of the Operations view - tree view or from
Machines in the Summary Information group box displayed in the Operations view – the main window.
Click the Machines icon to display the Group List group box in the main window.

Group List
Display Count
"Action" Link
(Checkbox)
Name

Subgroup Number
(Directly/Subordinates)
Machine Number
(Directly/Subordinates)
Edit

Select the number of the group registered on DPM Server
to display.
When you click Delete Group, the group which is checked
in the left checkbox will be deleted.
If you select the top checkbox, all groups in the list will be
selected.
Displays the name of the groups that are registered for
DPM Server. When you click the name, the detailed
information for the concerned group will be displayed.
Displays the number of groups directly under/subordinate
of the concerned group.
Displays the number of machines (managed machines)
directly under/subordinate of the concerned group.
You can edit the group information. Click the " " icon to
display the Edit Group screen in the main window. See
Section 3.5.1, "Edit Machine Group."
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3.3.1.

Add Machine Group

Add a machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Machines icon. The Summary Information group box appears in the main
window. Click Machines.
(3) The Configuration menu for the Machines icon will be displayed. Then click Add Group.
(4) The Add Group screen appears in the main window. Set each item.
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Add Group
Name
(Required)

Network Setting

Subnetwork is same with
DPM Server
Subnetwork is not same
with DPM Server

Default Gateway
(Required)

Subnet Mask
(Required)
Automatic Update Setting

Automatic Update

Enter the group name. 1 - 64 single-byte characters can be
entered. You cannot set the same name in the same layer.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
;/
Set the group network.
This will be the default for newly added machines.
The default will be Subnetwork is same with DPM
Server.
Select this when the managed machines of the group are
on the same Subnetwork as DPM Server.
Select this when the managed machines of the group are
on a different Subnetwork than DPM Server.
Select this when the group goes through a router and
belongs to a different network than the Management
Server.
The following items will be enabled if Subnetwork is not
same with DPM Server is selected.
•Default Gateway
•Subnet Mask
You must set these items if you select this.
Set the default gateway when the managed machines of
the group are on a different Subnetwork from DPM Server.
The top order of the IP address (first octet) is set in the
range of "1-223".
Set the subnet mask when the managed machines of the
group are on a different Subnetwork than DPM Server.
This setting will be default values for newly added
machines.
The values set on the Management view -> Automatic
Update Setting screen are displayed as default.
See Section 2.7.4, "Automatic Update Setting" regarding
the Automatic Update Setting screen.
Set the automatic update function. You can select the
following operations.
•Constantly OFF
•ON At Startup
•OFF At Startup
The default is OFF At Startup.
The following setting values will be disabled if the setting is
Constantly OFF.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval(Min.)
When you set the automatic update function to Constantly
OFF, the managed machine will not request not applied
packages to the Management Server. (*See Section 2.7.4,
"Automatic Update Setting" regarding "The example of the
automatic update setting and action.")
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Automatic Update Time
Left List Box

Right List Box

Application Timing

Retry Count

Retry Interval(Min.)

OK
Cancel

Set the automatic update time.
Select the date. You can select from the following.
•Everyday
•Sun - Sat
The default is blank.
Select hourly increments from "0:00" to "23:00." If you
select blank in the left list box, the setting time will be
disabled.
Set the package application timing. You can select from
the following.
•Immediately
•At Next Startup
•Show Confirmation
The default is At Next Startup.
If the application timing setting is Immediately or At Next
Startup, the confirmation screen will not be displayed on
the managed machines. (* See Section 2.7.4, "Automatic
Update Setting" about selection and action of the
Application Timing.)
If the connection to the Management Server failed, the
connection will be re-tried the set number of times. This
can be set in the range of "1 – 5" times.
The default value is "1" time.
If the connection to the Management Server failed, the
connection will be re-tried at the set time interval. This can
be configured in five minute increments from "5" to "30"
minutes.
The default value is "5" minutes.
The machine group is created with the setting from the
Add Group screen and it returns to the previous window.
Returns to the previous window without saving the setting
from the Add Group screen.

Note that the upper limit to machine groups and managed machines is as follows.
Item
Upper Limit
Total number of machine groups(total number of machine groups including
1000
sub-machine groups)
Number of machine group layers
20
Total number of managed machines(total number of managed machines
affiliated with all machine groups, including sub-machine groups)
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40000

3.3.2.

Delete Machine Group

Delete a machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon, then click the Machines icon.
(3) The Group List group box appears. Then select the checkbox on the left side of Machine Group to Delete.
(4) When you click the Action link for Delete Group, a confirmation dialog will be displayed.
(5) Click OK and run.
You can also do the following steps to delete a machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon, then click the Machines icon -> Machine Group to Delete icon.
(3) The Configuration menu for the machine group icon will be displayed, and then click Delete Group.
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(4) The confirmation dialog box appears. Click OK.
 When you delete a group, the sub-groups and machines directly under the
corresponding group will also be deleted.
 If the Status column of any of the managed machines belonging to the group
has one of the following status, the group cannot be deleted. Furthermore, if
the status condition of the sub-group machines is any of these, the group
cannot be deleted.
•Scenario Executing
•Scenario Execution Error
•Scenario Execution Stop
•Remote Power ON Error
•Automatic Update Progress
•Transferring Files(Automatic Update)
•Setting Automatic Update Time
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3.3.3.

Import Machine Data

Execute the batch registration of the machine data.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Machines icon. The Summary Information group box appears in the main
window. Click Machines.
(3) The Configuration menu for the Machines icon will be displayed. Then click Import Machine Data.
(4) The Import Machine Data screen appears in the main window. Then please select the CSV file from the
Browse button in the CSV File Settings group box.

CSV File Setting
CSV File
(Required)
Browse

Encoding
UTF-8
Shift-JIS
ISO-8859-1

Displays the CSV file path.
Click Browse and select the CSV file to import the machine data.
You cannot import the file if the CSV File Path is blank, if it is not a
CSV format, or if the CSV file format is invalid.
After importing the file, click Operations menu -> Refresh, and
confirm that the file is imported correctly.(*1)
Select this if the encoding is UTF-8.
Select this if the encoding is Shift-JIS.
Select this if the encoding is ISO-8859-1.

*1
 When importing the CSV file which was exported on the Web Console of DPM Ver6.0 or later, select
UTF-8 in Encoding. When you created the CSV file manually, select the same encoding with the file.
 Note the following when importing the machine data (CSV file) created in earlier DPM version.
1) When using the machine data (CSV file) created in the version earlier than DPM Ver5.0
The CSV file can be imported without editing it.
However, Identification Name, IP Address, Kernel ID, Kernel Display Name, and UUID, which
were added in the version later than DPM Ver5.0, are set as blank (Not specified) when importing it.
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2) When using the machine data (CSV file) created in the version earlier than DPM Ver6.0.
•Select "ISO-8859-1" in Encoding.
•There were group types (General Computer/BladeServer) in the version earlier than DPM Ver6.0,
but the group type was abolished from DPM Ver6.0 and they were unified to a General Computer
group (It is called Group from DPM Ver6.0).
The Unit ID/Slot ID/Scenario assignment permission and Slot width created by the BladeServer
group are disregarded. The scenario assignment is always permitted from DPM Ver6.0.
3) When using the machine data (CSV file) created in the version earlier than DPM Ver6.02.
In DPM Ver6.02 or later, the way to specify a group was changed from the machine group name, to
which the machine belongs directly, to the path name of the group, to which the machine is
registered. Therefore, when using the machine data (CSV file) created in the version earlier than
DPM Ver6.02, modify the file as to describe the path name of the group.
(When using the file created in the version earlier than DPM Ver6.02 without editing it, a machine
group is created directly under Machines icon.)
Also, the Identification Name added by the functional enhancement is set as blank (Not specified)
when importing it.
 The format and the explanation of the machine data file (CSV file).
The first and second lines are fixed (the strings described as follows). Describe the information of the
managed machine since third line.
CSV File Format
Version1.0
Machine Name,Identification Name,Group Path,MAC Address,IP Address,Kernel ID,Kernel Display
Name,UUID
"Machine Name(the first machine)","Identification Name(the first machine)","Group Path","MAC
Address","IP Address","Kernel ID","Kernel Display Name","UUID"
"Machine Name(the second machine)","Identification Name(the second machine)","Group Path","MAC
Address","IP Address","Kernel ID","Kernel Display Name","UUID"

How to describe since the third line
Item
Specifying is
Description
Required/
Optional
Machine Name Required
Enter the name of the managed machine. 1 - 63 single-byte
characters can be entered. The allowed characters are
single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
Also, you cannot register a machine name with only numbers.
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Identification
Name

Optional

Group Path

Required

MAC Address

Optional

IP Address

Optional

Kernel ID

Optional

Kernel Display Optional
Name
UUID

Optional





Enter the identification name of the managed machine.
1 - 63 single-byte characters can be entered. The allowed
characters are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
Also, you cannot enter the Identification Name containing only
numerals.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
Enter the full path of the machine group to which the machine is
registered.
The number of the layer of the group path is up to 20.
Enter "/"(slash) to separate the layer of the machine group.
1 - 64 single-byte characters can be entered as a group name
for each layer.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
;
When there is not a group corresponding to the specified path, a
machine group is automatically created.
Enter the MAC address.
A hexadecimal number can be entered (0 - 9/a - f/A - F).
Enter it in the form "xx-xx-xx-xx-xx-xx".
If there are multiple MAC addresses, describe the MAC
addresses separating by "|".
Example) "00-15-87-1e-c2-11|00-12-75-1e-d2-32"
Enter "--" (two single-byte hyphens) when omitting the MAC
address.
Furthermore, when importing the machine data, all of the MAC
addresses described in the CSV are imported.
Enter either or both of the MAC address/UUID.
Enter the IP address.
The type of characters that can be used are "0 - 9." Enter them
in the form "xxx.xxx.xxx.xxx".
If there are multiple IP addresses, describe the IP addresses
separating by ",". However, only first IP address is imported.
Enter "-- (two single-byte hyphens) when omitting the IP
address.
Enter the kernel ID.
Enter "--" (two single-byte hyphens) when omitting the kernel ID.
Enter the kernel display name.
Enter "--" (two single-byte hyphens) when omitting the kernel
display name.
Enter the UUID.
A hexadecimal number can be entered. (0 - 9/a - f/A - F).
Enter them in the form
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx".
Enter "--" (two single-byte hyphens) when omitting the UUID.
Enter either or both of the MAC address/UUID.

When specifying character strings including ", describe "" and enclose the
item with ".
Example)
When the group name is /grou"p/, describe as "/grou""p/".
You can also register by the CSV file, which is output using Export Machine
Data.
See Section 3.3.4, "Export Machine Data" about exported CSV files.
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Example) When creating a CSV file to register the machine data by the contents of the following table, describe
the file as sample01.csv.
Machine Identifi Group
MAC Address
IP Address Kernel Kernel
UUID
Name
cation Path
ID
Display
Name
Name
COMP1 IDEN1 /GROUP1/ 00-11-22-33-44-55 None
None
None
None
GROUP2/
00-11-22-33-44-66 192.168.0.1 None
COMP2 IDEN2
None
b4e8f2e4-a2ff-4464
GROUP3
-a97c-7e93fef0542
a
00-11-22-33-44-77 192.168.0.2 kernel1 NEC
COMP3 None
None
Express58
00 001
COMP4 IDEN4 /GROUP4 00-11-22-33-44-88 192.168.0.3 kernel2 NEC
8dda9b94-6918-42
00-11-22-33-44-99 192.168.0.4
Express58 ed-bd4c-1aa3cfec7
00 002
50c
sample01.csv
Version1.0
Machine Name,Identification Name,Group Path,MAC Address,IP Address,Kernel ID,Kernel Display
Name,UUID
"COMP1","IDEN1","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-55","--","--","--","--"
"COMP2","IDEN2","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-66","192.168.0.1","--","--","b4
e8f2e4-a2ff-4464-a97c-7e93fef0542a"
"COMP3","","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-77","192.168.0.2","kernel1","NEC
Express5800 001","--"
"COMP4","IDEN4","/GROUP4","00-11-22-33-44-88|00-11-22-33-44-99","192.168.0.3,192.168.0.4",
"kernel2","NEC Express5800 002","8dda9b94-6918-42ed-bd4c-1aa3cfec750c"

3.3.4.

Export Machine Data

The machine data is exported as a CSV format file. Once the machine data export is performed, you can simply
make a format.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Machines icon. Or by clicking the Machines icon, the Summary Information
group box appears in the main window. Click Machines.
(3) The Configuration menu for the Machines icon will be displayed. Then click Export Machine Data.
(4) The File Download dialog box appears and then please click Save.






All of the machines included under the sub-group are exported.
When exported, the data is encoded to UTF-8.
Only the group on which the machine is registered is exported.
It will not export the Network Setting and Automatic Update Time Setting
information. The default when importing will be the same settings as the
registered group.
If the managed machine has multiple MAC addresses, all MAC addresses will be
exported.
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3.4. "Group" Icon
The machines are classified by group and managed in the Group icon.
You can access the Group icon from the Machines icon -> Group icon at the top of the Operations view -> tree
view or from Machines -> Group icon in the Summary Information group box displayed in the Operations view
-> main window.
Click the Group icon to display the Group Detail, the Machine List, and the Subgroup List group box in the
main window.

3.5. Machine Group Details
Displays the group detailed information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Display Group Detail icon.
(3) Displays the Group Detail, Machine List and Subgroup List group box in the main window.
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Group Detail

Parent Group Name

Name
Network Setting
Network
Default Gateway

Subnet Mask

Automatic Update Setting
Automatic Update
Automatic Update Time
Application Timing
Retry Count
Retry Interval(Min.)
Machine List
Display Count
"Action" Link

(Checkbox)
"Action" Menu

Displays the group detail.
This group box is not displayed by default.
Expand it by clicking on the arrow ( ) in the right.
The parent group name is displayed only when it is a
submachine group (The group level is the second level or
is lower than the second level). The parent group name
will not be displayed for groups directly under the
Machines (first level groups).
Displays the group name.
Displays the group network setting.
Displays whether the managed machines of the group are
on the same Subnetwork as DPM Server.
Displays the default gateway when the managed
machines of the group are on a different Subnetwork than
DPM Server.
Displays the subnet mask when the managed machines of
the group are on a different Subnetwork than DPM Server.
This cannot be edited.
Displays the automatic update setting for the group.
Displays the automatic update function.
Displays the automatic update time.
Displays the operation for the automatic update
application timing.
Displays the number of retries.
Displays the retry interval.
Select the number of items of the managed machines
registered in the group to display.
・ When you click Move Machine, the managed
machine, which is selected in the left checkbox, is
moved between groups. You can move multiple
managed machines between groups collectively by
selecting the multiple checkboxes.
・ When you click Delete Machine, the managed
machine, which is selected in the left checkbox, is
deleted. You can delete multiple managed machines
collectively by selecting the multiple checkboxes.
You can select all of the managed machines in the list if
you select the top checkbox.
Performs the operation on the selected managed
machine. You can select the following from the action
menu.
•Power ON
•Shutdown
•Set Power Management Schedule
•Assign Scenario
•Remove Scenario Assignment
•Execute Scenario
•Scenario Execution Stop
•Remove Error
•Remove Interruption
If you select Set Power Management Schedule, the
Power Management Schedule screen will be displayed.
See Section 3.8.5, "Power Management Schedule"
regarding the screen.
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Name

Displays the identification name of the managed machine
registered to the group. (Displays the machine name when
the identification name is not specified.) This cannot be
edited.

IP Address

Displays the IP address of the managed machine. This
cannot be edited.
Displays the MAC address of the managed machine. This
cannot be edited.
The status of the managed machine is displayed. See
Section 3.7.1, "Machine Status" regarding status types
and explanations.
Displays the machine power status.
Displays the name of the scenario assigned to the
machine.
Click Scenario Name to display the Scenario Detail
screen in the main window.
See Section 3.15, "Scenario Detail Information" regarding
the screen.

MAC Address
Status

Power
Scenario Name

Edit

Subgroup List
Display Count
"Action" Link

(Checkbox)
Name
Subgroup Number
(Directly/Subordinates)
Machine Number
(Directly/Subordinates)
Edit

Edit the managed machine. Click the " " icon to display
the Edit Machine screen in the main window. See Section
3.7.2, "Edit Managed Machine" regarding the edit screen.

Select the number of items of the sub-groups registered in
the group to display.
When you click Delete Group, the sub-group, which is
selected in the left checkbox, will be deleted
You can delete multiple sub-groups collectively by
selecting the multiple checkboxes.
You can select all of the sub-groups in the list if you select
the top checkbox.
Displays the name of the sub-group registered with the
group. This cannot be edited.
Displays the number of sub-groups directly
under/subordinate to the concerned group.
Displays the number of machines (managed machines)
directly under/subordinate to the concerned group.
Edit a sub- group. Click the " " icon to display the Edit
Group screen in the main window. See Section 3.5.1, "Edit
Machine Group" regarding the edit screen.
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3.5.1.

Edit Machine Group

Edit a machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Edit icon.
(3) The Configuration menu for the Machine Group icon will be displayed, and then click Edit Group.
(4) Click OK to display the Edit Group screen in the main window and please edit each item.
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Edit Group
Parent Group Name

Name
(Required)

Network Setting

Subnetwork is same with
DPM Server
Subnetwork is not same
with DPM Server

Default Gateway
(Required)

Subnet Mask
(Required)
Reflect setting to the
machines that has been
already registered to this
group as well
Reflect setting to the
direct machine

Reflect setting to the
subordinate machine
and group

The parent group name is displayed only when it is a
sub-machine group (The group level is the second level or
is lower than the second level).
The parent group name will not be displayed for groups
(first level groups) directly under the Machines.
Enter the group name. 1 - 64 single-byte characters can
be entered. You cannot set the same name in the same
layer. The allowed characters are single-byte
alphanumeric characters.
The following symbols cannot be used.
;/
Edit the group network setting.
The default is the value set on the Add Group screen.
See Section 3.3.1, "Add Machine Group" regarding the
Add Group screen.
If you edit the group network setting this will become the
default value for the newly added machine.
Select this when the managed machines of the group are
on the same Subnetwork as DPM Server.
Select this when the managed machines of the group are
on a different Subnetwork than DPM Server.
Select this when the group goes through a router and
belongs to a different network than DPM Server.
The following items will be enabled if the setting is
Subnetwork is not same with DPM Server.
•Default Gateway
•Sub-net Mask
Set up is required if the items are enabled.
Set the default gateway when the managed machines of
the group on a different Subnetwork than DPM Server.
The top order of the IP address (first octet) is set in the
range of "1-223."
Set the subnet mask when the managed machines of the
group on a different Subnetwork than DPM Server.
You can also apply the network settings to the managed
machines belonging to this group If you select the Reflect
setting to the machines that has been already
registered to this group as well checkbox. By default,
the checkbox is not selected.
Select this to apply the setting to the machines directly
under the group.
Reflect setting to the direct machine is selected by
default.
Select this to apply the setting to groups and machines
under the group.
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Automatic Update Setting

Automatic Update

Automatic Update Time
Left List Box

Right List Box

Edit the automatic update settings for the group.
The default is the value set on the Add Group screen.
See Section 3.3.1, "Add Machine Group" regarding the
Add Group screen.
If you edit the automatic update settings, this will become
the default value for the newly added machine.
Set the automatic update function. You can select from
the following.
•Constantly Off
•ON At Startup
•OFF At Startup
The default is the value set on the Add Machine Group
screen. See Section 3.3.1, "Add Machine Group"
regarding the setting values.
The following setting values will be disabled it the setting
is Constantly Off.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval (Min.)
When you set the automatic update function to
Constantly OFF, the managed machine will not request
not applied packages to the Management Server. (*See
Section 2.7.4, "Automatic Update Setting" regarding "The
example of the automatic update setting and action.")
Set the automatic update time.
Select the day for performing the automatic update. You
can select from the following.
•Everyday
•Sun. – Sat.
The default is the value set on the Add Machine Group
screen. See Section 3.3.1, "Add Machine Group"
regarding the setting values.
You can select hourly increments from "0:00" to "23:00." If
you select blank in the left list box, the setting time will be
disabled.
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Application Timing

Retry Count

Retry Interval(Min.)

Reflect setting to the
machines that has been
already registered to this
group as well
Reflect setting to the
direct machine

Reflect setting to the
subordinate
machine
and group
OK
Cancel

3.5.2.

Set the package Application Timing. You can select
from the following.
•Immediately
•At Next Startup
•Show Confirmation
The default is the value set in the Add Machine Group.
See Section 3.3.1, "Add Machine Group" regarding the
setting values. At Next Startup
If the Application Timing setting is Immediately or At
Next Startup, the user confirmation screen will not be
displayed on the managed machines. (*See Section 2.7.4,
"Automatic Update Setting" about selection and action of
the Application Timing.")
If the connection to DPM Server failed, the connection will
be re-tried the specified number of times for re-try. This
can be set in the range of "1 – 5" times.
The default is the value set in the Add Machine Group.
See Section 3.3.1, "Add Machine Group" regarding the
setting values.
If the connection to DPM Server failed, the connection will
be re-tried at the set time interval. This can be configured
in five minute increments from "5" to "30" minutes.
The default is the value set in the Add Machine Group.
See Section 3.3.1, "Add Machine Group" regarding the
setting values.
You can also apply the automatic update settings to the
managed machines belonging to this group If you select
the Reflect setting to the machines that has been
already registered to this group as well checkbox. By
default, the checkbox is not checked.
Select this to apply the setting to the machines directly
under the group.
Reflect setting to the direct machine is selected by
default.
Select this to apply the setting to groups and machines
under the group.
Saves the setting on the Edit Group screen and returns to
the previous window.
Returns to the previous window without saving the setting
from the Edit Group screen.

Delete Machine Group

Delete a machine group.
See Section 3.3.2, "Delete Machine Group" regarding the details.
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3.5.3.

Add Sub Group

Add a sub-machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Add subgroup icon.
(3) The Configuration menu for the Machine Group icon will be displayed, then click Add Subgroup.
(4) The Add Group screen appears in the main window. Enter the subgroup information and set each item.
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Add Group
Parent Group Name
Name
(Required)

Network Setting

Subnetwork is same
with DPM Server
Subnetwork
is
not
same with DPM Server

Default Gateway
(Required)

Subnet Mask
(Required)
Automatic Update Setting

Display the parent group name. This cannot be edited.
Enter the subgroup name. 1 - 64 single-byte characters
can be entered. You cannot set the same name in the
same layer.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
;/
Edit the network settings for a subgroup.
By default, the new group will inherit the values set in the
parent group.
If network settings are performed on the subgroup, these
will become the default for machines under the
corresponding group.
Select this when the managed machines of the group are
on the same Subnetwork as DPM Server.
Select this when the managed machines of the group are
on a different Subnetwork than DPM Server.
Select this when the group goes through a router and
belongs to a different network than DPM Server.
The following items will be enabled if the setting is
Subnetwork is not same with DPM Server.
•Default Gateway
•Subnet Mask
Set up is required if the items are enabled.
Set the default gateway when the managed machines of
the group are on a different Subnetwork than DPM Server.
The top order of the IP address (first octet) is set in the
range of "1-223."
Set the subnet mask when the managed machines of the
group are on a different Subnetwork than DPM Server.
Perform automatic updates setting for a sub group.
By default, the new group will inherit the values set in the
parent group.
If automatic update setting is performed on the subgroup,
these will become the default for machines under the
corresponding group.
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Automatic Update

Automatic Update Time
Left List Box

Right List Box

Application Timing

Retry Count

Retry Interval(.Min)

OK
Cancel

Set the automatic update function. You can select from the
following.
•Constantly OFF
•ON At Startup
•OFF At Startup
The default is OFF At Startup.
The following setting will be disabled it the setting is
Constantly OFF.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval (Min.)
When you set the automatic update function to
Constantly OFF, the managed machine will not request
not applied packages to the Management Server. (*See
Section 2.7.4, "Automatic Update Setting" regarding "The
example of the automatic update setting and action.")
Set the automatic update time.
Select the date. You can select from the following.
•Everyday
•Sun - Sat
The default is blank.
Select hourly increments from "0:00" to "23:00". If you
select blank in the left list box, the setting time will be
disabled.
Set the package application timing. You can select from
the following.
•Immediately
•At Next Startup
•Show Confirmation
The default is At Next Startup
If the application timing is Immediately or At Next
Startup, the confirmation screen will not be displayed on
the managed machines. (*See Section 2.7.4, "Automatic
Update Setting" about selection and action of the
Application Timing.)
If the connection to the Management Server failed, the
connection will be re-tried by the set number. This can be
set in the range of "0 – 5" times.
The default value is "1" time.
If the connection to the Management Server failed, the
connection will be re-tried by the set time interval. This can
be configured in five minute increments from "5" to "30"
minutes.
The default value is "5" minutes.
The sub-machine group is created with the setting on the
Add Group screen and it returns to the previous window.
Returns to the previous window without saving the setting
from the Add Group screen.

Note that the upper limit to machine groups and managed machines is as follows.
Item
Upper Limit
Total number of machine groups (total number of machine groups including
1000
subgroups)
Number of machine group layers
20
Total number of managed machines (total number of managed machines
affiliated with all machine groups, including sub-machine groups)
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40000

3.5.4.

Delete Subgroup

Delete a sub-machine group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Delete Sub Machine Group
icon.
(3) Subgroup List group box appears in the main window. Select the left checkbox of Machine Group to
Delete.
(4) Click Delete Group in Action link. The confirmation dialog box appears.
(5) Click OK.
Also, you can delete a sub-machine group in the following procedure.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2)

In the tree view, click Resource icon -> Machines icon -> Sub Machine Group to Delete icon.

(3)

The Configuration menu for the Sub Machine Group icon appears. Click Delete Group.

(4) The confirmation dialog box appears. Click OK.
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When you delete a group, the sub-groups and managed machines under the group
will be also deleted.

3.5.5.

Register Managed Machine

Add a managed machine.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon, click the Machines icon, and then click the Machine Group to
Add Managed Machine icon.
(3) The Configuration menu for the Group icon will be displayed, and then click Add Machine.
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(4) The Add Machine screen appears in the main window. Please set each item.
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Add Machine
Group Name
Machine Name
(Required)

Identification Name

MAC Address
(You must enter either or
both of the MAC
address/UUID)
UUID
(You must enter either or
both of the MAC
address/UUID)

IP Address

Displays the name of the group to which the managed machine
will be added. This cannot be edited.
Enter the managed machine name.
1 - 63 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
Also, you cannot register a machine name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
If the OS is already installed on the machine to be added, you
must enter the same name as the machine (OS) has.
If DPM Client is installed, even if the machine name registered
on the Web Console and the actual machine are different, the
name will be automatically changed to the actual machine name
on the Web Console when the machine is powered ON.
Enter the identification name of the managed machine.
1 - 63 single-byte characters can be entered. The allowed
characters are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
Also, you cannot use a name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
You cannot add a machine with the same name under the same
DPM Server.
Enter the MAC address of the managed machine.
A hexadecimal number can be entered.(0 - 9/a - f/A - F).
Enter it in the form "xx-xx-xx-xx-xx-xx".
Enter the UUID of the managed machine.
A hexadecimal number can be entered.(0 - 9/a - f/A - F). Enter
them in the form
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx".
If you enter all "0" or all "F", the value is handled "nothing" by the
DPM.
If the UUID is unknown, register the machine without UUID.
Please make the corresponding machine be booted from
network, or please install DPM Client. The UUID will be complete
through the network boot or DPM Client installation.(*1)
Enter the IP address of the managed machine.
The type of characters that can be used are "0 - 9." Enter them in
the form "xxx.xxx.xxx.xxx".
You cannot add a machine with the same IP address under the
same DPM Server.
If there are multiple IP addresses on the managed machine,
enter the IP address communicating with DPM Server.
If you do not install DPM Client on the managed machine, enter
IP address necessarily.
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Deploy-OS

Select Deploy-OS to be used by the managed machine when
you execute backup/restore/disk configuration check.
Please contact your sales or support representative about the
value, which is set for each machine model.
Deploy-OS installed in DPM Server is displayed in the list box.
If Deploy-OS for the machine model that is being used is not
displayed in the list box, obtain the module for the machine
model from your sales or support representative and install it on
DPM Server. Deploy-OS will be displayed in the list box.

Scenario Setting
Assign Scenario
Scenario Name

Remove Scenario
Assignment
Scenario Applying
Schedule
Only
Once

Daily

Select to assign a scenario to a managed machine. Browse in
the Scenario Name text box is enabled.
Set the scenario, which will be assigned to the managed
machines.
When you click Browse, the Select Scenario screen appears.
Select the scenario and click OK.
Select to remove the scenario assignment
If you select the Scenario Applying Schedule checkbox, you
can set the scenario applying schedule. If you do not set the
scenario, you cannot select the checkbox.

The schedule is executed only once.
Date
Set the date.
(Required)
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
Time
Set the time.
(Required)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
The allowed characters are single-byte numbers.
The schedule is executed on the set "Day" and "Time" from "Start Date."
Start Date
Set the start date.
(Required)
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
End Date
Set the end date.
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
If the end date is not set, the schedule will repeatedly run the set
content. This is optional.
Time
Set the time.
(Required)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
Interval
Edit the interval in day units. This can be set in the range of "1 (Required)
99" days.
The default value is "1" (once per day).
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Weekly

Monthly

The schedule is executed weekly on the set "Day of the Week" and "Time."
Start Date
Set the start date.
(Required)
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
End Date
Set the end date.
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
If the end date is not set, the schedule will be repeatedly run by
the set content. This is optional.
Time
Set the time.
(Required)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
Day of the
Set one or more of Sunday - Saturday.
Week Setting
(Required)
The schedule is executed monthly on the set "Date" and "Time."
Start Month
Set the start month.
(Required)
You can enter the date (year/month) or click the " " icon on the
side of the textbox and select the date from the displayed
calendar.
When you enter a month, use YYYY/MM format.
End Month
Set the end month.
You can enter the date (year/month) or click the " " icon on the
side of the textbox and select the date from the displayed
calendar.
When you enter a month, use YYYY/MM format.
If the end month is not set, the schedule will repeatedly run the
set content. This is optional.
Time
Set the time.
(Required)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
Day
If you select Day, set the day from the list box.
(You Must Set
Example) "End of Month" day
Either Day/
Week
Week
If you select Week, set the day of the week from the list box.
(You Must Set
Example) "1(First)" - "Monday"
Either Day/
Week
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Power
Management Schedule

Only
Once

Specify
Day

If you select the Power Management Schedule checkbox, you
can manage the machine's power status.
If a check is entered, select either or both Power ON Time
/Shutdown Time.
The schedule is executed only once.
Power ON Time If you select the Power ON Time checkbox, you can set the
(You must set
power ON time.
either or both
You can enter the date (year/month/day) or click the " " icon on
of Power ON
the side of the textbox and select the date from the displayed
Time/Shutdow
calendar.
When you enter a date, use YYYY/MM/DD format.
n Time.)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
Set the time from after 5 minutes from the current time.
Shutdown
If you select the Shutdown Time checkbox, you can set the
Time
shutdown time.
(You must set
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
either or both
calendar.
of Power ON
Time/Shutdow
When you enter a date, use YYYY/MM/DD format.
n Time.)
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59
Set the time from after 5 minutes from the current time. If you set
this at the same time as the Power ON Time, set the interval
more than 10 minutes.
Do not show
If you select the Do not show countdown dialog checkbox, the
countdown
countdown dialog is not displayed at the time of shutdown.
dialog
The schedule is executed on the set "Day of the Week" and "Time."
Power On Time If you select the Power ON Time checkbox, you can set the
(You must set
power ON time.
either or both
You can enter the following range in the textbox.
of Power ON
•"Hr" 0 - 23
Time/Shutdow
•"Min" 0 - 59
n Time.)
Shutdown
If you select the Shutdown Time checkbox, you can set the
Time
shutdown time.
(You must set
You can enter the following range in the textbox.
either or both
•"Hr" 0 - 23
of Power ON
•"Min" 0 - 59
Time/Shutdow
If you set this at the same time as the Power ON Time, set the
n Time.)
interval more than 10 minutes.
Do not show
If you select the Do not show countdown dialog checkbox, you
countdown
cannot display the countdown timer dialog at the time of
dialog
shutdown or not.
Day of the
Set one or more of Sunday - Saturday.
Week Setting
(Required)
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Network Setting
Subnetwork is same with
DPM Server
Subnetwork is not same
with DPM Server

Default Gateway
(Required)
Subnet Mask
(Required)
Automatic Update Setting
Automatic Update

Automatic Update Time
Left List Box

Right List Box
Application Timing

Select this when the managed machine is on the same
Subnetwork as DPM Server.
Select this when the managed machines is on a different
Subnetwork than DPM Server.
Select this when the managed machine goes through a router
and belongs to a different network than DPM Server.
The following items will be enabled if the setting is Subnetwork
is not same with DPM Server.
•Default Gateway
•Subnet Mask
Set up is required if the items are enabled.
Set the default gateway when the managed machine is on a
different Subnetwork than DPM Server. The top order of the IP
address (first octet) is set in the range of "1-223."
Set the subnet mask when the managed machine is on a
different Subnetwork than DPM Server.
Set the automatic update function. You can select from the
following.
•Constantly OFF
•ON At Startup
•OFF At Startup
The default is OFF At Startup.
The following setting will be disabled it the setting is Constantly
OFF.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval (Min.)
When you set the automatic update function to Constantly OFF,
the managed machine will not request not applied packages to
the Management Server. (*See Section 2.7.4, "Automatic Update
Setting" regarding "The example of the automatic update setting
and action.")
Set the automatic update time.
Select the day for performing the automatic update. You can
select from the following.
•Everyday
•Sun - Sat
The default is blank.
Select hourly increments from "0:00" to "23:00". If you select
blank in the left list box, the setting time will be disabled.
Set the package application timing. You can select from the
following.
•Immediately
•At Next Startup
•Show Confirmation
The default is At Next Startup
If the application timing is Immediately or At Next Startup, the
confirmation screen will not be displayed on the managed
machines. (*See Section 2.7.4, "Automatic Update Setting" about
selection and action of the Application Timing.)
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Retry Count

Retry Interval (Min.)

OK
Cancel

If the connection to the Management Server failed, the
connection will be re-tried the set number of re-try times. This
can be set in the range of "1 – 5" times.
The default value is "1" time.
If the connection to the Management Server failed, the
connection will be re-tried at the set time interval. This can be
configured in five minute increments from "5" to "30" minutes.
The default value is "5" minutes.
The machine is added with the setting on the Add Machine
screen and it returns to the previous window.
It returns to the previous window without adding the machine with
the setting from the Add Machine screen.

*1
The DPM will distinguish the registered machine by UUID, so SSC coordination may not be performed
properly if the UUID is not registered. In that case, please register the UUID.

3.5.6.

Move Machine

Move a managed machine between groups. You can move the managed machine regardless of its status
(automatic update status/scenario status/power status).
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Machine to Move on the Machine List group box in the main
window.
(4) Click Move Machine of Action link.
(5) The Move Machine dialog box appears and then set Move Target Group.

(6) Click OK.
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You can also display the Move Machine screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon - Machines icon - Machine Group icon.
(3) The Machine List group box appears in the main window. Then click the name of the Machine to Move.
(4) The Configuration menu for the machine will be displayed, and then click Move Machine.
(5) The Move Machine dialog box appears and then set Move Target Group.
(6) Click OK.

3.5.7.

Delete Machine

Delete a managed machine.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Machine to Delete on the Machine List group box in the main
window.
(4) When you click the Action link for Delete Machine, a confirmation dialog will be displayed.
(5) Click OK.
You can also execute Delete Machine using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Machine to Delete.
(4) The Configuration menu for the machine will be displayed, and then click Delete Machine.
(5) Click OK.
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3.5.8.

Batch Network Setting

Set the network settings as a batch. Batch Network Setting can be applied to the machines directly under the
group or the groups and machines under the group that is the target for the application.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch Network Setting
icon.
(3) The Configuration menu for the Machine Group icon will be displayed, and then click Network Setting
from Batch Setting.
(4) The Batch Network Setting screen will be displayed in the main window and you can configure each item.
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Batch Network Setting
Group Name

Displays the group name. This cannot be edited.

Network Setting

Configure the network settings.
The default is Subnetwork is same with DPM Server.

Subnetwork is same
with DPM Server

Select this when the managed machines of the group are on the
same Subnetwork as DPM Server.

Subnetwork is not
same with DPM Server

Select this when the managed machines of the group are on a
different Subnetwork than DPM Server.
Select this when the group or the managed machines which are
specified by Scope To Apply goes through a router and belongs to a
different network than DPM Server.
The following items will be enabled if the setting is Subnetwork is
not same with DPM Server.
•Default Gateway
•Subnet Mask

Set up is required if the items are enabled.
Default Gateway
(Required)

Set the default gateway when Subnetwork is not same with DPM
Server is selected. The top order of the IP address (first octet) is set
in the range of "1-223."

Subnet Mask
(Required)

Set the subnet mask when Subnetwork is not same with DPM
Server is selected.

Scope To Apply

Set the target for the network batch.

Reflect setting to the
direct machine

Select this to apply the setting to the machines directly under the
group.
Reflect setting to the direct machine is selected by default.

Reflect setting to the
subordinate machine
and group

Select this to apply the setting to groups and machines under the
group.

OK

Saves the batch settings details of the Batch Network Setting
screen and returns to the previous window.

Cancel

Returns to the previous window without saving the setting from the
Batch Network Setting screen.
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3.5.9.

Batch Set Automatic Update Time

The automatic update time for the managed machine registered with the group is set by batch.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Set Automatic Update
Time icon.
(3) The Configuration menu for the Machine group icon will be displayed, and then click Set Automatic
Update Time from Batch Setting.
(4) The Batch Set Automatic Update Time screen will be displayed in the main window and you can
configure each item.
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Batch Set Automatic Update Time
Group Name

Displays the group name. This cannot be edited.

Automatic Update Time Setting
Automatic Update

Set the automatic update function for the group. You can select
from the following.
•Constantly Off
•ON At Startup
•OFF At Startup

The default is OFF At Startup.
The following setting values will be disabled it the setting is
Constantly Off.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval (Min.)
When you set the automatic update function to Constantly Off,
the managed machine will not request not applied packages to the
Management Server. (*See Section 2.7.4, "Automatic Update
Setting" regarding "The example of the automatic update setting
and action.")

Automatic Update Time
Left List Box

Set the automatic update time for the group.
Select the day for performing the automatic update. You can select
from the following.
•Everyday
•Sunday - Saturday(Sun. – Sat)

The default is blank.
Right List Box
Application Timing

Select hourly increments from "0:00" to "23:00". If you select blank
in the left list box, the setting time will be disabled.

Set the action of application timing of the package. You can
select from the following.
•Immediately
•At Next Startup
•Show Confirmation

Retry Count

Retry Interval(Min.)

The default is At Next Startup.
If the application timing is Immediately or At Next Startup, the
screen will not be displayed on the managed machines. (*See
Section 2.7.4, "Automatic Update Setting" about selection and
action of the Application Timing.)
If the connection to the Management Server failed, the connection
will be re-tried by the set number. This can be set in the range of "0
- 5" times.
The default value is "1" time.
If the connection to the Management Server failed, the connection
will be re-tried at the set time interval. This can be configured in
five minute increments from "5" to "30" minutes.
The default value is "5" minutes.
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Scope To Apply

Set the target for Batch Set Automatic Update Time.

Reflect setting to the
direct machine

Select this to apply the setting to the machines directly under the
group.
Reflect setting to the direct machine is selected by default.

Reflect setting to the
subordinate machine
and group

Select this to apply the setting to groups and machines under the
group.

OK

Saves the batch settings details of the Batch Set Automatic
Update Time screen and returns to the previous window.

Cancel

Returns to the previous window without saving the batch settings
details from the Batch Set Automatic Update Time screen.
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3.6. Menu Operations for a Group
Explains the menus related to the operations used by the group.

3.6.1.

Batch Execution

These are batch operations such as Assign Scenario, Remove Scenario Assignment, Power ON, Shutdown,
Execute Scenario, and Scenario Execution Stop for all of the managed machines in the corresponding group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch Execution icon.
(3) The Machine List group box appears. Then please perform the various operations from Batch Execution
on the Operation menu. The configuration and the notes about the Operation menu is the same with that
about the Operation menu for the managed machine. See Section 3.8, "Menu Operations to a Machine."
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Batch Execution
Assign Scenario

Assigns the scenario to all managed machines in the corresponding
group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.

Remove Scenario
Assignment

Deletes the scenario assignment for all managed machines in the
corresponding group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.

Power ON

Executes the Power ON for all managed machines in the
corresponding group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.

Shutdown

Executes the shutdown for all managed machines in the
corresponding group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.

Execute Scenario

Executes the scenario for all managed machines in the corresponding
group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.

Scenario Execution Stop

Stops the scenario execution for all managed machines in the
corresponding group.
Select the target from the Scope To Apply group box using the option
button for the target machines as shown in the following example.




The managed machine that scenario execution stop was executed is
powered off at the timing of PXE boot after running scenario is stopped.
When a scenario is executed on the managed machine over Machines For
Simultaneous Execution, the processing of the scenario execution stop
may be executed, after the processing of the execution is started on the
machine, depending on the timing.
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Example)
If you click Assign Scenario from Batch Execution on the Operation menu, the Batch Assign
Scenario screen will be displayed.

Application Target
Group Name

Displays the group name. This cannot be edited.

Scope To Apply

Set the target of the batch operation.

Reflect setting to the
direct machine

Select this to assign the scenario to the machines directly under
the group.
Reflect setting to the direct machine is selected by default.

Reflect setting to the
subordinate machine

Select this to assign the scenario to groups and machines under
the group.

Run Now
(only for Assign Scenario)

The scenario will run immediately on the target machine. An error
message will be displayed if there is no scenario assigned to the
target machine.

OK

Batch execution will be done by the configuration on the screen
and returns to the previous window.

Cancel

Returns to the previous window without doing batch execution by
the configuration on the screen.
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3.7. Managed Machine Details
Displays the machine detailed information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears. Click the name of the Machine to Display Information.
(4) The Machine Detail group box appears in the main window.
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Machine Detail
Machine Name

Displays the name of the managed machine. This cannot be edited.

Identification Name

Displays the identification name of the managed machine. This
cannot be edited.

Group

Displays the corresponding group to which the managed machine
belongs. This cannot be edited.

UUID

Displays the UUID of the managed machine.

IP Address

Displays the IP address of the managed machine.
If there are multiple IP addresses for the managed machine, all IP
addresses will be displayed. This will be displayed as blank if there is
no IP address information.

IPv6 Address

Displays the IPv6 address of the managed machine.
If there are multiple IPv6 addresses for the managed machine, all
IPv6 addresses will be displayed. This will be displayed as blank if
there is no IPv6 address information.

MAC Address

Displays the MAC address of the managed machine.

Deploy-OS

Displays Deploy-OS to be used by the managed machine when you
execute backup/restore/disk configuration check.

Status

Displays the status of the managed machine. See Section 3.7.1,
"Machine Status" regarding the status.
Click Status to display the Scenario Execution List screen in the
main window. See Section 4.3, "Scenario Execution List" regarding
the screen.

Power

Displays the power status of the managed machine. See Section
3.8.1, "Power On" to Section 3.8.2, "Shutdown" regarding the power
status.

Operating System

Displays the name of the OS on the managed machine.

Service Pack

Displays the service pack information for the managed machine.

OS Language

Displays the OS language of the managed machine.

HotFix/Application

Displays the Detail if there is a hotfix or an application.
Click Detail to display the HotFix/Application List screen in the
main window.
See Section 3.7.1.1, "HotFix/Application List" for details.

Package Applying Status

Displays the Detail link.
Click Detail to display the Package Applying Status (Package List)
screen in the main window.
See Section 3.7.1.2, "Package Applying Status (Package List)"
regarding the screen.

Scenario Assignment
Scenario Name

Displays the scenario assigned to the managed machine.
Click n Scenario Name to display the Scenario Detail screen in the
main window.
See Section 3.15, "Scenario Detail Information" regarding the screen.

Scenario Applying
Schedule

Displays the scenario applying schedule.

Schedule

Displays the scenario applying schedule time.
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Power Management Schedule Information
Schedule

Displays the power management schedule.

Power ON Time

Displays the power ON time.

Shutdown Time

Displays the shutdown time.

Do not show countdown
dialog

Displays whether or not the countdown dialog will be displayed at
shutdown.

Network Settings
Network

Displays whether the managed machine is on the same Subnetwork
as DPM Server.

Default Gateway

Displays the default gateway when the managed machine is not on
the same Subnetwork as DPM Server.

Subnet Mask

Displays the subnet mask when the managed machine is on a
different Subnetwork than DPM Server.

Automatic Update Settings
Automatic Update

Displays the automatic update function.

Automatic Update Time

Displays the automatic update time.

Application Timing

Displays the application timing.

Retry Count

Displays the number of retry count.

Retry Interval(Min.)

Displays the retry interval.

The following value will be displayed if the machine's OS is Windows Server 2003 R2.
Operating System: Microsoft Windows Server 2003 Standard Edition,
or Microsoft Windows Server 2003 Enterprise Edition
Service Pack
: Service Pack 1
The machine name displayed on the Web Console will be only the host name in the FQDN.
The domain suffix will not be shown.
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3.7.1.

Machine Status

The DPM displays status information of the machine.
The status information displayed in Status and Power on the Machine Detail screen shows the scenario
execution status, the automatic update status and the power status.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Machine to Confirm
Status.
(4) The Machine Detail group box appears. Confirm the Status column and the Power column.
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 Status
Displays the scenario execution status and the automatic update status for the machine.
Status

Description

(Blank)

The status will be blank if it is not in the middle of running a scenario or
automatic update.

Scenario Executing

Displays when running a scenario.
Displays if scenario execution for a machine is interrupted.
If you click Scenario Execution Stop displayed in the Status column, a
scenario execution list will be displayed. See Section 4.3, "Scenario
Execution List" regarding the scenario execution list.
Displays when there is a scenario execution error.
If you click Scenario Execution Error displayed in the Status column, a
scenario execution list will be displayed. See Section 4.3, "Scenario
Execution List" regarding the scenario execution list.
Furthermore, if the status of the managed machine is both a scenario
execution error and an automatic update execution error, Scenario
Execution Error is displayed.
See Section 4.7, "Automatic Update Result List Details" regarding the
error status.

Scenario Execution Stop

Scenario Execution Error

Remote Power ON Error

Displays when there is a Power On error.
If you click Remote Power ON Error displayed in the Status column, a
scenario execution list will be displayed. See Section 4.3, "Scenario
Execution List" regarding the scenario execution list.

Applying A
Package(Automatic Update)

Displays when applying an automatic update package.

Transferring
Files(Automatic Update)

Displays when transferring an automatic update file to a managed
machine.

Confirming With
User(Automatic Update)

Displays when confirming the user of executing an automatic update.

Waiting For
Restart(Automatic Update)

Displays when waiting for a machine restart.

Automatic Update In
Progress

Displays when confirming the package after the automatic update starts.

Automatic Update
Execution Error

Displays when there is an error with the automatic update.

Setting Automatic Update
Time

Displays when setting the automatic update time for the managed
machine.

Automatic Update Setting
Error

Displays when there is an error when setting automatic update.
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The method is different for handling errors related to scenarios and errors related to automatic
update.
•Errors related to scenarios
Please remove the error. See Section 3.8.8, "Error Cancellation" about the removing the error.
Furthermore, a scenario execution error will occur when the scenario does not complete until
the timeout expires, which was set in Section 2.7.1.2, "Scenario Tab."
•Errors related to automatic update
Please handle this by execute it again or restarting DPM Client.
 Power
Displays the power status of the machine.
Power status

Description

On

The power status of the machine is "On".

Off

The power status of the machine is "Off".

Unknown

The power status of the machine is "Unknown".
This is displayed when the IP address is not set on the managed machine.
You cannot use some functions as the shutdown.
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3.7.1.1.

HotFix/Application List

The list of hotfix/applications applied to the machine is displayed.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Machine with the
Applied HotFix/Application.
(4) Click HotFix/Application -> Detail in the Machine Detail group box.
(5) The Applied HotFix and Installed Application group box appears in the main window.
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Applied HotFix
HotFix Name

Displays the applied hotfix list.

Installed Applications
Application Name

Displays the installed applications list.

When service packs, hotfixes, and applications are installed on a Windows managed
machine, you cannot shut down after installation if it has the following status.
Please be careful that these conditions do not occur if shutdown is specified.
•The machine is locked by a workstation lock
•The machine is locked with a screensaver with a password
•The machine is connected to remote desktop, terminal service, or other remote
connection software
•There is data that is being edited or there is an application that does not respond to
a shutdown request.

3.7.1.2.

Package Applying Status (Package List)

The package applying status of the managed machine (package list) is displayed.
The package application status is only displayed for Windows OS packages. Linux OS packages will not be
displayed.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, so click the name of the Machine to which the
package was applied.
(4) Click Package Applying Status -> Detail.
(5) The Package Applying Status (Package List) group box appears in the main window so please confirm
the Applied Status column corresponding to the package ID.

Package Applying Status (Package List)
Display Count

Select the Display Count to be displayed in the package list.

Package ID

Displays the package ID.

Summary

Displays the package summary.

Applied Date

Displays the package applied date.

Applied Status

Displays the package applied status. (*1)
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Packages that cannot be applied to the managed machine will not be displayed in the
list.
*1
Explains the display of the package applying status.
The display of the Description
package applied
status
Applied
This is the status when the package has been applied to the managed machine.
This is displayed if the prerequisites (conditions specified in the Dependency
Information tab at the time of package creation) for applying the package have
been met and the package application completion conditions (MS number, ID
Information and conditions specified for application information) have been
met.
The absorbing service pack will determine to meet the package application
complete conditions if the version of the service pack on the managed machine
is the same as the Absorbing Service Pack or if it is newer in automatic
update process.
Not Applied
The package is unapplied.
This will be displayed if the conditions specified in the Dependency
Information tab are met and if the MS Number, ID Information and conditions
specified for application information are not met.
Unnecessary
Application of the package is unnecessary.
This is displayed if the conditions specified in the Dependency Information are
not met.
Unrecognized
The application status cannot be identified.
This is displayed when nothing is specified in the MS number and ID
Information tabs.
A package will not be displayed on the list in the following case because it is not a package application
target.
If the OS, language and service pack of the managed machine does not meet the OS, Lang, Base
Service Pack or Absorbing Service Pack specified in Applicable OS/Language at the time of
package creation by Image Builder or PackageDescriber, it is not a package application target and
the package will not be displayed on the list.
See Section 5, "Image Builder" or Section 6, "PackageDescriber" regarding the details of the methods
for setting these.
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The conditions for the display of the package application status are below.
OS/Language/Service Pack/Group Information
Conditions met
Managed Machine Information Inquiry
Inquiry completed
MS Number/Dependent Information/Service Pack
Conditions Conditions not met
There is no MS
met
number and
Dependency
Information for
the package
Applied
Dependency
Unrecognized
(*1)
Conditions met Conditions
not met
Not Applied
Unnecessary

Inquiry not
completed
Not Applied
(*2)

Conditions
not met
(Not
displayed
on the list)

*1
This is not displayed on the Package Applying Status (Machine List).
*2
"Not Applied" is displayed if the inquiry is incomplete in automatic update processing or information
sending from a managed machine to the Management Server.

3.7.2.

Edit Managed Machine

Edit the setting information for a managed machine.
You cannot edit the information of a managed machine when the status of the machine
is as follows.
•Scenario Executing
•Scenario Execution Error
•Scenario Execution Stop
•Remote Power ON Error
•Automatic Update In Progress
•Transferring Files(Automatic Update)
•Setting Automatic Update Time
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Then click the name of the Machine to Edit.
(4) The Configuration menu for the machine will be displayed, and then click Edit Machine.
(5) The Edit Machine screen appears in the main window. Then edit each item.
You can also display the Edit Machine screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
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(3) The Machine List group box appears in the main window, click the Edit icon (
(4) The Edit Machine screen appears in the main window. Then edit each item.
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) for the Machine to Edit.

Edit Machine
Group Name

Displays the corresponding group name to which the managed machine
belongs. This cannot be edited.

Machine Name
(Required)

Edit the managed machine name. 1 - 63 single-byte characters can be
entered.
The allowed characters are alphanumeric characters.
The following symbols and single-byte spaces cannot be used. Also, you
cannot change to a machine name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
If DPM Client is installed, even if the machine name registered on the
Web Console and the actual machine are different, the name will be
automatically changed to the actual machine name on the Web Console
when the machine is powered ON.(*1)
Edit the identification name of the managed machine.
1 - 63 single-byte characters can be entered. The allowed characters are
single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used. Also, you
cannot use a name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]

Identification Name

The same name cannot be set under the same DPM Server.
MAC Address

Displays the MAC address of the managed machine. This cannot be
edited.

UUID

Displays UUID of the managed machine are displayed. This cannot be
edited.
Edit the IP address of the managed machine.
The type of characters that can be used are "0 - 9." Enter them in the form
"xxx.xxx.xxx.xxx".
The same IP address cannot be set under the same DPM Server.

IP Address

If there are multiple IP addresses on the managed machine, enter the IP
address communicating with DPM Server.
If you do not install DPM Client on the managed machine, enter IP
address necessarily.
Deploy-OS

Select Deploy-OS used by the managed machine when you execute
backup/restore/disk configuration check.
Please contact your sales or support representative about the setting
values for each machine type.
Deploy-OS installed in DPM Server is displayed in the list box.
If Deploy-OS for the machine that is being used is not displayed in the list
box, obtain the module for the machine from your sales or support
representative and install it on DPM Server. Deploy-OS will be displayed
in the list box.
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Scenario Setting
Assign scenario

Select to assign a scenario to a managed machine. Browse in the
Scenario Name text box is enabled.

Scenario Name

Set the scenario which will be assigned to the managed machines.
When you click Browse, the Select Scenario screen appears. Select the
scenario and click OK.

Remove Scenario
Assignment

Select to remove the scenario assignment.

Scenario Applying
Schedule
Only
Once

If you put a check in the Scenario Applying Schedule checkbox, you
can set the scenario applying schedule. If you have not set the scenario,
you cannot select the checkbox.

The schedule is executed Only Once.
Date
(Required)

Time
(Required)

Edit the date.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Edit the time.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Daily

The schedule is executed on the set "Day" and "Time" from "Start Date."
Start Date
(Required)

End Date

Edit the start date.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Edit the end date.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the end date is not set, the schedule will repeatedly run the set content.
This is optional.

Time
(Required)

Edit the time.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Interval
(Required)

Edit the interval in day units. This can be set in the range of "1 - 99" days.
The default value is "1" (once per day).
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Weekly

The schedule is executed weekly on the set "Day of the Week" and "Time."
Start Date
(Required)

End Date

Edit the start date.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Edit the end date.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the end date is not set, the schedule will repeatedly run the set content.
This is optional.

Time
(Required)

Edit the time.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Day of the
Week Setting
(Required)
Monthly

Set one or more of Sunday - Saturday.

The schedule is executed monthly on the set "Date" and "Time."
Start Month
(Required)

End Month

Edit the start month.
You can enter the date (year/month) or click the " " icon on the side of
the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
Edit the end month.
You can enter the date (year/month) or click the " " icon on the side of
the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
If the end month is not set, the schedule will repeatedly run the set
content. This is optional.

Time
(Required)

Edit the time.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Day
(You Must Set
Either Day/ Week

If you select Day, set the day from the list box.
Example) "End of Month"

Week
(You Must Set
Either Day /
Week

If you select Week, set the day of the week from the list box.
Example) "1" - "Mon."
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Power Management
Schedule

Only
Once

If you select the Power Management Schedule checkbox, you can
manage the managed machine's power status.
If a check is entered, select either or both Power ON Time / Shutdown
Time.

The schedule is executed Only Once.
Power ON Time
(You must set
either or both of
Power ON
Time/Shutdown
Time.)

If you select the Power ON Time checkbox, you can edit the power ON
time.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Set the time from after 5 minutes from the current time.
Shutdown Time
(You must set
either or both of
Power ON
Time/Shutdown
Time.)

If you select the Shutdown Time checkbox, you can edit the shutdown
time.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
You can enter the following range in the textbox.
•"Hr" 0 - 23
•"Min" 0 - 59

Set the time from after 5 minutes from the current time. If you set this at
the same time as the Power ON Time, set the interval more than 10
minutes.
Do not show
countdown
dialog
Specify
Day

If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.

The schedule is executed on the set "Day of the Week" and "Time."
Power On Time
(You must set
either or both of
Power ON
Time/Shutdown
Time.)

If you select the Power ON Time checkbox, you can edit the power ON
time.
You can enter the following range in the textbox.
•"Hr" 0 - 23

Shutdown Time
(You must set
either or both of
Power ON
Time/Shutdown
Time.)

If you select the Shutdown Time checkbox, you can edit the shutdown
time.
You can enter the following range in the textbox.
•"Hr" 0 - 23

•"Min" 0 - 59

•"Min" 0 - 59

If you set this at the same time as the Power ON Time, set the interval
more than 10 minutes.
Do not show
countdown
dialog

If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.

Day of the Week
Setting
(Required)

Set one or more of Sunday - Saturday.
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Network Setting
Subnetwork is same
with DPM Server

Select this when the managed machine is on the same Subnetwork as
DPM Server.

Subnetwork is not
same with DPM Server

Select this when the managed machine is on a different Subnetwork than
DPM Server.
Select this when the managed machine goes through a router and
belongs to a different network than DPM Server.
The following items will be enabled if the setting is Subnetwork is not
same with DPM Server.
•Default Gateway
•Subnet Mask

Set up is required if the items are enabled.
Default Gateway
(Required)

Set the default gateway when the managed machine is on a different
Subnetwork than DPM Server. The top order of the IP address (first
octet) is set in the range of "1-223."

Subnet Mask
(Required)

Edit the subnet mask when the managed machine is on a different
Subnetwork than DPM Server.

Automatic Update Setting(*2)
Automatic Update

Set the automatic update function. You can select the following
operations.
•Constantly OFF
•ON At Startup
•OFF At Startup

The following setting will be disabled if the setting is Constantly OFF.
•Automatic Update Time
•Application Timing
•Retry Count
•Retry Interval (Min.)
When you set the automatic update function to Constantly OFF, the
managed machine will not request not applied packages to the
Management Server. (*See Section 2.7.4, "Automatic Update Setting"
regarding "The example of the automatic update setting and action".)

Automatic Update Time
Left List Box

Set the automatic update time.
Select the day for performing the automatic update. You can select from
the following.
•Everyday
•Sun - Sat

Right List Box

Select hourly increments from "0:00" to "23:00". If you select blank in the
left list box, the setting time will be disabled.
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Application Timing

Set the package application timing. You can select from the following.
•Immediately
•At Next Startup
•Show Confirmation

If the application timing is Immediately or At Next Startup, the
confirmation screen will not be displayed on the managed machines.
(*See Section 2.7.4, "Automatic Update Setting" about selection and
action of the Application Timing.)
Retry Count

Retry Interval(Min.)

If the connection to the Management Server failed, the connection will be
re-tried the set number of re-try times. This can be set in the range of "1 5" times.
If the connection to the Management Server failed, the connection will be
re-tried at the set time interval. This can be configured in five minute
increments from "5" to "30" minutes.

OK

Saves the settings details on the Edit Machine screen and returns to the
previous window.

Cancel

Returns to the previous window without saving the settings details from
the Edit Machine screen.

*1
When the Web Console is not started, do not change the name of the machine to which the scenario schedule
is assigned. Scenario execution error may occur or the scenario may not be executed on the appropriate
machine. When the Web Console is started, the schedule is executed correctly.
*2
When the status of the managed machine is either of the followings, Automatic Update Setting are set at the
timing that the machine is started at next time. For details about the status, see Section 3.7.1, "Machine
Status."
・ Status
- Scenario Executing
- Scenario Execution Stop
- Applying A Package(Automatic Update)
- Transferring Files(Automatic Update)
- Confirming With User(Automatic Update)
- Waiting For Restart(Automatic Update)
- Automatic Update In Progress
・ Power
- Off

3.7.3.

Move Machine

Move a machine.
See Section 3.5.6, "Move Machine" regarding moving a machine.

3.7.4.

Delete Machine

Delete a machine.
See Section 3.5.7, "Delete Machine" regarding deleting a machine.
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3.8. Menu Operations to a Machine
Explains the Action menu and Operation menu for the machine.

3.8.1.

Power On

Turn ON the power of the managed machine.
You can operate Power ON for only one managed machine or multiple selected managed machines by Machine
Individual Operations.
• To operate for only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to
Power ON.
(4) The Operation menu for the managed machine is displayed, so click the Operation -> Power ON.
• To operate selected multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Machine to Power ON in the Machine List group box in the
main window.
(4) Click Power ON of Machine Individual Operations... from the Action menu.
(green) On" after Power ON.
The Power icon will become "
If Power ON fails, Remote Power ON Error is displayed. Also, an error message is displayed.
 If the Machine List group box status still shows power OFF after execute Power ON,
please click Refresh from the Operation menu to refresh to the latest information.
 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Power ON for batch
operations for all managed machines.

3.8.2.

Shutdown

Shut down a managed machine.
You can operate Shutdown for only one managed machine or multiple selected machines by Machine
Individual Operations.
• To operate for only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Machine to shut down.
(4) The Operation menu for the managed machine will be displayed, and then click Shutdown.
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• To operate selected multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Machine to shut down on the Machine List group box in the
main window.
(4) Click Shutdown of Machine Individual Operations... from the Action menu.
(black) Off" after Shutdown.
The Power column icon will become "
If Shutdown fails, nothing will be displayed.
 Please install DPM Client on the machine to perform shutdown. See Section 2.2,
"Installing the DPM Client" in Installation Guide for details.
 You cannot shut down if the Windows managed machine status is as follows.
• The machine is locked by a workstation lock.
• The machine is locked with a screen saver with a password.
• The machine is connected to remote desktop, terminal service, or other remote
connection software.
• There is data that is being edited or there is an application that does not respond
to a shutdown request.
If password lock function is enabled by default in the OS, shut down after canceling the
password lock.
If a Linux machine is operating on X Window system, when Console is not running, you
cannot confirm that shutdown was executed.





3.8.3.

If the Machine List group box status still shows power ON after execute Shutdown,
please click Refresh from the Operation menu to refresh to the latest information.
If shutdown is performed on a Windows machine, a countdown dialog box will be
displayed on the managed machine. If you click Cancel at this time, you can cancel the
shutdown. If it is a Linux machine, a countdown message will be displayed on the
managed machine. You can cancel the shutdown by executing
/usr/local/bin/depcancel from the console. If the OS of the managed machine is SUSE
Linux Enterprise and it is an environment that X-Window is not running (run level 3), there
are cases that two message lines appear during remote updating or remote shutdown.
This message does not affect operations.
See Section 3.6.1, "Batch Execution" regarding Batch Execution - Shutdown of batch
operations for all managed machines.

Assign Scenario

Assign the scenario to managed machines.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Then click the name of the Managed Machine
to Assign Scenario.
(4) The Operation menu for the managed machine will be displayed, and then click Assign Scenario.
(5) The Assign Scenario screen appears so set each item.
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You can also display the Assign Scenario screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Check the check box on the left of the Managed
Machine to Assign Scenario.
(4) Click Assign Scenario from Machine Individual Operations... from the Action menu.
(5) The Assign Scenario screen appears in the main window so set each item.
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Assign Scenario
Base Information

Displays the basic information of the managed machine.
This group box is not displayed by default.
Please expand it by clicking on the arrow ( ) in the right.

Name

Displays the identification name of the managed machine. (When
the identification name is not specified, the machine name is
displayed.)

Group

Displays the group name to which the managed machine belongs.

UUID

Displays the UUID.

IP Address

Displays the IP address. If there are multiple IP addresses for the
managed machine, all of the IP addresses will be displayed.

MAC Address

Displays the MAC address. This cannot be edited.

Deploy-OS

Displays Deploy-OS to be used by the managed machine when you
execute backup/restore/disk configuration check.

OS Name

Displays the OS name.

Service Pack

Displays the service pack information on the machine.
This is not displayed if a service pack is not applied.

Scenario Setting
Assign Scenario

Select to assign a scenario.
If this is selected, Browse in the Scenario Name text box is
enabled.

Scenario Name

Set the scenario which will be assigned to the machines. If you click
Browse, Select Scenario screen appears. Select a scenario and
click OK.

Remove Scenario
Assignment

You cannot select Remove Scenario Assignment in this screen.
To Remove Scenario Assignment, please operate from Machine
List group box -> Action menu -> Remove Scenario Assignment.
See Section 3.5, "Machine Group Details" for details. (*1)

Scenario Applying Schedule

Only
Once

If you select the Scenario Applying Schedule checkbox, you can
set the scenario applying schedule. If you do not set the scenario,
you cannot select the checkbox.

The schedule is executed Only Once.
Date
(Required)

Time
(Required)

Set the date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
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Daily

The schedule is executed on the set "Day" and "Time" from Start Date.
Start Date
(Required)

End Date

Set the start date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the end date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the end date is not set, the schedule will repeatedly run following
the set content. This is optional.

Weekly

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Interval
(Required)

Edit the interval in day units. This can be set in the range of "1 - 99"
days.
The default value is "1" (once per day).

The schedule is executed weekly on the set "Day of the Week" and "Time."
Start Date
(Required)

End Date

Set the start date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the end date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the End Date is not set, the schedule will repeatedly run the set
content. This is optional.

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Day of the Week
Setting
(Required)

Set one or more of Sunday - Saturday.
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Monthly

The schedule is executed monthly on the set "Date" and "Time."
Start Month
(Required)

End Month

Set the start month.
You can enter the date (year/month) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
Set the end month.
You can enter the date (year/month) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
If the End Month is not set, the schedule will repeatedly run the set
content. This is optional.

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Day
(You must set
either
Day/Week.)

If you select Day, select the day from the list box.
example) "Last of the Month" day

Week
(You must set
either
Day/Week.)

If you select Week, select the day of the week from the list box.
example) "1" "Monday"

Run Now

Assigns the scenario and execute it immediately.

OK

Assigns the scenario with the setting on the Assign Scenario
screen and returns to the previous window.

Cancel

Returns to the previous window without assigning the scenario with
the setting from the Assign Scenario screen.

*1
Also, the option button of Remove Scenario Assignment cannot be selected on the Operation menu ->
Batch Execution -> Assign Scenario.
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A scenario execution may not be executed properly in the following cases.
・ After setting the scenario applying schedule, the date and the time of the
Management Server are changed beyond the scenario schedule. (from the future
to the past or from the past to the future)
・ The scenario schedule and the Power ON/Shutdown schedule are set at the
same date and time.
th
th
For a monthly schedule, the schedule may not be run if you select the 29 , 30 or
st
31 as there are months that do not have those days.
Example)
st
If the monthly date is set to be the 31 , the schedule will not be run in February,
April, June, September or November. The schedule will be executed in January,
March, May, July, August, October and December.

See Section 3.6.1, "Batch Execution" regarding Batch Execution - Assign Scenario for
batch operations for all managed machines.

3.8.4.

Remove Scenario Assignment

Remove the assignment of the scenario from the managed machine.
You can operate Remove Scenario Assignment for only one managed machine or multiple selected managed
machines by Machine Individual Operations.
• To operate on only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to
Remove Scenario.
(4) The Operation menu for the managed machine will be displayed, and then click Remove Scenario
Assignment.
• To operate selected multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine
to Remove Scenario.
(4) Click Remove Scenario Assignment of Machine Individual Operations... from the Action menu.
See Section 3.6.1, "Batch Execution" regarding Batch Execution - Remove Scenario
Assignment for batch operations for all managed machines.
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3.8.5.

Power Management Schedule

Set the power management schedule for the managed machine.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to
Schedule Power Management.
(4) The Operation menu for the managed machine will be displayed, and then click Set Power Management
Schedule -> OK.
(5) Click OK to display the Power Management Schedule screen in the main window and then set each item.
Also, the Power Management Schedule screen can be displayed in the following procedure.
(1)

On the Web Console, click Operations in the title bar to switch to the Operations view.

(2)

In the tree view, click Resource icon -> Machines icon -> Machine Group icon.

(3)

The Machine List group box appears in the main window, then select the checkbox on the left side of
Managed Machine to Schedule Power Management.

(4)

From Machine Individual Operations of Action menu, select the Set Power Management Schedule.
The dialog box appears.
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(5)

Click OK to display the Power Management Schedule screen in the main window and then set each item.

Power Management Schedule
Base Information

Display the base information for the managed machine.
This group box is not displayed by default.
Please expand it by clicking on the arrow ( ) in the right.

Name

Displays the identification name of the managed machine. (When the
identification name is not specified, the machine name is displayed.)

Group

Displays the corresponding group name to which the managed machine
belongs.

UUID

Displays the UUID.

IP Address

Displays the IP address. If there are multiple IP addresses for the
managed machine, all of the IP addresses will be displayed.

MAC Address

Displays the MAC address.

Deploy-OS

Displays Deploy-OS to be used by the managed machine when you
execute backup/restore/disk configuration check.

OS Name

Displays the OS name.

Service Pack

Display the service pack information for the machine.
This is not displayed if a service pack is not applied.
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Power Management
Schedule

Only
Once

The schedule is executed Only Once.
Power On Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

Shutdown
Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

Do not show
countdown
dialog
Specify
Day

If you select the Power Management Schedule checkbox, you can
manage the machine's power status.
If this is selected, select either or both Power ON Time / Shutdown
Time.

If you select the Power ON Time checkbox, you can set the power ON
time.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the time from after 5 minutes from the current time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
If you select the Shutdown Time checkbox, you can set the shutdown
time.
You can enter the date (year/month/day) or click the " " icon on the side
of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
Set the time from after 5 minutes from the current time. If you set this at
the same time as the Power ON Time, set the interval more than 10
minutes.
If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.

The schedule will be executed on the set "Day of the Week" and "Time."
Power On Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

If you select the Power ON Time checkbox, you can set the power ON
time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Shutdown
Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

If you select the Shutdown Time checkbox, you can set the shutdown
time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
If you set this at the same time as the Power ON Time, set the interval
more than 10 minutes.

Do not show
countdown
dialog

If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.

Day of the
Week Setting
(Required)

Set one or more of Sunday - Saturday.
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OK

Saves the settings details on the Power Management Schedule screen
and returns to the previous window.

Cancel

Returns to the previous window without saving the settings details from
the Power Management Schedule screen.

3.8.6.

Execute Scenario

Execute the scenario assigned to the managed machines.
You can operate Execute Scenario for only one managed machine or multiple selected managed machines by
Machine Individual Operations.
• To operate on only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to
Execute Scenario.
(4) The Operation menu for the managed machine will be displayed, and then click Execute Scenario.
• To operate selecting multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine
to Execute Scenario.
(4) Click Execute Scenario of Machine Individual Operations... from the Action menu.
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To execute a scenario of the backup/restore/disk configuration check, you need to set
up Deploy-OS that corresponds to the machine model of the managed machine
before executing the scenario. For details, see Section 3.9.2, "Register New
Machine."
In the case that the scenario except the remote update scenario does not run when
the power of the managed machine is on, perform either of the following operations:
• On the Edit Scenario screen, select the Forced Execution Of A Reboot Is
Performed Before Execution checkbox in the Scenario Execution Operation
Setting group box on the Option tab.
* If the Windows managed machine has the following status, you cannot restart,
even if you select the Forced Execution Of A Reboot Is Performed Before
Execution checkbox.
- The machine is locked by a workstation lock.
- The machine is locked with a screensaver with a password
- The machine is connected to remote desktop, terminal service, or other
remote connection software
- There is data that is being edited or there is an application that does not
respond to a shutdown request.
• Restart the managed machine manually.
DPM executes UDP communication when data is sent by multicast.
With UDP communication, if devices of a different transmission rate are located on
the path, a difference occurs in the volume of data transmitted between the
transmission side and reception side and the data transmission may fail.
If this happens, it will take a longer time to complete the scenario.
If you install RUR(revision up release) module for Express 5800 Series by DPM, you
need to log on to the target machine by an arbitrary user and execute the scenario
without running screen saver. When the machine is locked even if you logged on, or
screen saver is started during the installing, the automatic installing cannot be continued in
some cases.
When you execute the scenario of a service pack, which switches the firewall function
from disabled to enabled(Windows XP SP2 and so on), most ports are blocked when
applying the service pack and the Management Server cannot communicate with the
managed machine. Therefore, a scenario execution error will occur. In this case, open
the port that DPM uses by Port Opening Tool after removing the error.
See Section 7.1, "Port Opening Tool" about Port Opening Tool.
A managed machine before rebooting can execute 100 scenarios specified under
Execute At Next Startup under Execution Timing Setting on the Package tab of
the scenario. If you execute 101 or more scenarios, reboot the managed machine.
Rebooting allows you to execute another 100 scenarios.
If you specified an application at the same time as the service pack, hotfix, or Linux
patch file, the service pack, hotfix, or Linux patch file will first be applied followed by
application installation.
See Section 3.6.1, "Batch Execution" regarding Batch Execution - Execute
Scenario about batch operations for all managed machines.
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Also, if Password or Warning is set in Execute Scenario in the Management view -> DPM Server ->
Guard Parameter Setting screen, the following Confirm Scenario Setting screen will be displayed when
the scenario runs.

Confirm Scenario Setting
Scenario Name

Displays the scenario name.

Scenario Information
Scenario Name

Displays the scenario name.

Scenario Group Name

Displays the scenario group name.

Type

Displays the scenario type.

The scenario information displayed here will differ depending on type of scenario selected in
Scenario Name. See Section 3.15, "Scenario Detail Information" regarding the details.
Options
The Scenario Execution Option Setting set in the Add Scenario screen -> Option tab will be
displayed. See Section 3.13.5, "Option Tab" regarding the settings.
Target Machine
Machine Name

Displays the identification name of the managed machine on which
the scenario will be executed. (When the identification name is not
specified, the machine name is displayed.)
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OK

The scenario is run using the settings details on the Confirm
Scenario Setting screen and it returns to the previous window.

Cancel

It returns to the previous without running the scenario using the
settings details from the Confirm Scenario Setting screen.

3.8.7.

Interrupt Scenario Execution

Stop the execution of the scenario assigned to the managed machines.
You can operate Scenario Execution Stop for only one managed machine or multiple selected managed
machines by Machine Individual Operations.
• To operate on only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to
Stop Scenario Execute.
(4) The Operation menu for the managed machine will be displayed, and then click Scenario Execution
Stop.
• To operate selecting multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine
to Stop Scenario Execute.
(4) Click Scenario Execution Stop of Machine Individual Operations... from the Action menu.
In the case of Scenario Execution Stop, the machine icon becomes " " and Scenario Execution Stop is
displayed. An error message will be displayed if Scenario Execution Stop fails.





You cannot restart a scenario when the scenario was stopped. In order to re-run the
scenario, please execute the scenario again after the scenario interrupt process has
completed.
The managed machine that scenario execution stop was executed is powered off at the
timing of PXE boot after running scenario is stopped.
When a scenario is executed on the managed machine over Machines For
Simultaneous Execution, the processing of the scenario execution stop may be
executed, after the processing of the execution is started on the machine, depending on
the timing.

The Scenario Execution Stop status will automatically clear and return to normal once the
interrupt process has completed. The interrupt process for the executed scenario may take
some time.
See Section 3.6.1, "Batch Execution" regarding Batch Execution - Scenario Execution Stop
regarding batch operations for all managed machines.
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3.8.8.

Error Cancellation

Remove the Scenario Execution Error for the scenario assigned to the managed machine and Remote Power
ON Error.
You can operate Remove Error for only one managed machine or multiple selected managed machines by
Machine Individual Operations.
• To operate on only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to
Remove Error.
(4) The Operations menu for the managed machine will be displayed, and then click Remove Error.
(5) Click OK.
• To operate selecting multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Managed Machine to Remove Error on the Machine List
group box in the main window.
(4) Click Remove Error of Machine Individual Operations... from the Action menu.
(5) Click OK.

3.8.9.

Remove Interruption

Remove Interruption for the scenario assigned to the managed machines.
You can operate Remove Interruption for only one managed machine or multiple selected managed machines
by Machine Individual Operations.
You do Remove Interruption in the following cases.
- The latest information is still Scenario Execution Stop when more than 2 hours have passed since the
Scenario Execution Stop.
- The managed machine has been powered OFF manually.
Normally, after the process of Scenario Execution Stop is completed, the status returns to normal. Therefore,
it is not necessary to do Remove Interruption.
• To operate on only one managed machine
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to
Remove Interruption.
(4) The Operation menu for the managed machine will be displayed, and then click Remove Interruption.
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• To operate selecting multiple managed machines
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Managed Machine to Remove Interruption on the Machine
List group box in the main window.
(4) Click Remove Interruption of Machine Individual Operations... from the Action menu.




If the status of the machine on the Web Console is still Scenario Execution Stop
after selecting Remove Interruption, please click Refresh in the Operation menu to
refresh the latest information.
When you execute Remove Interruption, there may be cases where the interrupt
processing does not proceed properly and the following status may occur. In this
case, please manually turn the power of the managed machine ON or OFF.
•You cannot turn the power ON or OFF for the managed machine from the Web
Console.
•You cannot execute a scenario.

3.8.10. File/Folder List
The list of files and folders on the managed machine is displayed.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) The Machine List group box appears in the main window, then click the name of the Machine that the list
of files and folders is displayed.
(4) The Operation menu for the managed machine will be displayed, and then click File/Folder List.
You can also display the File/Folder List screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon.
(3) Select the checkbox in the left column of the Machine that the list of files and folders is displayed on the
Machine List group box in the main window.
(4) Click File/Folder List of Machine Individual Operations... from the Action menu.
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(5) File/Folder List appears in the main window.

File/Folder List
Base Information

Displays the basic information of the managed machine.
This group box is not displayed by default.
Expand it by clicking the arrow ( ) in the right.

Name

Displays the identification name of the managed machine. (When the
identification name is not specified, the machine name is displayed.)

Group

Displays the group name to which the managed machine belongs.

UUID

Displays the UUID.

IP Address

Displays the IP address. If there are multiple IP addresses for the
managed machine, all of the IP addresses will be displayed.

MAC Address

Displays the MAC address.

Deploy-OS

Displays Deploy-OS to be used by the managed machine when you
execute backup/restore/disk configuration check.

OS Name

Displays the OS name.

Service Pack

Displays the service pack information on the machine.
This is not displayed if a service pack is not applied.
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Folder Path

Displays the path of the current folder.

Display Count

Select the number of folders or files to be displayed directly under the
current folder.

File Name

Displays the name of folders or files. This cannot be edited.
If you click the link of the drive name or the folder name, the contents
directly under the corresponding drive or folder are displayed.
If you click

link, the upper layer is displayed.

Updated Date

Displays the updated date of the folder or the file. This cannot be
edited.
In the case of a drive, this is not displayed.

Size

Displays the file size. This cannot be edited.
In the case of a drive or a folder, this is not displayed.

In either case of the following, the name of the corresponding folder or file cannot be
displayed correctly.
・ When OS on the managed machine is Linux, the following characters are included
in the folder path or the file path.
\:*?"<>|$~`
・ When the length of the folder path or the file path is longer than 259Byte.
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3.9. "New Machine" Icon
The new machine is managed with the New Machine icon.
You can access the New Machine icon from the Machines icon -> New Machine icon on the tree view of the
Operations view.
Click the New Machine icon to display the New Machine List group box in the main window.
If the managed machine supports PXE boot, the New Machine icon is automatically displayed in the tree view
when a PXE packet is received.
Also, even if the machine does not support PXE boot, if DPM Client is installed on the machine, DPM Client
communicates with the Management Server when the machine is started up, and the New Machine icon will
automatically be displayed in the tree view.

New Machine List
Display Count

Select the display count to be displayed for the new machine.

"Action" Link

・ When you click Add Machine, the new machine which is selected
on the left checkbox will be added.
You can add multiple new machines by selecting the multiple
checkboxes.
・ When you click Delete Machine, the new machine which is
selected on the left checkbox will be deleted.
You can delete multiple new machines by selecting the multiple
checkboxes.

(Checkbox)

You can select all of the new machines in the list if you select the
top checkbox.

MAC Address

Displays the MAC address of the new machine.
Click the MAC address to display the Base Information group box
in the main window. See Section 3.9.1, "New Machine Detailed
Information" regarding the base information.

UUID

Displays the UUID of the new machine are displayed.

IP Address

Displays the IP address of the new machine.
If there are multiple IP addresses, the IP address for
communicating with the Management Server will be displayed. This
will be displayed as blank if there is no IP address information.
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3.9.1.

New Machine Detailed Information

Displays the new machine detailed information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> New Machine icon.
(3) The New Machine List screen appears, and then click the MAC Address for the new machine to display
detailed information.
(4) The Base Information group box appears in the main window. Then please confirm base information for
the new machine.

Basic Information
UUID

Displays the UUID. This cannot be edited.

MAC Address

Displays the MAC address. This cannot be edited.

IP Address

Displays the IP address. This cannot be edited.
If there are multiple IP addresses, the IP address for
communicating with the Management Server will be displayed.
This will be displayed as blank if there is no IP address
information.
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3.9.2.

Register New Machine

Add a new machine.
You can select one machine or multiple machines and add them to a group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> New Machine.
(3) The New Machine List screen appears in the main window. Then select the left column of the New
Machine to Add and click the Action link for Add Machine.
(4) The Add New Machine screen appears in the main window. Please set each item.
You can also display the Add New Machine screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> New Machine icon -> MAC Address of the New
Machine to Add.
(3) The Configuration menu for the new machine will be displayed. Then click Add Machine.
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(4) The Add New Machine screen appears in the main window. Please set each item.
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Add New Machine
Group Name

Select the group name, to which the machine will be added, from the
tree.

Machine Name

Displays the new machine name.
You can edit the name of the managed machine when you add one new
machine.1 - 63 single-byte characters can be entered. The allowed
characters are single-byte alphanumeric characters. The following
symbols and single-byte spaces cannot be used. Also, you cannot use a
machine name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]
The default is "PC-xxx_xxx_xxx_xxx(yy-yy-yy-yy-yy-yy)".
xxx_xxx_xxx_xxx is the IP address and yy-yy-yy-yy-yy-yy is the MAC
address.
When the IP address cannot be obtained, the machine name is
displayed as "PC-(yy-yy-yy-yy-yy-yy)".
When you add multiple new machines, all of the new machines are
displayed in the list box. In this case, the machine name cannot be
edited.
If DPM Client is installed, even if the name of the added machine and
the actual machine is different, the name on the Web Console will be
automatically changed to the actual machine name when the machine is
powered ON.
Enter the identification name of the managed machine when you add
one new machine.
1 - 63 single-byte characters can be entered. The allowed characters
are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used. Also,
you cannot use a name with only numbers.
.,;`~!@#$^&*=+{}%\|:'"<>/?[]

Identification Name

You cannot add a machine with the same name under the same DPM
Server.
When you add multiple new machines, this item is not displayed.
MAC Address

When you add only one new machine, the MAC address is
automatically obtained and displayed.
When you add multiple new machines, this item is not displayed.

UUID

When you add only one new machine, the UUID is automatically
obtained and displayed.
When you add multiple new machines, this item is not displayed.

IP Address

When you add only one new machine, the IP address is automatically
obtained and displayed. When you edit it, the type of characters that can
be used are "0 - 9." Enter them in the form "xxx.xxx.xxx.xxx".
You cannot add a machine with the same IP address under the same
DPM Server.
If there are multiple IP addresses on the managed machine, enter the IP
address communicating with DPM Server.
When you add multiple new machines, this item is not displayed.
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Deploy-OS

Select Deploy-OS to be used by the managed machine when you
execute backup/restore/disk configuration check.
Please contact your sales or support representative about the setting
values for each machine model.
Deploy-OS installed in DPM Server is displayed in the list box.
If Deploy-OS for the machine that is being used is not displayed in the
list box, obtain the module for the machine model from your sales or
support representative and install it on DPM Server. Deploy-OS will be
displayed in the list box.

Scenario Setting
Assign scenario

Select to assign a scenario.
If you select this, Browse in the Scenario Name text box is enabled.

Scenario Name

Set the scenario which will be assigned to the added managed
machines. If you click Browse, Select Scenario screen appears. Select
a scenario and click OK.

Remove Scenario
Assignment

Select to remove the scenario assignment.

Scenario Applying
Schedule
Only
Once

The schedule is executed Only Once.
Date
(Required)

Time
(Required)

Daily

If you select the Scenario Applying Schedule checkbox, you can set
the scenario applying schedule. If you do not set the scenario, you
cannot select the checkbox. Setting is required if this is checked.
Set the date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

The schedule is executed on the set "Day" and "Time" from Start Date.
Start Date
(Required)

End Date

Set the start date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the end date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the End Date is not set, the schedule will repeatedly run following the
set content. This is optional.
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Weekly

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Interval
(Required)

Edit the interval in day units. This can be set in the range of "1 - 99"
days.
The default value is "1" (once per day).

The schedule is executed weekly on the set "Day of the Week" and "Time."
Start Date
(Required)

End Date

Set the start date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the end date.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
If the End Date is not set, the schedule will repeatedly run the set
content. This is optional.

Monthly

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Day of the
Week Setting
(Required)

Set one or more of Sunday - Saturday.

The schedule is executed monthly on the set "Date" and "Time."
Start Month
(Required)

End Month

Set the start month.
You can enter the date (year/month) or click the " " icon on the side of
the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
Set the end month.
You can enter the date (year/month) or click the " " icon on the side of
the textbox and select the date from the displayed calendar.
When you enter a month, use YYYY/MM format.
If the End Month is not set, the schedule will repeatedly run the set
content. This is optional.

Time
(Required)

Set the time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
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Day
(You Must Set
Either Day/
Week
Day of the
Week
(You Must Set
Either Day/
Week

・ 01 - 31
・ End of Month
Example) "End of Month" day
If you select Week, set the day of the week.
Example) "1" - "Mon."

Left List Box

Select from the following.
• 1st - 4th
• Last

Right List
Box

Select from the following.
• Monday - Sunday

Power
Management
Schedule
Only
Once

If you select Day, select the day.

If you select the Power Management Schedule checkbox, you can
manage the machine's power status.
If you select the checkbox, select either or both Power ON Time /
Shutdown Time.

The schedule is executed Only Once.
Power
On Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

Shutdown
Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

Do not show
countdown
dialog

If you select the Power ON Time checkbox, you can set the power ON
time.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
Set the time from after 5 minutes from the current time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
If you select the Shutdown Time checkbox, you can set the shutdown
time.
You can enter the date (year/month/day) or click the " " icon on the
side of the textbox and select the date from the displayed calendar.
When you enter a date, use YYYY/MM/DD format.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59
Set the time from after 5 minutes from the current time. If you set this at
the same time as the Power ON Time, set the interval more than 10
minutes.
If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.
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Specify
Day

The schedule is executed on the set "Day of the Week" and "Time."
Power
On Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

If you select the Power ON Time checkbox, you can set the power ON
time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Shutdown
Time
(You must set
either or both
of Power ON
Time/Shutdow
n Time.)

If you select the Shutdown Time checkbox, you can set the shutdown
time.
You can enter the following range in the textbox.
• "Hr" 0 - 23
• "Min" 0 - 59

Do not show
countdown
dialog

If you select the Do not show countdown dialog checkbox, the
countdown dialog is not displayed at the time of shutdown.

Day of the
Week Setting
(Required)

Set one or more of Sunday - Saturday.

Network Setting

Edit the network settings for a managed machine.
The default is Subnetwork is same with DPM Server.

Subnetwork is same
with DPM Server

Select this when the managed machine is on the same Subnetwork as
DPM Server.

Subnetwork is not
same with DPM Server

Select this when the managed machine is on a different Subnetwork
than DPM Server.
Select this when the machine goes through a router and belongs to a
different network than DPM Server.
The following items will be enabled if the setting is Subnetwork is not
same with DPM Server.
• Default Gateway
• Subnet Mask
They are required if this item is enabled.

Default Gateway
(Required)

Set the default gateway when the managed machine is on a different
Subnetwork than DPM Server. The top order of the IP address (first
octet) is set in the range of "1-223."

Subnet Mask
(Required)

Set the subnet mask when the managed machine is on a different
Subnetwork than DPM Server.
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Automatic Update Setting

Perform automatic update settings for a new managed machine.
The default is the value set on the Management view –> DPM Server
icon -> Automatic Update Setting screen.
See Section 2.7.4, "Automatic Update Setting" regarding the Automatic
Update Setting screen.

Automatic Update

Set the automatic update function. You can select from the following.
• Constantly OFF
• ON At Startup
• OFF At Startup
The default is OFF At Startup.
The following setting will be disabled if the setting is Constantly OFF.
• Automatic Update Time
• Application Timing
• Retry Count
• Retry Interval (Min.)
When you set the automatic update function to Constantly OFF, the
managed machine will not request not applied packages to the
Management Server. (*See Section 2.7.4, "Automatic Update Setting"
regarding "The example of the automatic update setting and action".)

Automatic Update Time

Set the automatic update time.

Left List Box

You can set the day for performing the automatic update. You can
select from the following.
• Everyday
• Sun - Sat
The default is blank.

Right List Box

You can select hourly increments from "0:00" to "23:00".

Application Timing

Set the operation for the automatic update application timing when a
new managed machine is registered to the group. You can select from
the following.
• Immediately
• At Next Startup
• Show Confirmation
If the application timing is Immediately or At Next Startup, the
confirmation screen will not be displayed on the managed machines.
(*See Section 2.7.4, "Automatic Update Setting" about selection and
action of the Application Timing.)

Retry Count

If the connection to the Management Server failed, the connection will
be re-tried the set number of re-try times. This can be set in the range of
"0 - 5" times.

Retry Interval (Min.)

If the connection to the Management Server failed, the connection will
be re-tried at the set time interval. This can be configured in five minute
increments from "5" to "30" minutes.

OK

Adds the new machine with the setting on the Add New Machine
screen and returns to the previous window.

Cancel

It returns to the previous window without adding the new machine with
the setting from the Add New Machine screen.
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3.9.3.

Delete New Machine

Delete a new machine.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> New Machine.
(3) The New Machine List screen appears. If you select the checkbox in the left column of the New Machine
to Delete and click Delete Machine of the Action link, a confirmation dialog box appears.
(4) Click OK.
You can also delete the new machine, following steps below.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> New Machine.
(3) The New Machine List screen appears, and then click the MAC Address for the New Machine to Delete.
(4) The Configuration menu for the new machine will be displayed. Then click Delete Machine.
(5) The confirmation dialog box appears. Click OK.
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3.10. "Scenario" Icon
You can manage the scenario group and scenario from the Scenarios icon.
You can access the Scenarios icon from the Scenarios icon at the top of the tree view of the Operations view
or from Scenarios in the Summary Information group box displayed in the main window of the Operations
view.
Click the Scenarios icon to display the Group List group box in the main window.

Scenario Group List
Display Count

You can select the Display Count to be displayed in the
scenario group.

"Action" Link

When you click Delete Group, the scenario group which is
selected on the left checkbox will be deleted.
You can delete multiple scenario groups by selecting the
multiple checkboxes.

(Checkbox)

You can select all of the scenario groups in the list if you select
the top checkbox.

Name

Displays the scenario group name. This cannot be edited.

Subgroup Number
(Directly/Subordinates)

Displays the number of subgroups directly under/subordinate
to the concerned group.

Scenario Number
(Directly/Subordinates)

Displays the number of scenarios directly under/subordinate to
the concerned group.

Edit

Edit a scenario group name. Click the " " icon to display the
Edit Scenario Group screen in the main window.
See Section 3.12.1, "Edit Scenario Group" regarding the Edit
Scenario Group screen.
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If you install DPM Server, the Built-in Scenarios scenario group is created and
the following scenarios are registered.
・ System_AgentUpgrade_Multicast
・ System_Backup
・ System_DiskProbe
・ System_LinuxAgentUpgrade_Multicast
・ System_LinuxMasterSetup(*)
・ System_Restore_Unicast
・ System_WindowsMasterSetup(*)
・ System_WindowsMasterSetupVM(*)
(*) These are scenarios to set up the master machine. Special processing to work the
scenario properly is added. Therefore, the scenario cannot be deleted or edited. It
can be copied. However, if you edit the scenario after copying it, special
processing is cleared and it cannot be used to set up the master machine.

3.10.1. Add Scenario Group
Add the scenario group to which the scenario belongs before adding the scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon.
(3) The Configuration menu for the Scenarios icon will be displayed, then click Add Group.
(4) The Add Scenario Group screen appears in the main window. Set each item.

Add Scenario Group
Name
(Required)

Enter the scenario group name. 1 - 64 single-byte characters can be
entered. You cannot set the same name in the same layer.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
;/

OK

The scenario group is created with the setting on the Add Scenario Group
screen and it returns to the previous window.

Cancel

It returns to the previous window without creating the scenario group with
the setting from the Add Scenario Group screen.
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The following table shows the upper limit related to the number of scenario groups and scenario files.
Item

Upper Limit

Total number of scenario groups (total number of scenario groups including
sub-scenario groups)

1000

Number of scenario group layer

20

Number of scenario files that can be registered per a scenario group

Unrestricted

Total number of scenarios (total number of scenarios affiliated with all scenario
groups, including sub-scenario groups)

Unrestricted

3.10.2. Delete Scenario Group
Delete a scenario group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon.
(3) The Group List group box appears in the main window. Then select the left checkbox of Scenario Group
to Delete.
(4) When you click the Action link for Delete Group, a confirmation dialog will be displayed.
(5) Click OK.
You can also delete a scenario group, following steps below.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete icon.
(3) The Configuration menu for the Scenario Group icon appears, and then click Delete Group.
(4) The confirmation dialog box appears. Click OK.



When you delete a scenario group, the sub-scenario groups and scenarios under the
corresponding group will also be deleted.
You cannot delete a scenario group if there are machines with a Scenario Executing,
Scenario Execution Error, or Scenario Execution Stop.

3.11. "Scenario Group" Icon
The scenarios are classified by scenario group and managed in the Scenario Group icon.
You can access the Scenario Group icon from the Scenarios icon -> Scenario Group icon at the top of the tree
view of the Operations view or from Scenarios icon -> Scenario Group icon in the Summary Information
group box displayed in the main window of the Operations view.
Click the Scenario Group icon to display the Base Information, the Scenario List, and the Subgroup List
group box in the main window.
See Section 3.12, "Scenario Group Details" regarding the screen.
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3.12. Scenario Group Details
Displays the scenario group details information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Display Details icon.
(3) Displays the Base Information, Scenario List and Subgroup List group box in the main window.

Base Information

Displays the scenario group basic information.
This group box is not displayed by default.
Please expand it by clicking on the arrow ( ) in the right.

Parent Group Name

Displays the Parent Group Name only when it is a sub-scenario
group (The scenario group level is the second level or is lower than
the second level). The Parent Group Name will not be displayed
for scenario groups (first level scenario groups) directly under the
Scenarios icon.

Name

Displays the scenario group name.
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Scenario List
Display Count
"Action" Link

Select the Display Count of the scenarios registered in the group.
・ When you click Move Scenario, the scenario, which is selected
in the left checkbox, is moved between groups. You can move
multiple scenarios between groups by selecting the multiple
checkboxes.
・ When you click Copy Scenario, the scenario, which is selected
in the left checkbox, is copied. You cannot copy the multiple
scenarios at the same time.
・ When you click Delete Scenario, the scenario, which is selected
in the left checkbox, is deleted. You can delete multiple
scenarios by selecting the multiple checkboxes.
・ When you click Assign Scenario, the scenario, which is
selected in the left checkbox, is assigned to the managed
machine. You cannot assign the multiple scenarios at the same
time.

(Checkbox)

You can select all of the scenarios in the list if you select the top
checkbox.

Scenario Name

Displays the name of the scenario registered with this scenario
group.

Type

Displays the scenario type.

Edit

Edit a scenario. Click the " " icon to display the Edit Scenario
screen in the main window.
See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option
Tab" regarding the Edit Scenario screen.

Subgroup List
Display Count

Select the Display Count of the sub-groups registered in the group
to display.

"Action" Link

When you click Delete Group, the sub-group, which is selected in
the left checkbox, is deleted.

(Checkbox)

You can select all of the sub-groups in the list if you select the top
checkbox.

Name

Displays the name of the sub-group registered with this group.

Subgroup
Number(Directly/Subo
rdinates)

Displays the number of sub-groups directly under/subordinate to
the concerned group.

Scenario
Number(Directly/Subo
rdinates)

Displays the number of scenarios directly under/subordinate to the
concerned group.

Edit

Edit a scenario group name. Click the " " icon to display the Edit
Scenario Group screen in the main window. See Section 3.12.1,
"Edit Scenario Group" regarding the Edit Group Scenario screen.
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3.12.1. Edit Scenario Group
Edit the scenario group name.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Edit icon.
(3) The Configuration menu for the Scenario Group icon will be displayed, and then click Edit Group.
(4) The Edit Scenario Group screen appears in the main window. Then edit the scenario group name.

Edit Scenario Group
Name
(Required)

Edit the scenario group name. Up to 1 - 64 single-byte
characters can be entered. You cannot set the same name in
the same layer.
The allowed characters are single-byte alphanumeric
characters.
The following symbols cannot be used.
;/

OK

Saves the settings details on the Edit Scenario Group screen
and returns to the previous window.

Cancel

Returns to the previous window without saving the setting from
the Edit Scenario Group screen.
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3.12.2. Delete Scenario Group
Delete a scenario group.
See Section 3.10.2, "Delete Scenario Group" for details.

3.12.3. Add Sub-scenario Group
Add a sub-scenario group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add Sub-scenario Group
icon.
(3) The Configuration menu for the Scenario Group icon will be displayed, then click Add Subgroup.
(4) The Add Scenario Group screen appears in the main window, and then set the sub-scenario group name.

Add Scenario Group
Parent Group Name

Displays the parent scenario group name. This cannot be edited.

Name
(Required)

Set the scenario group name.
1 - 64 single-byte characters can be entered. You cannot set the same
name in the same layer. The allowed characters are single-byte
alphanumeric characters.
The following symbols cannot be used.
;/

OK

The sub-scenario group is created with the setting on the Add
Scenario Group screen and it returns to the previous window.

Cancel

It returns to the previous window without creating the sub-scenario
group with the setting from the Add Scenario Group screen.
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The following table shows the upper limit related to the number of scenario groups and scenario files.
Item
Upper Limit
Total number of scenario groups (total number of scenario groups including
sub-scenario groups)

1000

Number of scenario group layers

20

Number of scenario files that can be registered per scenario group

Unrestricted

Total number of scenarios (total number of scenarios affiliated with all scenario
groups, including sub-scenario groups)

Unrestricted

3.12.4. Delete Sub-scenario Group
Delete a sub-scenario group.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete Sub-scenario
Group icon.
(3) The Subgroup List group box appears. Then select the left checkbox of Sub-scenario Group to Delete.
(4) When you click the Action link for Delete Group, a confirmation dialog appears.
(5) Click OK.
You can also delete the sub-scenario group, following steps below.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete Sub-scenario
Group icon.
(3) The Subgroup List group box appears, and then click the name of the Sub-scenario Group to Delete.
(4) The Configuration menu for the Sub-scenario Group icon appears, and then click Delete Group.
(5) The confirmation dialog box appears. Click OK.
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3.12.5. Add Scenario
Add a scenario.
See Section 3.13, "Add Scenario" for details.

3.12.6. Move Scenario
Move a scenario between groups. You can move a scenario regardless of the managed machine's status
(automatic update status/scenario status/power status).
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) Select the checkbox in the left column of the Scenario to be Moved on the Scenario List group box that is
displayed in the main window.
(4) Click Move Scenario under the Action link.
(5) The Move Scenario dialog box appears and then set Target Group.

(6) Click OK.
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You can also move the scenario, following steps below.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window, then click the name of the Scenario to Move.
(4) The Configuration menu for the Scenario will be displayed, and then click Move Scenario.
(5) The Move Scenario dialog box appears and then set Target Group.
(6) Click OK.
You can select and move multiple scenarios that are under the same group.

3.12.7. Copy Scenario
Copy a scenario between groups. You can copy a scenario regardless of the managed machine's status
(automatic update status/scenario status/power status).
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) Select the checkbox in the left column of the Scenario to be Copied on the Scenario List group box that
is displayed in the main window.
(4) Click Copy Scenario under the Action link.
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(5) The Copy Scenario screen appears in the main window. Then select Copy To -> Target Group.

(6) Click OK.
You can also display the Copy Scenario screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window, then click the Scenario Name to Copy.
(4) The Configuration menu for the Scenario will be displayed, and then click Copy Scenario.
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(5) The Copy Scenario screen appears in the main window. Then select Copy To -> Target Group.
(6) Click OK.
Copy Scenario
Scenario Name
(Required)

Displays the scenario name on the target. The scenario name is
displayed as "Original Scenario Name_YYYY-MM-DD hh-mm-ss".
You can edit the scenario name. 1 - 58 single-byte characters can be
entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
.,\/:;*?"<>|

Copy To

Select the scenario group of the target.

OK

Copy the scenario with the settings details on the Copy Scenario
screen and returns to the previous window.

Cancel

Returns to the previous window without copying the scenario with the
settings details on the Copy Scenario screen.
The contents of each tab on the original scenario are displayed and can be edited. See
Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding editing.

3.12.8. Delete Scenario
Delete a scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) Select the checkbox in the left column of the Scenario to Delete on the Scenario List group box that is
displayed in the main window.
(4) When you click the Action link for Delete Scenario, a confirmation dialog will be displayed.
(5) Click OK.
You can also display the Delete Scenario screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window, then click the name of the Scenario to Delete.

147

(4) The Configuration menu for the Scenario will be displayed, and then click Delete Scenario.
(5) The confirmation dialog box appears. Click OK.

3.12.9. Assign scenario
Assign a scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) Select the checkbox in the left column of the Scenario Name on the Scenario List group box that is
displayed in the main window.
(4) Click Assign Scenario in the Action link.
(5) The Assign scenario screen appears in the main window. Then select a Group.

(6) The machine list under the group selected in (5) is displayed in the Machine List group box. Then select
the Machine to Assign Scenario.
(7) Please click OK and run.
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You can assign the scenario, following steps below.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window. Then click the Scenario Name.
(4) The Configuration menu for the Scenario will be displayed, and then click Assign Scenario.
(5) The Assign scenario screen appears in the main window. Then select a Group.
(6) The machine list under the group selected in (5) is displayed in the Machine List group box. Then select
the Machine to Assign Scenario.
(7) Click OK.

3.13. Add Scenario
Add a scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add Scenario icon.
(3) The Configuration menu for the Scenario Group icon will be displayed, then click Add Scenario.
(4) The Add Scenario screen appears in the main window. Set each item.

Add Scenario
Group Name

Displays the scenario group name. This cannot be edited.

Scenario Name
(Required)

Set the scenario name. Up to 1 - 58 single-byte characters can be
entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
.,\/:;*?"<>|

See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" for an
explanation of each of the tabs (HW Setting, OS, Package, Backup/Restore and
Option).
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3.13.1. "HW Settings" Tab
Set the HW Setting tab of the scenario.

HW Setting
Image File Name
1. - 8.

Select the image file from the 8 list boxes.
Please select Floppy Disk Image created using Image Builder as
the image file.
You cannot select the image file name here if you selected the Disk
Configuration Check option button in Execute
Backup/Restoration on the Backup/Restore tab.

You cannot perform registration or deletion of the image file at the same time as creating or
editing a scenario. Please do not operate Image Builder at the same time the scenario
creation/editing screen is open.
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3.13.2. "OS" Tab
Set the OS tab of the scenario.

OS
OS
OS Name

Select the OS name.
The OSs displayed in the list box are "Linux" and
"Linux(gPXE)"
Usually, select "Linux"
If you select the OS, the Setup Parameter File setting will
be enabled.
You cannot set the OS Name if you select Restore or Disk
Configuration Check option button in Execute
Backup/Restoration on the Backup/Restore tab.

OS Type

If you select "Linux" or "Linux(gPXE)" in the OS Name,
"Linux" is displayed in the OS Type.

Setup Parameter File
It Assigns By The
Machine Name

Select this when assigning by the machine name.
It Assigns By The Machine Name is selected by default.
If there are the machines which have the same machine
name, do not select this.
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Specify File Name

Select this when specifying the name of the setup parameter
file created by Image Builder in advance.
You can specify the file name in the list box by selecting the
option button. Setting is required if this item is enabled.

You cannot set OS and Package tab at the same time in the restore scenario.

3.13.3. "Package" Tab
Set the Package tab of the scenario.
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Package
Package
Name

Displays the name of the package to be executed.

Type

Displays the type of the package to be executed.
There are the following two types.
• Service packs/hotfixes/Linux patch files
• Applications

Setup Parameter

Set the setup parameter for the executed package.
Up to 128 characters can be entered. The allowed characters are
single-byte alphanumeric characters and symbols.
The default is the value which was set for the setup parameter when
creating the package.
About the set value, there are notes which are the same as when
creating a package. For details, see "Execution Settings tab" in Section
5.5.1, "Create Windows Package" or Section 6.2.2, "Execution Setting
Information."

"Action" Link

• The Add Package group box appears when you click Add.

You can select and add multiple packages by selecting the checkbox in
the left column of the package to add. The added package will be
displayed in the Package group box.
Furthermore, please use Image Builder or PackageDescriber to create
the package to be added. See Section 5.5, "Package
Registration/Modification" or Section 6.2, "Create Package" regarding
creating a package.
• When you click Delete, the package, which is selected in the left
checkbox, will be deleted. You can delete multiple packages by
selecting the multiple checkboxes.
(Checkbox)

You can select all of packages in the list if you select the top checkbox.

Up

The package, which is selected in the left checkbox, will move up one
place.

Down

The package, which is selected in the left checkbox, will move down one
place.

Add Package
(Checkbox)

Select the checkbox in the left column of the package to add.
When you select the checkbox and click OK, the package will be added
to the Package group box.

Name

Displays the name of the package.

Type

Displays the type of the package.
There are the following two types.
• Service packs/hotfixes/Linux patch files
• Applications
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Default Setup
Parameter

Displays the setup parameter specified when creating a package.

OK

Adds the package and closes the Add Package group box.

Cancel

Closes the Add Package group box without adding the package.

Execution Timing Setting
Execute Immediately
After Distribution

Select this option button when executing the package immediately after
distribution.

Execute At Next
Startup

Select this when executing the package at the time of the next
startup.
A managed machine before rebooting can execute 100 scenarios
specified under Execute At Next Startup under Execution Timing
Setting on the Package tab of the scenario. If you want to execute
101 or more scenarios, reboot the managed machine. Rebooting
allows you to execute another 100 scenarios.
Furthermore, please be careful of the following if Execute At Next
Startup is selected.
・ If you select the Turn Off Power After Scenario Execution under
the Option tab, the managed machine's power will not turn OFF
when the update is completed, but will turn OFF after the data
distribution.
・ The managed machine will have a scenario execution error if
there is an update or an application scenario execution during
update at next startup. Please retry executing the scenario after
the update is completed.

After Operating Setting
Restart After Applying

If you select the Restart After Applying checkbox, the managed
machine will be restarted after the package execution.
Restart After Applying takes priority in the case of scenarios set only
on the Package tab, and the managed machine will be restarted after
the package execution.
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Distribution Condition Setting
Transmit Data By
Unicast

Select this to send data by unicast.
Transmit Data By Unicast is the default.
Please select Transmit Data By Unicast in cases when you cannot
send the data by multicast such as to perform an update on another
network segment beyond the router.
Furthermore, it is not necessary to set the multicast IP for scenarios
where Transmit Data By Unicast is checked.

Transmit Data By
Multicast

Select this to send data by multicast. The following items are valid.(*1)
• Maximum Targets (1-1000)
• Maximum Waiting Time (1-1440 minutes)
• Multicast IP Address(Package)
• Multicast TTL
• Maximum Transmission Rate

Maximum Targets
(1-1000)

Set the maximum number of machines on which the scenario is
executed simultaneously.
When the machines whose number is specified at this setting are ready,
the scenario will start.
This can be set in the range of "1 - 1000".
The default is blank.

Maximum Waiting
Time (1-1440
minutes)

Set the maximum wait time when sending data by multicast. This
can be set in the range of "1 - 1440".
The default value is "10" minutes.
If you exceed the Maximum Wait Time, the update will start only on
the managed machines which are waiting for the file transferring.

Multicast IP
Address(Package)
(Required)

Set the multicast IP address.
The multicast IP is the IP address specified for the multicast. The
multicast IP address can be set in the range of "224.0.0.0 239.255.255.255." However, the range of "239.192.0.0 239.255.255.255" is recommended. (*1)
When you execute multiple scenarios of installing service packs,
hotfixes, Linux patch files, and applications at the same time,
please configure not to duplicate the multicast IP address for the
each scenario.

Multicast TTL
(Required)

Sets the number for multicast TTL. This can be specified in the
range of "1 - 127." The default value is "16." (*2)

Maximum
Transmission Rate
(Required)

When you select the Maximum Transfer Rate checkbox, you can
control the scenario transfer rate.
The maximum transfer rate is set as the maximum data volume in
MByte that will transfer in 1 minute. This can be set in the range of
"1 - 99999999". The default value is "500" MByte/minute.
By default, the checkbox is not selected. Set the value to match the
environment to use.
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*1
 Multicast is a communication method of using a single packet and sending the same data to multiple
machines at the same time. With this, you can reduce the traffic on the LAN.
 Executing packages will wait for until the number of the machines, on which the preparation for execution
has been completed, equals to the Maximum Targets, or until the Maximum Waiting Time has passed,
after the scenario execution has been directed. There is no function for immediately executing packages on
a machine that is in a waiting state.
 If neither the maximum number of target nor the maximum wait time has been specified, it will immediately
run without waiting for other computers after the scenario runs.
*2
The packet lifetime is indicated in TTL. This value is decremented by 1 each time it passes through the router,
and it is disposed of once it reaches "0." The packet cannot pass through the router if it is set to "1."
You cannot set OS and Package tab at the same time in the restore scenario.
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3.13.4. "Backup/Restore" Tab
Set the Backup/Restore tab of the scenario.
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Backup/Restore
Execute Backup/Restoration
(Checkbox)

If you select the checkbox, the backup, restore and disk configuration
check scenario setting items will be enabled. By default, the checkbox is
not selected.

Backup

Select this to create a backup scenario.

Restore

Select this to create a restore scenario.
You cannot select settings except the HW tab at the same time.

Disk Configuration
Check

Select this to create a disk configuration check scenario.
You cannot select Disk Configuration Check at the same time if it is set
on the Package tab.

Image File
(Required)

Set the backup image name of backup/restore scenario and the stored
location. Enter the file path including the file extension (.lbr) in the Image
File column, or click Browse and specify the backup image file. If you
select backup and do not enter the file extension (.lbr), it will automatically
be added.
• If entering the file path, the number of characters that can be entered for
backup/restore are as follows.
- Backup: 120 single-byte characters
* The above number of characters is the maximum number of
characters when a check is entered in all of the Machine Name/MAC
Address/UUID checkboxes. In other cases, up to 128 single-byte
characters can be entered.
- Restore: 236 single-byte characters
* The above number of characters is the maximum number of
characters when either of the Machine Name/MAC address/UUID
checkbox is selected. If any of them are not selected, up to 260
single-byte characters can be entered.
• The allowed characters for both backup and restore are single-byte
alphanumeric characters and single-byte spaces. The following symbols
cannot be used.
/*?<>|:"
• When specified using Browse
- This can be selected when entering a check in the backup or restore
checkbox.
- You cannot specify a folder that does not exist. A scenario error will
occur when the backup scenario runs if the folder that does not exist
is specified.
Also, if the stored location of the backup image file is a drive formatted
by FAT format, you can only create a backup image file that is less
than 4GByte(2GByte for FAT16) based on the system limitations.
Also, if checks are entered for Machine Name, MAC Address and
UUID at the time the backup scenario is created, select the same
checkboxes when creating the restore scenario. If you select the
Machine Name, MAC Address and UUID, they will be added to the
backup image file name. If you do not check the same boxes, a
restore file will be specified with a different name than the backup file
and the restore cannot be executed.(*1)
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Browse

Specify the backup image file of the backup scenario or the restore
scenario from Browse.
When you click Browse, the Image File Setting screen appears. Select
the backup image file (.lbr).
Or, enter the backup image file name in the Image File Name column.

Machine Name

If you select the Machine Name checkbox, the machine name will be
automatically added to the backup image file name.
Example) BackUp_Server01.lbr
An underscore will be added between the backup image file name
(BackUp) and the machine name (Server01).
Also, the Machine Name, MAC Address and UUID will be added in
order if multiple items of the Machine Name, MAC Address and
UUID are specified.
You can select the checkbox in the following cases.
・ When creating a backup scenario or a unicast restore scenario
・ When the machine of the backup and the restore target are the same
If there are the machines which have the same machine name, set this
item by the combination of MAC Address and UUID.
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MAC Address

If you select the MAC Address checkbox, the MAC address will be
automatically added to the backup image file name.
Example) BackUp_00-16-57-1a-b2-47.lbr
An underscore will be added between the backup image file name
(BackUp) and the MAC address (00-16-57-1a-b2-47).
Also, the Machine Name, MAC Address and UUID will be added in
order if multiple items of the Machine Name, MAC Address and
UUID are specified.
You can select the checkbox in the following cases.
• When creating a backup scenario or a unicast restore scenario
• When the machine of the backup and the restore target are the same

UUID

If you select the UUID checkbox, the UUID will be automatically added to
the backup image file name.
You can select the checkbox in the following cases.
• When creating a backup scenario or a unicast restore scenario
• When the machine of the backup and the restore target are the same

Comment

Comments about the backup image file can be added as information.
Up to 638 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
This is optional.

Backup/Restore Target
Full Sector Option

Set the full sector option.
When you create a restore scenario, set to match with the backup image
to distribute.

Disk Number (1-1000)
(Required)

Specify the disk number. This can be set in the range of "1 - 1000".
The default value is "1."
Furthermore, please set this after confirming the disk number by Disk
Viewer. (Because the disk number may differ depending on the DPM
Version, please execute the Disk Configuration Check.) See Section
7.2, "Disk Configuration Check Tool" for details. (*2)

Partition Setting(*3)
Entire Disk

You can select this in case of backup/restore.
If you select this, the entire disk is backed up/restored.

Specify

You can select this in case of backup/restore.
Select this if you specify the partition number. If you select this, Partition
Number can be specified.
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Partition Number
(1-1000)
(Required)

Set the partition number. This can be set in the range of "1 - 1000." The
default value is "1."
Usually the Partition number is assigned sequentially from the
beginning of the disk. If there are hidden partitions or expansion partitions
on the disk, however, the way in which the numbers are assigned
changes.
Therefore, confirm the disk number using Disk Viewer necessarily before
executing a backup/restore.
When you restore by specifying a partition, specify the same place as the
original backup partition and match the partition size and the type of the
file system between the original backup partition and the restoring
partition.

Hidden Partition Is
Disregarded
(Backup/Restore)

When you back up or restore specifying the partition number, if you select
the Hidden Partition Is Disregarded checkbox, the hidden partitions will
be ignored. By default, the checkbox is selected.
If you select the Hidden Partition Is Disregarded (Backup/Restore),
the hidden partitions are not counted.
Therefore, when the disk is separated into four partitions
(A) - (D) as the following example, specify "2" as the partition number if
you want to specify partition (D).
Example) Disk device
Hidden
Normal
Hidden
Normal
Partition
Partition
Partition
Partition
(A)
(B)
(C)
(D)
Specify the partition number "4" if Hidden Partition Is Disregarded
(Backup/Restore) is not selected.
When you back up or restore the entire disk without specifying the
partition number, this setting is ignored.
(*4)

Distribution Condition
Setting

The distribution condition setting can be set only if Restore is selected in
the Execute Backup/Restoration group box.

Transmit Data By
Unicast

Select this to send data by unicast. The settings can be done only if
Restore is selected from Execute Backup/Restoration.
Transmit Data By Unicast is the default.
Please select Transmit Data By Unicast in cases where you cannot
send the data by multicast such as to perform a restore on a network
segment beyond the router.
Furthermore, it is not necessary to set the multicast IP for scenarios
where Transmit Data By Unicast is checked.

Transmit Data By
Multicast

Select this to send data by multicast. The following settings become valid
if Restore is selected from Execute Backup/Restoration.
• Maximum Targets (1-1000)
• Maximum Waiting Time (1-1440 Min.)
• Multicast IP Address (Restore)
• Multicast TTL
• Maximum Transmission Rate
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Maximum Targets
(1-1000)

Set the maximum number of machines on which the scenario is executed
simultaneously.
When the machines whose number is specified at this setting are ready,
the scenario will start.
The maximum number of packets can be set in the range of "1 - 1000".
The machine will wait for the restore if the number of executing scenario
exceeds the setting. At the time when the restore completes on the
machine executing restore, if the Maximum Targets or Maximum
Waiting Time condition is met, or you click Run Now on the
Backup/Restore Execute List screen, the restore begins on machines
in a standby state.
Furthermore, DPM executes UDP communication when data is sent by
multicast.
With UDP communication, if a device with a different transmission rate is
located on the path, a difference occurs in the volume of data transmitted
between the transmission side and reception side, which can result in
data transmission failure.
If this happens, the amount of time until scenario completion may increase.

Maximum Waiting Time
(1-1440 minutes)

Set the maximum wait time when sending data by multicast. This can be
set only when restore is selected. When the wait time specified here
exceeds, restore will start only on the machines whose status are
"Restore StandBy". This can be set in the range of "1 - 1440".
The default value is "10" minutes.

Multicast IP Address
(Restore)
(Required)

Set the multicast IP address.
The multicast IP is the IP address specified for the multicast. The
multicast IP address can be set in the range of "224.0.0.0 239.255.255.255." However, the range of "239.192.0.0 239.255.255.255" is recommended.
To execute multiple restore scenarios at the same time, set not to
duplicate the multicast IP address on the each scenario. (*5)

Multicast TTL
(Required)

Sets the number for multicast TTL. This can be specified in the range of
"1 - 127". The default value is "16." (*6)

Maximum
Transmission Rate
(Required)

When you select the Maximum Transfer Rate checkbox, you can control
the transfer rate.
The maximum transfer rate is set as the maximum data volume in MByte
that will transfer in 1 minute. This can be set in the range of "1 - 500."
The default value is "500" MByte/minute.
By default, the checkbox is not selected. Set the value to match the
environment to use.

Backup Setting
Data Compression
Compress

Select the option button to send compressed data when executing the
backup/restore.

Not Compress

Select the option button to send not compressed data when executing the
backup/restore.
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The Number Of
Backup Image File
Generations To Be
Managed (0-99)
(Required)

Sets the generation management number of the backup image file.
Generation management is a function used to specify the number of
backup data copy generations you would like to save.
This can be set in the range of "0 - 99". The default value is "0."
When you use generation management function, the number of image
files to be created is the number of generation management + 1. Pay
attention to free space in HDD where image files are to be stored.
(*7)
Example)
When the number of generation management is 5 and the size of the
image file is approximate 5GByte, free space of approximate 30GByte
is necessary at maximum.
5GByte x (5 + 1) = 30GByte

Create Verification
Data

If you select the Create Verification Data checkbox, the verify data will
be created.
Verification data is a function used to verify whether any backed up data
has been damaged since the time of backup.
This function allows you to check at the time of data restoration whether
or not the backup data is invalid (whether data has been damaged and so
on) using the Backup Image File Verification Tool.

*1


The following warnings are for the case of a restore scenario.
• If you select the Machine Name, MAC Address or UUID checkbox, and then change the machine name
and so on for that machine, you will not be able to continue to manage the backup image for backups
before the change. For this reason, please remove the check from the Machine Name, MAC Address or
UUID checkboxes and specify an existing backup image in the Image File Column in order to restore an
existing backup image.
• If you select Transmit Data By Multicast, do not select the Machine Name, MAC Address or UUID
checkbox. If you select it, a scenario will fail.
• If you select Transmit Data By Unicast and select the Machine Name, MAC Address or UUID
checkbox, the backup image file name will be obtained following the set contents.
• When you specify the backup image file which is managed by generations, specify the file name by
deleting the part of "yyyymmddhhmmss" (the same value with the file path which is specified in Image
File of the backup scenario). Automatically, the restore scenario is executed by the backup image file
whose name has the latest date.

 If you back up without selecting the Machine Name, MAC Address or UUID checkboxes.
It is not recommended to execute the backup of multiple managed machines with one scenario. If it is
executed with one scenario, the backup image file will be overwritten.
 For backup, the backup data is created as a temporary file. The temporary file is renamed by the name
specified in the scenario when the backup is completed. Therefore, when there is a backup image file
which was already created, the disk volume is necessary for the size of the existing image file and the
temporary file.
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 When specifying the path of an image file in another computer connected to the network
(hereafter referred to as "file server"), perform the followings.
Example)
If you use Windows Server 2008/ Windows Server 2008 R2 as the OS of the Management Server and
file server, configure the following settings:
Perform the operations indicated in the steps 1 to 3 below on the Management Server.
1) Log on to the machine which DPM Server is installed, using an account with administrator authority.
2) From Start, select Management tool, then select Services. Open the following service
property, select Account in Log On tab, and enter account and its password used when you
install DPM Server.
DeploymentManager Backup/Restore Management
DeploymentManager API Service
Also, set on DeploymentManager PXE Management only when Management view -> DPM
Server icon ->Detail Setting -> DHCP Server tab ->Do Not Use A DHCP Server is selected on the
Web Console.
Please specify a password that meets the password policy in the case of Windows Server 2008 and
Windows Server 2008 R2.
The following important notes are for the file server.
・ Please create a user with the account and the password used when DPM Server was installed
on the file server.
・ Please configure that the account indicated here has access rights with full control to the Folder
for Image on the file server.
3) Restart services you changed the settings in step 2.
Perform the operations indicated in the steps 4 to 6 below on the file server.
4) Log on using an account that has Administrator authority.
5) Create a Folder for Backup Image by Explorer and so on to save backup image files.
6) Add an account that has administrator authority configured in step 2 to permit the access to the
Folder for Backup Image that is created in step 5,
Perform the following 7 to 8 on the Web Console.
7) When creating a scenario, enter the file path under the folder created in step 5 for the Image
File of Backup/Restore tab. For the path of the folder of image file, enter a UNC (Universal
Naming Convention) format (\\Machine Name\
Folder for Backup Image\Sub-folder) path name in Image File.
8) Execute the scenario
 You cannot perform registration or deletion of image file at the same time as creating or editing a scenario.
Please do not operate Image Builder if the scenario creation/editing screen is open.
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*2
If any one of the following is relevant, back up all disks in which necessary data are stored. Until the backup or
restore of all disks are completed, make sure that the OS does not start up. In order to prevent the OS from
starting up when the scenario is executed, select the Turn Off Power After
Scenario Execution from Option tab.
・ If the backup source and restoration destination are located in different devices.
・ The data required for OS startup are stored over multiple disks
・ If the data required for OS startup and the data required for OS installation by disk duplication
(Windows: sysprep, Linux: /opt/dpmclient) are stored over multiple disks
・ When files, needed as the system, are stored in a different HDD.
・ When disks are connected over multiple disks or multiple partitions, such as mounting other drives.
・ When it is necessary to have consistency in the data between disks or partitions (dynamic disk,
LVM1/LVM2 and so on)
*3
About the range that you can recover by backup/restore function for logical failure or physical failure of hard
disk, see "Regarding the range that can be recovered with the backup/restore function in response to a
physical defect or logical defect with a hard disk" in Section 2.2.2, "Regarding Backup/Restore" in First Step
Guide.
*4
 Systems, depending on the manufacturer, may not recognize a maintenance partition as a hidden
partition.
Example)
The maintenance partition used by the EXPRESSBUILDER for Express5800 series is not
recognized as a hidden partition.
 The partition number is assigned in the order of primary partitions and then logical drives in extended
partition.
Example)
For the disk below, partition (A) is "1," the expansion partition logic drive (B) is "3," the
expansion partition logic drive (C) is "4" and partition (D) is "2."
Disk
Primary Partition
(A)

Expansion Partition
Logical Drive (B)
Logical Drive (C)

Primary Partition
(D)

*5
Multicast is a communication method of using a single packet and sending the same data to multiple machines
at the same time. With this, you can reduce the traffic on the LAN.
*6
TTL means the packet lifetime. This value is decremented by 1 each time it passes through the router, and it is
disposed of once it reaches "0." The packet cannot pass through the router if it is set to "1."
*7
 If you are doing generation management, a time stamp (year/month/day/hour/minute/second) which is the
time of creating the backup image file is added to the name of the file.
・ If The Number Of Backup Image File Generations To Be Managed is 0
The timestamp is not added to the backup image file name. If the backup image file name specified
by the scenario exists before backup, the backup image file will be deleted.
・ If The Number Of Backup Image File Generations To Be Managed is 1 or higher
If the backup image file name specified by the scenario exists before backup, the update time for this
backup image file is obtained and a timestamp is added to the backup image file name for generation
management.
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For a scenario that the generation management is disabled, if you change it to enabled on
operation, a timestamp will be added to the backup image file name from the time of the next
backup.
In this case, the previous backup images that were created when generation management was
disabled will be renamed adding a time stamp when the scenario was executed.
If the generation management is enabled and there is already a backup image with the same
file name including the time stamp, the backup image file will not be overwritten, but a scenario
error will occur.
 If backup exceeds the specified number of times, the oldest image file is deleted automatically.
Example)
If 10 backup data except the latest backup data should be saved, enter "10." If you execute the backup,
the backup image file, whose name is <Specified file name>timestamp.lbr, is saved.
You can only select the Machine Name, MAC Address and UUID checkboxes if the
machine to backup and the machine to restore are the same.
• You can select the checkbox in the following case.
- Backup/restore (for the same machine)
• You cannot select the checkbox in the following case.
- OS installation by disk duplication
- Backup/restore (for different machines )



You cannot set OS tab or Package tab at the same time in the restore scenario.
When you decreased the number of The Number Of Backup Image File Generations
To Be Managed, the backup image file is deleted from the oldest one automatically.
Example) When you changed from "10" to "3" in The Number Of Backup Image File
Generations To Be Managed and executed backup, 7 files from the oldest backup
image file are deleted automatically.
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3.13.5. "Option" Tab
Set the Option tab of the scenario.
You can control the power status of the managed machines before and after the scenario execution from the
Options tab.

Option
Scenario Execution Option Setting
Forced Execution Of A
Reboot Is Performed
Before Execution

If you select the Forced Execution Of A Reboot Is Performed Before
Execution checkbox, the managed machine will be restarted before the
scenario runs.
If the OS is running on the managed machine before the scenario
execution, it will be forcibly restarted and then the scenario will run.
This option is effective in the following cases.
• If DPM Client is installed on the managed machine
• If you are using the following functions
- Backup
- Restore
- OS clear installation
- Distribution of floppy disk image for BIOS/firmware
• If you execute the scenario on managed machines where the OS is
running.

Turn Off Power After
Scenario Execution

If you select the Turn Off Power After Scenario Execution checkbox,
the managed machine will be powered OFF after the scenario execution.

OK

The scenario is added using the setting from the Add Scenario screen
and it returns to the previous window.

Cancel

It returns to the previous window without adding the scenario using the
setting from the Add Scenario screen.
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Please be sure to select the Forced Execution Of A Reboot Is Performed Before
Execution to execute the scenario on the machine on which OS is running. However, if
you are executing a remote update (independently installing service packs, Installing
service packs, hotfixes, Linux patch files, and applications) scenario, it is not a problem if
the OS is running, so you do not need to select the Forced Execution Of A Reboot Is
Performed Before Execution. The machine will not restart even if you select it and the
scenario runs.
If the Windows managed machine has the following status, you cannot shut down, even if
you select the Forced Execution Of A Reboot Is Performed Before Execution.
・ The machine is locked by a workstation lock.
・ The machine is locked with a screensaver with a password
・ The machine is connected to remote desktop, terminal service, or other remote
connection software
・ There is data that is being edited or there is an application that does not respond to a
shutdown request.

3.14. Menu Operations for a Scenario
The menus related to the operations for the scenario will be explained.

3.14.1. Edit Scenario
Edit a scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window, then click the Scenario Name to Edit.
(4) The Configuration menu for the Scenarios icon will be displayed, then click Edit Scenario.
(5) The Edit Scenario screen will be displayed in the main window and you can edit each item.
You can also display the Edit Scenario screen using the following steps.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window, then click the Edit icon(
edit.

) for the scenario to

(4) The Edit Scenario screen will be displayed in the main window and you can edit each tab.
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Edit Scenario
Group Name

Displays the scenario group name. This cannot be edited.

Scenario Name

Displays the scenario name. This cannot be edited. If you want to edit
it, please re-create the same scenario and specify another scenario
name.

OK

Saves the settings details from the Edit Scenario screen and returns
to the previous window.

Cancel

Returns to the previous window without saving the setting on the Edit
Scenario screen.
See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding editing each
tab.

3.14.2. Copy Scenario
Copy a scenario.
See Section 3.12.7, "Copy Scenario" for details.

3.14.3. Move Scenario
Move a scenario.
See Section 3.12.6, "Move Scenario" regarding the details.

3.14.4. Delete Scenario
Delete a scenario.
See Section 3.12.8, "Delete Scenario" for details.

3.14.5. Assign Scenario
Assign a scenario.
See Section 3.12.9, "Assign Scenario" for details.
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3.15. Scenario Detail Information
Displays the scenario detail information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon.
(3) The Scenario List group box appears in the main window. Then click the Scenario Name.
(4) Displays the Scenario Detail, Option and Machine List group box in the main window.
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Scenario Detail
Scenario Name

Displays the scenario name. This cannot be edited.

Scenario Group Name

Displays the scenario group name. This cannot be edited.

Type

Displays either of the following types.
• Disk Configuration check
• Restore
• Backup
• Package
• OS
• HW setting
The displayed type and the setting are shown in the Scenario Detail
group box.
If HW Setting is displayed in the Type column, HW Setting will be
displayed in the Scenario Detail group box.
The image file name set in the Add Scenario screen -> HW Setting
tab will be displayed.

HW Setting

Image File Name
OS Install

Displays the image file name.
If OS is displayed in the Type column, OS Install will be displayed in the
Scenario Details group box. Only the status set in the Add Scenario
screen -> OS tab will be displayed.

OS Name

Displays the OS name.

OS Type

Displays the OS category.

Setup Parameter File

Displays the setup parameter file.

Backup

If Backup is displayed in the Type column, Backup will be displayed
on the Scenario Details group box. The backup scenario will be
created by specifying on the Add Scenario screen -> Backup/Restore
tab and only the set status will be displayed.

Image File

Displays the backup image file of the backup scenario.

Image File Comment

Displays comments that are entered in the Comment column.

Full Sector Option

Displays whether the full sector option is set.

Disk Number

Displays the disk number.

Partition Setting

Displays the partition settings.

A Hidden Partition Is
Disregarded

Displays whether a hidden partition will be disregarded.

Compress Data Setting

Displays whether to compress the data.

The Number Of Backup
Image File Generations
To Be Managed

Displays the number of the backup image file generation to be
managed.

Create Verification Data

Displays whether to create the verify data.
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Restore

If Restore is displayed in the Type column, Restore will be displayed
on the Scenario Details group box. The restore scenario will be
created by specifying on the Add Scenario screen -> Backup/Restore
tab and only the set status will be displayed.

Image File

Displays the backup image file of the restore scenario.

Full Sector Option

Displays whether the full sector option is set.

Disk Number

Displays the disk number.

Partition Setting

Displays the partition settings.

A Hidden Partition Is
Disregarded

Displays whether a hidden partition will be ignored.

Distribution Condition
Setting

Displays whether the data is transmitted by Unicast or by Multicast.

Maximum Targets

Displays the maximum number of targets.

Maximum Waiting Time

Displays the maximum wait time. The unit is minute.

Multicast IP Address
(Restore)

Displays the multicast IP address.

Multicast TTL

Displays the number for multicast TTL.

Maximum Transmission
Rate

Displays the maximum transfer rate. The unit is MByte/minute.

Package

If Package is displayed in the Type column, Package will be displayed
on the Scenario Details group box. Only the status set in the Add
Scenario screen -> Package tab will be displayed.

Package Name

Displays the name of service packs/hotfixes/applications.

Execution Timing
Setting

Displays the scenario execution timing.

After Operating Setting

Displays if DPM Client is restarted after package execution.

Distribution Condition
Setting

Displays for send data by Unicast or send data by Multicast.

Maximum Targets

Displays the maximum number of targets.

Maximum Waiting Time

Displays the maximum wait time. The unit is minute.

Multicast IP Address
(Package)

Displays the multicast IP address.

Multicast TTL

Displays the number for multicast TTL.

Maximum Transmission
Rate

Displays the maximum transfer rate. The units is MByte/minute.
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Option
Forced Execution Of A
Reboot Is Performed
Before Execution

Displays whether the managed machine is rebooted forcibly before the
scenario execution.

Turn Off Power After
Scenario Execution

Displays whether the managed machine is powered off after the
scenario execution.

Machine List
Display Count

Select the number of managed machines to be displayed.

Machine Name

Displays the Identification Name of the managed machine that the
scenario is assigned. (Displays the machine name when the
Identification Name is not specified.)

IP Address

Displays the IP address of the managed machine that the scenario is
assigned.

MAC Address

Displays the MAC address of the managed machine that the scenario is
assigned.

Group Name

Displays the name of the group, in which the managed machine that the
scenario is assigned is registered.

3.16. "Images" Icon
You can manage the different types of image information such as package, backup image, HW image or OS
image from the Images icon.
You can access the Images icon from the Images icon at the top of the Operations view tree view or from the
Images icon in the Summary Information group box displayed in the Operations view main window.
Click the Images icon to display the Search Conditions and Image List group boxes in the main window.
See Section 3.17, "Image Detailed Information" regarding the screen.
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3.17. Image Detailed Information
Displays the detailed information for the each image, the package, backup image, HW image and OS image.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Images icon.
Or, the Summary Information group box appears in the main window. Click Images.
(3) Displays the Search Conditions and Image List group box in the main window.
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Search Conditions
Image Type

Select the search image type. You can select from the following.
• All Type
• HW Image
• OS Image
• Package
• Backup Image
The default is All Type.
If you select Package or Backup Image, You can search the image
that meets the conditions that you specified. The condition that can
be specified varies depending on Package or Backup Image.
• Package
OS, Type, Date
• Backup image
Date, Machine Name

OS

If you search by OS type, you can select the type of OS to search.
The default is "All OS."
About the backup image, only the backup image which is saved in
the Folder for Backup Image is the target to search.
About the Folder for Backup Image, see Section 2.7.1.1, "General
Tab."

Type

If you search by type, you can select the type of package to search.
You can select from the following.
• All Type
• HotFix
• Service Pack
• Linux Patch
• Application
The default is All Type.

Date

If you search by date, you can enter the start date and the end date
to search.
You can enter the date (year/month/day) or click the " " icon on
the side of the textbox and select the date from the displayed
calendar.
When you enter a date, use YYYY/MM/DD format.
• If you specify only the start date, it will search with the search
condition of dates after the start date.
• If you specify only the end date, it will search with the search
condition of dates up to the end date.
• If you specify the start date and end date, it will search with the
search condition within the specified period.

Machine Name

Enter the machine name to search by the machine name.
1 - 63 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.

Search

If you click Search, images will be searched with the specified
search conditions.
The search results will be displayed in the Image List group box.
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Image List
Display Count

Select the number of images to be displayed.

Image Name

Displays the image name.
You can confirm the basic information for the Package and Backup
Image by clicking on the image name.
See Section 3.17.1, "Package Image Detailed Information"
regarding the Package.
See Section 3.17.3, "Backup Image Detailed Information" regarding
the Backup Image.
You cannot click the image name for a HW Image or an OS Image.

Summary

Displays the summary of the image.

Image Type

Displays the image type.

Date

Displays the date and time that the image is created.

Applying Status

If the Image Type is Package, a ">>" will be displayed in the
Applying Status column.
Click >> to display the Package Applying Status (Machine List)
screen in the main window. See Section 3.17.2, "Package Applying
Status (Machine List)" regarding the screen.
If the Image Type is other than Package, the Applying Status will
be blank.
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3.17.1. Package Image Detailed Information
Displays the package image detail information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Images icon.
(3) The Image List group box appears in the main window. Then click the Image Name.
(4) Displays the Base Information and Applicable OS and language group box in the main window.
You can also display the package image basic information screen using the following steps.
(1) The Summary Information group box appears in the main window. Click the Packages icon.
(2) The Image List group box appears in the main window. Then click the Image Name.
(3) Displays the Base Information and Applicable OS and language group box in the main window.
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Base Information
Package Name

Displays the package name.

Summary

Displays the summary of the package.

Type

Displays the package type.

Release Date

Displays the package released date.

MS Number

Displays the MS Q Number or the KB number for hotfixes or service
packs.

Major Version

Displays the major version of the service pack.

Minor Version

Displays the minor version of the service pack.

Application Name

Displays the application name of the package.

Applicable OS and language
OS Name

Displays the name of the OS that is the target of the package.

Language

Displays the OS language that is the target of the package.

Base Service Pack

Displays the list of the Base Service Pack.

Absorbing Service Pack

Displays the list of the Absorbing Service Pack.

3.17.2. Package Applying Status (Machine List)
Display the Package Applying Status (Machine List).
The package applying status is only displayed for Windows OS packages. Linux OS packages are not displayed.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Images icon.
(3) The Image List group box appears in the main window. Then click ">>" in Applying Status.
(4) Displays the Base Information and Package Applying Status (Machine List) group box in the main
window.
You can also display the Package Applying Status (Machine List) screen using the following steps.
(1) The Summary Information group box appears in the main window. Click the Packages icon.
(2) The Image List group box appears in the main window. Then click ">>" in Applying Status.
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(3) Displays the Base Information and Package Applying Status (Machine List) group box in the main
window.

Package Applying Status(Machine List)
Base Information
Package ID

Displays the package ID.

The Number Of
Machines

Displays the number of managed machines related to the package.

Applied

Displays the number of the managed machines that the package was
applied.

Not Applied

Displays the number of the managed machines that the package was
not applied.

Unnecessary

Displays the number of the managed machines that it is unnecessary
to apply the package.

Unrecognized

Displays the number of the managed machines that the applying
status of the package cannot be recognized.

Package Applying Status(Machine List)
Display Count

You can select the Display Count of managed machines to display on
the Package Applying Status(Machine List) screen.

Group Name

Displays the name of the group that the managed machine is
registered.

Machine Name

Displays the identification name of the managed machine. (When the
identification name is not specified, the machine name is displayed.)

MAC Address

Displays the MAC address of the managed machine.

Applied Status

Displays the applied status of the package.
See Section 3.7.1.2, "Package Applying Status (Package List)" for
details on the applied status.
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3.17.3. Backup Image Detailed Information
Display the backup image detailed information.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click the Resource icon -> Images icon. Or the Summary Information group box
appears in the main window. Click Images -> Backup Images.
(3) The Image List group box appears in the main window. Then click the Image Name.
(4) The Image Base Information Of Image, Original Base Information and Original Applied Packages
group boxes are displayed.
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Base Information Of Image
Image Name

Displays the folder for backup image and image file name.

Create Date Time

Displays the date when the backup image was created.

Disk Number

Displays the disk number.

Partition Number

Displays the partition information.

Compress Or Not

Displays if the backup image is compressed or not.

Specify Verification Data
Or Not

Displays if the backup image verify data exists or not.

A Hidden Partition Is
Disregarded Or Not

Displays whether hidden partitions will be ignored or not.

Backup Execution Time

Displays the time taken for backup execution.

Image File Size

Displays the image file size.

Specify Full Sector Or Not

Displays the set status of the full sector option.

Product Version (DPM
Server)

Displays the DPM version of the Management Server.

Original Base Information
Machine Name

Displays the name of the machine from which the backup image was
created.

Summary

Displays the comment of the backup image.

IP Address

Displays the IP Address of the machine that the backup image was
created.

MAC Address

Displays MAC address of the machine that the backup image was
created.

UUID

Displays UUID of the machine that the backup image was created.

OS Name

Displays OS Name of the machine that the backup image was
created.

Original Applied Packages
Display Count

Select the Display Count of Original Applied Packages.

Package Name

Displays the package name.

Summary

Displays the summary of the package.

Type

Displays the package type.
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4.

Monitor

4.1. "Monitor" view
You can monitor the information necessary to use the DPM, such as scenario execution status and automatic
update status and so on in the Monitor view. You can also clear the status of multiple managed machines by the
batch.
When you click Monitor in the title bar, it will switch to the Monitor view. The Monitor Function List group box
appears in the main window.

4.2. "Scenario Execution List" Icon
You can view the execution status list for Scenario Execution on the DPM, and batch clear the abnormal
statuses.
You can access the Scenario Execution List icon from the Scenario Execution List icon at the top of the
Monitor view tree view or from Scenario Execution List in the Monitor Function List group box displayed in
the Monitor view main window.
Click the Scenario Execution List icon to display the Scenario Execution List group box in the main window.
See Section 4.3, "Scenario Execution List" regarding the screen.

182

4.3. Scenario Execution List
The following information is displayed in the Scenario Execution List screen.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click the Scenario Execution List icon. Or in the Monitor Function List group box in the
main window, click Scenario Execution List.
(3) The Scenario Execution List group box appears in the main window.

Scenario Execution List
Display Count

Select the number of managed machines to be displayed.

Status

The scenario execution status can be selected and displayed from
the following three types.
• All Status
• Normal Status
• Error Status
Select Normal Status to confirm the running status.
The default is All Status.

Machine Name

Displays the identification name of the managed machine that the
scenario is running or completed. (When the identification name is
not specified, the machine name is displayed.) When you click the
name, the Operation view - Machine Detail group box appears.
See Section 3.7, "Managed Machine Details" regarding the
Machine Detail.

IP Address

Displays the IP address of the managed machine that the scenario
is running or completed. This will be blank for managed machines
without IP address information.

MAC Address

Displays the MAC address of the managed machine that the
scenario is running or completed.
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Group Name

Displays the group name of the managed machine that the scenario
is running or completed. If the group is layered, the parent group
name for the managed machine that is running the scenario or has
completed scenario execution is displayed.
When you click the group name, the Operation view - Group
Detail group box appears. See Section 3.5, "Machine Group
Details" regarding the Group Detail group box.

Scenario Name

Displays the name of the running scenario or the completed
scenario.

Status

Displays the status of the managed machine that the scenario is
running or completed. (*1)

Execute Status

Displays the execution progress as percent (%) in the status bar.
If the status is Scenario Executing, it will be displayed by a
progress bar up to "100%".
The progress bar will show "0%" for Scenario Execution Stop,
Scenario Execution Error or Remote Power ON Error.

Detail

While running scenarios including backup/restore, ">>" appears in
the Detail column. It will be blank in the case of other scenarios.
When you click ">>", the Backup/Restore Execute List screen
appears. See Section 4.3.2, "Backup/Restore Execute List"
regarding the screen. (*2)

*1
There are the following types in the status of the machine that the scenario is running and completed.
Execute Status

Description

Scenario Executing

This is displayed when the scenario is running.

Scenario Execution Stop

This is displayed when the scenario has been interrupted.

Scenario Execution Error

This is displayed when there is a scenario execution error.

Remote Power ON Error

This is displayed when the remote power on is failed.

Execution Completed
This is displayed when scenario execution has completed.
*2
">>" is displayed until the scenario status information including backup/restore for the managed machine
was cleared. ">>" won't be displayed except for the above cases.

4.3.1.

Batch Clear Status

Batch clear the status for scenarios run by DPM.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click the Monitor icon -> Scenario Execution List icon. Or in the Monitor Function List
group box in the main window, click Scenario Execution List.
(3) In the Operation menu, click Batch Clear Status.
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(4) The Status Clear screen appears in the main window. Then select the status information to be cleared.
(5) Click OK.

Clear Status Information
Scenario Execution
Completed

The status when scenario is completed.

Scenario Execution Stop

The status when scenario is interrupted.

Scenario Execution Error

The status when there is a scenario execution error.

Remote Power ON Error

The status when there is a remote power on error.

OK

The selected statuses will be cleared collectively and it returns
to the previous window.

Cancel

It returns to the previous window without clearing the selected
statuses.

4.3.2.

Backup/Restore Execute List

Manage the backup/restore scenario execution status.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main
window, click Scenario Execution List.
(3) The Scenario Execution List group box appears. Click ">>" in the Details column.
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(4) The Backup/Restore Execute List screen appears in the main window.
Depending on unicast or multicast, the information that will be displayed in the Backup/Restore Execute
List screen differs.
<Data is transferred using unicast>

Machine Information
Machine Name

Displays the identification name of the managed machine
(When the identification name is not specified, the machine
name is displayed.)

IP Address

Displays the IP address of the managed machine.

MAC Address

Displays the MAC address of the managed machine.

Group Name

Displays the group name to which the managed machine
belongs.

Execution Progress
Scenario Name

Displays the scenario name.

Type

Displays Backup or Restore (Unicast).

Progress Status

Displays the execution progress as percent (%) in the status
bar.

Start Time

Displays the scenario start time.

Execution Lapsed Time

Execution Lapsed Time is displayed while running a scenario.
The Scenario End Time is displayed when the scenario
execution completes.

Transfer Size (MB)

Displays the transfer size. The whole size and the transferred
size are displayed. The unit is MByte(MB).
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<Data is transferred using multicast>

Machine Information
Machine Name

Displays the identification name of the managed machine. (When
the identification name is not specified, the machine name is
displayed.)

IP Address

Displays the IP address of the managed machine.

MAC Address

Displays the MAC address of the managed machine.

Group Name

Displays the group name to which the managed machine belongs

Execution Progress
Scenario Name

Displays the scenario name.

Type

Displays Restore(Multicast)

Progress Status

The execution progress is displayed as percent (%) in the status
bar.

Start Time

Displays the scenario start time.

Execution Lapsed Time

Execution Lapsed Time is displayed while running a scenario.
The Scenario End Time is displayed when the scenario is
completed.

Transfer Size (MB)

Displays the transfer size. The whole size and the complete
transfer size are displayed. The unit is MByte(MB).
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Multicast Execution Progress
Start Target Number

Displays the number of managed machines until starting the
scenario execution
The scenario will start when the number of managed machines
reaches the Start Target Number.

Current Target Number

Displays the number of managed machines ready for scenario
execution.
The scenario execution will start when this number reaches the
Start Target Number or the Remainder Time has been
exceeded.

Remainder Time(Min.)

Displays the time left until the scenario execution starts.
Displayed by one minute increments.

Multicast Machine List
Display Count

Select the number of managed machines to be displayed

Machine Name

Displays the identification name of the managed machine that the
scenario is running or completed. (When the identification name is
not specified, the machine name is displayed.)

MAC Address

Displays the MAC address of the managed machine.

Group Name

Displays the group name to which the managed machine belongs.

Running Status

Displays the scenario progress. (*1)

Action Link

• When you click Start Now, scenario will start for all of the
machines to which the scenario is assigned.
• When you click Interrupt Scenario, scenario will be interrupted
for all of the machines to which the scenario is assigned.

*1
The displayed state conditions can be the following types.
Execute Status

Description

Backup Under preparation

This is displayed when it is preparing for a backup.

Backup Standby mode

This is displayed when the backup is waiting for
execution.

Backup Running

This is displayed when the backup is running.

Backup Successful completion

This is displayed when the backup completes
successfully.

Backup Verifying

This is displayed when the verification data for the
backup scenario is being created.

Backup Stop processing

This is displayed when a backup is canceled.

Backup Error stops processing

This is displayed when a backup error interruption is
being executed.

Backup Stop

This is displayed when the user cancels the backup.

Backup Error stop

This is displayed when there is backup error interruption.

Backup Pausing

This is displayed when the backup is being halted.
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Restore Under preparation

This is displayed when it is preparing for a restore.

Restore Standby mode

This is displayed when the restore is waiting for
execution.

Restore Running

This is displayed when the restore is running.

Restore Successful completion

This is displayed when the restore completes properly.

Restore Stop processing

This is displayed when a restore is canceled.

Restore Error stops processing

This is displayed when there is restore error interruption

Restore Stop

This is displayed when the user cancels the restore on a
managed machine.

Restore Error stop

This is displayed when there is restore error interruption.

Restore Pausing

This is displayed when the restore is being halted.

Click Refresh from the Operation menu and refresh the latest information in order to
confirm the latest execute status.

4.3.3.

Start Immediately

Backup/restore immediately, even if the start conditions are not met.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main
window, click Scenario Execution List.
(3) The Scenario Execution List group box appears in the main window. Click ">>" in the Detail column.
(4) The Backup/Restore Execute List screen appears. Then click the Start Now on the Action link.
(5) Start the backup or restore immediately, even if the start conditions are not met.
Start Conditions are not Met indicates that the managed machines that have
completed the execution preparation have not been reached the maximum number of
targets or the execution time for the first managed machine for the restore has not
reached the maximum wait time.
The execute status in the Backup/Restore Execute List for the managed machine
that has completed execution preparation will be Waiting Execution.
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4.3.4.

Scenario Execution Stop

Stop the scenario at the time of backup/restore.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main
window, click Scenario Execution List.
(3) The Scenario Execution List group box appears in the main window. Click ">>" in the Detail column.
(4) The Backup/Restore Execute List screen appears. Then click the Interrupt Scenario on the Action link.



The managed machine that scenario execution stop was executed is powered off
at the timing of PXE boot after running scenario is stopped.
When a scenario is executed on the managed machine over Machines For
Simultaneous Execution, the processing of the scenario execution stop may be
executed, after the processing of the execution is started on the machine,
depending on the timing.

If you click Interrupt Scenario by multiple times, the logs of Stop Execution are
displayed in Scenario Execution Result List by the number of times you clicked.

4.4. "Scenario Execution Result List" Icon
The Scenario Execution Result List icon displays the list of the scenario execution results which has been
executed in the DPM.
You can access the Scenario Execution Result List icon from the Scenario Execution Result List icon at the
top of the Monitor view tree view or from Scenario Execution Result List in the Monitor Function List group
box displayed in the Monitor view main window.
Click the Scenario Execution Result List icon to display the Scenario Execution Result List group box in the
main window. See Section 4.5, "Scenario Execution Result List Details" regarding the screen.

4.5. Scenario Execution Result List Details
The following information is displayed in the Scenario Execution Result List screen.
The Scenario Execution Result List is displayed, sorted by the various items (Type, Date, MAC Address,
Scenario Name, Machine Name and IP Address).
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or in the Monitor
Function List group box appears in the main window. Click Scenario Execution Result List.
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(3) The Basic Information and Scenario Execution Result List group box appear in the main window.

Basic Information
Scenario Execution Log(s)

Displays the number of scenario execution logs.
You can confirm the number of logs shown here in the following
Scenario Execution Result List group box.

Scenario Execution Result List
Display Count

Select the number of scenario execution logs to be displayed.

Type

Displays the scenario execution status. (*1)

Date

Displays the scenario date and time.

Scenario Name

Displays the scenario name.
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Machine Name

Displays the machine name of the managed machine.
Furthermore, if it is upgraded from a version earlier than DPM
Ver6.0, the machine name will not be displayed in the result of
scenario executed before the upgrade.

IP Address

Displays the IP address.
Furthermore, if it was upgraded from a version earlier than DPM
Ver6.0, the IP address will not be displayed in the result of
scenario executed before the upgrade.

MAC Address

Displays the MAC address of the managed machine on which
the scenario was executed.
When you click the MAC address, the Operation view Machine Detail group box appears.
See Section 3.7, "Managed Machine Details" regarding the
Machine Detail group box.

*1
The displayed scenario execution results list status can be the following types.
Type

Description

Stop Execution

This is displayed when the scenario execution is interrupted.

Interrupt The Time Out

This is displayed when the timeout time set in the Management
view -> DPM Server -> Detail Settings -> Scenario tab is
exceeded.
Interrupt The Time Out is displayed only in the case of
Hardware Setting or Linux Installation scenario execution.

Start Execution

This is displayed when the scenario execution starts.

Completed Execution

This is displayed when the scenario execution is completed.

Error

This is displayed when an error occurs during the scenario
execution.
Remove the error if there is a scenario execution error. See Section 3.8.8, "Error
Cancellation" about removing the error.

4.5.1.

Save in CSV Format

The scenario execution results are saved in the CSV format.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or the Monitor Function
List group box appears in the main window. Click Scenario Execution Result List.
(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then click Save In
CSV.
(4) The File Download dialog box appears. Click Save and save the file.
If the File Download dialog is not displayed, please confirm the security settings for your browser.
・ Internet Explorer
Select Internet Options from the Tools menu, then click Custom level from the Security level for this
zone on the Security tab and the Security Settings screen appears.
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1) Set Enable from Downloads – File Download.
2) Set Enable from Downloads – Automatic prompting for file downloads.
(Only Internet Explorer 7/8)

4.5.2.

Delete Log

Delete the log file.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or in the Monitor
Function List group box appears in the main window. Click Scenario Execution Result List.
(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then click Delete Log
from the Operation menu.
(4) Click OK.
The scenario execution results log file is saved in the following folder. Also, the log file
can increase in size without limit until it is deleted.
Default: C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\SnrReport
See Appendix E, "Log Files Output by DPM" regarding the log file.

4.6. "Automatic Update Result List" Icon
The Automatic Update Result List icon displays the list of the automatic update result which has been
executed in the DPM.
You can access the Automatic Update Result List icon from the Automatic Update Result List icon at the top
of the Monitor view tree view or from Automatic Update Result List in the Monitor Function List group box
displayed in the Monitor view main window.
Click the Automatic Update Result List icon to display the Automatic Update Result List group box in the
main window. See Section 4.7, "Automatic Update Result List Details" regarding the screen.
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4.7. Automatic Update Result List Details
The following information is displayed in the Automatic Update Result List screen.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or the Monitor Function List group
box appears in the main window. Click Automatic Update Result List.
(3) The Automatic Update Result List group box appears in the main window.

Basic Information
Auto Update Log(s)

Displays the number of automatic update logs.

Automatic Update Result List
Display Count

Select the number of automatic update logs to be displayed.

Type

Displays the automatic update log type. (*1)

Date

Displays the automatic update date and time.

Machine Name

Displays the machine name of the managed machine on which the
automatic update was executed.

MAC Address

Displays the MAC address of the managed machine on which the
automatic update was executed.

Detail

When you click "
appears.

", the Detail of Automatic Update Result screen

*1
The displayed automatic update result list type can be the following types.
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Type

Description

Update Completed

This is displayed when the automatic update was successful.

Update Warning

This is displayed when the execution conditions are not met during a check before
the automatic update execution. The execution conditions are not met if there are
more than the maximum number of automatic update clients or if the scenario is
running and so on.

Update Error

This is displayed when an error occurs in the automatic update.
* File transfer error or failure of searching a package to apply and so on.

Notice Completed

This is displayed when the automatic update notice was successful.

Notice Error

This is displayed when an error occurs during the automatic update notice due to a
communication error and so on.

Time Setting
Completed

This is displayed when automatic update time setting is completed.

Time Setting
Warning

This is displayed when it failed to set the automatic update time due to the failing of
connection to the managed machine or the failing of communication and so on.
If there is an automatic update error, please re-run or restart DPM Client.

4.7.1.

Automatic Update Result Details Display

Display the detail information of the automatic update result.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or the Monitor Function List group
box appears in the main window and click Automatic Update Result List.
(3) The Automatic Update Result List group box appears in the main window. Then click the Detail (
to confirm the automatic update result for the managed machine.
(4) The detail of automatic update result is displayed in the main window.
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) icon

When you click the Detail Icon ( ) of Automatic Update Result List group box, the
Detail Of Automatic Update Result screen appears only if the automatic update
result (xx-xx-xx-xx-xx-xx.rpt) exists in the DPM installation folder
(Default value: C:\Programfiles\NEC\DeploymentManager\Datafile\LogFile\AuReport).

4.7.2.

Maximum Number of Logs Settings

You can set the maximum output number for automatic updates.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or the Monitor Function List group
box appears in the main window. Click Automatic Update Result List.
(3) The Configuration menu for the Automatic Update Result List icon will be displayed, then click
Maximum Number of Log.
(4) The Maximum Number of Log Setting screen appears in the main window. Then set the maximum
number of logs.

Maximum Number of Log Setting
Maximum Number of Logs
(1-100000)
(Required)

Set the maximum number of output logs for the automatic
updates.
This can be set in the range of "1 - 100000."
The default value is "10000."

OK

Saves the settings of the Maximum Number of Log Setting
screen and returns to the previous window.

Cancel

Returns to the previous window without saving the settings
details from the Maximum Number of Log Setting screen.
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4.7.3.

Only the specified maximum number of logs will be displayed on the screen.
If the Maximum Number of Logs is set to less than 10000, the old information that
exceeds the maximum number of logs will be deleted in order. If the Maximum
Number of Logs is set to more than 10000, 10% of the old logs that exceed the
maximum number of logs will be deleted.
If you set the Maximum Number of Logs smaller than the previously set value, it is
possible that part of the logs may be deleted.
Change the Maximum Number of Logs according to the managed number of
managed machines.
It is recommended that the Maximum Number of Logs be set higher than the
number of managed machines.
For example, If you are managing 100 managed machines, and if you set the
Maximum Number of Logs to more than 100, then you can confirm the automatic
update result for the updates for all of the managed machines.

Save in CSV Format

The automatic update execution results and detailed information are saved in the CSV format.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or the Monitor Function List
group box appears in the main window. Click Automatic Update Result List.
(3) The Automatic Update Result List screen appears. Click Save In CSV in Operation menu.
(4) The File Download dialog box appears. Click Save and save the file.
If the File Download screen is not displayed, please confirm the security settings for
your browser. See Section 4.5.1, "Save in CSV Format" regarding the settings.

4.7.4.

Delete Log

Delete the automatic update result log file.
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view.
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or the Monitor Function List
group box appears in the main window. Click Automatic Update Result List.
(3) The Automatic Update Result List screen appears. Click Delete Log in Operation menu.
(4) Click OK.
The automatic update result log file is saved in the following folder.
Default: C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\AuReport
See Appendix E, "Log Files Output by DPM" regarding the log file.
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5.

Image Builder

This chapter explains Image Builder which is a tool to register an image.



In the case of Windows Server 2012 or Windows 8, be sure to log on with
Administrator user.
When UAC is enabled on OS except Windows Server 2012 and Windows 8, run
Image Builder as an administrator. It may not work properly by other authorities.

5.1. Connection Settings
Set when using Image Builder (Remote Console).
When changing the Management Server to which Image Builder (Remote Console) is connected, change the IP
address and the port entered during the first startup using the following procedure.
(1) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.
(2) Click Setting connection. The Setting connection screen appears.

(3) Enter the IP address and the port of DPM Server and click OK.
The connection setting is completed.



The IP address of the Management Server, to which Image Builder (Remote Console)
connects, is the one specified in Management view -> DPM Server icon -> Detailed
Setting -> General tab -> Server Information -> IP address.
The port of the Management Server, to which Image Builder (Remote Console)
connects, is the port number configured in the Management Server.
You can confirm the port number configured in the Management Server in the
following file.
<DPM Server installation folder>\PXE\Images\Port.ini
・ Key name: FTUnicast
・ Default value:26508(It is 56023 when you upgraded DPM Server from the earlier
version than DPM Ver6.1.)
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5.2. Creating a Floppy Disk Image
By using the Creating Floppy Disk Image function, you can register floppy disk images of BIOS updates, firmware
updates and distribute the images via the network.
You can also register, distribute, and execute floppy images of other application programs that start up from a
floppy disk. However, the size of the programs should be up to the floppy disk size, 1.44MByte.
 This section describes how to create an image of a floppy disk.
The image is created using Image Builder. Once created, the image is registered to DPM Server.
The following describes how to register a floppy disk image in DPM using Image Builder.
First, get the floppy disk that automatically executes BIOS and firmware updates. And insert the disk into the
floppy disk drive of the Management Server or the machine in which Image Builder (Remote Console) has been
installed, in order to register the image in DPM.
(1) From the Start menu of the machine where the Management Server or Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder.
(2) When Image Builder is launched, click Creating Floppy Disk Image/Registering EFI application.
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When you start Image Builder and select a menu item for the first time, the
following screen appears. Confirm the content and click I Accept. If you select I
Decline, you cannot use the function.

(3) The Select registration image screen appears. Select Creating Floppy Disk Image and click OK.
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(4) The Creating Floppy Disk Image screen appears. Enter image file name and click OK.

Creating Floppy Disk Image
Image File Name

Enter the image file name.
Only 8 single-byte numeric characters can be entered. A
character can be any single-byte alphabet and numeric
characters or any of the following symbols:
._-

(5) A confirmation screen appears. Confirm that the floppy disk is inserted, and click OK.
(6) The following screen appears. Click OK.

5.3. Registering an Operating System
If you create an NFS public folder except <Folder for Image>\exports, you must register
the operating system manually without using Image Builder. For details, see "About Linux
Installation" in Section 3.5.6, "Precautions/Other" in Operation Guide.
(1) From the Start menu of the machine where the Management Server or Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder.
(2) When Image Builder is launched, click Registering operating system.
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(3) The OS Registration screen appears. Configure each item and click OK.

Registering operating system

Operating System Name

Operating System Type

Enter the operating system name.
Names such as "Linux", "Linux(gPXE)", "ks", "daemon", and
"pxelinux.*" are reserved and cannot be registered.
In Linux, numeric characters and the following symbols can be
used:
. _- ( )
Select the following operating systems from the list box.
・ Red Hat Linux 3,4,5/VMware ESX/Citrix XenServer
・ Red Hat Enterprise Linux 6

initrd.img/vmlinuz folder

The floppy disk drive is displayed here. The default is "A:\". Click
Browse and select the location of initrd.img/vmlinuz.
If Red Hat Enterprise Linux 6 was selected in the Operating
System Type, specify "images\pxeboot" folder of the installation
media directly, or mount the ISO file for installation and select
"images/pxeboot".

CD-ROM Source Folder
(Install ISO is displayed
when Red Hat Enterprise
Linux 6 is selected as
Operating System Type.)

When Operating System Type is selected, the CD-ROM drive is
displayed.
Click Browse and select the location of the folder containing the
OS.
If Red Hat Enterprise Linux 6 was selected, select the ISO file
for installation.

OK

The OS image is created with the settings on the Registering
operating system screen before returning to the previous
window.

Cancel

The previous window is returned to without creating the OS
image with the settings from the Registering operating system
screen.
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To prepare a Linux image file, all under the source folder of the specified CD-ROM are
copied as the image file.
With Red Hat Linux, multiple CD-ROMs are involved and thus a message prompting you
to copy the next CD-ROM will appear after the first CD-ROM is copied. Insert the
CD-ROMs in order, and continue copying.
When an overwrite confirmation dialog box appears during this time, select Yes or Yes to
All, and proceed.
(4) Wait until the copy of the file of vmlinuz/initrd.img and CD is completed.
The Red Hat CD Image copy screen appears. If there are any remaining Red Hat installation CDs to
register, replace the CD and click Next. There are several Red Hat installation CDs.

(5) When the screen to confirm the replacing appears during copying, click Yes to All.
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(6) When all CDs have been copied, the Red Hat CD Image copy screen appears. Click Finish.

5.4. Creating a Setup Parameter File
The setup parameter file is a file which is used to perform an OS installation by disk duplication or an OS clear
installation. The managed machines are configured using this file. We will describe a method for creating a
separate setup parameter file for each managed machine, and a batch creation method.

5.4.1.

Creating a Disk Duplication Data File (Windows)

This section describes how to create a disk duplication data file for configuring individual machines when
performing an OS installation by disk duplication in Windows.

5.4.1.1.

Creating a Disk Duplication Data File (Windows Server
2000/Windows Server 2003/Windows XP)

To create a disk duplication data file for Windows Server 2000/2003/XP, the data file is created and then the disk
duplication data file is created on the basis of that data file. See "1. Creating a Data File" through "2. Creating a
Disk Duplication Data File."
The various settings configured in "1. Creating a Data File" become the default values in the disk duplication data
file created in "2. Creating a Disk Duplication Data File."
1. Creating a Data File
Create one data file which will act as the basis for creating the disk duplication data file.




The entry items vary depending on the type of Windows OS.
Depending on the item, other entry items sometimes have to be checked. If any
such messages appear on the screen, follow them.
You must use a setup parameter file created using DPM.
Setup parameters created using a product except DPM, such as using seamless
setup with EXPRESSBUILDER which comes standard with the Express5800
Series, cannot be used.

(1) From the Start menu of the Management Server or the machine where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
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(2) Select "Setting Setup Parameter File." The Select Parameter screen appears. Select Windows
Parameter File and click OK.

(3) The Create Setup Parameter File screen appears.
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(4) In the Setting Setup Parameter File screen, select File -> Create New information files. The Basic
information screen will be displayed, so select the OS type in the red box of the following screen. The item
in the red box must be set.
The following items do not need to be set.
- Target machine
- OS Installation path
- System Partition
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Basic Information
OS type

Activation
Retail Version or OEM
Version other than NEC
NEC OEM Version

Select the install OS. The following OS's can be selected.(*1)
-Windows 2000 Professional
-Windows 2000 Server
-Windows 2000 Advanced Server
-Windows XP Professional
-Windows Server 2003 Standard Edition
-Windows Server 2003 Enterprise Edition
-Windows Server 2003 Standard x64 Edition
-Windows Server 2003 Enterprise x64 Edition
If Windows XP or Windows Server 2003 is selected in OS type, the
Activation setting is enabled.
Select this if you are using a retail version or OEM version other than
NEC. (*2)
Select this if you are using an NEC OEM version. (*2)

*1
 Activation is enabled when the following OS's are selected.
Select either Retail Version or OEM Version other than NEC or NEC OEM Version.
-Windows XP Professional
-Windows Server 2003 Standard Edition
-Windows Server 2003 Enterprise Edition
-Windows Server 2003 Standard x64 Edition
-Windows Server 2003 Enterprise x64 Edition
 The setting data is not maintained if the OS type is changed. Make sure that each item is configured correctly.
 The followings are displayed in OS type. However, these are not supported in this version.
・ Windows Server 2003 Datacenter Edition
・ Windows Server 2003 Datacenter x64 Edition
 An activation (license authentication) request might appear during OS installation by disk duplication. If this
happens, follow the license authentication procedure in accordance with the instructions on the screen.
*2
 When running a DPM Server in x64, keep the following in mind.
- The data file cannot be created if NEC OEM Version is selected for the following OS media. If an OS
installation by disk duplication is performed for these OS's, select Retail Version or OEM Version other
than NEC and create the data file using the product key that came with the OS medium or the hardware.
-Windows XP Professional(no SP, SP1)(CD number:243-110442-007-A)
-Windows XP Professional w/SP2(excluding 2006/06and after)(CD number:243-110442-007-C)
-Windows Server 2003 Standard Edition(no SP)(CD number:243-110442-100-A/C)
-Windows Server 2003 Enterprise Edition(no SP)(CD number:243-110442-101-A/B/C)
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 If NEC OEM was selected under Activation, the following screen appears, so insert the CD-ROM for the OS
into the CD-ROM drive and click OK.

(5) Click Next to display the User Information screen and then configure each item.
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User Information
User Name
(Required)

Company name

Product-Key

TimeZone

Enter the name of the user.
Up to 50 characters can be entered. The allowed characters
are single-byte alphanumeric characters.
The following symbols cannot be used.
,
Enter the name of the company.
Up to 50 characters can be entered. The allowed characters
are single-byte alphanumeric characters.
The following symbols cannot be used.
,
This entry is not optional.
Enter the Windows OS product key.
Enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx".
This does not need to be entered if NEC OEM Version is
selected.
In the case of a pre-installed machine, enter the product key on
the sticker attached to the machine body. If the OS has been
installed using a dedicated medium under a volume licensing
contract with Microsoft, enter the product key that came with
the medium.
Set the time zone. Select the appropriate region in the list box.
This is optional.
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(6) Select Next to display the Role of Computer screen. Items in red boxes in the screen below must be set.
The item in the red box must be set.
The following items do not need to be set.
- Client License Mode
- Specify an Account
- Network setup
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Role of Computer
Computer Name
(Required)

Enter the machine name registered in DPM.
Up to 15 characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
.,`~!@#$&*%=+{}\|;:'"<>/?[]^()
Also, you cannot register a machine name made up only of
numbers.
Make sure the name is not the same as that of any other machine
or domain/workgroup.

Administrator Password

Set the password for administrator authority.
Only 14 single-byte characters can be entered.
Only single-byte alphanumeric characters and symbols can be
used.
The following symbols as well as single-byte spaces and
single-byte kana cannot be used.
,"
This is optional.
If you set a password, see also the password configuration policy
of each OS.

Administrator Password
again

Re-enter the password set in Administrator Password. This
must be entered if Administrator Password was set.

MAC Address

This is used during OS installation by disk duplication. This item
cannot be set.

Domain

Set the domain. Select Domain and enter the corresponding
name. (*1)
The following symbols and single-byte spaces may not be used.
.,"\/;:|*?<>[]

Workgroup

Set the workgroup. Select Workgroup and enter the
corresponding name.
The following symbols cannot be used.
,"\;:|*?<>+=

*1
 When setting Domain, follow the policy of the password setting for the domain controller. If you do not
follow the policy, the processing of OS installation by disk duplication may stop at every login screen. In this
case, log in manually.
 Do not omit the password. When you omit it, a scenario execution error occurs.
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(7) Select Next to display the Display Setup screen. This does not need to be set for OS installation by disk
duplication, so just click Next.
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(8) Click Next to display the Network Setup screen and configure the NIC (LAN board). The items in red boxes
in the screen below are set. The item in the red box must be set.
The following items do not need to be set.
- Network services
- Network client
When the NIC Settings are made, the Protocol Setting, IP Address, DNS, and WINS can be set. These
settings can be indicated directly to the NIC of the machine. If the NIC is indicated, however, the MAC
address must be entered.
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Network Setup
NIC Settings
AutoDetect

MAC Address

Add
MAC addresses list of
the NIC to be added
Protocol setting

If the NIC is not specified, select "AutoDetect".
If "AutoDetect" is added to the MAC addresses list of the NIC to be
added, the numbers 1-4 are added to "AutoDetect".
When performing an OS installation by disk duplication by setting
"AutoDetect", if there are multiple NICs, an arbitrary NIC is selected and
the setting is done.
If the NIC is specified, select MAC Address and enter the MAC address
in the text box.
MAC address must be entered in the form "xx-xx-xx-xx-xx-xx".
When performing an OS installation by disk duplication setting MAC
address, the settings are configured for the specified MAC address.
For an NIC having a MAC address that is registered to the DPM,
configure the settings so that network communication is possible
regardless of whether the address is a static IP address or is acquired
from the DHCP server. If network communication is impossible, the
scenario might not be completed.
Add any NIC's to the List of Added NIC MAC addresses.
Select AutoDetect or enter MAC address and then click Add.
Displays a list of MAC address.
Set one or more NIC's. Up to a total of four AutoDetect and MAC
addresses can be added.
Configure the protocol for added NIC's. Click Protocol Setting to display
the Protocol Setting screen. See "Protocol Settings" below for details on
this screen.

When adding an Internet Protocol (TCP/IP), Internet Protocols (TCP/IP)
equal to the number of NIC's added by selecting NIC Settings -> Add are
added to the Protocol list to be added.
The following is an example where two NIC's, 00-00-00-00-00-00 and
AutoDetect1, have been added by selecting NIC Settings -> Add.
Example) Protocol list to be added
Internet Protocol (TCP/IP) 00-00-00-00-00-00
Internet Protocol (TCP/IP) AutoDetect1
Delete

To delete an added MAC address or AutoDetect, select it from the list and
click Delete.
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 Protocol setting
This section describes the Protocol setting screen.
When setting several NIC's (LAN boards), repeat steps 3)-4).
1)

In the Protocol Setting screen, select Internet Protocol (TCP/IP) from the Protocol list box, and click
Add.
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Protocol Setting
Protocol

Configure the protocol for the NIC.
The following protocols can be added. Note that the selectable items
vary depending on the OS.
- Internet protocol (TCP/IP)
(Required)
- NWLINK IPX/SPX/NetBIOS-compatible transport protocol
- Apple Talk protocol
- Network monitor driver
- NetBEUI protocol
- DLC protocol
- Streams environment

Protocol list to be added
(Required)

Displays the list of added protocols.
Select Protocol and click Add to add a protocol to the Protocol list to
be added.

Details

Detailed settings for the internet protocol (TCP/IP) for each NIC are
configured here.
If you select Internet Protocol (TCP/IP) from the Protocol list to be
added, you can click Details.
Click Details to display the Internet Protocol (TCP/IP) and set each
item.
See the description below for details on the screen.
This is optional.(*1)

Delete

Deletes an added protocol.
Select the protocol to delete from the Protocol list to be added and
click Delete.

OK

Saves the settings on the Protocol Setting screen and returns to the
previous window.

Cancel

Returns to the previous window without saving the settings in the
Protocol Setting screen.

*1
When you do not set, Acquire Automatically is set as a default for all IP address, DNS, and WINS. The
value of the scope ID is not reflected.
Click OK in the Protocol Setting screen, click Next in the Network Settings screen, and go to (9) the
Component Settings screen.
2) Internet Protocol (TCP/IP) is added to the Protocol list to be added. Select the protocol and click Details.
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3) The Settings Internet Protocol (TCP/IP) screen appears. Select the IP Setting tab in the Settings
Internet Protocol (TCP/IP) screen and configure each item.
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Settings Internet Protocol (TCP/IP)
IP Setting

Here you can set the IP address, subnet mask, gateway, and
metrics. The settings differ depending on whether they are acquired
automatically or set manually.

Acquire the IP address
automatically
Use the following IP
address
IP Address
Add

Edit

Delete

Default gateway
Add

Selecting this option button causes the IP address to be acquired
automatically.
The default setting is Acquire the IP address automatically.
Selecting this option button enables setting of the IP address,
subnet mask, gateway, and metric.
Clicking Add causes the TCP/IP Address screen to be displayed,
so enter the IP address and subnet mask.

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP Address screen, IP address and
subnet mask are added to the list of IP Address.
Up to a total of four IP addresses and subnet masks can be set for
each NIC.
Select the IP address/subnet mask to be edited from the list of the
IP Address and click Edit. The TCP/IP Address screen appears.
Edit the IP address/subnet mask.
Select the IP address/subnet mask to be deleted from the list of the
IP Address and click Delete. IP address/subnet mask will be
deleted.
Clicking Add causes the TCP/IP gateway address screen to be
displayed, so enter the gateway and metric.

Enter in Gateway by the form "xxx xxx xxx xxx".
Enter a single-byte number in Metric. This can be set in the range of
"1-9999." The default value is "1."
By clicking on Add in the TCP/IP gateway address screen, the
gateway/metric will be added to the list of the Default Gateway.
Up to a total of four gateways and metrics can be added.
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Edit

Delete

Select the gateway/metric to be edited from the list of Default
Gateway and click Edit. The TCP/IP gateway address screen
appears. Edit the gateway/metric.
Select the gateway/metric to be deleted from the list of the Default
Gateway box and click Delete. The gateway/metric will be deleted.

When you select the Check the completion of a scenario by the communication with
DPM Client checkbox (Web Console Management view -> DPM Server icon -> Detail
setting in Configuration menu -> General tab), the completion of the scenario may not
be detected if the managed machine cannot communicate with the Management Server by
the set IP address. Set IP address by which the machine can communicate with the
Management Server.
When you clear the Check the completion of a scenario by the communication with
DPM Client checkbox, the completion of the scenario can be detected regardless of
whether the machine can communicate with the Management Server or not.
4) Set the items in the DNS/WINS tab on Settings Internet Protocol (TCP/IP) screen.
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Settings Internet Protocol (TCP/IP)
DNS/WINS
The DNS and WINS settings are made here. The settings differ

Acquire the address of
DNS server
automatically

depending on whether they are acquired automatically or set
manually.
Select this to acquire the address of the DNS server automatically.
Select this if the managed machine is a DNS server.
The default setting is Acquire the address of DNS server
automatically.
Select this to set the IP address of the DNS server.

Use the following
address of DNS server
DNS Server Address (the Order of Use)
Add
By clicking Add, the TCP/IP DNS Server screen appears. Enter the
address of the DNS server.

Edit

Delete

Acquire the address of
WINS server
automatically
Use the following
address of WINS server

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP DNS Server screen, IP address of
the DNS server is added to the list of the DNS Server Address
(the Order of Use). Up to four IP addresses of DNS server can be
added.
Select IP address of the DNS server to be edited from the list of the
DNS Server Address (the Order of Use) and click Edit. The
TCP/IP DNS Server screen appears. Edit IP address of the DNS
server.
Select IP address of the DNS server to be deleted from the list of
the DNS Server Address (the Order of Use) and click Delete to
delete IP address of the DNS server.
Select this to acquire the address of the WINS server automatically.
Select this if the managed machine is a WINS server.
The default setting is Acquire the address of WINS server
automatically.
Select this to set the IP address of the WINS server.
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WINS Server Address (the Order of Use)
Clicking Add causes the TCP/IP WINS Server screen to be displayed,
Add
so enter the address of the WINS server.

Edit

Delete

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP WINS Server screen, the address of the
WINS server will be added to the list of WINS Address (the Order of
Use). Up to four WINS server addresses can be added.
Select IP address of the WINS server to be edited from the list of the
WINS Address (the Order of Use) and click Edit. The TCP/IP WINS
server screen appears. Edit IP address of the WINS server.
Select IP address of the WINS server to be deleted from the list of the
WINS Address (the Order of Use) and click Delete to delete IP
address of the WINS server.
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5) Set the ScopeID in the Settings Internet Protocol (TCP/IP) screen.

Settings Internet Protocol (TCP/IP)
ScopeID

Set the scope ID.
The scope ID cannot be set for each NIC. If the internet protocol
(TCP/IP) scope ID has been set for one NIC, the previously set scope
ID is displayed, even if the Settings Internet Protocol (TCP/IP)
screen is opened for the internet protocol (TCP/IP) of another NIC.
This is optional.

OK

Saves the settings in the Settings Internet Protocol (TCP/IP) screen
and returns to the previous window.

Cancel

Returns to the previous window without saving the settings in the
Settings Internet Protocol (TCP/IP) screen.
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(9) Select Next to display the Setting the Component screen. This does not need to be set for OS installation
by disk duplication, so just click Finish.
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(10) The agreement screen appears. Read this carefully and click I Accept.

If you select I Decline, you cannot use the function.
(11) By clicking on I Accept, the Specify a file screen appears. Click Browse, select a file name, and save the
data file.

224

Specify a file
File name

Set the name of the data file that has been set and where it is
contained.
You can select where to save it with the Browse button or enter
the file path directly.
Up to 63 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
"/\;:|,*?<>
If you use the Browse button to set the folder to be saved and
the file name, set the file name so that it is no longer than 254
single-byte characters, including the path.

OK

Save the data file to the saving specified designated on the
Specify a file screen.

Cancel

Closes the window without saving the data file with the settings.

Creation of the data file is completed once the Create a Setup Parameter File screen appears.
2. Creating a Disk Duplication Data File
The disk duplication data file is created on the basis of the data file created in "1. Creating a Data File."
A disk duplication data file must be created for each machine to which the system will
be deployed.
(1) From the Start menu of the Management Server or the computer where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(2) Select "Setting Setup Parameter File". The Select Parameters screen appears. Select Windows
Parameter File and click OK.
(3) The Create a Setup Parameter File screen appears. In the File menu, select Create New Disk copy
information File for 2003/2000/XP(P). The Open screen appears.
(4) Select the data file you created according to "1. Creating a Data File" in "5.4.1.1 Creating a Disk Duplication
Data File (Windows Server 2000/Windows Server 2003/Windows XP)."
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(5) The Setup Information File screen appears. Set the data required for the managed machine in which setup
is to be performed. Items in red boxes in the following screen must be set.
The following tabs do not need to be set.
- Basic information

- Display Setup
- Setting the Components
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Setup Information File (*1)
Role of Computer

- Computer Name must be set.
The MAC address is automatically entered by entering the
name of the machine registered to DPM and placing the
cursor over the MAC Address field.
- The following symbols as well as single-byte kana cannot be
used in the Administrator Password and the password for
Specify an Account.
",
- For the MAC Address, enter the MAC address of the
machine in which OS installation by disk duplication is
executed. Enter it in the form "xx-xx-xx-xx-xx-xx".

User Information

- User Name must be set.
- On the ProductKey, set the product key used on the machine
in which OS installation by disk duplication is executed.

Network Setup

Set as necessary.
For an NIC having a MAC address that is registered to the
DPM, configure the settings so that network communication
can be done regardless of whether the address is a static IP
address or is acquired from the DHCP server. If network
communication cannot be done normally, an executed scenario
may not be completed.

*1
Items are configured with the content of the data file that has been prepared. Change as needed.
(6) Click OK to display the Specify a file screen and click OK.
Clicking Cancel returns the screen to the previous window, without saving the settings in the Setup
Information File screen.
The file name of the created setup parameters becomes the entered MAC address
automatically. The file name cannot be changed.
Creation of a disk duplication data file is completed.
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5.4.1.2.

Creating a Disk Duplication Data File (Windows Server
2008/Windows Vista or Later)

Create a disk duplication data file for Windows Server 2008/Windows Vista or later.
The disk duplication data file for Windows Server 2008/Windows Vista or later includes the conventional Disk
Duplication Data File (Windows Parameter File) used in the version earlier than DPM Ver6.0, and a Disk
Duplication Data File (Windows parameter file(Express)) that enables rapid setup of machines.






The Windows parameter file(Express) cannot be used for the batch creation of
disk duplication data files. Therefore, use the conventional disk duplication data
file. See "2. Creating a Disk Duplication Data File (Windows Parameter File)"
below about disk duplication data file for the batch creation.
A disk duplication data file created using the Windows parameter file(Express)
cannot be edited in Image Builder by specifying the Windows parameter file.
Furthermore, a disk duplication data file created using the Windows parameter
file cannot be edited in Image Builder by specifying the Windows parameter
file(Express).
Items which cannot be entered in the Image Builder screens are not used in
settings of this procedure (creating a disk duplication data file for Windows
Server 20008/Windows Vista or later).

1. Creating a Disk Duplication Data File (Windows parameter file(Express))
In creating a disk duplication data file (Windows parameter file(Express)), the procedure for creating a disk
duplication data file that can set a machine up rapidly.
(1) From the Start menu of the computer where the Management Server or Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder.
(2) Select "Setting Setup Parameter File." The Select Parameters screen appears. Select Windows
Parameter File (Express) and click OK.
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(3) When the Create Setup Parameter File screen appears, click Create a new disk copy files for
2008/Vista or later (B).

(4) When the Basic information screen appears, set the OS type.
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Basic Information
OS type

Select the installation OS. The following OS's can be selected.
(*1)
- Windows Server 2008 Standard
- Windows Server 2008 Enterprise
- Windows Server 2008 Datacenter
- Windows Server 2008 Standard x64 Edition
- Windows Server 2008 Enterprise x64 Edition
- Windows Server 2008 Datacenter x64 Edition
- Windows Server 2008 R2 Standard
- Windows Server 2008 R2 Enterprise
- Windows Server 2008 R2 Datacenter
- Windows Vista Business
- Windows Vista Enterprise
- Windows Vista Ultimate
- Windows 7 Professional
- Windows 7 Ultimate
- Windows 7 Enterprise
- Windows 7 Professional x64 Edition
- Windows 7 Ultimate x64 Edition
- Windows 7 Enterprise x64 Edition
- Windows 8 Pro
- Windows 8 Enterprise
- Windows 8 Pro x64 Edition
- Windows 8 Enterprise x64 Edition
- Windows Server 2012 Standard
- Windows Server 2012 Datacenter

Activation
Retail Version
or OEM Version other
than NEC
NEC OEM Version

MVLS Version

Select this if you are using Retail Version or OEM Version other
than NEC.
Select this if you are using an NEC OEM version.
However, this cannot be selected about Windows Vista/Windows 7/
Windows 8, because OS installation by disk duplication for NEC
OEM versions is not permitted due to the license.
Select this if you are using a volume licensed version.

*1
 The setting data is not maintained if the OS type is changed. Make sure that each item is configured
correctly.
 An activation (license authentication) may be requested during OS installation by disk duplication. If
this happens, follow the license authentication procedure in accordance with the instructions on the
screen.
 The followings are displayed in OS type. However, these are not supported in this version.
・ Windows Server 2008 Datacenter Edition
・ Windows Server 2008 Datacenter x64 Edition
・ Windows Server 2008 R2 Datacenter

230

(5) After configuring the settings in the Basic Information screen, click Next to display the User Information
screen and then configure each item.
<When Windows Server 2008 or
Windows Server 2012 is selected>

<When Windows Vista, Windows 7, or Windows 8
is selected>
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User Information
User Name
(Required)

Company name

Product-Key

Enter the name of the user.
Up to 50 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
,
Enter the name of the company.
Up to 50 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols cannot be used.
,
This entry is optional.
Enter the Windows OS product key.
Enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx".
In the case of a pre-installed machine, enter the product key on the
sticker attached to the machine body. If the OS has been installed
using a dedicated medium under a volume licensing contract with
Microsoft, enter the product key that came with the medium.
This must be entered if Retail Version or OEM Version other
than NEC was selected in Activation in the Basic information
screen.
This does not need to be entered if NEC OEM Version is selected.
If you selected MVLS Version, this does not need to be entered.

Timezone

Set the time zone. Select the appropriate region from the list box.

Language

Select the language to use from the list box.

Help protect Windows
automatically

This item is only for Windows Vista/Windows 7/Windows 8.
Select the setting to protect Windows automatically from the list
box. The following three options are available.
- Use recommended settings.
- Install important updates only.
- Ask me later.

Select your computer's
current location

This item is only for Windows Vista/Windows 7/Windows 8.
Select the current location of your computer from the list box. The
following three options are available.
- Home
- Work
- Public location
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(6) After setting the User Information screen, select Next to display the Role of Computer screen. Items in
red boxes in the screen below must be set. The item in the red box must be set.
The following items do not need to be set.
- Client License Mode
- Network Setup
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Role of Computer
Computer Name
(Required)

Enter the machine name registered in DPM.
Up to 15 single-byte characters can be entered.
The allowed characters are single-byte alphanumeric characters.
The following symbols and single-byte spaces cannot be used.
.,`~!@#$&*%=+{}\|;:'"<>/?[]^()
Also, you cannot register a machine name made up only of
numbers.
Make sure the name is not the same as that of any other machine
or domain/workgroup.
If the name of a machine registered to DPM is used, the
Management Server can automatically acquire the MAC address
of the managed machine.

Administrator Password

Set the password for administrator authority.
For setting the password, see the password configuration policy of
each OS.
The number of characters that can be entered depends on the
OS.
• For Windows Server 2008/Windows Server 2012:
3-14 single-byte characters for mixed single-byte alphanumeric
characters (including lower case for Latin letters).
• For Windows Vista/Windows 7/Windows 8:
Only 14 single-byte numeric characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols as well as single-byte spaces and
single-byte kana cannot be used.
,"
This is optional.

Administrator
again

Re-enter the password set in Administrator Password. This
must be entered if Administrator Password was set.

Password

MAC Address

If the NIC (LAN board) is specified, select MAC Address and
enter the MAC address in the text box.
MAC Address must be entered in the form "xx-xx-xx-xx-xx-xx".
For an NIC having a MAC address that is registered to the DPM,
configure the settings so that network communication is possible,
regardless of whether the address is a static IP address or is
acquired from the DHCP server. If network communication is
impossible, an executed scenario might not be completed.

Domain

Set the domain. Select Domain and enter the corresponding
name.
The following symbols and single-byte spaces cannot be used.
,"\/;:|*?<>[]
When setting Domain, follow the password setting policy for the
domain controller. If the policy is not followed, the OS installation
by disk duplication will stop at every login screen. If this happens,
log in manually.

234

Workgroup

The workgroup name cannot be changed in Windows Server
2008/Windows Vista or later when using the disk duplication data
file (Windows parameter file). Use the existing workgroup.
When using the disk duplication data file (Windows parameter
file(Express)), the workgroup name can be changed.
The following symbols cannot be used.
,"\;:|*?<>+=

Specify an Account

This can only be entered if Domain has been selected.
Check this to set the account and password when participating in
a domain.
If this is selected, Account, Password, and Password again can
be set.

Account

Enter the account name.
32 single-byte characters can be used.
The following symbols cannot be used.
,"/;:*?<>+=[]|

Password

Enter the password.
- For Windows Server 2008/Windows Server 2012, 3-14 bytes can
be entered using single-byte alphanumeric characters.
The following characters cannot be used in the password.
,"
- For Windows Vista/Windows 7/Windows 8, enter no more than
14 bytes.
The following characters cannot be used in the password.
,"
Do not omit the Password. Omitting it will result in a scenario
execution error.
Enter the password entered in Password.

Password again
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(7) After setting the Role of Computer screen, select Next to display the Network Setup screen. Items in red
boxes in the screen below must be set.
The following items do not need to be set.
- Network services
- Network client
The protocol can be set and the IP address, DNS, and WINS settings can be configured for the NIC (LAN
board). With these settings, the NIC of the computer can be specified directly. If the NIC is indicated,
however, the MAC address must be entered.
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Network Setup
NIC Setting
AutoDetect

MAC Address

Add
MAC Addresses list of
the NIC to be added

Protocol Setting

If the NIC is not specified, select AutoDetect.
If AutoDetect is added to the MAC addresses list of the NIC to be added, the
following numbers are added to AutoDetect.
- Windows parameter file(Express): 1-8
- Windows parameter file: 1-4
When performing an OS installation by disk duplication by setting
"AutoDetect", an arbitrary NIC is selected and the setting is done.
If the NIC is specified, select MAC Address and enter the MAC address in
the text box.
MAC address must be entered in the form "xx-xx-xx-xx-xx-xx".
If the data file is used in which the MAC address is set, the settings are
made to the specified MAC address.
For an NIC having a MAC address that is registered to the DPM, configure
the settings so that network communication is possible regardless of
whether the address is a static IP address or is acquired from the DHCP
server. If network communication is impossible, an executed scenario may
not be completed.
Adds a NIC. Select AutoDetect or enter MAC address and then click Add.
Displays a list of added NIC MAC addresses.
Click Add and add a MAC address to the list.
Set one or more NIC's. The following total number of AutoDetect and MAC
addresses can be added:
- Windows parameter file(Express): up to 8
- Windows parameter file: up to 4
NIC not configured here is configured to acquire an IP address automatically
using DHCP.
Configure the protocol for added NIC's. Click Protocol Setting to display the
Protocol Setting screen. See " Protocol Setting" below for details on this
screen.

When adding an Internet Protocol (TCP/IP), Internet Protocols (TCP/IP)
equal to the number of NIC's added by selecting NIC Settings -> Add are
added to the Protocol List to be Added.
The following is an example where two NIC's, 00-00-00-00-00-00 and
AutoDetect1, have been added by selecting NIC Settings -> Add.
Example) Protocol list to be added
Internet Protocol (TCP/IP) 00-00-00-00-00-00
Internet Protocol (TCP/IP) AutoDetect1
Delete

To delete an added MAC address or AutoDetect, select either from the list
and click Delete.

 Protocol Setting
This section describes the Protocol Setting screen.
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1) In the Protocol Setting screen, select Internet Protocol (TCP/IP) or Internet Protocol (TCP/IPv6) from
the Protocol list box, and click Add.
 Set IP address(IPv4) necessarily for the LAN board which communicate with the
Management Server.
 Only in the case of Windows parameter file(Express), IPv6 address can be set.

Protocol Setting
Protocol

Configure the protocol for the NIC.
The protocol which can be added is Internet Protocol (TCP/IP) or
Internet Protocol (TCP/IPv6).
The number of protocols that can be added depends on the disk
duplication data file that was created.
• Windows parameter file(Express): up to 16
• Windows parameter file: up to 4

Protocol list to be added
(Required)

Displays the list of added protocols.
Select Protocol and click Add to add a protocol to the Protocol List
to be Added screen.

Details

Configure detailed settings for the protocol for each NIC.
If you select Internet Protocol (TCP/IP) or Internet Protocol
(TCP/IPv6) from the Protocol list to be added, you can click
Details.
Click Details to display the screen. Set each item, seeing the
following description.
This is optional.
If the NIC is not configured, the IP address, DNS, and WINS settings
are all "acquire automatically" by default. The value of the scope ID
is not reflected. For the remaining settings, go to (8).

Delete

Delete an added protocol.
Select the protocol to delete from the Protocol list to be added and
click Delete.
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OK

Saves the settings in the Protocol Setting screen and returns to the
previous window.

Cancel

Returns to the previous window without saving the settings in the
Protocol Setting screen.

2)

Add Internet Protocol (TCP/IP) or Internet Protocol (TCP/IPv6) to the Protocol list to be added and click
Details.

3)

The screen for setting is displayed as the following. Configure on the IP Settings tab.
There is no area to enter the scope ID with the disk duplication data file (Windows parameter
file(Express)).
When setting several NIC's (LAN boards), repeat steps 3-4.
 In the case of Settings Internet Protocol(TCP/IP) screen
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Settings Internet Protocol (TCP/IP)
IP Setting
Here you can set the IP address, subnet mask, gateway, and metrics. The settings
differ depending on whether they are acquired automatically or set manually.
Acquire the IP
If you select this option button, the IP address is acquired automatically.
Address
The option button is selected by default.
Automatically
Use the following Selecting this option button enables setting of the IP address, subnet mask, gateway,
IP Address
and metric.
IP address
If you click Add, the TCP/IP address screen appears. Enter the IP address and
Add
subnet mask.

Edit
Delete

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP address screen, the IP address and subnet mask are
added to the list of IP address.
The total number of IP addresses and subnet masks that can be set for each NIC are
as follows:
• Windows parameter file(Express): up to 16
• Windows parameter file: up to 4
Select the IP address/subnet mask to be edited from the IP address group box and
click Edit. The TCP/IP address screen appears. Edit the IP address/subnet mask.
Select the IP address/subnet mask to be deleted from the IP address group box and
click Delete. The IP address/subnet mask is deleted.

Default Gateway
If you click Add, the TCP/IP gateway address screen appears. So enter the gateway
Add
and metric.

Edit
Delete

Enter these in the form "xxx xxx xxx xxx" in the Gateway.
Enter as a single-byte number in the Metric. This can be set in the range of "1-9999."
The default value is "1."
If you click Add in the TCP/IP gateway address screen, the gateway and metric are
added to the list of Default gateway.
The total number of gateways and metrics that can be added is as follows:
• Windows parameter file(Express): up to 16
• Windows parameter file: up to 4
Select the gateway/metric to be edited from the list of Default gateway and click Edit.
The TCP/IP gateway address screen appears. Edit the gateway/metric.
Select the gateway/metric to be deleted from the list of Default gateway and click
Delete to delete the gateway/metric.
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When you select the Check the completion of a scenario by the communication with
DPM Client checkbox (Web Console Management view -> DPM Server icon -> Detail
setting in Configuration menu -> General tab), the completion of the scenario may not
be detected if the managed machine cannot communicate with the Management Server by
the set IP address. Set IP address by which the machine can communicate with the
Management Server.
When you clear the Check the completion of a scenario by the communication with
DPM Client checkbox, the completion of the scenario can be detected regardless of
whether the machine can communicate with the Management Server or not.
 In the case of Settings Internet Protocol(TCP/IPv6) screen

Settings Internet Protocol (TCP/IPv6)
IP Setting
You can set the IPv6 address, subnet prefix, gateway, and metrics. The
settings differ depending on whether they are acquired automatically or set
manually.
Router
If you select the Router Advertisement checkbox, the machine will
Advertisement
receive Router Advertisement.
This is not selected by default.
Acquire the IP
If you select this option button, the IPv6 address is acquired automatically.
Address
The option button is selected by default.
Automatically
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Use the
following IP
Address
IP address
Add

Edit

Delete

If you select this option button, settings of the IPv6 address, subnet prefix,
gateway, and metric are enabled.

If you click Add, the TCP/IPv6 address screen appears. Enter the IPv6
address and subnet prefix.

Enter IP address in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx".
Example)
fe80::1895:3454:53e3:40cc
Enter the length of the prefix in Subnet Prefix by bit(single-byte number).
You can set in the range of "0-128".
Example)
64
If you click Add in the TCP/IPv6 address screen, the IPv6 address and
subnet prefix are added to the list of IP address.
The total number of IPv6 addresses and subnet prefix that can be set for
each NIC is up to 16.
Select the IPv6 address/subnet prefix to be edited from the list of IP
address and click Edit. The TCP/IPv6 address screen appears. Edit the
IPv6 address/subnet prefix.
Select the IP address/subnet prefix to be deleted from the list of IP
address and click Delete. The IPv6 address and subnet prefix are deleted.

Default Gateway
If you click Add, the TCP/IPv6 gateway address screen appears. Enter
Add
the gateway and metric.

Edit

Delete

Enter Gateway in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx".
Example)
fe80::1895:3454:53e3:40cc
Enter Metric by single-byte number.
You can set in the range of "1-9999". Default is "1".
If you click Add in the TCP/IPv6 gateway address screen, the gateway
and metric are added to the list of Default Gateway.
The gateway and metric can be set up to 16.
Select the gateway/metric to be edited from the list of Default gateway
and click Edit. The TCP/IPv6 gateway address screen appears. Edit the
gateway/metric.
Select the gateway/metric to be deleted from the list of Default gateway
and click Delete to delete the gateway/metric.

242

4)

The screen for setting is displayed as the following. Configure the DNS/WINS tab(DNS tab).

 In the case of Settings Internet Protocol(TCP/IP) screen
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Settings Internet Protocol (TCP/IP)
DNS/WINS

The DNS and WINS settings are made here. The settings differ
depending on whether they are acquired automatically or set
manually.
Select this to acquire the address of the DNS server
Acquire the address of
automatically.
DNS server automatically
Select Acquire the address of DNS server automatically if the
destination machine is a DNS server.
The option button is selected by default.
Select Use the following address of DNS server to set the IP
Use the following address
address of the DNS server.
of DNS server
DNS server address (the order of use)
If you click Add, the TCP/IP DNS server screen appears. Enter
Add
the address of the DNS server.

Edit

Delete

Acquire the address of
WINS server automatically

Use the following address
of WINS server

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP DNS server screen, IP address of
the DNS server is added to the list of DNS server address (the
order of use).
The total number of IP addresses of DNS server that can be
added is as follows:
• Windows parameter file(Express): up to 16
• Windows parameter file: up to 4
Select IP address of the DNS server to be edited from the list of
DNS server address (the order of use) and click Edit. The
TCP/IP DNS server screen appears. Edit IP address of the DNS
server.
Select IP address of the DNS server to be deleted from the list of
DNS server address (the order of use) and click Delete to
delete IP address of the DNS server.
Select this to acquire IP address of the WINS server
automatically.
Select Acquire the address for WINS server automatically if
the destination machine is a WINS server.
The option button is selected by default.
Select the Use the following address of WINS server checkbox
to set the IP address of the WINS server.
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WINS address (the order of use)
Add
If you click Add, the TCP/IP WINS server screen appears. So
enter the address of the WINS server.

Edit

Delete

Enter these in the form "xxx xxx xxx xxx".
If you click Add in the TCP/IP WINS server screen, IP address of
the WINS server is added to the list of WINS address (the order
of use).
The total number of IP addresses of WINS server that can be
added is as follows:
• Windows parameter file(Express): up to 16
• Windows parameter file: up to 4
Select IP address of the WINS server to be edited from the list of
WINS address (the order of use) and click Edit. The TCP/IP
WINS server screen appears. Edit the IP address of the WINS
server.
Select IP address of the WINS server to be deleted from the list
of WINS address (the order of use) and click Delete to delete IP
address of the WINS server.

When the OS is Windows Server 2008 or Windows Vista, the WINS server address may not
be set on the machine after the OS installation by disk duplication even if you specify it in the
Windows parameter file (Express).
Contact your sales or support representative for the detail.
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 In the case of Settings Internet Protocol(TCP/IPv6) screen

Settings Internet Protocol (TCP/IPv6)
DNS

Acquire the address of
DNS server automatically

Use the following address
of DNS server

The DNS settings can be configured. The settings differ
depending on whether they are acquired automatically or set
manually.
Select this to acquire the address of the DNS server
automatically.
Select Acquire the address of DNS server automatically if the
destination machine is a DNS server.
The option button is selected by default.
Select Use the following address of DNS server to set IPv6
address of the DNS server.
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DNS server address (the order of use)
If you click Add, the TCP/IPv6 DNS server screen appears.
Add
Enter IPv6 address of the DNS server.

Edit

Delete

Enter these in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx "
Example)
fe80::1895:3454:53e3:40cc
If you click Add in the TCP/IPv6 DNS server screen, IPv6
address of the DNS server is added to the list of DNS server
address (the order of use).
The total number of IPv6 addresses of the DNS server that can
be added is up to 16.
Select IPv6 address of the DNS server to be edited from the list of
DNS server address (the order of use) and click Edit. The
TCP/IPv6 DNS server screen appears. Edit IPv6 address of the
DNS server.
Select IPv6 address of the DNS server to be deleted from the list
of DNS server address (the order of use) and click Delete to
delete IPv6 address of the DNS server.
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5)

Set the Scope ID in the Settings Internet Protocol (TCP/IP) screen. This can only be set in the case of the
disk duplication data file (Windows parameter file). This cannot be set with the disk duplication data file
(Windows parameter file(Express)).

Settings Internet Protocol (TCP/IP)
Scope ID

Set the scope ID.
The scope ID cannot be set for each NIC. If the internet protocol
(TCP/IP) scope ID has been set for one NIC, the previously set scope
ID is displayed, even if the Settings Internet Protocol (TCP/IP)
screen is opened for the internet protocol (TCP/IP) of another NIC.
This is optional.

OK

Click OK when you reflect the settings in 3)-5). This saves the settings
in the Settings Internet Protocol (TCP/IP) screen and returns to the
previous window.

Cancel

Click Cancel when you do not reflect the settings in 3)-5). This saves
the settings in the Settings Internet Protocol (TCP/IP) screen and
returns to the previous window.
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(8) After setting the Network Setup screen, click Finish.
(9) The agreement screen appears. Read this carefully and click I Accept.

If you select I Decline, you cannot use this function.
(10) Click I Accept to display the Specify a file screen and click OK.
Creation of the parameter file is completed once the Creating Setup Parameter File screen appears.
The file name is the automatically entered MAC address.

249

2. Creating a Disk Duplication Data File (Windows Parameter File)
This section describes the procedure for creating the disk duplication data file (Windows parameter file).
(1) From the Start menu of the computer where the Management Server or Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder.
(2) Select Setting Setup Parameter File". The Select Parameters screen appears. Select Windows
Parameter File and click OK.

(3) When the Setting Setup Parameter File screen appears, click Create new disk copy information
files2008/Vista or later (B).

(4) The rest of the settings are the same as for the Windows parameter file(Express). See "1.Creating a Disk
Duplication Data File (Windows parameter file(Express))." The upper limit values sometimes vary between
the Windows parameter file(Express) and the Windows parameter file. Differences are described in the
description of the Windows parameter file(Express).
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5.4.2.

Batch Creation of Disk Duplication Data Files (Windows)

When executing OS installation by disk duplication on multiple Windows managed machines, a disk duplication
data file must be created for each machine.
This section describes batch creation of Windows disk duplication data files.
Batch creation is not possible using a disk duplication data file created using the
Windows parameter file (Express).
(1) Prepare the disk duplication data file that will act as the basis for creating a large quantity of disk duplication
data files.
For details on how to create the setup parameter file, see Section 5.4.1, "Creating a
Disk Duplication Data File (Windows)."
(2) From the Start menu of the Management Server or the computer where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(3) When you click Setting Setup Parameter File, the Select parameter screen appears. Select Windows
Parameter File and click OK.
(4) When the Setting Setup Parameter File screen appears, select Creation of multiple disk copy
information files assistant -> Output disk duplication data file in CSV format (I) in the Option menu.
(5) When the Open screen appears, indicate the disk duplication data file prepared in (1) above and open it.
(6) Specify the CSV file name to save to and click OK. The CSV-format disk duplication data file is created and
stored in <Folder for Image>\AnsFile\Sysprep\csv.

The CSV file created here is referred to as a template file from now on.
(7) Edit the template file created in (6) above. Open the CSV file created in (6) located in <Folder for
Image>\AnsFile\Sysprep\csv.
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(8) Open and edit the CSV-format template file that has been created and is located in <Folder for
Image>\AnsFile\Sysprep\csv.
Each line in the template file is as follows:
1)
2)
3)
4)

1st line
Name of the file that is the basis for the template file.
2nd line
Items in the disk duplication data file that can be specified during batch creation.
3rd line
Parameters specified by the file that is the basis for the template file.
4th line and later
Fill in the items corresponding to the 2nd line to perform batch creation. Each line corresponds to
one disk duplication data file.
Do not modify lines 1-3. Any modification will make batch creation using the template file
impossible.

See the table below for details on configuring the 4th line and later.








If you edit the file as a text file, items are separated by commas ( , ). Let each item of
the 4th line and later correspond with that of the 2nd line.
Do not include spaces before or after items when editing the 4th line and on in the CSV
file. Do not use commas ( , ) or double quotes ( " ) in the items. This might prevent
successful creation of the disk duplication data file.
Unless indicated in the table below, the format for each item in the 4th line should be in
accordance with "5.4.1 Creating a Disk Duplication Data File (Windows)." If an item is
mentioned in the table below, ensure accurate capitalization.
The machine name must be entered.
The DNS/WINS for each LAN board corresponds to the DNS/WINS set for each LAN
board in the file which is the basis for the template file.
When creating the file that is the basis for the template file, the internet protocols
(TCP/IP) equal to the number of LAN boards are added to the Protocol list to be
added in the Protocol Setting screen. In the DNS/WINS settings, items line up as
LAN board 1, LAN board 2, LAN board 3, and LAN board 4 from the above of the list.
Example) of the correspondence is as below.
Protocol list to be added
Apple Talk protocol
Internet Protocol (TCP/IP)
Internet Protocol (TCP/IP)
Internet Protocol (TCP/IP)
Internet Protocol (TCP/IP)

00-00-00-00-00-00
00-00-00-00-00-11
AutoDetect1
AutoDetect2
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LAN board 1
LAN board 2
LAN board 3
LAN board 4

Items in the 2nd line

Explanation of input items in the
4th line and later

Computer Name
(Required)
MAC Address
(Displayed only for disk
duplication data file.)
(Required)
User Name

Input the computer name.

Company name

Input the company name.

Product Key

Input product key for Retail Version
or OEM Version other than NEC.
For NEC OEM Version, NEC OEM is
input (single-byte space between NEC
and OEM). Note that if the product key
in the 3rd line of the template file is not
NEC OEM, an error will be returned
during creation of a disk duplication
information file.
Input administrator password in plain
text.
Input the workgroup name.
Note that if Domain, Domain
Account Name, or Domain Account
Password is input when the
workgroup is input, an error will be
returned during creation of the disk
duplication data file.
Input the domain name.
However, when both a domain and
workgroup are entered, an error will
be returned during creation of a disk
duplication data file.
Input the domain's account name.
Note that if Workgroup is input when
the domain is input, an error will be
returned during creation of a disk
duplication data file.
Input domain's account password in
plain text.
Note that if Workgroup is input when
the domain is input, an error will be
returned during creation of a disk
duplication data file.
Input the first LAN board If the NIC is
specified, input the MAC address.
If the NIC is not specified, input
AutoDetect.

Administrator Password
Workgroup

Domain

Domain's Account Name

Domain's Account
Password

NIC1

When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
Error.

Input the MAC address of the
machine.

Error.

Input the user name.

Same value as in parameter of 3rd
line in template file.
Same value as in parameter of 3rd
line in template file.
Same value as in parameter of 3rd
line in template file.
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Same value as in parameter of 3rd
line in template file.
If Domain is not input, the same
value as the parameter on the 3rd
line of the template file is used.

If Workgroup is not input, the
same value as the parameter on
the 3rd line of the template file is
used.
If Workgroup, Domain, and
Domain Account Name are not
input, the same value as the
parameter on the 3rd line of the
template file is used.
If Workgroup, Domain, Domain
Account Name, and Domain
Account Password are not input,
the same value as the parameter
on the 3rd line of the template file is
used.
Set as AutoDetect1, and the IP
address for NIC1 is Automatically
Acquire IP Address. The values
of IP address1 (NIC1)-Metric4
(NIC1) are not reflected.

Items in 2nd line

Explanation of input items in the
4th line and later

IP Address 1
(NIC1)

Input the first IP address in LAN board
1.
DHCP is entered if automatically
acquired.

SubnetMask1
(NIC1)

Input the first subnet mask in LAN
board 1.

IP Address 2 (NIC1)

Input the second IP address in LAN
board 1.
Input the second subnet mask in LAN
board 1.

SubnetMask2 (NIC1)

IP Address 3 (NIC1)
SubnetMask3 (NIC1)

IP Address 4 (NIC1)
SubnetMask4 (NIC1)

Input the third IP address in LAN
board 1.
Input the third subnet mask in LAN
board 1.

Input the fourth IP address in LAN
board 1.
Input the fourth subnet mask in LAN
board 1.

Gateway1 (NIC1)
Metric1 (NIC1)

Input the first gateway in LAN board 1.
Input the first metric in LAN board 1.

Gateway2 (NIC1)

Input the second gateway in LAN
board 1.
Input the second metric in LAN board
1.
Input the third gateway in LAN board
1.
Input the third metric in LAN board 1.

Metric2 (NIC1)
Gateway3 (NIC1)
Metric3 (NIC1)
Gateway4 (NIC1)

Input the fourth gateway in LAN board
1.
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When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
Set to Acquire the address of
DNS server automatically. The
values of SubnetMask1
(NIC1)-SubnetMask4 (NIC1) are
not reflected.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
1 (NIC1) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
2 (NIC1) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
3 (NIC1) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
4 (NIC1) has been input.
No setting in all other cases.
No setting.
Set to 1 only when Gateway1
(NIC1) has already been input.
No setting.
Set to 1 only when Gateway2
(NIC1) has already been input.
No setting.
Set to 1 only when Gateway3
(NIC1) has already been input.
No setting.

Items in 2nd line

Explanation of input items in the
4th line and later

Metric4(NIC1)

Input the fourth metric in LAN board 1.

NIC2

Input the MAC address of the second
LAN board or AutoDetect.

IP Address 1 (NIC2)

Input the first IP address of LAN board
2 if LAN board 2 has been set. DHCP
is entered if automatically acquired.

SubnetMask1(NIC2)

Input the first subnet mask in LAN
board 2.

IP Address 2 (NIC2)

Input the second IP address in LAN
board 2.
Input the second subnet mask in LAN
board 2.

SubnetMask2(NIC2)

IP Address 3 (NIC2)
SubnetMask3(NIC2)

IP Address 4 (NIC2)
SubnetMask4(NIC2)

Input the third IP address in LAN
board 2.
Input the third subnet mask in LAN
board 2.

Input the fourth IP address in LAN
board 2.
Input the fourth subnet mask in LAN
board 2.

Gateway1(NIC2)
Metric1(NIC2)

Input the first gateway in LAN board 2.
Input the first metric in LAN board 2.

Gateway2(NIC2)

Input the second gateway in LAN
board 2.
Input the second metric in LAN board
2.
Input the third gateway in LAN board
2.
Input the third metric in LAN board 2.

Metric2(NIC2)
Gateway3(NIC2)
Metric3(NIC2)
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When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
Set to 1 only when Gateway4
(NIC1) has already been input.
No setting.
The values of IP address 1
(NIC2)-Metric4 (NIC2) are not
reflected.
Set to Automatically Acquire IP
Address. The values of
SubnetMask1
(NIC2)-SubnetMask4 (NIC2) are
not reflected.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 1 (NIC2) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 2 (NIC2) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 3 (NIC2) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 4 (NIC2) has been input.
No setting in all other cases.
No setting.
Set to 1 only when Gateway1
(NIC2) has already been input.
No setting.
Set to 1 only when Gateway2
(NIC2) has already been input.
No setting.
Set to 1 only when Gateway3
(NIC2) has already been input.

Items in 2nd line

Explanation of input items in the
4th line and later

Gateway4(NIC2)

Input the fourth gateway in LAN board
2.
Input the fourth metric in LAN board 2.

Metric4(NIC2)

NIC3

Input the MAC address of the third
LAN board or AutoDetect.

IP address 1(NIC3)

Input the first IP address of LAN board
3 if LAN board 3 has been set.
DHCP is entered if automatically
acquired.

SubnetMask1
(NIC3)

Input the first subnet mask in LAN
board 3.

IP address 2(NIC3)

Input the second IP address in LAN
board 3.
Input the second subnet mask in LAN
board 3.

SubnetMask2(NIC3)

IP address 3(NIC3)
SubnetMask3(NIC3)

IP address 4(NIC3)
SubnetMask4(NIC3)

Gateway1(NIC3)
Metric1(NIC3)

Input the third IP address in LAN
board 3.
Input the third subnet mask in LAN
board 3.

Input the fourth IP address in LAN
board 3.
Input the fourth subnet mask in LAN
board 3.

Input the first gateway in LAN board 3.
Input the first metric in LAN board 3.
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When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
No setting.
Set to 1 only when Gateway4
(NIC2) has already been input.
No setting. The values of IP
address 1 (NIC3)-Metric4 (NIC3)
are not reflected.
Set to Automatically Acquire IP
Address. The values of
SubnetMask1
(NIC3)-SubnetMask4 (NIC3) are
not reflected.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
1 (NIC3) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
2 (NIC3) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
3 (NIC3) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP address
4 (NIC3) has been input.
No setting in all other cases.
No setting.
Set to 1 only when Gateway1
(NIC3) has already been input.

Items in 2nd line

Explanation of input items in the
4th line and later

Gateway2(NIC3)

Input the second gateway in LAN
board 3.
Input the second metric in LAN board
3.
Input the third gateway in LAN board
3.
Input the third metric in LAN board 3.

Metric2(NIC3)
Gateway3(NIC3)
Metric3(NIC3)
Gateway4(NIC3)
Metric4(NIC3)

Input the fourth gateway in LAN board
3.
Input the fourth metric in LAN board 3.

NIC4

Input the MAC address of the fourth
LAN board or AutoDetect.

IP address1(NIC4)

Input the first IP address of LAN board
4 if LAN board 4 has been set. DHCP
is entered if automatically acquired.

SubnetMask1(NIC4)

Input the first subnet mask in LAN
board 4.

IP address 2(NIC4)

Input the second IP address in LAN
board 4.
Input the second subnet mask in LAN
board 4.

SubnetMask2(NIC4)

IP address 3(NIC4)
SubnetMask3(NIC4)

IP address 4(NIC4)
SubnetMask4(NIC4)

Input the third IP address in LAN
board 4.
Input the third subnet mask in LAN
board 4.

Input the fourth IP address in LAN
board 4.
Input the fourth subnet mask in LAN
board 4.
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When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
No setting.
Set to 1 only when Gateway2
(NIC3) has already been input.
No setting.
Set to 1 only when Gateway3
(NIC3) has already been input.
No setting.
Set to 1 only when Gateway4
(NIC3) has already been input.
No setting.
The values of IP address 1
(NIC4)-Metric4 (NIC4) are not
reflected.
Set to Automatically Acquire IP
Address. The values of
SubnetMask1
(NIC4)-SubnetMask4 (NIC4) are
not reflected.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 1 (NIC4) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 2 (NIC4) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 3 (NIC4) has been input.
No setting in all other cases.
No setting.
Set to same value as the data in
the file which is the basis of the
template file only when IP
address 4 (NIC4) has been input.
No setting in all other cases.

Items in 2nd line

Explanation of input items in the
4th line and later

Gateway1(NIC4)
Metric1(NIC4)

Input the first gateway in LAN board 4.
Input the first metric in LAN board 4.

Gateway2(NIC4)

Input the second gateway in LAN
board 4.
Input the second metric in LAN board
4.
Input the third gateway in LAN board
4.
Input the third metric in LAN board 4.

Metric2(NIC4)
Gateway3(NIC4)
Metric3(NIC4)
Gateway4(NIC4)
Metric4(NIC4)

Input the fourth gateway in LAN board
4.
Input the fourth metric in LAN board 4.

When items in the 4th line and
later is blank spaces, how to
handle in the batch creation in
step (9).
No setting.
Set to 1 only when Gateway1
(NIC4) has already been input.
No setting.
Set to 1 only when Gateway2
(NIC4) has already been input.
No setting.
Set to 1 only when Gateway3
(NIC4) has already been input.
No setting.
Set to 1 only when Gateway4
(NIC4) has already been input.

(9) Save the CSV file after editing it.
(10) Select Creation of multiple disk copy information files assistant -> Create multiple disk duplication
data files in Option menu of the Create Setup Parameter File screen.
(11) When the Open File screen appears, select the CSV file saved in (9) above. The Result of creating
multiple information files screen appears, showing the results of the creation. One disk duplication data
file is created for each computer registered in the CSV file.
If "Data file creation failed" is displayed in the Batch Data File Creation Results screen,
click Error Information. Detailed information about errors is displayed. Correct the CSV
file accordingly and perform the operation again.
(12) Click OK. Batch creation of the data files is completed.
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5.4.3.

Creating a Disk Duplication Parameter File (Linux)

This section describes how to create a disk duplication data file for configuring individual machines when
performing an OS installation by disk duplication in Linux.
 When creating a disk duplication data file, there are two working modes: Online Mode
and Offline Mode.
Online mode: mode for normal use.
Offline mode: creates files on a local computer without sending files to the
Management Server.
This section mainly explains the Online Mode that is used normally.
 For a LAN board having a MAC address that is registered to the DPM, configure the
settings so that network communication can be done regardless of whether the
address is a static IP address or is acquired from the DHCP server. If network
communication cannot be done, an executed scenario may not be completed.
 For OS installation by disk duplication, use the disk duplication data file that has the
same name as MAC address of the managed machine registered on the Web Console.
 The disk duplication data file becomes a template used for batch creation of disk
duplication data files.
 The disk duplication data file is created using Image Builder installed on the
Management Server or Image Builder (Remote Console).
 Online Mode
The disk duplication data file (Linux duplication parameter file) is created and managed in the Folder for
Images on the Management Server over the network.
Management Server
Managed folder: <Folder for Image>\AnsFile\machineinf

Saved Linux duplication parameter file

Send a file

Read and save a file

Receive a file

Working Linux duplication parameter file
Temporary folder: <Installation folder>\linux\online
(Default:C:\Program Files\NEC\DeploymentManager\linux\online)

Image Builder
(Remote Console) Machine
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 Offline Mode
The disk duplication data file (Linux parameter file) is created and managed on the machine on which Image
Builder is launched, using any folder as the working folder.

Read and save a file
Saved Linux duplication parameter file
Managed folder: Arbitrary working folder
Image Builder
(Remote Console) Machine

The default working folder is <Installation directory>\linux\offline.
The working mode and working folder can be changed at any time.
The disk duplication data file is created in the text file format for Linux. Note when you
edit the file using a text editor or other application on a Windows machine.
Create a new disk duplication data file. If you use an existing file, see "2. Other Operations and Displays"
below.
The keyboard operations effective with buttons for creating a disk duplication data file are
the Enter key and space key only.
1. Creating a Disk Duplication Data File (New File)
This section describes how to create a new disk duplication data file for configuring individual machines when
performing an OS installation by disk duplication in Linux.
(1) From the Start menu of the Management Server or the computer where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(2) Select Setting Setup Parameter File.
The Select parameter screen appears. Select Linux disk copy parameter file and click OK.
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(3) When this screen is launched for the first time, or the environment configuration data file "LinuxSysRep.cfg"
is not in the install directory, the LinuxOS Replicate Environment Set appears. Configure the settings to
match your environment.

LinuxOS Replicate Environment Set
Install Directory
Displays the folder where Image Builder has been installed.
This cannot be edited.
Work Directory
Displays the working folder in offline mode. This can be entered only
when "Offline Mode" is selected in Select Working Mode.
The number of characters allowed is 1-254 single-byte characters.
Only single-byte alphanumeric characters can be used.
The following symbols cannot be used.
,;*?"'<>|[]@
The default is [Install Directory\linux\offline].
Select Working Mode
Select one of the following working modes.
- Online mode
- Offline mode
The default is Online Mode.
Management Server
The IP address of the Management Server that was set during
installation of Image Builder is acquired from the registry data and
displayed here.
Management Server
Displays the folder name on the Management Server where the disk
Directory
duplication data file is to be saved when in online mode. (Fixed data)
CANCLE
Discards changes and closes the environment settings screen.
SAVE
Saves the settings to the environment settings file [LinuxSysRep.cfg]
and closes the environment settings screen.
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A confirmation message appears when the environment data for installation directory and the IP address of
the Management Server cannot be acquired from the registry or the .ini file.
Click OK to close without launching the creation tool of the disk duplication data file.

(4) When the configuration is completed, click SAVE.
(5) The confirmation screen appears. Click Yes.

If there is an error in the settings, an error message is displayed in red font and saving
cannot be performed. Correct the settings and re-save.

If you select CANCEL, the confirmation screen below is displayed. Clicking on Yes
discards the settings and closes the screen.

262

(6) The LinuxOS Replicate Parameter Making screen appears. Configure settings to match your
environment.

LinuxOS Replicate Parameter Making
MAC Address
Enter the MAC address of the Ethernet device of the managed
(Required)
machine which is registered in DPM in 12 hexadecimal number.
Example) "1A-2B-3C-4D-5E-6F", "1a-2b-3c-4d-5e-6f", and so on.
When saving the file, the entered MAC address is used to create
and save the disk duplication data file. The extension is .rep.
Example) "1A2B3C4D5E6F.rep", "1a2b3c4d5e6f.rep", and so
on.
Primary DNS
This is for entering the IP address of the primary DNS server as
set in the managed machine. This entry is optional.
Secondary DNS
This is for entering the IP address of the secondary DNS server
as set in the managed machine. This entry is optional.
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 Network Information Settings
 When a computer with multiple LAN boards (Ethernet devices) is used and IP addresses
in the same segment are assigned to the LAN boards, communication may fail if there
are any LAN boards which are not connected to LAN cables.
It is recommended that the LAN boards that are not connected with a LAN
cable should not have a static IP assigned, but be set with DHCP, or not set.
 In an environment where the Network Manager daemon is enabled, the DNS settings
set by the disk duplication data file will not be applied.
If you perform DNS setting, please disable the NetworkManager daemon using th
e following method at the time of the master image creation.
1) Confirm the start level of the NetworkManager
#chkconfig --list NetworkManager
(Execution results Example)
NetworkManager 0:off 1:off

2:on

3:on

4:on

Run the following command if at least one is "on".
All will be changed to "off".
2) To disable the NetworkManager (run with root authority)
#chkconfig NetworkManager off
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5:on

6:off

Configure a TCP/IP network for Ethernet devices eth0 through eth6 in the Linux OS duplication target machine.
1)

Select the Ethernet device to be configured, and click EDIT.
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2)

The Network Data Set screen appears. Configure settings to match your environment.

Network Data Set
Device Name
Host Name

Displays the name of the Ethernet device being edited.
Displays the host name. Up to 255 single-byte characters can be
entered.
Only single-byte alphanumeric characters can be used.
The following symbols cannot be used.
\ / : , ; * ? " < > ' | [ ] @ as well as spaces.
This must be entered for eth0.
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IPv4

Network Type

IP Address

Network Mask

Gateway

IPv6

Network Type

IPv6 Address

Prefix

Gateway

DNS Address

CANCLE
SAVE

If you select IPv4 checkbox, you can configure for IP address.
You need to configure for eth0 necessarily.
This is selected by default.
Select and set the type of TCP/IP network from below.
- DHCP: IP addresses are set dynamically by a DHCP server.
- Static IP: IP addresses are set manually.
The default value is DHCP.
Set the IP address.
This must be entered only if Static IP has been selected as the
network type.
Example) "192.168.0.1" "192.168.100.150" and so on.
Set the network mask.
This must be entered only if Static IP has been selected as the
network type.
Example) "255.255.0.0", "255.255.255.0" and so on.
Enter the IP address of the gateway machine that corresponds to
the IP address of the Ethernet device being configured.
This does not need to be entered even if either DHCP or Static
IP has been selected as the network type.
Example) "192.168.0.250" "192.168.100.200" and so on.
If you select IPv6 checkbox, you can configure for IPv6 address.
This is supported only for Red Hat Enterprise Linux 5/5AP/6.
This is not selected by default.
Select the TCP/IP network type from the followings.
・ RA: Configures IPv6 address by the Router Advertisement.
・ DHCP: Configures IPv6 address dynamically by DHCP
server.
・ Fixed IPv6: Configures IPv6 address manually.
The default is "RA".
Set IPv6 address.
This is required only when "Fixed IPv6" is selected in Network
Type.
Example)
fe80::1895:3454:53e3:40cc
Set the prefix.
This is required only when "Fixed IPv6" is selected in Network
Type.
Example)
64
Set IPv6 address of the gateway machine for IPv6 address of the
target ethernet device.
You can enter only when "DHCP" or "Fixed IPv6" is selected in
Network Type. This is optional.
Example)
fe80::1895:3454:53e3:40cc
Set IPv6 address of DNS server.
This is optional.
Example)
fe80::1895:3454:53e3:40cc
Closes the Network Data Set without saving the Ethernet device
settings.
Saves the Ethernet device settings and closes the Network Data
Set.
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 For a LAN board having a MAC address that is registered to the DPM, configure the
settings so that network communication can be done, regardless of whether the address
is a static IP address or is acquired from the DHCP server.
If network communication cannot be done, an executed scenario may not be
completed.
 In the case of SUSE Linux Enterprise, the only setting of the gateway for the Ethernet
device which is "eth0" is valid.
 For managed machines registered in DPM, assign a connectable IP address in the
same segment. If an address which is not connectable is assigned, scenario execution
may not be completed.
If a setting is not correct, an error message is displayed in red at the bottom of the Network
Data Set and saving cannot be performed.
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 Time Zone
Select the time zone to set for the Linux duplication target machine from the time zone list in the red box.
The item in the red box must be set. The default is America/New_York.
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 Script Data
Set the Linux shell script to be executed after duplication is completed in the Linux OS duplication target
machine.

Script Data

Enter the script data. Up to 100 lines of numeric characters (up to
256 Byte per line) can be entered.
Only single-byte alphanumeric characters and symbols can be used.
The file cannot be read if the total of the previously entered data and
the file that is read exceeds the character limit.

Read

Displays the file selection dialogue screen, with the current work
folder as the default folder.
Select a file from among the file names to read the script data.

Clear

Deletes all currently entered script data.
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(7) Save the disk duplication data file as the MAC address name.
 Working Mode: Online
Save the currently setting of Linux duplication parameters.
1)

File menu -> click Save As MacAddress.

2)

When the file save confirmation message is displayed for the disk duplication data file, confirm the
name of the file to be saved and click Yes.
The file is saved with the entered MAC address name under
<Folder for Image>\AnsFile\machineinf> on the Management Server. The file name is
"MACaddress.rep".
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If the following message is displayed, save the file again after checking the setting of the
Management Server and network and resolving the problem.

 Working Mode: Offline
The file is saved as the entered MAC address name under the specified folder.
The file name is MACaddress.rep.
1) When the Select Directory screen appears, select the folder to save the disk duplication data file.

2) When the file save confirmation message is displayed for the disk duplication data file, confirm the
name of the file to be saved and click Yes.
If a file with the same file name already exists in the folder to be saved, the overwrite
confirmation message is displayed. To overwrite, click Yes. If not, click No.
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The following message is displayed when the file has successfully been saved to the selected folder.

If the following message is displayed, check whether there is a problem in the
folder to be saved, and save it again.

2. Other Operations and Displays
 Opening the Disk Duplication Data File (Existing File)
This section describes how to create the disk duplication data file using an existing file.
(1) In Select parameter screen, select Linux disk copy parameter file and click OK.

(2) When the LinuxOS Replicate Parameter Making screen appears, open the File menu, click Open, and
select MACaddress.rep to open the file.
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(3) The existing disk duplication data file is displayed.

 Working Mode: Online
The Select Host Name screen appears to select the disk duplication data file in
<Folder for Image>\AnsFile\machineinf on the Management Server. Select the host file (the template file)
and click Select.
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 Working Mode: Offline
A list of disk duplication data files in the current working folder is displayed in the Select File screen. Select
the disk duplication data file and click Open.

If there is an error during reading of the disk duplication data file, the following
message is displayed. Check the disk duplication data file.

 Changing the working mode
The working mode can be changed by the following procedure.
(1) In Select parameter screen, select Linux disk copy parameter file and click OK.
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(2) When the LinuxOS Replicate Parameter Making screen appears, open the Working Mode menu and
select the Set Online or Set Offline option button to change the working mode.



Displaying Replicate Parameter
The parameters set during OS installation by disk duplication can be displayed as a list or printed in the output
format of the disk duplication data file.
1)

Open the File menu in the LinuxOS Replicate Parameter Making screen and click Display Replicate
Parameter.

2)

When the LinuxOS Replicate Parameter List screen appears, click Print to print out the checklist.
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If there are any problems or errors in the current setting, the Duplication Parameter
Error List screen is displayed instead of the LinuxOS Replicate Parameter List
screen.
Check the content displayed in the error list and correct any errors in the LinuxOS
Replicate Parameter Making screen.

 Error Message Display Area
If any problems or errors are discovered during an operation, an error message is displayed in red.
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5.4.4.

Batch Creation of Disk Duplication Parameter File (Linux)

When executing OS installation by disk duplication on multiple Linux managed machines, a disk duplication data
file must be created for each machine.
This section describes batch creation of Linux disk duplication data files.
(1) Prepare the disk duplication data file that will act as the basis for batch creation of data files. See "5.4.3
Creating a Disk Duplication Parameter File (Linux)" for how to create the disk duplication data file.
(2) From the Start menu of the Management Server or the computer where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(3) When you click Setting Setup Parameter File, the Select parameter screen appears. Select Linux disk
copy parameter file and click OK.
(4) Open the file created in Section 5.4.3, "Creating a Disk Duplication Parameter File (Linux)." See "2. Other
Operations and Displays" in Section 5.4.3, "Creating a Disk Duplication Parameter File (Linux)" for how to
open an existing file.
(5) When the Creating Linux OS Duplication Parameters screen appears, open the Replicate Parameter
menu and select Make Replicate Parameter.
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(6) When the Replicate Parameter Extensive creation screen appears, configure the settings in the red box.
The disk duplication parameter data can be set for up to 100 Linux duplication machines. Enter the network
data for Ethernet device eth0 of the target machine for duplication.

Replicate Parameter Extensive creation
Model Host
The disk duplication data file name used in the currently read template is
displayed.
Host Name
Set the host name for Ethernet device eth0. Up to 255 single-byte characters can
(Required)
be entered.
MAC Address Set the MAC address of the Ethernet device. The address must be entered in 12
(Required)
hexadecimal number format.
Example) 1A-2B-3C-4D-5E-6F, 1a-2b-3c-4d-5e-6f

When a file is saved, the Linux duplicate parameter file is created and saved by
using the entered
MAC address. The extension is ".rep."
DHCP(0:ON)

IP Address

Network
mask
Gateway

Example) 1A2B3C4D5E6F.rep or, 1a2b3c4d5e6f.rep
Select and set the type of TCP/IP network for Ethernet device eth0 from below.
・ D H C P: Enter 0 to have the DHCP server set the IP address
dynamically. (Required)
・ Static IP: Do not enter anything to have the IP address set manually.
Set the IP address for Ethernet device eth0.
Example) 192.168.0.11, or 192.168.100.150, and so on.
This must be set if the network type is Static IP.
Set the network mask for the IP address of Ethernet device eth0.
Example) 255.255.0.0, 255.255.255.0, and so on.
This must be set if the network type is Static IP.
Enter the IP address of the gateway machine that corresponds to the IP address of
Ethernet device eth0.
Example) 192.168.0.250, 192.168.100.200, and so on.
This does not need to be set, whether the network type is DHCP or Static IP, it is

an optional input item.
DNS Address

Enter the IP address of the primary DNS that corresponds to the IP address of the
Ethernet device.
Example) 192.168.0.250, 192.168.100.200, and so on.
This does not need to be set, whether the network type is DHCP or Static IP.
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(7) Click Save and save the settings. See the following table for operations of the various buttons outlined in
red.
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Replicate Parameter Extensive creation
Clear
Clears all the content entered in the current screen.
Read
Reads duplication parameter data saved in CSV file format and places it in the
entry fields for Replicate Parameter Extensive creation. The file selection
dialogue screen appears, with the CSV folder in the currently set working folder
as the default folder.
Select the file name and click Open.
Check
Checks consistency by the content which is currently input.
If there are no problems or errors, the following message dialogue screen
appears.

Save

Extensive Creation

Exit

Saves the input content in CSV file format.
It is saved to the CSV folder in the currently set working folder.
The default is <Installation folder>\linux\offline\CSV.
Clicking Save brings up the Save as..." dialogue box. Enter the file name and
save the file.
Performs an extensive creation of disk duplication data files by the currently input
content.
If extensive creation is completed successfully, the Replicate Parameter
Creation result list screen appears. (*1)

Closes the Replicate Parameter Extensive creation screen and terminates
batch creation of duplication parameters.
To end, click Yes. Otherwise, click No.
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*1
 Working Mode: Online
The file is saved with the entered MAC address name under <Folder for Image>\AnsFile\machineinf>
on the Management Server.
 Working Mode: Offline
The file is saved with the entered MAC address in the current working folder.
The file name is MACaddress.rep.
 If there are problems with the settings, the Replicate Parameter Error list is displayed
instead of the Replicate Parameter Extensive creation screen. Check the content that
is displayed in the error list, and correct any errors in the Replicate Parameter Extensive
creation screen.
 If there is a problem in any of the duplication parameters, the Replicate Parameter Error
list screen is displayed, and no files are created. Check the parameters, resolve any
problems, and reattempt creation.
Other Operations and Displays
 Linux OS Duplication Parameter Settings Data
The data for the Linux OS duplication parameter settings is confirmed as follows.
(1) From the Help menu in the LinuxOS Replicate Parameter Making screen, select Version. This displays
the LinuxOS Replicate Parameter Making Info screen.
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5.4.5. Creating a Parameter File for OS Clear Installation (Linux)
A Linux installation parameter file is a file that stores all of the items required during Linux installation setup in
advance, enabling unattended OS installation. This section describes how to create a Linux installation
parameter file.
 This file must be configured when you install Linux.
 For a Linux installation parameter file that was created with a version earlier than DPM
Ver4.21, be sure to read the Linux installation parameter file using this version and
overwrite it.
• See "Other Operations and Displays" in this Section regarding reading a saved file.
• See " Overwrite of the Linux installation parameter file" in this Section regarding
overwrite saving.
 The root password is "deploymgr" that is set with the Linux install parameter setting tool.
Use the following method if you want to change the password.
(1) If the password is not encrypted:
Change the "rootpw" line of the Linux installation parameter file (cfg file) saved below.
<Folder for Image>:\exports\ks
Example) rootpw –iscrypted **********.. (encrypted password)
rootpw deploy
(2) If the password is encrypted:
Set the password with the Linux standard kickstart file creation tool and create a
kickstart parameter file.
Copy the "rootpw" line in the created file to the "rootpw" line in Linux installation
parameter file (cfg file), which was created using the Linux installation parameter
setting tool, in the following folder.
<Folder for Image>:\exports\ks
Example) rootpw –iscrypted **********... (encrypted password)
rootpw --iscrypted

XXXXXXXXXX... (encrypted password)

 The Linux installation parameter file creation has two operating modes: online mode and
offline mode.
• Online mode: typically used mode.
• Offline mode: Used for setting up the NFS shared folder (exports) in locations except
<Folder for Image>\exports.
This section mainly describes online mode which is usually used.
 For notes when installing the NFS server on the machine except the Management Server,
see Section 3.5.6, "Precautions/Other" in Operation Guide.
 To create multiple Linux installation parameter files, see Section 5.4.6, "Batch Creation of
Parameter File for OS Clear Installation (Linux)"
 You can change the working mode and the working folder at any timing.
 The keyboard operations which are effective with buttons of Linux installation parameter file
creation tool are the Enter key and the Space bar only.
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 Online Mode
The Linux installation parameter file is created and managed over the network in the Folder for Images on
the Management Server.
The Linux installation parameter file is comprised of and managed by two files.
• The Linux boot parameter file (no file extension)
Example) nec_host
• The Linux setup parameter file (extension ".cfg")
Example) nec_host.cfg
The root password is output to the file as "deploymgr".
Managed directory
:<Folder for Image>\AnsFile\ linux(Linux boot parameter file)
:<Folder for Image>\exports\ks(Linux setup parameter file)
Saved Linux install parameter file

Send a file

Receive a file

Read and save a file
Working Linux installation parameter file
Temporary folder:<Installation folder>\linux\online
(Default:C:\Program Files\NEC\DeploymentManager\linux\online)
Image Builder
(Remote Console) Machine
 Offline Mode
The Linux parameter file is created and managed on the machine on which Image Builder is launched, using any
working folders.
Read and save a file
Saved Linux installation parameter
file

Image Builder
(Remote Console) Machine

Managed folder: Arbitrary working folder
(Default:C:\Program Files\NEC\DeploymentManager\linux\online)
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 Initial settings for the creation of a Linux installation parameter file
(1) From the Start menu of the Management Server or the computer where Image Builder (Remote Console) is
installed, select All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(2) Select Setting setup parameter file.
The Select parameter screen appears. Select Linux parameter file and click OK.

(3) When this function is launched for the first time, or the environment configuration data file "LinuxIParm.cfg"
is not in the install directory, the LinuxOS Install Environment Set Screen appears. Please set it to match
your environment.
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LinuxOS Install Environment Set
Install Directory
Displays the folder where Image Builder has been installed.
This cannot be edited.
Work Directory
Displays the working folder for offline mode. This can be entered only
when "Offline mode" is selected in Select Working Mode.
The number of characters allowed is 1-254 single-byte characters. Only
single-byte alphanumeric characters can be used.
The following symbols cannot be used.
,;*?"'<>|[]@
Default is
"C:\Program Files\NEC\DeploymentManager\linux\offline"
Select Working Mode Select one of the following working mode.
- Online mode
- Offline mode
The default is Online Mode.
Management Server
The IP address of the Management Server that was set during
installation of Image Builder is acquired from the registry data and
displayed here.
"ks" Server Directory Displays the folder name on the Management Server where the Linux
setup parameter file is to be saved when in online mode.
This cannot be edited.
"syslinux" Server
Displays the folder name on the Management Server where the Linux
Directory
boot parameter file is to be saved when in online mode.
This cannot be edited.
CANCEL
This discards changes and closes the environment settings screen.
SAVE

Saves the settings to the environment settings file LinuxSysRep.cfg and
closes the environment settings screen.

When the environment information of the install directory and IP address of the Management Server cannot
be obtained properly, the configuration tool for Linux install parameter does not start.
(4) Once the setting is completed, click Save.
(5) The confirmation screen appears. Click Yes.
If there is an error in the settings, an error message is displayed in red font and saving
cannot be performed. Correct the settings and re-save.
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 Linux installation parameter file creation
(1) The LinuxOS Install Parameter Making is started and the following main initial screen appears.
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(2) The Linux install parameter is set.
The Linux install parameters are configured from the following nine types of information panels.
Click each button, then the information panel will change and each item can be set.
If there are any problems or errors with the information entered into each of the information
panels, a red error message will be displayed at the bottom of each information panel.
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 Basic Configuration setting panel
Set the basic information for the Linux boot parameters and Linux setup parameters.
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LinuxOS Install Parameter Making
Basic Configuration
(Required)
Install Linux
(Required)

Boot Directory
(Required)

NFS Server
(Required)
Install Device
(Required)

Installation Number

Install Language
(Required)

Select Linux OS as the type to install from the list box.
The default is "Red Hat Enterprise Linux ES 3."
If the boot directory is not entered at the time the install OS is
selected, the default value of the boot directory appropriate for
the selected OS will be set as the boot directory. (*1)
Select the boot directory or enter the boot directory for the Linux
OS to install. The number of characters allowed is 1 - 255
single-byte characters.
Only single-byte alphanumeric characters can be used.
The following symbols or blank spaces cannot be used.
,;*?"'<>|[]@
When you click "...", the Select Boot Directory screen will be
displayed. Then select it from boot directory list on the
Management Server

In the case of offline, you cannot use the Select Boot Directory
Selection screen, so you must enter and set the boot directory
name.
The NFS server IP address is set. Normally this is set as the
same IP address as DPM Server.
The default value is the IP address of the Management Server.
Set the Ethernet device (the installation device which is used for
the communication).
The default value is eth0.
If you set a LAN board with a MAC address not registered with
the Management Server, the scenario may not complete.
Displays when "Red Hat Enterprise Linux 5.1/5.1 AP" is
selected as the install OS.
Enter the install number of the Red Hat Enterprise Linux at the
time of the product purchase.
This entry is not required.
Select the type of language used at the time of installation from
the list.
The default value is English.
In the case of Red Hat Enterprise Linux 6, English is set
regardless of the selected content.
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Keyboard
(Required)

Mouse
(Required)

3 Button Emulation

Time Zone
Support Language
(Required)

Select the type of keyboard used by the managed machine from
the list.
The default value is U.S.English.
In the case of Red Hat Enterprise Linux 6, U.S.English is set
regardless of the selected content.
Select the type of mouse used by the managed machine for the
install from the list.
The default value is Generic Mouse (PS/2).
If the mouse is not set correctly after an OS clean installation,
assign "Probe For Mouse" to the mouse and automatically
search for the mouse.
This item will not be displayed for Red Hat Enterprise Linux 6.
If the mouse device uses a 3 button emulation function, select
this checkbox.
By default, the checkbox is not selected.
This is optional.
This item will not be displayed for Red Hat Enterprise Linux 6.
Select the time zone from the list box. The default value is
America/New_York. This entry is not required.
Set the language environment from the list.
To select multiple items, press the Ctrl key while selecting.
The default value is English. You cannot deselect English.
In the case of Red Hat Enterprise Linux 5/5AP, all languages
are set regardless of the selected content.
In the case of Red Hat Enterprise Linux 6, English is set
regardless of the selected content.

*1
You can select the install OS from the Linux OSs below from the list.
Install OS
Red Hat Enterprise Linux AS 3
Red Hat Enterprise Linux ES 3
Red Hat Enterprise Linux AS 4
Red Hat Enterprise Linux ES 4
Red Hat Enterprise Linux 5.1/5.1 AP
Red Hat Enterprise Linux 6

Boot Directory Default Value
RedHatAS3
RedHatES3
RedHatAS4
RedHatES4
RedHatServer5.1
RedHatServer6

Supported Architecture
x86
x86
x86/x64
x86/x64
x86/x64
x86/x64

Select Red Hat Enterprise Linux 5.1/5.1 AP in the case of Red Hat Enterprise Linux
5.2~5.6/5.2 AP~5.6 AP.
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 Boot Configuration
You can do settings related to the boot loader for the managed machine to install.
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Boot Configuration(required)
A new boot loader is
installed

A boot loader is not installed

Boot Loader Options
GRUB is used as a boot
loader

GRUB Option
GRUB Password
LILO is used as a boot
loader
LILO Option

A boot loader is installed
in a master boot record
(MBR) / A boot loader is
Installed on the head
Sector of a boot partition
(You must select one)

Kernel Parameter

Select this to install a new boot loader.
If you select A new boot is installed, the Boot Loader Options will
be enabled.
The default value is A new boot is installed.
Select this not to install a boot loader.
If installing Linux and A boot loader is not installed is selected, the
scenario will complete successfully, but you cannot run Linux from the
partition where Linux was installed.
Select boot loader option and a new boot loader will be installed.
Set this to install the GRUB boot loader.
The LILO package will be cancelled for Red Hat Enterprise Linux
AS4, ES4, and 5/5AP. Select Use GRUB as a Boot Loader when
installing Red Hat Enterprise Linux AS4, ES4, 5/5AP.
This is optional.
This can be set when selecting GRUB is used as a boot loader.
This is optional.
Set this to install the LILO boot loader.
The default value is set as LILO is used as a boot loader.
This item cannot be set for Red Hat Enterprise Linux 6.
Set the working mode for LILO boot loader.
Select one of the checkboxes below.
• Use linear mode
• Force use LBA32 mode
This is optional.
Set the install destination for the boot loader.
Select one of the following option buttons.
• A boot loader is installed in a master boot record (MBR)
• A Boot loader is installed on the head sector of a boot partition
Select A boot loader is installed in a master boot record (MBR)
when performing backup/restore on the disk with boot loader
installed.
This item cannot be set for Red Hat Enterprise Linux 6.
Set the kernel parameters.
The number of characters allowed is 1 - 255 single-byte characters.
The allowed characters are single-byte alphabet and numeric
characters. This is optional.
This item cannot be set for Red Hat Enterprise Linux 6.
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 Partition Configuration
Set the environment used for the disk drive of the managed machine for install.

You cannot set software RAID with this tool.

294

Partition Configuration
(Required)
Master Boot Record
(Required)

Partitions
(Required)

Disk Label Set
(Required)

Add

Mount Point

File System Type
(Required)
File System Size (MB)

Additional Size
Options
(Required if
selectable)

Set the master boot record handling.
Select one of the following option buttons.
• Clear the current master boot record
• Do not delete the current master boot record
Set the partition handling.
Select one of the following option buttons.
• Remove all of the current existing partitions
• Remove only the existing Linux partitions
• Keep the existing partitions
Set the disk level handling.
Select one of the following option buttons.
• Initialize the disk label
• Do not initialize the disk label
Set the new disk partition information at the time of install.
Click Add when adding a disk partition. The Partition Information
screen appears when you click the Add button.

Select the partition mount directory from the list box or enter it. Only
single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
,;*?"'<>|[]@
You cannot select this if the file system type is swap.
It must be selected if the file system type is other than swap.
Select the file system type from the list box.
The default value is ext3 type.
Set the volume of the partition to create. Enter the units in MByte(MB).
The default value is 1MByte.
Setting is required when Fixed size is selected in Additional Size
Options.
Set the volume of the partition.
Select one of the following option buttons.
• Fixed size
• Fill all space up to (MB)
• Fill to maximum allowable size
If you select Fill all space up to (MB), enter the increased volume in
MByte.
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The swapfile size of
recommendation is
used

If you select "swap" in the file system type, you can select the
checkbox.
If you select this, the volume of the swap files system will be
automatically set at the time of install.

Force to be a primary
partition

The partition is forcibly allocated as the primary partition. It will end
abnormally when this cannot be executed.
This is optional.

Make partition
on specific drive
(Required)

Create a new partition.
Enter the disk drive name to add a partition. The allowed characters
are single-byte alphanumeric characters.
For an IDE disk, set the first as hda and the second as hdb. For a
SCSI disk, set the first one as sda.

Use existing partition

Set the existing partition name.
Following the partition setting, the partition is set up on the existing
partition.
The allowed characters are single-byte alphanumeric characters.
For the first partition of the primary IDE disk, hda1 should be
specified, and for the second partition of the secondary IDE disk,
hdb2 should be specified. Also, for the first partition of the first SCSI
disk, sda1 should be specified.
Format a partition.
The default value is Format partition.
Closes the screen without saving the specified partition information.
Saves the specified partition information and closes the screen.
If there is a problem or error with the specified partition's information,
the error list is displayed and it cannot be saved.

Format partition
CANCEL
SAVE
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Edit

Edit the disk partition.
Select the partition to be edited from the list and click Edit.

Partition Information screen appears when you click Edit.

Delete

Deletes the currently specified disk partition.
Select the partition to be deleted from the partition list and click
Delete.
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If installing on a machine with multiple disks and you do not specify the drive for install,
the installer will automatically assign which disk is installed on. Please set the
installation drive with Create Partition on Specified Drive specifying the install disk.
 Network Configuration
Set the network information. Set the LAN board specified for the install device in the Basic Configuration
panel.
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Network Configuration
Host Name

Network Type

IP Address

Network Mask

Gateway

Name Server

Enter the managed machine host name. Up to 255 single-byte
characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank spaces cannot be used.
\/:,;*?"<>'|[]@
Select and set the type of TCP/IP network from below.
- DHCP: IP addresses are set dynamically by a DHCP server.
- Static IP: IP addresses are set manually.
The default value is DHCP.
Enter the IP address.
This must be entered only if Static IP has been selected as the network
type.
Enter the netmask.
This must be entered only if Static IP has been selected as the network
type.
Enter the IP address of the gateway machine that corresponds to the IP
address of the Ethernet device being configured.
This does not need to be entered, even if either DHCP or Static IP has
been selected as the network type.
Enter the IP address for the DNS server.
This does not need to be entered, even if either DHCP or Static IP has
been selected as the network type.

For a LAN board having a MAC address that is registered to the DPM, configure the
settings so that network communication can be done regardless of whether the address is a
static IP address or is acquired from the DHCP server. If network communication cannot be
done, an executed scenario may not be completed.
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 Authentication Set
Set the information for each authentication function used on the managed machine for install.

300

Authentication Set
Authentication

NIS Configuration
NIS Domain
(Required)

Use broadcast to find NIS
Server
(Required)
NIS Server
(Required)

LDAP Configuration

LDAP Server
(Required)

LDAP Database
(Required)

Kerberos 5 Configuration
Realm (Required)

Domain Controller (KDC)
(Required)

Select the user authentication method.
• Use Shadow Password
Select this to Use Shadow Password for the user
password.
• Use MD5.
Select this to Use MD5 encryption for the user password.
In the case of Red Hat Enterprise Linux 5/5AP, select the
Use Shadow Password.
Select the Enable NIS checkbox in the case of NIS
(Network Information Service) authentication.
Set the NIS domain name.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Select the checkbox to use broadcast for NIS server search.

Enter the NIS server name.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
,;*?"'<>|[]@=
Select the Enable LDAP checkbox in the case of LDAP
(Lightweight Directory Access Protocol).
Set the LDAP server name.
Only 32 single-byte characters can be entered.
Only single-byte characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Set the LDAP database name.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Select the Enable Kerberos 5 Configuration checkbox in
the case of Kerberos 5 Configuration.
Set the realm name.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Set the domain controller(KDC) name.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
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Master Server
(Required)

HESIOD Configuration

HESIOD LHS
(Required)

HESIOD RHS
(Required)

SMB Configuration

SMB Server
(Required)

SMB Work Group
(Required)

NSCD Configuration

Set the master server name.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
You must specify the KDC name where kadmind is running
on the KDC belonging to the specified realm. This master
server will become the KDC server that handles the
changes in the user information and so on.
Select the Enable HESIOD checkbox in the case of
HESIOD authentication.
HESIOD authentication manages the user and group
information by using DNS.
In HESIOD LHS (Left-hand side), set to the LHS that is used
at the time of the search for the user information and so on.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space characters cannot be
used.
\/:,;*?"<>'|[]@=
In HESIOD RHS (Right-hand side), set to the RHS that is
used at the time of the search for the user information and
so on.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Select the Enable SMB checkbox in the case of SMB
authentication.
In case of Red Hat Enterprise Linux 6, this setting is invalid.
Set the SMB server name.
If there are multiple SMB servers, enter the server names,
separated by commas.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Set the SMB workgroup.
Only 32 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/:,;*?"<>'|[]@=
Select the checkbox for NSCD authentication.
You can cache the information of user and group and so on
if you select the Enable Name Switch Cash Domain
(nscd) checkbox.
In case of Red Hat Enterprise Linux 6, this setting is invalid.
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Firewall Configuration
This set the firewall environment information of the managed machine for install.
This information cannot be set for Red Hat Enterprise Linux 6.
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Firewall Configuration
Security Level
(Required)

Customize

Other Ports (1029:tcp)

Set the level of the firewall.
Select one of the following option buttons.
• High
• Medium
• Disabled
The default value is Medium.
Select Security Level as Enabled or Disabled with Red Hat
Enterprise Linux 5/5AP.
Security Level is automatically set as Disabled with Red Hat
Enterprise Linux 6.
The followings are applied for Red Hat Enterprise Linux 3/4
versions.
• High, Medium -> firewall is set
• Disabled
-> firewall is not set
Select the firewall rules to set.
Select one of the following option buttons.
• Use default firewall rules
• Customize
If you select Customize the Firewall Rules, select the
checkbox for the following required setting items.
• Trusted devices
Only eth0 can be selected.
(If you select eth0, the setting of the firewall is not done on
the eth0.)
• Allow incoming
Select the communication protocols allowing
communication through the firewall. You can select the
multiple items.
In the case of Red Hat Enterprise Linux 5/5AP, SSH is
always allowed regardless of the selected content.
• WWW(HTTP)
• FTP
• SSH
• DHCP
• Mail(SMTP)
• Telnet
Select the communication protocols and ports with
authorization to communicate through the firewall.
Up to 255 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\/;-*?"<>'|[]@
Enter it by the format of "Port Number:Protocol".
When you enter multiple ports, describe them by separating
","(comma).
Example) 1029:tcp,1040:udp

 When you install OS of Red Hat Enterprise Linux 3 update2 and earlier, set the
Security Level to Disabled.
 If the Security Level is set to either of High, Medium, or Enabled, select
Customize and add the following description to Other Ports.
Protocol
Port Number
UDP
68
TCP
26509(*1)
TCP
26510(*1)
TCP
26520
UDP
26529(*1)
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*1
When you upgraded DPM Server from the version earlier than DPM Ver6.1,
used (opened) port number are different. For details, see *10 of
"Communications between the Management Server and managed machines"
in Appendix D, "Network Port and Protocol List."
Also, if Security Level is Disabled and you configure the firewall after installing OS,
open the ports described in the above table.
 X-Window Configuration
This set the X Window environment information of the managed machine for install.
This information cannot be set for Red Hat Enterprise Linux 6.
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X-Window Configuration
Configure the X Window
System

Color Depth
(Required)

Resolution
(Required)
Default Desktop
(Required)

Select a Video Card

Select Monitor

Set the X Window System.
If you select the checkbox, X Window System will be forcibly
selected in the install package.
Also, you can configure the detailed settings for X Window.
Set the color depth. Select this from the list.
The default value is 8.
In the case of Red Hat Enterprise Linux 5/5AP, it will be
automatically set regardless of the selected content.
Set the resolution. Select this from the list box.
The default value is 640x480.
Set the desktop environment.
Select one of the following option buttons. The default value is KDE.
• GNOME
• KDE
In the case of Red Hat Enterprise Linux 5.1~5.4, 5.1 AP~5.4AP, it
will be automatically set regardless of the selected content.
Select the Start the X Windows system on boot to start X Window
when the system starts.
Set the video card.
Select the Probe for video card checkbox to set it automatically.
Select it from the list to set it manually.
Probe the monitor.
Select the Probe for monitor checkbox to set it automatically.
Select it from the list to set it manually.
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 Package Group Selection
Set the information for each software package to install on the managed machine.
This information cannot be set for Red Hat Enterprise Linux 6.
In Red Hat Enterprise Linux 6, the following packages are installed by the fixed setting.
・ Server Platform
・ Deployment Tools
・ Server Platform Development
・ Compatibility libraries
・ Network file system client
・ japanese-support

Package Group Selection
The package Install Method

Install package group

Set the install method for the packages to be installed.
Select one of the following option buttons.
• A package dependency is solved automatically
• A package dependency is disregarded
Set the package group to install during the installation. Select this
from the list. You can select the multiple items.
The content of the list will change based on the content in the
Install Linux in the Basic Configuration panel.
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If the managed machine is an x64 edition, /lib/libgcc_s.so.1 is required.
If /lib/libgcc_s.so.1 does not exist, multicast remote updates will not be possible. Please
install /lib/libgcc_s.so.1 by one of the following methods.
1) Select the "Compatibility Arch Support" package when doing an OS clear install.
2) Install libgcc-3.4.5-2.i386.rpm by unicast using a remote update after the OS clear install.

 Script Set
Set the shell script to run after the managed machine installation has completed.
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Script Set
Run outside of the chroot
environment

Use an interpreter

Input %post Script
(Text box)

READ

CLEAR

Run outside the chroot environment.
Normally, scripts are executed in the chroot environment. Select the
Run Outside the chroot Environment checkbox to run outside the
chroot environment.
Set the interpreter file name to use.
Enter the interpreter file name to use when using an interpreter
except the default shell interpreter.
Up to 255 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
The following symbols or blank space cannot be used.
\:,;*?"<>'|[]@
Example) /usr/bin/python
Set the Linux shell script you want to run after the installation is
completed. You can enter scripts with up to 320 single-byte
characters per line and a maximum of 600 lines.
An error will occur if the script that is read in includes a line with
more than 320 characters, and the post script will not be read in.
If there is a line that exceeds 320 characters, correct it so that the
character count for a line does not exceed 320 characters by
starting a new paragraph by inserting a "\" at the position to start a
new paragraph.
Example)
A modification example is shown below. ("XXXX---YYY" is a line
in a script.)
Before modification -------------------------------------------------------:
XXXXXXXXXXXXXXXXXXXXXXXXXZZZZZZZZZZZZZZZ
:
------------------------------------------------------------After modification -------------------------------------------------------:
XXXXXXXXXXXXXXXXXXXXXXXXX \
ZZZZZZZZZZZZZZZ
:
------------------------------------------------------------The file is read in as script information.
The file selection screen appears with the current working folder as
the initial folder. Then open a file.
When the file is read in, scripts for introduction and setup of DPM
Client software are automatically configured.
When a file is read in, the file cannot be read in if the number of
lines in the combination of complete input content and the file
content exceeds 600 or if any line exceeds 320 characters.
Deletes all currently entered script data.

(3) The Linux install parameter is saved.
LinuxOS Install Parameter Making
SAVE
EXIT

The detail settings of the install parameter are saved as the Linux
installation parameter file and it closes.
Closes without saving the detail settings of the install parameter.
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 Working Mode: Online
The file is transmitted from the temporary working folder to the managed folder.
The default folder is as follows:
<Folder for Image>\AnsFile\linux (Linux boot parameter file)
<Folder for Image>\exports\ks (Linux setup parameter file)

 Working Mode: Offline
The folder that was specified in working folder appears, so specify the File Name and save.
The default folder is as follows:
C:\Program Files\NEC\DeploymentManager\linux\offline
The following screen will be displayed if it is saved properly.

Other Operations and Displays
 Read an existing Linux installation parameter file
In the File menu, select Open.
 Working Mode: Online
(1) The Linux setup parameter file list that exists under the "<Folder for Image>\exports\ks" folder on the
Management Server appears.
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(2) Double-click the target Linux setup parameter file, or select the Linux setup parameter file and click
SELECT. The Linux setup parameter file is read and the screen appears.

Do not use an install parameter file of Linux OS that is not supported by this version.
See Appendix A, "Function Tables" in First Step Guide for details of supported OSs.

If some error occurs when the Linux installation parameter file is read, then the
following message is displayed. Check the contents of the Linux setup parameter file
and Linux boot parameter file.
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 Working Mode: Offline
(1) A list of the Linux setup parameter files in the current working folder appears.

(2) If you double-click the target Linux setup parameter file or select the Linux setup parameter file and click
Open, the screen with the Linux setup parameter file read in will be displayed.
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Do not use an install parameter file of Linux OS that is not supported by this
version. See Appendix A, "Function Tables" in First Step Guide for details of
supported OSs.
If some error occurs when the Linux installation parameter file is read, then the
following message is displayed. Check the contents of the Linux setup parameter
file and Linux boot parameter file.

 Overwrite of the Linux installation parameter file
The content of the currently displayed Linux installation parameter are overwritten and saved to the original
file.
In the File menu, select Overwrite.
 Working Mode: Online
The following file will be overwritten by the settings of the Linux installation parameter file.
• Linux boot parameter file: <Folder for Image>\AnsFile\Linux on the Management Server
• Linux setup parameter file: <Folder for Image>\exports\ks on the Management Server
The following message is displayed when the file has successfully been saved to the Management
Server.

The following message will be displayed if there is any problem when saving the
file to the Management Server, so please save again after resolving the problems
with the Management Server or the network.
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Working Mode: Offline
The settings will be overwritten by the settings of the Linux install parameter under the currently specified
working folder.
The following message is displayed when the file has successfully been saved in the working folder.

The following message will be displayed if there is any problem in saving the file to
working folder, so please save again after resolving the problems with the working
folder to be saved.

 Saves the Linux installation parameter file with the name
The contents of the currently specified Linux installation parameter will be newly saved with the specified
name.
In the File menu, select Save As New Name.
 Working Mode: Online
A list of the files that exist in the <Folder for Image>\exports\ks on the Management Server are displayed
in the Host Name List screen. Enter the Save File Name and click SELECT.
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• Linux boot parameter file:
Saves with the file name without the extension in the <Folder for Image>\AnsFile\Linux on the
Management Server.
• Linux setup parameter file:
Saves with the file name with the extension ".cfg" in the <Folder for Image>\exports\ks on the
Management Server.
The following message is displayed when the file has successfully been saved to the Management Server.

The following message will be displayed if there is any problem in saving the file to
the Management Server, so please save again after resolving the problems with
the Management Server or the network.

 Working Mode: Offline
A list of the files that are in the currently set working folder appears in the Select File screen.
Enter the File Name and click Save.

• Linux boot parameter file:
Saves with the file name without an extension in the selected folder.
• Linux setup parameter file:
Saves with the file name with the extension ".cfg" in the selected folder.
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The following message appears when the file has successfully been saved.

 The following message will be displayed if there is any problem in saving the file to working
folder, so please save again after resolving the problems with the working folder to be
saved.

 If a file with the same file name already exists in the folder to be saved, the following screen
appears. To overwrite, click Yes. If not, click No.

 Change working mode
You can change the current working mode.
(1) From the Start menu of the Management Server or the computer where Image Builder (Remote Console)
is installed, click All Programs -> DeploymentManager -> Image Builder and launch Image Builder.
(2) Select Setting Setup Parameter File.
(3) The Select parameter screen appears. Select Linux parameter file and click OK.
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(4) When the LinuxOS Install Parameter Making screen appears, open the Working Mode menu and select
the Set Online or Set Offline option button to change the working mode.

 Closing the install parameter setting tool
(1) In the File menu, click Exit.
(2) The LinuxOS Install Parameter Making close confirmation screen appears, then click Yes to close and No
not to close.
If you close, all of the screens will close and the Linux install setting tool will close.
The EXIT on the lower left of the main screen will also close the install parameter setting tool.
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 Displaying Settings Data
(1) In the File menu, click Display Install Parameter.
(2) The currently set install parameter details will be displayed in a list in the Linux install parameter output
format. The currently set Linux install parameter details are displayed.

LinuxOS Install Parameter List
Prints the details of LinuxOS Install Parameter List.
PRINT
CLOSE
Closes the currently displayed Install Setting Parameter Screen.
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The Install Parameter Error List screen from the previous item will be displayed if there
is a problem or error with the details of the currently set Linux install parameters. Correct
any items displayed in the error list.

 Linux installation parameter file creation tool information
The Linux OS install parameter setting information is confirmed with the following steps.
(1) On the LinuxOS Install Parameter Making screen, click Help menu -> Version and the Linux Install
Parameter Making screen will be displayed.
(2) Check the information.
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5.4.6.

Batch Creation of Parameter File for OS Clear Installation (Linux)

This section describes an explanation of the method for creating the multiple Linux installation parameter files.
(1) Prepare the template Linux installation parameter file that will be the base for multiple Linux installation
parameter files.
Do not use an install parameter file of Linux OS that is not supported by this version. See
Appendix A, "Function Tables" in First Step Guide for details of supported OSs.

See Section 5.4.5, "Creating a Parameter File for OS Clear Installation (Linux)" for the
method for creating a Linux installation parameter file.
(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.
(3) Image Builder runs, then click Setting setup parameter file.
(4) The Select parameter screen appears. Select Linux parameter file and click OK.

320

When this function is launched for the first time or if the environment configuration data file LinuxIParm.cfg
is not in the install directory, the LinuxOS Install Environment Set screen appears. Configure the settings
to match your environment.

Install Directory
Work Directory

Select Working Mode
Management Server
[ks] Server Directory

[syslinux] Server Directory

CANCEL

SAVE

Displays the folder where Image Builder has been installed.
Default is "C:\Program Files\NEC\DeploymentManager".
You can change the working folder for Offline mode to any
location. This can be entered only when "Offline Mode" is
selected in Select Working Mode.
Default is
"C:\Program Files\NEC\DeploymentManager\linux\offline"
The characters that can be entered are single-byte alphanumeric
characters.
The following symbols cannot be used.
,;*?"'<>|[]@
The working mode can be set to Online mode or Offline mode.
The default is Online Mode.
The Management Server IP address is required.
Displays the folder name on the Management Server where the
Linux setup parameter file is to be saved when in online mode.
This is fixed value and cannot be edited.
Displays the folder name on the Management Server where the
Linux boot parameter file is to be saved when in online mode.
This is fixed value and cannot be edited.
Discards changes and closes the environment settings screen.
The confirmation message for canceling is displayed, then click
Yes or No.
Saves the settings to the environment settings file
LinuxIParm.cfg and closes the environment set screen.
The confirmation message for saving is displayed, then click Yes
or No.
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(5) The LinuxOS Install Parameter Making will open. Then select Open from File menu. Select a setup
parameter file on the Host Name List screen and click SELECT.

(6) The Setup Parameter File will be read, then click Install Parameter -> Make Install Parameter.
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(7) The details of the currently set Linux installation parameter file are checked, and the Install Parameter
Extensive creation screen appears. Then enter the Ethernet device eth0 network information for the target
machine for the Linux install.

Install Parameter Extensive creation
Model Host
The name of the currently loaded Linux installation parameter file
used for the template is displayed and configured.
Host Name
Set the host name for Ethernet device eth0. The number of characters
(Required)
that can be entered is 255 single-bytes characters.
DHCP(0:ON)
Select and set the type of TCP/IP network for Ethernet device eth0
from below.
- DHCP: Enter 0 if the IP address is set dynamically with DHCP
server. (Required)
- Static IP: Do not enter anything if the IP address is set manually.
IP Address
Set the IP address for Ethernet device eth0.
This must be set if the network type is Static IP.
Network Mask
Set the netmask value for the IP address of Ethernet device eth0. This
must be set if the network type is Static IP.
Gateway
Enter the IP address of the gateway machine that corresponds to the
IP address of Ethernet device eth0. This does not need to be set,
whether the network type is DHCP or Static IP.
DNS Address
Enter the IP address of the primary DNS that corresponds to the IP
address of the Ethernet device. This does not need to be set, whether
the network type is DHCP or Static IP.
Clears all the content entered in the current screen.
CLEAR
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READ

Reads install parameter data saved with CSV file format and places it
in the entry fields for install parameter batch creation.
The file selection dialog screen appears, with the CSV folder in the
currently set working folder as the default folder. Select the file name
and click Open.

CHECK

Performs a prior check of the consistency of the batch creation install
parameter information that is currently input.
If there are no problems or errors, the following message dialogue
screen appears.

SAVE

The batch creation install parameter information file is saved with the
CSV file format.
It is saved to the CSV folder in the currently set work folder.
The default is <Installation folder>\linux\offline\CSV.
By clicking Save, the Save As New Name dialog box appears. Enter
the file name and save the file.
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Extensive Creation

EXIT

Performs a batch creation of Linux installation parameter files in
accordance with the currently input batch creation install parameter
data.
If batch creation is completed successfully, the Install Parameter
Creation Result List screen appears.

• if the Working Mode is Online
The Linux boot parameter file is saved with the input host name and
for
without
an
extension
in
the
folder
"<Folder
Image>\AnsFile\Linux" on the Management Server.
The Linux setup parameter file is saved with the input host name
and ".cfg" extension in the "<Folder for Image>\exports\ks" on the
Management Server.
• if the Working Mode is Offline
The Linux boot parameter file is saved with the input host name and
without an extension in the currently set working folder.
The Linux setup parameter file is saved with the input host name
and with ".cfg" extension.
The currently displayed Install Parameter Extensive Creation
dialog screen will close and the Install Parameter Extensive
Creation operation will end.
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 The Install Parameter Error List screen appears if there is a problem or error with the
description of the Linux installation parameter file when reading in the file. Confirm the
content of the error and correct it.

 You can set the install parameter data for up to 100 machines at one time.
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5.5. Package Registration/Modification
Perform package registration/modification. Follow the steps below.
Use PackageDescriber when creation or modification of a package involves any of the
settings shown below. See Section 6, "PackageDescriber" for an explanation of each setting.
・ When specifying a hyphen (-), period (.), or underscore (_) for MS Number under the Basic
tab.
・ When specifying a file that includes the msp or msu extensions for Execution File under
the Execution Settings tab.
・ When specifying a path described in the registry as a file path for file conditions under the
Dependency Information tab.
・ When specifying any of the following for file conditions or registry conditions under the
Dependency Information tab.
- Exists (smaller than version)
- Exists (version or earlier)
- Exists (larger than version)
- Exists (version or later)
・ When specifying multiple conditions using And or Or in Condition Specifications under
the Dependency Information tab.
・ When specifying a path described in the registry as the file path under the ID Information
tab.
If you register RUR(revision up release) module for Express 5800 Series as a package,
register it after confirming the installation manual of RUR necessarily.
(1) From the Start menu of the computer where Image Builder is used, click All Programs ->
DeploymentManager -> Image Builder and launch Image Builder.
(2) Click Package registration/modification.
(3) The Package registration/modification screen appears. Then click the various menus under the File
menu to register/modify the package.
When creating a Windows package -> Create Windows Package
See Section 5.5.1, "Create Windows Package"
for details.
When modifying a Windows package -> Modify Windows Package
See Section 5.5.2, "Modify Windows Package"
for details.
When creating a Linux package
-> Create Linux Package
See Section 5.5.3, "Create Linux Package"
for details.
When modifying a Linux package
-> Modify Linux Package
See Section 5.5.4, "Modify Linux Package"
for details.
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5.5.1.

Create Windows Package

Explains the Basic, Execution Settings, Applicable OS and language, Dependency information and ID
information tab settings.

 If you change Type on the Basic tab, the Urgency will change to default. Also, the
Execution Settings tab settings will change to default.
• If the type was changed to Service Pack
Urgency is changed to general. Also, the Restart after the installation and Apply
independently check boxes on the Execution Settings tab are automatically checked.
If multiple folders have been added to the copied folder, all folder settings are deleted
from the package.
• If the type was changed to HotFix
Urgency is changed to High. Also, the Restart after the installation and Apply
independently check boxes on the Execution Settings tab are automatically cleared.
If multiple folders have been added to the copied folder, all folder settings are deleted
from the package.
• If the type was changed to application
Urgency is changed to Normal. Also, the Restart after the installation and Apply
independently check boxes on the Execution Settings tab are automatically cleared.
 When you created the package specifying the bat file in the Execution Settings tab ->
Execution File in Create Windows package screen in the version of DPM Ver3.8 and
earlier, re-create the package in this version.
 When you register the package of a service pack, which switches the firewall function from
disabled to enabled(Windows XP SP2 and so on), most ports are blocked when applying
the service pack and the Management Server cannot communicate with the managed
machine. Therefore, a scenario execution error will occur. In this case, open the port that
DPM uses by Port Opening Tool after removing the error. See Section 7.1, "Port Opening
Tool" about Port Opening Tool.
 When you register a service pack of SP2 or later as a package, there are some service
packs, which cannot be directly applied to the environment that a service pack is not
applied, by the specification of the service pack.
About the specification of the service pack, see the site of Microsoft Corporation and so
on.
Example)
In the case of Windows Server 2008 SP2, SP1 needs to be already applied as the
condition that SP2 will be applied.(SP2 cannnot be directly applied to the environment
without SP.)
・ When creating a package, specify the following in registry condition of
Dependency information tab.
Key name: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT
\CurrentVersion
Name: CSDVersion
Conditions: Exists
・ When a package is distributed by the automatic update function, if there are
multiple packages of service packs on the Management Server, the package of the
latest service pack will be distributed.
As the above, the package will not be applied to the managed machine without SP
by the specification of the service pack.
If you want to apply SP2 to the managed machine without SP, distribute by either
of the following.
- The package of SP2 is not registered.
Distribute the required service pack(SP1) by the automatic update function. After
that, register SP2.
- The package of SP2 is already registered.
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Distribute the required service pack(SP1) by the scenario. After that, SP2 will be
distributed by the automatic update function.
(1) Set each item on each tab in the Create Windows package screen.
 Basic tab
Click Basic tab in the Create Windows package screen and set each item. The places (types) circled in red
are settings that will vary depending on the selected type.
• If HotFix was selected as the type
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Basic
Package ID
(Required)
Company name
Release Date

Enter the package ID. Up to 63 single-bytes can be entered. Any single-byte
alphabet and numeric characters or the following symbols can be entered.
-_
Enter the name of the company that issued the package. Up to 127
single-bytes can be entered.
Enter the package release date. Enter it in the year/month/day format. Enter
the year as four digits and the month and day as two digits.
If you enter an invalid value, it will be ignored or automatically corrected.

Package summary

Enter package summary information. Up to 511 single-bytes can be entered.

Type

Select the service pack/hotfix/application from the list box.
The default is HotFix.
Set the urgency (four types) of the package.
The default is High when you select HotFix.
The default is Normal when you select service pack or application. (*1)
Enter the MS (KB) number appended to the service pack or HotFix issued by
Microsoft. Up to 31 single-bytes can be entered.
Example) KB889293
Q819696
・ In case of a Microsoft HotFix, the value entered in the MS number column
is compared with the MS number written in the registry (KBXXXXXX or
QXXXXXX), and if the two values match, it is judged that the HotFix has
been applied. Enter the correct value, including the "KB" or "Q." If a value is
not entered in the MS number column, the application status is judged by
the registry and file information entered in ID Information.
・ Microsoft HotFixes for which information has not been entered in both MS
number and ID Information are not automatically updated. Please specify
either one when specifying Highest or High urgency.
・ You do not need to enter the MS number or the ID Information for service
pack.

Urgency

MS number

*1
The handling process will differ according to the type of urgency as shown in the table below.
Urgency
Highest

Power Status of
Computer
Powered ON computer
Powered OFF computer

High

Powered ON computer
Powered OFF computer

Normal
Low

Sending Process
It will be immediately sent to a managed machine where it can be
applied.
An automatic update notice is immediately issued, but if the
power is off, automatic update cannot be performed. Next time
the computer is started up, it is judged whether or not the
package has been applied based on information set in the
package, and only packages that have not been applied are
distributed.
It will be sent at a time specified in advance on the Management
Server side.
Automatic update is performed the next time the computer is
started up.
It determines whether or not the package has been applied
based on information set in the package, and only packages that
have not been applied are distributed.
Create a scenario on the Management Server, and distribute it
manually.
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• If Service Pack is selected as the type

Basic
Major version/Minor
version

You must enter major version and minor version if the created package is a
service pack. Values that can be entered are as follows.
Major version: 0~65535
Minor version: 0~65535
In the case of a Microsoft service pack, the numbers entered in the Major
Version column and Minor Version column are compared with the service
pack versions currently installed in the OS, and it is judged whether the
service pack has been applied. Enter the correct numbers.

 If an invalid value is entered for major version or minor version, it is corrected
automatically.
 In the case of a service pack, the major version and minor version must be entered. See
the following table.
Example) For Windows 2000 and Windows XP
OS Category
Windows 2000

Windows XP

Service Pack
SP1
SP2
SP3
SP4
SP1
SP2
SP3
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Major Version
1
2
3
4
1
2
3

Minor Version
0
0
0
0
0
0
0

• If Application is selected as the type

Basic
Display name

Display version

Enter the application display name.
This will become the same as the value for the DisplayName saved in
the registry Uninstall sub-key after the application is installed. Up to
511 single-bytes can be entered.
Enter the application display version. This will become the same as
the value for the DisplayVersion saved in the registry Uninstall
sub-key after the application is installed. Up to 127 single-bytes can be
entered.
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 Execution Settings tab
Click Execution Settings tab in the Create Windows package screen and set each item.

Execution Settings
Folder name
Browse

Enter the folder name in which the patch or the application is stored.
Up to 255 single-bytes can be entered.
The Browse for Folder screen appears when you click Browse. Select
the folder in which the patch or the application is stored.

Added folder
Add
Delete

The folder with the folder name entered will be added as an added
folder.
The folder selected from the added folder will be deleted.
The Delete will only be enabled if you select one or more folders from
the added folder.
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Execution File

Browse
Setup Parameters

Restart after the
installation
Apply
independently

Enter the executable file name. Up to 255 single-byte characters can be
entered. The allowed characters are single-byte alphanumeric
characters and symbols. The path will be automatically cleared if the
entered path length is larger than 255 single-bytes.
Please do not register a file (example: file%9d.exe) with an executable
file name including %xx(xx is hexadecimal number 0 - f) characters. If a
package contains %xx, it cannot be properly downloaded to the
Management Server.
Please specify the items in the executable file such that all of the
following conditions are met.
・ Silent install can be done. (You do not need to respond such as key
entry while the file is being executed, or you can execute silent install
by creating a batch file.)
・ A reboot of the OS does not occur during the install.
・ You can install with a local system account. (Network browsing is not
performed.)
・ The total file size does not exceed 2GByte.
・ When an executable file generates descendant processes
(executable file->child process-> grandchild process) in the
execution, generated child process finishes after grandchild process
finishes. Also, when an executable file is a script file such as bat or
sh, the executable file finishes after generated child process finishes.
The open file screen appears when you click Browse. Select the folder
in which the patch or the application is stored.
Set the setup parameters for the executable file.
Up to 128 single-byte characters can be entered. The allowed
characters are single-byte alphanumeric characters and symbols.
In the case of service pack or hotfix, specify two parameters: "Do not
restart after execution", and "Unattended mode" or "Quiet mode".
Example)
In the case of Windows Server 2008
・ Do not restart after execution: /norestart
・ Unattended mode: /unattend
・ Quiet mode: /quiet
About the parameter of service pack or hotfix, execute the file by
specifying "/h" or "-?" in advance and check the parameter.
When you specify Windows XP SP2 or SP3 and OEM specific driver is
installed, specify also "Execute processing without displaying the
command prompt"("-o").
Set it to restart after the package is applied. Effective when applied by
automatic update type.
Select this for service pack and hotfix which need to be applied
independently. If you select this, it will automatically restart before
application. Effective when applied by automatic update type.
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 The registered service pack/hotfix/Linux patch file/application must be copied to an
internal folder on the Management Server. The free space required for registration is
twice as much as the space of required for the service pack/hotfix/Linux patch
file/application to be registered.
 The service packs/hotfix/Linux patch files/applications registered here are limited to those
which are silently installed and do not require restart after installation. (For those that
display a security warning screen due to digital signature information, a confirmation
screen appears on the managed machine when it is applied, and installation cannot
continue.)
*Silent installation means that when an executable file type (setup.exe or Update.exe) is
run, setup is performed automatically and does not require clicking Next or entering
values.
*In the case of service packs, hotfixes, and so on that require a restart to be valid, please
register an image with the option not to perform restart and set the Restart After
Applying option in the scenario.
A patch is registered in folder unit. Store only one patch in one folder.

335

 Applicable OS and language tab
Click Applicable OS and language tab in the Create Windows package screen and set each item.

Applicable OS and language
OS

Lang

Select the OS to which the package is to be applied.
Set the OS supported by the service pack/hotfix correctly.
If you select All OS, all OSs except "Other OS" will be target.
Select the language of the OS to which the package is to be
applied.

Add

Add the selected OS and Lang.

Delete

Delete the selected OS and Lang.

Base Service Pack

Select a server pack that is required for applying the hotfix.

Add

Add the selected Base Service Pack.

Delete

Delete the selected Base Service Pack.

Absorbing Service Pack

Select the next Server Pack. Use it combined with Base Service
Pack.
Example) If there is a Windows 2000 computer with SP4 applied;
enter SP4 as the Base Service Pack, and SP5 as the
Absorbing Service Pack. In this way, the conditions will be
[this will apply to computers where SP4 is applied but SP5 is
not applied].

Add

Add the selected Absorbing Service Pack.

Delete

Delete the selected Absorbing Service Pack.
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 Dependency Information tab
Click Dependency information tab in the Create Windows package screen and set each item.
The dependent information is checked when a package is applied. It will be applied only when dependent
conditions are met.
Specify the dependent conditions from the following 3 types.
• Package dependency
• File dependency
• Registry dependency
If you are adding a composite of package dependency, file dependency, and registry
dependency, it will only apply if all of the condition items have been met.
Example) If package dependency is A, file dependency information is B, and registry
dependency is C. The composite application conditions are as below.
Item

Added
information

Application conditions

A

1
2
3
1
2
1
2

All of 1, 2 and 3 are applied.

B
C

Either Condition of 1 or 2 is met.
Either Condition of 1 or 2 is met.
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Composite
application
condition
A is met
and
B is met
and
C is met.

Dependency information
Check the package
dependency relationship
Required packages

Add

The settings become valid when the Check for package
dependency relationship check box is checked.
The package is applied only if the package it depends on has been
installed.
Select the Required package checkbox and set.
Required packages are selected from other packages registered by
Image Builder or PackageDescriber. Also, if multiple required
packages have been added, the package will be applied if all required
dependent packages have been applied.
Example)
You cannot apply the cumulative security update for Internet
Explorer if Internet Explorer is not installed.
In this case, the required condition for applying the cumulative
security update is Internet Explorer.
The Add package dependency screen appears when you click Add.

The packages displayed on the Add package dependency screen
are those currently registered on the Management Server. Select a
dependent package from the list and click Add.
Delete
When you select a package from the dependent package list and click
Delete, the dependent package is deleted.
Apply depending on the It is determined if the package should be applied depending on
existence of any of the whether a file exists or not by the dependent file information. If
multiple files are added, it will be applied if at least one of them is met.
following files
Select the Apply depending on existence of any of the following
files checkbox.
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Add

Modify
Delete

When you click Add, the Add file dependency information screen
appears. Add the package dependent information.

• File path
Enter the dependent file path and file name. Up to 259 single-bytes
can be entered.
• File version
Enter the file version. Enter in "x.x.x.x" format with less than 31
single-bytes. The characters that can be entered are single-byte
numeric characters or symbols ("." only).
If a file version is not entered, the existence of the file is the
condition of the dependency.
You can check the file version in the Version tab of the file property.
You do not need to enter anything if there is not the Version tab in
the property or if the File version item in the Version tab is blank.
• Conditions
- Exists:
The package will be applied if the entered file exists.
- Does not exist:
The package will be applied if the entered file does not exist.
When you select a file and click Modify, the Modify file dependency
information screen appears.
When you select a file and click Delete, the dependent file is deleted.

Apply depending on the It is determined if the package should be applied depending on
existence of any of the whether the registry exists or not by the dependent registry
following registries
information. If multiple registry information is added, it will be applied if
at least one of them is met.
Select the Apply depending on the existence of any of the
following registries checkbox.
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Add

Modify
Delete

When you click Add, the Add registry dependency Information
screen appears. Add the package registry.

• Key name
Enter the registry name including the root key. Up to 255
single-bytes can be entered.
• Name
Enter the value associated with the key name (ValueName) as less
than 255 single-bytes.
• Data
Enter the value data (ValueData). You can enter the following
number of characters.
-"REG_SZ" and "REG_BINARY":up to 1024byte
-"REG_DWORD":the number of 0~4294967295
-"REG_QWORD"type:the number of 0~18446744073709551615
• Type
Select the value type (ValueType) from the list box. You can select
the following.
-REG_SZ
-REG_BINARY
-REG_DWORD
-REG_QWORD
• Conditions
- Exists
The package will be applied if the entered registry exists.
- Does not exist
The package will be applied if the entered registry does not
exist.
When you select a registry and click Modify, the Modify registry
dependency information screen appears.
When you select a registry and click Delete, the dependent registry is
deleted.
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 ID information tab
Click ID Information tab in the Create Windows package screen and set each item.
It determines whether a package has been applied to a machine using the ID information.
File and registry changes occurring due to the fact that a service pack/hotfix/Application was installed are
entered as ID information.
Example) Patch A is registered, and distributed to machines.
1) Before distribution: Which patches have been installed?
How is the file information or the registry?
2) After distribution: When patch A is distributed, what will the files and registry change to?
The package application status is determined based on the difference information obtained by comparing
1) and 2) above. If all entered file change information and registry change information are met, it is judged
that the package was applied.
If the ID information is not entered when the package is registered, the package will
become an unrecognized package and automatic update notice will not be sent.
If either the MS number or the ID information is not entered when a hotfix is registered,
a scenario will be created on the Management Server side and it must be sent.
 If the created package file is a service pack or hotfix issued by Microsoft, even if no ID
information was entered, the MS number entered on the Basic tab is compared with
the MS number (KBXXXXXX or QXXXXXX) written in the registry, and if the two
values match, it is judged that the package has been applied.
 ID information needs to be entered in the case of applying a package that does not
have an MS number or whose MS number cannot be identified, or a package that the
information remains only in the registry and so on.
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ID Information
File change information

Add

Used when judging whether a package was applied based on change
information occurring in the file system because the package was
applied.
When you click Add, the Add file information screen appears. Add
the package file information.

• File path
Enter the changed file path and file name. Up to 259 single-bytes
can be entered.
As the file path may vary depending on the usage environment,
enter the system environment variables.
Example)
If there is a change in winsock.dll under C:\WINNT\system32\
%WinDir%\system32\winsock.dll
• File version
Enter the file version. Enter in "x.x.x.x" format with less than 31
single-bytes using only single-byte characters and ".".
If a file version is not entered, the existence of the file becomes ID
information.
You can check the file version in the file properties Version tab. You
do not need to enter anything if there is nothing in the properties
Version tab on the OS or if the File version item in the Version tab
is blank.
• Change type
Select it from the list box.
Create new:
Select when the file is newly created by application of the
package.
Version up:
Select when the file is overwritten by application of the package
only in the case that it is newer than the existing file.
Replace:
Select when the file is unconditionally overwritten by application
of the package.
Delete:
Select when the file is deleted by application of the package.
Modify

Modify file ID information of the added package.

Delete

Delete file ID information of the added package.

342

Registry change
Add

Used when judging whether a package was applied based on registry
information that was changed because the package was applied.
When you click Add, the Add registry information screen appears.

• Key name
Enter the registry name including the root key.
• Name
Enter the value (ValueName) associated with the key name.
• Type
Enter the value Type (ValueType).
• Data
Enter the value data (ValueData). The item will be enabled if you
enter Name.
• Change
Select it from the list box.
Create new:
Select when the registry is newly created by application of the
package.
Replace:
Select when the registry is overwritten by application of the
package.
Delete:
Select when the registry is deleted by application of the package.
Modify

Modify registry information of the added package.

Delete

Delete registry information of the added package.

(2) When you click OK after entering the required information, the package is created.
When you click Cancel, all entered information is discarded and the Create Windows package screen will
close.
Input of the information required for Windows package creation is completed.
Click OK on the Create Windows package screen to create the Windows package.
You can create packages sequentially. When you create packages sequentially, enter the
next package information and click OK. To complete creating packages, click Finish.
(Cancel will become Finish once you click OK.)
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5.5.2.

Modify Windows Package

(1) When you select the Modify Windows package, the Select Windows package screen appears.

(2) Select the package from the Select Windows Package screen, and click Modify.
(3) The Modify Windows package screen appears. Modify items on each tab of the screen. The following
items can be modified.
See Section 5.5.1, "Create Windows Package," regarding each tab of the screen.
・ You can modify items except Package ID and Type on the Basic tab.
・ You can modify items except Folder to be copied and Execution file on the Execution Settings tab.
・ You can modify all items on the Applicable OS and language tab.
・ You can modify all items on the Dependency information tab.
・ You can modify all items on the ID Information tab.
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5.5.3.

Create Linux Package

If you select the Create Linux package menu item, the Create Linux package screen appears.
 Basic tab
Click Basic tab in the Create Linux package screen and set each item.

Basic
Package ID
(Required)

Company name
Release date
Package summary

Enter the package ID. Up to 63 characters can be entered. Any
single-byte alphanumeric character and the following symbols can be
entered.
-_
Enter the name of the issuing source that issued the package. Up to 127
characters can be entered.
Enter the package release date. The date is entered in the YYYY/MM/DD
format.
Enter package summary information. Up to 511 characters can be
entered.

Type

Select the Linux patch or application.

Urgency

Select the package urgency level. It cannot be changed.
After all of the required items are correctly entered, OK will be enabled.
The Linux package will be created when you click OK.
The screen closes without any processing.

OK
Cancel
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 Execution Settings tab
Click Execution Settings tab in the Create Linux Package screen and set each item.

Execution Settings
Folder name
Browse
Added Folder

Add
Delete

Enter the folder in which the patch or the application is stored. Up to 255
single-bytes can be entered.
The Browse for Folder is displayed when you click Browse. Select the
folder in which the patch or the application is stored.
Display the folder that was added.
- You can only add one folder in the case of a Linux patch.
- For an application, multiple folders can be added.
The folder entered in the Folder Name text box will be added as an
added folder.
The folder selected from the added folder column will be deleted.
Delete will only be enabled if you select one or more folders from the
added folder.
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Execution File

Enter the executable file. This is less than 255 single-bytes and the path
will be automatically cleared if the entered path length is larger than 255
single-bytes.
Do not register a file with an executable file name including %xx (xx is
hexadecimal number 0~f) characters. (example: file%9d.exe) If a
package contains %xx, it cannot be properly downloaded to the
Management Server.
Specify the executable file that all of the following conditions are met.
・ Silent install can be done. (You do not need to respond such as key
entry while the file is being executed, or you can execute silent install
by creating a batch file.)
・ A reboot of the OS does not occur during the install.
・ You can install with a local system account. (Network browsing is not
performed.)
・ The total file size does not exceed 2GByte.
・ When an executable file(setup.exe/update.exe and so on), which
installs the patch/application and so on, generates descendant
processes(executable file->child process-> grandchild process)
during the installation of the patch/application, generated child
process finishes after grandchild process finishes. Also, when an
executable file is a script file such as bat or sh, the executable file
finishes after generated child process finishes.
・ If a file path with "&" is entered, the executable file may not be

applied properly.
Browse
Setup parameters

Requires
restarting after the
installation
Requires apply
independently

The open file screen appears when you click Browse. Select the
package executable file.
Set the package setup parameters.
Set two parameters from Do not Restart After Execution and
Unattended Mode, or Quiet Mode. Up to 128 single-byte alphanumeric
characters can be entered.
This item is unavailable.

This item is unavailable.

When you register an rpm package, set the options for the install application with "-i" or "-U"
and so on as the command options.
 Do not output any messages on the console if you register a shell script. The scenario will
fail if a message is output. If a message is required, it should be redirected to a log file,
and unnecessary messages should be redirected to /dev/null and so on.
Example) When you saves a log
dmesg >> /tmp/dmesg.log
Example) When you do not save messages
/etc/rc.d/init.d/depagtd start > /dev/null
 If you register a shell script and so on, the script should return 0 at the normal end. If

the script returns a value except 0, a scenario that runs the script ends up in a state
of Scenario Execution Error although the script ends successfully.
When registering an RPM package, the package with "-i" option may not be properly installed
depending on the package registered. The cause may be that there is a signature, or it may
be an rpm with a dependency. Also, it might fail if it has already installed.
Representative options are indicated below. Specify the setup parameters based on the
content.
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Options Sub-Options
-i
-U

-F
-i

Contents
Installs a new package.

Upgrades the already installed packages. Installs
when it is not installed. The installed package is
uninstalled if an earlier version exists.
Updates older packages only if an older package
exists.

--oldpackage

Installs packages that are older than the already installed
packages.
-i
--replacefiles
Installs the packages even if they replace files which has
been installed in the already installed package.
-i
--replacepkgs Installs the packages even if some of them are already
installed.
the same as the oldpackage, replacefiles, and
-i
--force
replacepkgs options together
-i
--nodeps
Forcibly installs ignoring dependencies.
-i
--nosignature
Dose not examine the package or header signature
when reading in.
Also, when you specify options with a normal output, the install can fail so do not specify.
The display system options are shown below
-v, --verbose
Displays more information. Normally, routine
progress messages are displayed.
-vv
Prints debugging information.
-h, --hash
The progress status is displayed using 50 hash
marks "#" as it is taken from the package archive.
--percent
The percentage is displayed as the file is taken from
the package archive.
See the online help documents of the Linux you are using for option details.
With the above, input of the information required for Linux package creation is completed.
Click OK on the Create Linux Package screen to create the Linux package.
You can create packages sequentially. When you create packages sequentially, enter the
next package information and click OK. To complete creating packages, click Finish. (The
Cancel will become Finish once you click OK.)
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5.5.4.

Modify Linux Package

(1) When you select the Modify Linux Package, the Select Linux Package screen appears.

(2) Select the package to modify from the Select Linux Package screen, and click Modify.
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(3) The Modify Linux Package screen appears. Modify items on each tab of the screen. The following items
can be modified. See Section 5.5.3, "Create Linux Package" regarding each tab of the screen.
• You can modify items except Package ID and Type and Urgency Level on the Basic tab.
• You can modify items except Folder to be copied and Execution file on the Execution Settings tab.

5.5.5.

Exit Package Registration/Modification

When you click Exit menu, the Package registration/modification screen closes.
At this time, whether automatic update notification will be sent to the managed machine is decided based on the
urgency level of the registered package.
If the registered package has the Highest urgency level, automatic update notice will be sent to managed
machines where the package is applicable and it will be promptly installed.
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5.6. Delete Package
Delete the image data created in Image Builder. Follow the steps below to delete.
(1) From the Start menu of the machine where Image Builder is used, click All Programs ->
DeploymentManager -> Image Builder and launch Image Builder.
(2) Click Delete Registered Data. The Delete Registered Data screen appears.

Delete registered data
Image type

When you select the image type the applicable images are shown in the
table below.
You can select from the following.
• Image file
• Operating system
• setup parameter file
• Linux parameter file
• Service Pack/HotFix/Linux patch
• Application
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Delete

Delete is enabled only if you select one of the image files from the image
type. You can select and delete multiple image files.
A confirmation dialog box appears when you click Delete. If you click Yes,
the image file is deleted and the Delete Result Confirmation screen
appears.

Close

The Delete Registered Data screen closes.
 You can temporarily delete the package registered by automatic download using the
delete package function of Image Builder. However, if you do not delete the corresponding
package from the Package Web Server, it will be downloaded again at the time of the set
automatic download.
 Use PackageDescriber to delete the package from the Package Web Server. See Section
6, "PackageDescriber" for details.
 You cannot delete a disk duplication data File or CSV file from Delete Registered Data.
Please manually delete the file from the Management Server <Folder for
Image>\Ansfile folder if it is a Windows file.
Example) If the Folder for Image is on the C: drive.
・ Disk duplication data file (Windows parameter file(Express))
C:\Deploy\Ansfile\ ExpressSysprep\XX-XX-XX-XX-XX-XX.inf
XX-XX-XX-XX-XX-XX.bat
XX-XX-XX-XX-XX-XX.xml
・ Disk duplication data file (Windows parameter file)
C:\Deploy\Ansfile\sysprep\XX-XX-XX-XX-XX-XX.inf
XX-XX-XX-XX-XX-XX.bat
XX-XX-XX-XX-XX-XX.xml
・ Multiple disk duplication data file of disk duplication data file
C:\Deploy\Ansfile\sysprep\csv\XXX.csv
C:\Deploy\Ansfile\unattend\csv\XXX.csv
For a Linux file, the disk duplication parameter file is the file from the <Folder for
Image>\Ansfile on the Management Server, so manually delete the file from the location
indicated when the CSV file is saved.
Example) If the Folder for Image is on the C: drive.
C:\Deploy\Ansfile\machineinf\XXXXXXXXXXXX.rep
If the working folder and the install directory are default
C:\Program Files\NEC\DeploymentManager\linux\offline\CSV\XXX.csv
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5.7. Batch Registration
 Normally, the image data created in Image Builder is temporarily saved on the computer using Image Builder,
and later automatically sent to the Management Server. However, the data is not sent and the data remains
local in the following cases.
・ When doing a system update or copying drivers from the EXPRESSBUILDER CD-ROM.
・ When the network to the Management Server is disconnected after the temporary creation.
In these cases, there are the following methods for registering the locally created image data to the
Management Server.
・ Closing Image Builder (Remote Console)
・ Using Register all.
 This section explains the process for registering to the Management Server using Register all.
(1) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.
(2) Click Register all. The Registration file list screen appears. The batch register data list is displayed.

Register file list
Yes (register)

Sends the image to the Management Server.

Stop

Cancels Register all.

Delete all

Deletes the data that remains locally.

(3) Click Yes(register). Batch registration to the Management Server is completed.
If you register an online utility from remote Image Builder, one group of utilities can be
split into multiple files and uploaded. If you do not understand the file details, upload all
at the time of Register all. (If there are identical files, please overwrite)
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5.8. Agreement Display Settings
When registering an image file, if you select the Do not show this screen again checkbox in the agreement
screen and select I Accept, the agreement screen will not be displayed later. Select Agreement Redisplay (S)
from the system menu to display the screen again. The screen will be displayed again when you register an
image file.
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6.

PackageDescriber

This chapter explains PackageDescriber which is a tool to create packages and register them on the Package
Web Server.
In the case of Windows Server 2012 or Windows 8, be sure to log on with Administrator
user.

6.1. Initial settings: Set Environment
PackageDescriber is used in the following applications.
• Creation and modification of packages for Windows
• Registration and deletion of packages on the Package Web Server
• Online update of OS definition file and language definition file
PackageDescriber is a package creation tool for Windows. Use Image Builder to
register Linux packages.
 Configure the Package Web Server so that the Management Server can download packages stored in
the Web shared folder of the Package Web Server using HTTP. For the configuration, see Section
2.7.3. "Package Download Setting", and Appendix B, "Configuring the Package Web Server" in
Installation Guide.
 All created and modified packages are saved in the Temporary Folder of PackageDescriber. Register
them to the Package Web Server as necessary.
 When a package is registered in the Package Web Server from the Register in/Delete from the
Package Web Server window, it will become downloadable to the Management Server.
The relationships among folders associated with PackageDescriber are illustrated in the diagram below.
Package Web Server

PD running machine
1)
2)

Create package
Modify package

Web shared folder
4) Package Web Server registration

Package folder

3) Delete package

5) Delete from Package
Web Server
Temporary save folder

Recycle bin
Recycle bin

Package ABC is described here as an example.
(1) When you create the package, PackageDescriber copies the specified package ABC folder (file) to a
PackageDescriber Temporary Folder.
(2) When you modify the package, PackageDescriber modifies the package ABC stored in the
PackageDescriber Temporary Folder.
(3) When you delete the package, PackageDescriber deletes the package ABC from the
PackageDescriber Temporary Folder.
(4) When you register the package ABC in the Package Web Server, PackageDescriber copies from the
PackageDescriber Temporary Folder to the Web shared folder.
(5) When you delete the package ABC from the Package Web Server, PackageDescriber deletes the
package ABC from the Web shared folder.
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<<Initial Setting>>
This section describes the initial Setting of PackageDescriber.
(1) From Start menu, select All Programs -> DPM PackageDescriber. PackageDescriber is started and the
Initial settings: Set Environment window appears.

(2) Click Browse on the Web shared folder, the folder selection dialog is displayed, specify the folder and
click Open.
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(3) The folder specified as the Web shared folder is displayed. Perform the same procedure to change the
Temporary Folder only if necessary.

(4) Click OK to save settings and close the Initial settings: Set Environment screen.
 If the Web shared folder is not set, the Management Server cannot automatically download
packages. Furthermore, the Web shared folder and the Temporary Folder cannot be
omitted.
 Confirm that the Web shared folder has Read and Write properties.
 The registered package will be stored in the Web shared folder. Be sure to secure enough
free space.
 If the shared folder of the network computer is specified as a Web shared folder, it is
recommended to assign a local drive to the shared folder beforehand. If a drive is not
assigned, the shared folder of the network computer may not be accessible.
 If the Web shared folder is changed, previously registered packages must be re-registered.
 The <PackageDescriber installation folder> cannot be specified in the Web shared
folder.
 The Temporary Folder and the Web shared folder cannot be specified in the same folder.
 Note the combination of the folder (normally the Temporary Folder) to store package and
the package ID.
In DPM, a folder having the name specified as the package ID is created under the folder
in which the package is saved, and the package is managed.
If a folder of the same package ID already exists, that folder is temporarily deleted and the
package is created. For this reason, do not specify a folder used for applications except
saving the package, such as system folders, as the folder in which the package is saved.
 The file cannot be specified in the Temporary Folder.
 The write access is required to specify the folder in the Temporary Folder.
 On Windows Vista, if UAC is enabled, take note of the following.
・ Change the Temporary Folder from its initial setting, because even users having
administrator right do not have write access for %ProgramFiles%.
・ The PDconfig file cannot be set manually.
・ When you install PackageDescriber in an environment where PackageDescriber has
been uninstalled, the Initial settings: Set Environment window may not be displayed.
In this case, modify the setting from Set Environment windows from Settings menu.
・ When PackageDescriber is first started after the UAC setting (enable/disable) has been
switched, re-set Web shared folder and Temporary Folder which was set before UAC
has changed.
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 The setting of Web shared folder can be changed from Set Environment of the
Settings menu.
 It may take time for PackageDescriber to start up.
 When the Web shared folder and Temporary Folder have been set and OK is
clicked, information is written into the PackSerFolder (Web shared folder) and
PackageSavePath (Temporary folder) of <PackageDescriber installation
folder>\PDconfig.
 Once the Web shared folder or Temporary Folder has been set and OK has been
clicked on the Initial settings: Set Environment window, the values are written into
PDconfig and please check the values from it.
 If PDconfig has been edited directly, please restart PackageDescriber.
After restart, the PDconfig settings will be reflected.
 The saved folder when creating package can be set in the Temporary Folder.
The default is <PackageDescriber installation folder>\Packages.
<<Environment Settings>>
This section describes how to configure the Package Web Server.
(1) Select Start, then select All Programs, then select DPM PackageDescriber to open PackageDescriber.
(2) Select Settings, then select Set Environment, and set the Web shared folder and Temporary Folder.

The Package Web Server shared folder cannot be set while the Register in/delete
from the Package Web Server window or Online update window is open.
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Environment Configuration
Web shared folder
Cannot be omitted. The folder specified during the initial setting is
displayed.
You can enter up to 259 characters. The allowed characters are numeric
characters and symbols.
If the Web shared folder is changed, previously registered packages must
be re-registered.
Temporary Folder
The folder specified during the initial setting is displayed.
You can enter up to 245 characters. The allowed characters numeric
characters and symbols.
Browse
Open the folder selection dialog box.
Packages that are not registered to the Package Web Server cannot be
automatically downloaded by the Management Server.
OK
Save the settings and closes the window. An error message appears if
the setting failed or the Web shared folder was not specified.
Cancel
Closes the window without saving settings.
 Confirm that the Web shared folder and Temporary Folder have Read and Write
attributes.
 The registered package will be stored in the Web shared folder and Temporary Folder.
Be sure to secure enough free space.
 If a network computer's shared folder is specified as the Web shared folder or
Temporary Folder, it is recommended to assign a local drive to the folder in advance. If
a drive is not assigned, the network computer's shared folder may not be accessible
(3) Click OK to close the Window. Packages registered in Register in/delete from the Package Web Server
window are all saved under the Web shared folder.
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6.2. Create Package
 If you register RUR(revision up release) module for Express 5800 Series as a package,
register it after confirming the installation manual of RUR necessarily.
 When you register the package of a service pack, which switches the firewall function from
disabled to enabled(Windows XP SP2 and so on), most ports are blocked when applying the
service pack and the Management Server cannot communicate with the managed machine.
Therefore, a scenario execution error will occur. In this case, open the port that DPM uses
by Port Opening Tool after removing the error. See Section 7.1, "Port Opening Tool" about
Port Opening Tool.
 When you register a service pack of SP2 or later as a package, there are some service
packs, which cannot be directly applied to the environment that a service pack is not applied,
by the specification of the service pack.
About the specification of the service pack, see the site of Microsoft Corporation and so on.
Example)
In the case of Windows Server 2008 SP2, SP1 needs to be already applied as the
condition that SP2 will be applied.(SP2 cannnot be directly applied to the environment
without SP.)
・ When creating a package, specify the following in registry condition of Dependency
information tab.
Key name: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT
\CurrentVersion
Name: CSDVersion
Conditions: Exists
・ When a package is distributed by the automatic update function, if there are multiple
packages of service packs on the Management Server, the package of the latest
service pack will be distributed.
As the above, the package will not be applied to the managed machine without SP by
the specification of the service pack.
If you want to apply SP2 to the managed machine without SP, distribute by either of
the following.
- The package of SP2 is not registered.
Distribute the required service pack(SP1) by the automatic update function. After
that, register SP2.
- The package of SP2 is already registered.
Distribute the required service pack(SP1) by the scenario. After that, SP2 will be
distributed by the automatic update function.

6.2.1.

Basic Information

This section describes how to enter basic package information.
Click the PackageDescriber File menu -> Create Package, the Create Package window is displayed in the main
window. Set the items on the Basic tab. The place (type) circled in red frame is settings that will vary depending
on the selected type.
If the type has been changed, Urgency and Execution Settings information are changed to the
default. Confirm it again.
• If the type was changed to Service Pack
Urgency is changed to Normal. Also, the Requires restarting after the installation and
Requires applying independently check boxes on the Execution settings tab are
automatically checked.
If multiple folders have been added to the folder to be copied, all folder settings are deleted
from the package.
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• If the type was changed to HotFix
Urgency is changed to High. Also, the Requires restarting after the installation and
Requires applying independently check boxes on the Execution Settings tab are
automatically cleared.
If multiple folders have been added to the folder to be copied, all folder settings are deleted
from the package.
• If the type was changed to Application
Urgency is changed to Normal. Also, the Requires restarting after the installation and
Requires applying independently check boxes on the Execution settings tab are
automatically cleared.
• If HotFix was selected as the type
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Basic
Package ID
(Required)

Company name

Release date

Package Summary

Type

Urgency

MS number

Enter the package ID.
It can be entered with numeric character, - (hyphen), and _ (underscore) up to 63
characters.
Do not include hexadecimal number characters (%0D, %0A, and so on) in the
package ID.
The package cannot be properly downloaded to the Management Server.
Enter the name of the company from which patches and applications were
issued.
Up to 127 characters can be entered. The allowed characters are numeric
characters and symbols.
Enter the date when the patch or application was released.
When you enter a date, use YYYY/MM/DD format.
If an invalid value is entered, it will automatically become blank.
Enter summary information of the package.
Up to 511 characters can be entered. The allowed characters are numeric
characters and symbols.
Select the package type. You can select from the following.
• HotFix
• Service Pack
• Application
The default is HotFix.
When the type is changed, the screen switches in accordance with the changed
type. (If the screen does not switch, change the type by using the mouse.)
If you change the type, the contents of the Urgency and the Execution Settings
are changed to the default.
Set the urgency of the package. You can select from the following four types.
• Highest
• High
• Normal
• Low
The default is Normal, but it is High only if the type is HotFix.
If a package is registered as an automatically updated package, set the urgency to
highest or high. (*1)
Enter the MS (KB) number pre-assigned to the service pack or HotFix issued by
Microsoft. Up to 31 characters can be entered. The allowed characters are numeric
characters.
Example) KB889293
Q819696
• If service pack was selected as the type, there is no need to enter the MS
number and ID information.
• In case of a Microsoft HotFix, the value entered in the MS number field is
compared with the MS number written in the registry (KBXXXXXX or QXXXXXX),
and if the two values match, it is judged that the HotFix has been applied. Enter
the correct value, including the "KB" or "Q." If a value is not entered in the MS
number field, the applied status is judged by the information of registry, the files,
and so on, entered in ID Information tab.
• When you create a package for a HotFix that does not write the MS number in the
registry, if letters that cannot be entered by PackageDescriber are included in the
MS number, ID information must be entered in order to perform automatic
updates.
• If both MS number and ID information are not entered for Microsoft's HotFix, the
HotFix will be excluded from the automatic update. When selecting the urgency
Highest or High, make sure to enter at least one of these fields
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*1

 The process will be different when the Management Server executes automatic download differs depending
on urgency type. See the following table.
Urgency
Highest

High

Power Status of
Computer
Power on

Process After Package Registration

Power off

An automatic update notice is immediately issued, but if the
power is off, automatic update cannot be performed. At the next
startup of computers, it is judged whether or not the package has
been applied based on information set in the package, and only
packages that have not been applied are distributed.
Automatic update is performed at the time specified by the
Management Server.
Automatic update is performed when the computer is started up
next time.
It is judged whether or not the package has been applied based
on information set in the package, and only packages that have
not been applied are distributed.
There is no distribution with the automatic update.
Create a scenario on the Management Server, and distribute it
manually.

Power on
Power off

Normal
Low

An automatic update notice is immediately issued.

 Other than urgency, the following items must be set in order to be a target of automatic updates. If they are
not set, there will be no distribution with automatic updates even if urgency is Highest or High. Create a
scenario on the Management Server, and distribute it.
• HotFix:MS number (or ID information)
• Service Pack:Major version and Minor version
• Application:Display name and Display version (or ID information)
 For a package with Highest urgency, an automatic update notice is issued to all computers whose operating
systems are target OS of the package. However, automatic updates are not performed on computers whose
power is off or whose automatic update notice is set to constantly off.
*2
If an invalid value is input for major version or minor version, it is corrected automatically.
In the case of a service pack, the major version and minor version must be entered. See the following
example.
Example) Windows Server 2008 and Windows 7
OS type
Service Pack
Major Version
SP1
1
Windows Server
2008
SP2
2
Windows 7
SP1
1
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Minor Version
0
0
0

• If Service Pack is selected as the type

Basic
Major version/Minor
version

If service pack was selected as the type, enter the major version and
minor version.
This can be set in the range of "0~65535".
In the case of a Microsoft service pack, the numbers entered in the
Major version and Minor version field are compared with the service
pack versions currently installed in the OS, and it is judged whether or
not the service pack has been applied. Make sure to enter the correct
numbers. (*2)
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• If Application is selected as the type

Basic
Display Name

Display Version

• If Application was selected as the type, enter the display name.
Up to 511 single-byte characters can be entered.
In order to register as a target package of automatic update, enter the
application name displayed in Programs and Features. (*3)
For applications not displayed in Programs and Features even after being
installed, enter the ID information. See Section 6.2.5, "ID Information" for
details.
• If application was selected as the type, enter the Display version.
Do not enter anything if the version number is not displayed in Programs
and Features.
In order to register as a target package of automatic update, enter the
version displayed in Programs and Features. (*3) Do not enter anything if
the version number is not displayed in Programs and Features.
Up to 126 numeric characters can be entered.
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*3
Example) Name and Version displayed in Programs and Features
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6.2.2.

Execution Setting Information

This section describes how to enter the execution setting information of package.
Click the PackageDescriber File menu -> Create package to display the Create package screen in the main
window. Set the items on the Execution settings tab.

Create package
Execution settings
Folder to be copied
Folder name

Browse
Add
Added folder

Delete

Specify the folder where the patch or application is stored.
Up to 255 characters.
Only single-byte alphanumeric characters can be used.
Click Browse, and select the folder where the patch or application is
stored.
Specify the Folder name and click Add to add it to the Added folder.
Displays the folders that were added.
• When the package type is Service Pack or HotFix, one folder can be
added.
• When the package type is Application, multiple folders can be added.
Click Delete, and delete the folder selected in Added folder.
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Install
Execution file
(Required)

Browse
Setup parameters

Requires restarting
after the installation
Requires applying
independently

Enter the execution file name.
Up to 255 characters.
Only single-byte alphanumeric characters can be used.
Do not specify a file names that includes %xx. A file with such a file
name cannot be properly downloaded to the Management Server.
"xx" indicates hexadecimal number 0 ~ f. Example: file%9d.exe
• For the Execution file, be sure to specify the one that all of the
following conditions are met.
- Silent install can be done. (You do not need to respond such as key
entry while the file is being executed, or you can execute silent install
by creating a batch file.)
- OS is not restarted during installation.
- Installation is possible by Local System account. (The network is not
accessed.)
- The total file size does not exceed 2GByte.
- When an executable file generates descendant processes
(executable file->child process-> grandchild process) in the
execution, generated child process finishes after grandchild process
finishes. Also, when an executable file is a script file such as bat or
sh, the executable file finishes after generated child process finishes.
Click Browse and select the execution file.
Set the setup parameters for the executable file.
Up to 128 single-byte characters can be entered. The allowed
characters are single-byte alphanumeric characters and symbols.
In the case of service pack or hotfix, specify two parameters: "Do not
restart after execution", and "Unattended mode" or "Quiet mode".
Example)
In the case of Windows Server 2008
・ Do not restart after execution: /norestart
・ Unattended mode: /unattend
・ Quiet mode: /quiet
About the parameter of service pack or hotfix, execute the file by
specifying "/h" or "-?" in advance and check the parameter.
When you specify Windows XP SP2 or SP3 and OEM specific driver is
installed, specify also "Execute processing without displaying the
command prompt"("-o").
Set this parameter to perform restart after the package is applied.
Effective when applying by automatic update type.
Set for patches or applications which need to be applied independently
(for example, service pack). When this check box is selected, restart is
performed automatically before application. Effective when applied by
automatic update type.
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 The registered service pack/hotfix/application is copied to an internal folder on the
Management Server. The amount of free space required for registration is
approximately twice of the amount of the service pack/hotfix/application to be
registered.
 The service packs/hotfixes/applications registered here are limited to those which are
silently installed and do not require restart after installation. (For those that display a
security warning screen due to digital signature information, a confirmation screen
appears on the managed machine when it is applied, and installation cannot continue.)
*Silent installation means that when an executable file (setup.exe or Update.exe) is
run, setup is performed automatically and you do not need to click Next or enter the
key.
*For service packs, hotfixes and so on that require a restart, register an image with the
option not to perform restart and set the Restart After Applying option in the
scenario.
A patch is registered in folder unit. Store only one patch in one folder.
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6.2.3.

Applicable OS and Language Information

This section describes how to enter the Applicable OS and language information for the created package.
Click the PackageDescriber File menu -> Create package to display the Create package screen in the main
window. Set the items on the Applicable OS and language tab.

Create package
Applicable OS and language
Select the OS to which the package is to be applied. Select the OS
OS
to which the package corresponds.
(Required)
If All OS is selected, all OS except Other OS are the targets. Also,
the package is applied to all machines without relating to OS
information.
Select the language of the OS to which the package is to be applied.
Language
(Required)
Add
Add the selected OS and Language.
Delete
Delete the selected OS and Language.
Set the base service pack to which service pack/hotfix/application
Base Service Pack
can be applied. Add or delete the service pack using Add or Delete
button.
Absorbing Service Pack Set the next service pack. Set this with the Base Service Pack. Add
or delete the service pack using Add or Delete button.
Example) If "Windows Server 2008 SP2" is selected as Base
Service Pack and "Windows Server 2008 SP3" is selected as
Absorbing Service Pack, the package will be applied to the
machine on which SP2 is applied and SP3 is not applied.
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6.2.4.

Dependency Information

This section describes how to configure the dependency information of a package.
When the package is applied, the dependency information is checked. The package is applied only when the
dependency conditions are met.
Specify the dependency condition from the following three types.
• Package dependency
• File dependency
• Registry dependency
If ">" is used in the registry dependency, it may not be applied properly.
If a combination of package dependency, file dependency and registry dependency has
been added, the package is applied only when the package dependencies are met and all
the conditions set optionally in file dependency or registry dependency are met.
Example)
If the package dependency is A, the file dependency is B and the registry dependency
is C, then the composite application condition is as follows.
Item Added
Application conditions
Composite
information
application
condition
A
1
All of 1, 2 and 3 are applied.
A is met, and
2
conditions set
in B and C are
3
all met
B
1
AND/OR can be optionally set.
C

2
1

Either condition of 1 or 2 is met.

2
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(1) Click the PackageDescriber File menu -> Create package to display the Create package screen in the
main window. On the Dependency information tab, check the Check the package dependencies
relationship while applying the package check box, and configure the various items.

Dependency information
The settings become valid when Check the package dependency
Check the package
relationship while applying the package check box is checked.
dependency
relationship while
applying the
package
Required packages Can be applied only if the package it depends on has been installed.
Dependent packages are selected from other packages registered in
PackageDescriber. Also, if multiple dependent packages have been added, the
package will be applied if all dependent packages have been applied.
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Add

Delete
Condition List
File Condition List

The Add package dependency screen appears when you click Add.

The packages displayed on the Add package dependency screen are those
currently registered on the Package Web Server. Select a dependent package
from the list and click Add.
When you select a package from the dependent package list and click Delete,
the dependent package is deleted.
Applying the package depends on the existence of either file. To specify a file
as a condition for applying package, select the File Condition List check box.
The dependency condition is judged only after Select Conditions is set. Only
when the File Condition List and Registry Condition List are added, it will
not be judged.
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Add

Modify
Delete

When you click Add, the Add file dependency information screen appears.
Configure each item and click OK.

• File path
Up to 259 single-byte characters can be entered. The allowed characters are
single-byte alphanumeric characters.
Specify the path registered in the registry in the File path.
Specify the full-path registry name surrounded by single-byte brackets ("{",
"}").
Example)
When specifying EXCEL.EXE under
C:\Program Files\Microsoft Office\Office
Assume that the value of
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Excel\Insta
llRoot\Path
is set as C:\Program Files\Microsoft Office\Office\.
In this case, specify
{HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.0\Excel\Inst
allRoot\Path}EXCEL.EXE
as the file path.
• File version
Only 31 single-byte characters can be entered. Enter in "x.x.x.x" format.
The allowed characters are single-byte alphanumeric characters/symbols ("."
only).
If a file version is not entered, the dependency condition is the existence of the
file.
The file version can be confirmed on the Version tab of file properties, but if
the Version tab does not exist, or if the File version item on the Version tab
is blank, you do not need to enter it.
If the File version is entered and Does not exist is set as a condition, the
condition is matched when entered version does not exist.
Example)
When "4.0.0.0" is entered as the file version and Does not exist is set as a
condition, the condition is met if the file with the version "3.0.0.0" or
"5.0.0.0" exists. If the file with the version "4.0.0.0" exists, the condition is
not matched.
• Condition
Select the package application conditions.
(*1)
When you select a file and click Modify, the Modify file dependency
information screen appears. Change the configuration.
When you select a file and click Delete, the dependent file is deleted.
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Registry
Condition List
Add

Modify
Delete

Applying the package depends on the existence of either registry. To specify a
registry as a dependency, check the Registry Condition List check box.
When you click Add, the Add Dependent Registry Information screen
appears. Configure each item and click OK.

• Key name
Enter the registry key name including the root key. Up to 255 single-byte
characters can be entered. Only single-byte alphanumeric characters can be
used.
• Name
Enter the value (ValueName) that belongs to the key name.
Up to 255 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
• Data
Enter the value data (ValueData). The allowed characters vary depending on
the type selecting in Type.
-"REG_SZ":Single-byte characters, up to 1024 single-byte characters
-"REG_BINARY":Single-byte characters, up to 1024 single-byte characters
-"REG_DWORD":Single-byte number from 0 to 4294967295
-"REG_QWORD":Single-byte number from 0 to 18446744073709551615
• Type
Select the value type (ValueType). You can select from the following.
-REG_SZ
-REG_BINARY
-REG_DWORD
-REG_QWORD
• Condition
Select the package application conditions.
If Exist is specified, only the key name and name are compared.
For REG_BINARY, only Does not exist, Exist and Exist (=) can be selected.
(*2)
When you select a registry and click Modify, the Modify registry dependency
information screen appears. Please change the configuration.
When you select a registry and click Delete, the dependent registry is deleted.
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*1

 When reading a package created with DPM Ver5.0 or earlier with this version, the conditions are
converted as follows.
DPM Ver5.0 or Earlier
Does not exist
Exists
(File version has been entered)
Exists
(File version has not been entered)

This Version
Does not exist
Exist (=)
Exist (Version Check does not Apply)

 The operations performed when the respective conditions have been specified are as shown below.
Set Value
File
Version
Not
specified

Managed Machine Status
File Exists (version is shown below)
1.0.0.0
2.0.0.0
3.0.0.0
None
No
No
No
No
Yes
Yes
Yes
Yes

Condition

Does not exist
Exists
(Version Check does not
Apply)
2.0.0.0
Does not exist
Yes
No
Yes
Yes
Exists(=)
No
Yes
No
No
Exists(<)
Yes
No
No
No
Exists (<=)
Yes
Yes
No
No
Exists(>)
No
No
Yes
No
Exists (>=)
No
Yes
Yes
No
(Yes: Dependency condition is met. No: Dependency condition is not met.)

File does not
exist
Yes
No

Yes
No
No
No
No
No

*2
 Key name, name and data are not case-sensitive.
 Data comparison with respect to REG_SZ is a simple character string comparison. In the case of
"9.0.0.0" and "10.0.0.0", "9.0.0.0" is judged greater.
 When reading a package created with DPM Ver5.0 or earlier with this version, the conditions are
displayed as follows.
DPM Ver5.0 or Earlier
Does not exist
Exists
(data has been entered)
Exists
(data has not been entered)

This Version
Does not exist
Exist (=)
Exist
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 The operations performed when the respective conditions have been specified are as shown below.
- When only the key name is specified
Set Value
Managed Machine Status
Condition
Exists
Does not exist
Does not exist
No
Yes
Exists
Yes
No
(Yes: Dependency condition is met. No: Dependency condition is not met.)
- When the name is specified
• REG_SZ
Set Value
Data
Condition
Blank

Does not exist

Managed Machine Status
Name Exists
1.0.0.0
2.0.0.0
3.0.0.0
No
No
No

Blank
No

Exists
Yes
Yes
Yes
Yes
Does not exist
Yes
No
Yes
Yes
Exists (=)
No
Yes
No
No
Exists (<)
Yes
No
No
Yes
Exists (<=)
Yes
Yes
No
Yes
Exists (>)
No
No
Yes
No
Exists (>=)
No
Yes
Yes
No
(Yes: Dependency condition is met. No: Dependency condition is not met.)
2.0.0.0

• REG_BINARY
Set Value
Data
Condition
Blank

Does not exist

Managed Machine Status
Name Exists
AA
BB
CC
No
No
No

None
No

Exists
Yes
Yes
Yes
Yes
Does not exist
Yes
No
Yes
Yes
Exists (=)
No
Yes
No
No
(Yes: Dependency condition is met. No: Dependency condition is not met.)
BB
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Name does
not exist
Yes
No
Yes
No
No
No
No
No

Name does
not exist
Yes
No
Yes
No

• REG_DWORD
Set Value
Data
Condition

Managed Machine Status
Name Exists
Name does not exist
1
2
3
Blank
Does not exist
No
No
No
Yes
Exists
Yes
Yes
Yes
No
2
Does not exist
Yes
No
Yes
Yes
Exists (=)
No
Yes
No
No
Exists (<)
Yes
No
No
No
No
Exists (<=)
Yes
Yes
No
No
Exists (>)
No
No
Yes
No
Exists (>=)
No
Yes
Yes
(Yes: Dependency condition is met. No: Dependency condition is not met.)
• REG_QWORD
Set Value
Data
Condition

Managed Machine Status
Name Exists
Name does not exist
1
2
3
Blank
Does not exist
No
No
No
Yes
Exists
Yes
Yes
Yes
No
2
Does not exist
Yes
No
Yes
Yes
Exists (=)
No
Yes
No
No
Exists (<)
Yes
No
No
No
No
Exists (<=)
Yes
Yes
No
No
Exists (>)
No
No
Yes
No
Exists (>=)
No
Yes
Yes
(Yes: Dependency condition is met. No: Dependency condition is not met.)
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(2) After configuring the File Condition List and Registry Condition List of the Condition List group box, click
Select Conditions and configure the conditions.

 Conditions used in an AND/OR condition cannot be deleted.
 For the file condition below the deleting condition, if the registry condition is
specified with AND, OR, this condition cannot be deleted.
Example)
When the third file condition is used AND, OR, the first and second file
condition cannot be deleted
1)

The Select Conditions screen appears, and then click Add.
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The Condition Number is treated as "and" conditions, and the condition separated by
pipes ("|") is treated as "or" conditions.
2)

The OR Condition Specification screen appears. Specify "and" and "or" of the conditions.
By selecting file conditions or registry conditions and clicking ">>", you can add "or" condition to Condition
Items.
If you want to delete the "or" condition that you added to Condition Items, click "<<".

6.2.5.

ID Information

This section describes how to configure the ID information of a package you are creating.
It is judged whether or not a package has been applied to a managed machine using the ID information.
File and registry changes occurring due to the fact that a package was installed are entered as ID information.
Example)
Package A is registered, and distributed to managed machines.
1) Before distribution : Which patches have been installed as of now?
How was file information or the registry affected?
2) After distribution : When package A is distributed, in what way will the files
and registry change?
The difference information obtained by comparing 1) / 2) is registered as ID information.
In DPM, it judges the package application situation based on the ID information specified here. If all entered file
change information and registry change information is met, it is judged that the package was applied.
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 If the created package file is a service pack or hotfix issued by Microsoft, even if no ID
information was entered, the MS number entered on the Basic tab is compared with
the MS number written in the registry (KBXXXXXX or QXXXXXX), and if the two
values match, it is judged that the package has been applied.
 If the created package is a service pack issued by Microsoft, even if no ID information
was entered, the major version and minor version entered on the Basic tab are
compared with the service pack version currently installed in the OS, and it is judged
whether or not the service pack has been applied.
 ID information needs to be entered in the case of applying a package that does not
have an MS number or MS number cannot be identified, or a package that the
information remains only in the registry and so on.
(1) Click the PackageDescriber File menu -> Create Package to display the Create Package screen in the
main window. Set the items on the ID Information tab.
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ID Information
File change information

Add

Modify
Delete
Registry change
information

Used when judging whether a package was applied based on
change information occurring in the file system because the
package was applied.
When you click Add, the Add file information screen appears.
Add the file ID information of the package.

• File path
Enter the changed file path and file name. Up to 259 single-byte
characters can be entered.
Only single-byte alphanumeric characters can be used.
As the file path may vary depending on the usage environment,
enter the system environment variables. (See Section 6.2.4,
"Dependency Information" -> "File Condition List" -> "Add" for
examples of input.)
• File version
Enter the file version. Only 31 single-byte characters can be
entered.
The allowed characters are single-byte alphanumeric
characters/symbols ("." only).
If the file version is not entered, the existence of the file is an
identification condition.
The file version can be confirmed on the Version tab of File
Properties, but if the Version tab does not exist, or if the File
Version item on the Version tab is blank, there is no need to
enter it.
• Change type
Set the change type. You can select from the following.
・ Create new: Select when newly produced by application of
the package.
・ Replace: Select when unconditionally overwritten by
application of the package.
・ Version up: Select when it can be overwritten only when
newer than the existing file by application of the package.
・ Delete: Select when deleted by application of the package.
(*1)
When you select a file and click Modify, the Modify file
information screen appears. Modify the configuration.
When you select a file and click Delete, the file is deleted.
Used when judging whether a package was applied based on
registry information that was changed because the package was
applied.
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Add

Modify
Delete

When you click Add, the Add registry information screen
appears. Add the registry ID information of the package.

• Key Name
Enter the registry key name including the root key. Up to 255
single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
• Name
Enter the value (ValueName) associated with the key name.
Up to 255 single-byte characters can be entered.
Only single-byte alphanumeric characters can be used.
• Data
Enter the value data (ValueData). The allowed characters vary
/characters kinds depending on the type selected in Type.
-"REG_SZ":Up to 1024 single-byte characters
-"REG_BINARY":Up to 1024 single-byte characters
-"REG_DWORD":Single-byte number from 0 to 4294967295
-"REG_QWORD":Single-byte number from 0 to
18446744073709551615
• Type
Select the value type (ValueType). You can select from the
following.
-REG_SZ
-REG_BINARY
-REG_DWORD
-REG_QWORD
• Change type
Set the change type. You can select from the following.
- Create new: Select when newly produced by application of
the package.
- Replace: Select when unconditionally overwritten by
application of the package.
- Delete: Select when deleted by application of the package.
(*2)
Modify registry ID information of the added package.
Delete registry ID information of the added package.
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*1
 The operations performed when the respective conditions have been specified are as shown below.
Set Value
File
Version
Unspecified

2.0.0.0

Condition
Create new
Replace
Version up
Delete
Create new
Replace

Managed Machine Status
File Exists (version is shown below)
1.0.0.0
2.0.0.0
3.0.0.0
None
Yes
Yes
Yes
Yes
No
No
No
Yes

File does not exist
No
No

No
No
Yes

No
No
Yes

No
No
Yes

Yes
No
Yes

No
Yes
No

No

Yes

No

No

No

Version up
No
Yes
Yes
No
Delete
No
No
No
No
(Yes: Identification condition is met. No: Identification condition is not met.)

No
Yes

*2
 The operations performed when the respective conditions have been specified are as shown below.
1) When only the key name is specified
Set Value
Managed Machine Status
Condition
Exists
Does not exist
Create new
Yes
No
Delete
No
Yes
(Yes: Identification condition is met. No: Identification condition is not met.)
2) When the name is specified
• REG_SZ
Set Value
Data
Condition

Managed Machine Status
Name Exists
1.0.0.0
2.0.0.0
3.0.0.0

Blank

Blank

Name does not
exist

Create new Yes
Yes
Yes
Yes
No
Replace
No
No
No
Yes
No
Delete
No
No
No
No
Yes
2.0.0.0
Create new Yes
Yes
Yes
Yes
No
Replace
No
Yes
No
No
No
Delete
No
No
No
No
Yes
(Yes: Identification condition is met. No: Identification condition is not met.)
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• REG_BINARY
Set Value
Data
Condition

Blank

BB

Create new
Replace
Delete
Create new
Replace

Managed Machine Status
Name Exists
AA
BB
CC

None

Yes
No
No
Yes
No

Yes
Yes
No
Yes
No

Yes
No
No
Yes
Yes

Yes
No
No
Yes
No

Delete
No
No
No
No
(Yes: Identification condition is met. No: Identification condition is not met.)

Name
Does not
exist
No
No
Yes
No
No
Yes

• REG_DWORD
Set Value
Data
Condition

Managed Machine Status
Name Exists
Name
Does not exist
1
2
3
Create new
Blank
Yes
Yes
Yes
No
Replace
No
No
No
No
Delete
No
No
No
Yes
Create new
2
Yes
Yes
Yes
No
Replace
No
Yes
No
No
Delete
No
No
No
Yes
(Yes: Identification condition is met. No: Identification condition is not met.)

• REG_QWORD
Set Value
Data
Condition
Blank

2

Create new
Replace
Delete
Create new

Managed Machine Status
Name Exists
1
2
3
Yes
Yes
Yes
No
No
No
No
No
No
Yes
Yes
Yes

Name
Does not exist
No
No
Yes
No

Replace
No
Yes
No
No
Delete
No
No
No
Yes
(Yes: Identification condition is met. No: Identification condition is not met.)
(2) When you click OK after entering the necessary information, the package information file is created.
When you click Cancel, all entered information is discarded and the Create package screen is closed.
Input of the information necessary for package creation is completed.
Click the OK on the Create package screen to create the package.
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6.3. Modify/Delete Package
This section describes how to modify or delete a created package.
(1) Click the PackageDescriber File menu ->Modify/delete package to display the Local package list screen,
and click Select Folder.

The sort order of packages can be changed by clicking on a column heading on
the Local package list screen.
(2) The Select Folder dialog box appears. Select the folder of the package you modify or delete and click
Open.

(3) The packages in the folder specified on the Local package list screen are displayed. Select a package,
and modify or delete it.
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(4) In the case of modification, the Save screen is opened after modification. Select the folder to be saved and
click Save.





The package list initially displayed on the Local package list screen is the
package list of the folder specified as the Temporary folder.
File Name and File Type: All files are displayed on the screen. Select a folder.
When saving a folder in a folder except the Temporary folder, check that
packages having the same package ID do not exist in that folder so as not to
accidentally overwrite backup packages.

(5) Select a package from the Local package list screen and perform modification or deletion.
Local package list
Modify
Delete
Close

When you click Modify, the Modify package screen opens.
When you click Delete, the selected package is deleted.
When you click Close, the screen closes.
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(6) Click Modify on the Local package list screen to display the Modify package screen. Modify the items on
the Basic, Execution Settings, Applicable OS and language, Dependency information and ID
information tabs.

If you modify a package that was already added to the Package Web Server, click File
menu ->Register in/Delete from the Package Web Server -> Register/Re-register.
See Section 6.4, "Registration and Deletion in Package Web Server," for details.
The Package ID and Type on the Basic tab cannot be modified.
See Section 6.2.1, "Basic Information," through Section 6.2.5, "ID Information," for a
description of each tab.
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6.4. Registration and Deletion in Package Web
Server
This section describes how to register or delete a created package on the Package Web Server.
Created packages can be automatically downloaded from the Management Server by registering them on the
Package Web Server.
When registering a package on the Package Web Server, perform operations after
stopping the HTTP service.
Example) •World Wide Web Publishing Service(IIS)
•Apache Tomcat
Packages not registered on the Package Web Server cannot be automatically
downloaded from the Management Server.
(1) Click the PackageDescriber File menu -> Register in/Delete from the Package Web Server to display
the Register in/Delete from the Package Web Server screen.
Packages registered on the Package Web Server are displayed on the Register in/Delete from the
Package Web Server screen.
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Register in/Delete from the Package Web Server
Register/Re-regist When you click Register/Re-register, the Local package list screen
appears. See the procedure of item (2) regarding the Local package list
screen.
The package is deleted from the Package Web Server.
Delete
If you select the package to delete and click Delete, a confirmation screen
appears. To delete, click Yes.
If the package selected for deletion is dependent on another package, the
following confirmation screen appears. To delete, click Yes. Otherwise,
click No.

(2) When you click Register/Re-register, the Local package list screen appears. Click Select Folder and
select a folder from the Open dialog box, and register or re-register the package on the Package Web
Server.
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Local package list
Select Folder

Add

Cancel

The folder of the package you wish to register or re-register can be
selected and changed on the Local package list screen. See Section
6.3, "Modify/Delete Package," for details.
If you select the package you register and click Add, the package is
copied to the Web Server folder and registered on the Package Web
Server.
It is also displayed on the Register in/Delete from the Package Web
Server screen.
When re-registering a package, if that package is dependent on
another package, the following confirmation screen appears. To
re-register, click Yes. Otherwise, click No.

An error message will be displayed if the selected package does not
exist.
Click Cancel to end the operation and close the Local package list
screen.
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6.5. Online Update
When a new service pack is released for the OS that DPM supports (for example, when SP3 was released for
Windows Server 2003), the OS definition file and language definition file must be updated and the new service
pack information must be added.
PackageDescriber downloads the latest definition files from the DPM product site and updates them using the
Online update function.
By using this function, the correct information files can be created in patches and applications released in the
future as well.
The information for using this function (OS information URL column and Language information URL column)
is currently blank. When this function becomes available, the information will be provided on the product site.
The following describes how to perform online updates.
(1) Select Start -> All Programs -> DPM PackageDescriber, and start PackageDescriber.
(2) Click the PackageDescriber Help menu -> Online update to display the Online update screen, fill in
each item, and click Update.
The online update is started and the status and the result of the online update are displayed in the
Description.
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Online update
OS information URL
Language information URL
Proxy (check box)

Proxy

Port
Update
Save & Close

Enter the public URL of the OS definition file. There is no
need to change it from the default value.
Enter the public URL of the language definition file. There is
no need to change it from the default value.
Select this check box when accessing the DPM website via
a proxy server.
It does not have to be selected when connecting directly to
the Internet.
Enter the address of the proxy server. Up to 259
single-bytes can be entered.
If you have checked the Proxy check box, the domain name
or IP address must be entered.
Specify the port number of the proxy server.
This can be set in the range of "1~65535".
Download and save files from the entered OS information
URL and language information URL.
Saves the OS information URL and language information
URL to a file and Closes the screen.

If you do not know the proxy server and port number, please contact the administrator.
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7.

Other Tools

This chapter explains the tools used in DPM.

7.1. Port Opening Tool
Port Opening Tool is a tool to open the ports or programs used by DPM when Windows firewall is enabled.
The ports or programs are opened automatically by this tool when installing DPM Server or DPM Client.
Also, you can open the ports or programs by this tool after installing DPM Server or DPM Client. (when you
switch the firewall function to enabled, and so on.)

7.1.1.

Port Number Setting

For Management Server and managed machines, see the corresponding part below about the configuration of
port numbers/programs when the firewall is enabled.
• Management Server
If you operate DPM, enabling the firewall, the following ports or programs used by DPM are automatically
opened.
<The ports which are opened automatically>
Item
Ports used by DPM Server

Protocol
TCP

Port Number

UDP

apiserv.exe

TCP

bkressvc.exe

UDP

bkressvc.exe

TCP

depssvc.exe

UDP

depssvc.exe

TCP

ftsvc.exe

UDP

ftsvc.exe

TCP

pxemtftp.exe

UDP

pxemtftp.exe

TCP

pxesvc.exe

UDP

pxesvc.exe

TCP

rupdssvc.exe

UDP

rupdssvc.exe

TCP

schwatch.exe

UDP

schwatch.exe

apiserv.exe

<The ports which are not opened automatically>
The following ports are not opened by Port Opening Tool automatically.
Protocol
Port Number
TCP
Ports used by DPM Server
80
* When the port number is changed from 80 (Default), replace it.
Item
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• Managed machines
When you operate DPM, enabling the firewall on the managed machine, the following ports or programs used
by DPM are automatically opened.
Item

Protocol

Port Number

Check Power Status

ICMP

Remote Update
Automatic Update
Displaying file/folder list
Shutdown

TCP
UDP

8 (Echo
incoming)
rupdsvc.exe
rupdsvc.exe

TCP
UDP

DepAgent.exe
DepAgent.exe

 When the following services are stopped, ports or programs cannot be opened by Port
Opening Tool.
・ Windows Firewall/Internet Connection Sharing(ICS)
・ Windows Firewall
On Windows Server 2003 SP1/SP2 or Windows Server 2003 R2, these services are
disabled by default. Execute Port Opening Tool after starting the services.
 Using the DPM remote update function, Port Opening Tool cannot be used on
machines whose ports have not been opened.
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7.1.2.

Executing the Tool on Each Machine

This section describes how to use Port Opening Tool on the Management Server and managed machines.
To execute Port Opening Tool, DPM Server needs to be installed in the Management
Server and DPM Client needs to be installed in the managed machine.
(1) Insert the Installation media into the DVD drive of the machine on which you use Port Opening Tool.
(2) Start the command prompt and execute the command as follows.
- The Management Server
D:\TOOLS\OPENPORT\DepOpnPt.exe -m
- The managed machine
D:\TOOLS\OPENPORT\DepOpnPt.exe -c
(D: indicates the DVD drive.)
If "-s" is specified as a command option, it can be executed in silent mode
without messages being displayed.
Example) In case of the managed machine
D:\TOOLS\OPENPORT\DepOpnPt.exe -s -c
(D: indicates the DVD drive.)
(3) A confirmation screen appears. Click OK to open ports.

Port opening is completed.
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7.2. Disk Configuration Check Tool
This section describes the disk configuration check tool.
The disk configuration check tool checks the HDD configuration information (number of HDDs and partition
configuration) of managed machines via the network.
(The items that can be confirmed)
• Number of HDDs
• Partition configuration (file system, partition size)
• Disk management method (basic/dynamic/GPT)
• Disk number and partition number specified for backup/restore
 When executing backup/restore, check the disk number of the HDD to be used by
this function, and specify an appropriate value as the disk number of the
backup/restore scenario.
 In the default configuration of Disk Viewer, all hidden partitions are not displayed.
Therefore, the partition configuration on the managed machine displayed by the
OS and by Disk Viewer may differ.
 The disk size and partition size displayed by Disk Viewer and by the managed
machine may differ.
 When a disk configuration check scenario is executed for a disk which has been
converted to a dynamic disk from a basic disk on which partitions were not
created, it is displayed by Disk Viewer as a basic disk of 0GByte.
 The disk configuration and partition configuration that can be checked by the disk
configuration check scenario has the same limitations as backup/restore. For
details, see Section 2.2.2, "Regarding Backup/Restore" in First Step Guide and
"Support for File System and Disk Type" in Appendix A, "Function Tables."
It does not result in a scenario execution error if disk or partition recognition fails
due to this limitation.

7.2.1.

Creating a Scenario

There are two ways to execute the disk configuration check scenario, as follows:
• Use System_DiskProbe scenario which is already ready.
In this case, use the existing System_DiskProbe by seeing Section 7.2.2, "Assigning the Scenario."
• Use a newly created disk configuration check scenario.
In this case, create a new disk configuration check scenario by seeing Section 3.13.4, "Backup/Restore
Tab."



A disk configuration check scenario cannot be specified with except Options tab
at the same time.
Even if the Hidden Partition Is Disregarded in the Partition Setting group box
of the Backup/Restore tab of the scenario is selected, the hidden partition is
counted.
When checking the disk number (the partition number) by Disk Viewer, select the
Display menu -> A hidden partition is disregarded on Disk Viewer and switch
the display of the hidden partition.
See Section 7.2.5, "Checking the Disk Number (Partition Number)" about Disk
Viewer.
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7.2.2.

Assigning the Scenario

The following describes how to assign the scenario.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> Machine Group.
(3) The Managed Machine List group box appears in the main window. Click Managed Machine to which
the scenario is to be assigned.
(4) In the Operation menu, click Assign Scenario.
(5) The Assign Scenario screen appears in the main window. Assign the scenario created in Section 7.2.1,
"Creating a Scenario." See Section 3.8.3, "Assign Scenario." for details about Assign Scenario
screen.

The System_DiskProbe scenario is stored in the Built-in Scenarios scenario group.

7.2.3.

Executing the Scenario

The following describes how to execute the Disk Configuration Check scenario.
See Section 3.8.6, "Execute Scenario" regarding how to execute the scenario.
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In the Scenario Execution List group box in the main window, when the Status column corresponding to the
managed machine that executed the scenario indicates Scenario execution complete, the scenario is
completed.

The Disk Configuration Check scenario results are stored in the following folder.
Folder
: <Folder for Image>\probe
File name : probe_MAC Address.log
* The MAC address is that of the LAN board on the target machine.
Example) C:\Deploy\probe\probe_001122334455.log
The Folder for Image can be set from Management view –> DPM Server –> Configuration
menu –> Detail Setting. See Section 2.7.1.1, "General Tab" regarding the screen.
If the power of the managed machine is on when you attempt to execute the scenario, the
scenario will not run. If this happens, perform one of the following operations:
• On the Edit Scenario screen, place a checkmark next to Forced Execution Of A
Reboot Is Performed Before Execution in the Scenario Execution Option Setting
group box on the Option tab.
* If the Windows managed machine has the following status, you cannot restart,
even if you select the Forced Execution Of A Reboot Is Performed Before
Execution checkbox.
- The machine is locked by a workstation lock
- The machine is locked by a password protected screensaver
- The machine is connected from a remote desktop, terminal service, or
other remote connection software
- The machine has data that is currently being edited or an application that
will not respond to a shutdown request
• Reboot the managed machine manually.

7.2.4.

Checking the Result of the Scenario

This section describes how to check the Disk Configuration Check scenario execution results.
(1) On the Web Console, click Operations in the title bar to switch to the Operations view.
(2) In the tree view, click Resource -> Machines -> Machine group for checking disk configuration
check scenario execution results.
(3) The Machine List group box appears in the main window. Check the execution results of the disk
configuration check scenario from Status.
When you click the Status column, the Monitor view – Scenario Execution List group
box appears. See Section 4.3, "Scenario Execution List" regarding the screen.
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7.2.5.

Checking the Disk Number (Partition Number)

This section describes how to check the disk number (partition number) by Disk Viewer.
(1) From the Start menu, select All Programs -> DeploymentManager -> Disk Viewer.
When Disk Viewer reads a file, it retains the content. For this reason, if a file has been
read, the disk number (partition number) of the file read the previous time appears
when Disk Viewer starts up.
Menu Bar

Disk List

Disk List / Partition List

Item Descriptions
Menu bar

Reads and saves log files, switches between disk
list/partition list display, and switches to hidden partition
display.

Disk list

Displays the disk list of the target machine.

Disk list/Partition list

Displays a disk list or a partition list of the disk selected on
the disk list on the top of the screen.
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(2) After starting Disk Viewer, click File menu -> Read.
(3) Open the disk information file stored in the folder below.
Storage folder: <Folder for Image>\probe

(4) When the selected disk information file is read, the disk number (partition number) of the managed
machine is displayed.

(5) On the Display menu of Disk Viewer, click List of Partitions.
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(6) The partition list of the disk selected on the disk list appears on the bottom of the screen.

(7) From the information displayed in the disk size, partition size and partition list, compare the disk numbers
and partition numbers that are subject to backup/restore.
In DPM Disk Viewer, partition numbers are allocated in the following order.
It may differ from the display order of partitions displayed by Windows Disk Management.
• Primary partition
• Extended partition logical drive
Example) Disk device is as below
Extension partition
Primary
partition (C:)

Partition
no. 1

Logical drive (D:)

Partition
no. 3

Logical drive (E:)

Partition
no. 4

Primary
partition (F:)

Partition
no. 2

The display on Disk Viewer is as below
Partition 1
Primary
partition (C:)

Partition 2

Partition 3

Partition 4

Primary
partition (F:)

Logical drive (D:)

Logical drive (E:)
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(8) Based on the results of comparison, check the disk numbers and partition numbers in the
Backup/Restore scenarios.
Example)
When checking the disk numbers and partition numbers in the Backup scenario

The number assigned to the partition number
(1~1000) for the scenario file.

The number assigned to the disk number (1~1000) for the scenario file.
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 The number specified in partition Number may differ depending on the contents
set in Operation view -> Add Scenario screen -> Backup/Restore tab –>
Backup/Restore Target group box. To check the partition number specified,
switch between display/non-display of hidden partitions from Disk Viewer Display
menu -> A hidden partition is disregarded.
 The results displayed by Disk Viewer can be saved in a separate file. The saved file
can also be read in again.
To save a file, click Save from the File menu of Disk Viewer. The Save As screen
appears. Specify the save location and file name.

<Folder for Image>\Probe\Probe.dat is a file written as a temporary file in Disk
Viewer. Do not specify it for reading.
The extension of the saved file is automatically set to .dat.
(9) To close Disk Viewer, click Exit from the File menu of Disk Viewer, or click x button on the top right of the
window.
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7.3. Automatic Update Status Display Tool
The Automatic Update Status Display Tool displays the automatic update status as an icon in the task tray of the
managed machine.
The Automatic Update Status Display Tool cannot be used for the following managed
machines.
・ x64 Edition(Windows Server 2003/Windows XP only) remote desktop
・ Windows Server 2008(Server Core Installation)
・ Windows Server 2012(Server Core Installation)
・ Linux OS
The icons displayed in the task tray are shown in the table below.
Icon

Managed Machine Status
Ready

Automatically Updating

Transferring Automatic
Update File
Confirming Automatic
Update User
Waiting for Automatic
Update Restart

Applying an Automatic
Update Package
(Package ID)
Running Scenario
Automatic Update Error

Description
This appears when automatic update and scenario
execution are not being performed. (The icon at left
also appears when there is a scenario execution
error.
This appears after automatic update begins, while
the package to be applied is searched for and
judged.
This appears when transferring an automatic
update file to a managed machine.
This appears when the Run Immediately or Run
at Next Start Up dialog box appears.
This appears under any of the following conditions:
• Waiting for restart after Execute At Next Start
Up is set
• Waiting for restart after Cancel is clicked in
Restart dialog
This appears when applying an automatic update
package.
The package ID is also displayed.
This appears when a scenario is running.
This appears when an error has occurred in the
automatic update.

A popup hint appears when you hover over an icon with the mouse pointer.
The menu of the Client Setting Tool and About DeploymentManager can be used by right-clicking an icon.
See Section 7.3.1, "Client Setting Tool," through Section 7.3.2, "About DeploymentManager," regarding these
menus.
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7.3.1.

Client Setting Tool

Configure display/non-display of the Automatic Update Status Display Tool.
(1) Right-click the Automatic Update Status Display Tool icon.
(2) Select Client Configuration from the displayed menu.
Or, from the Start menu, select All Programs -> DeploymentManager -> Client Setting Tool to display
the Client Setting Tool.
(3) The Client Setting Tool appears. Configure whether or not to display the Client Automatic Update
Status Display Tool icon, and click OK.

7.3.2.

About DeploymentManager

If you right-click the Automatic Update Status Display Tool icon and select About DeploymentManager, the
version of DPM Client is displayed.

7.4. Backup Image File Verification Tool
The Backup Image File Verification Tool is for checking before restoring whether a backup file is incorrect and
can be restored properly.
This section describes how to use the Backup Image File Verification Tool.
(1) From the Start menu of DPM Server, select All Programs -> DeploymentManager -> Backup image file
verification tool.
(2) The following screen appears. Select Refer, select the backup file you want to check, and click Verify.

(3) Until checking of the backup file is completed, wait a moment.
A dialog box appears. Click OK.
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8.

DPM Command Line

This chapter explains DPM Command Line.

8.1. Operation from DPM Command Line
Using DPM Command Line (dpmcmd.exe), you can view managed machine information, execute scenarios, and
perform other tasks from the command line instead of the Web Console. Command options are described in the
following table.
 Explains how to execute commands from DPM Command Line:
(1) Start the command prompt from the machine where DPM Server or DPM Command Line is installed.
(2) On the command prompt, move to the folder where DPM Command Line is installed.
(3) Specify dpmcmd.exe and the options listed in the table below, and then execute.
Options
srvlist
clilist
snrlist
powon
shutdown
assign
snrexec
snrstop
progress
stsclear
cliadd
cliremove
liclist
?, /?, /help

Function
Displays DPM Server.
Displays the managed machine List, managed machine Details.
Displays the Scenario List.
Powers On.
Shuts down.
Assigns Scenario/Remove Scenario Assignment.
Executes Scenario.
Interrupts the Scenario Execution.
Displays the Scenario Execution Status.
Clears the Status.
Registers managed machines.
Deletes managed machines.
Displays the license information.
Displays Help.

While the command is running, do not operate to stop the command forcibly as
the followings. The command may end abnormally.
・ Entering Ctrl + Break key
・ Closing the command prompt.
・ Log off
・ Shutdown
The default installation folder is:
C:\Program Files\NEC\DeploymentManager
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 The command options are explained below.
Option
"DPM Server"
(Required)
"DPM Server(2)"

"Managed
Machine (Client)"
or /M "MAC
Address"
(Required in the
option using the
managed
machine)

"Scenario"
(Required in the
option specifying
the scenario)
"Password"
(Required in the
option specifying
the password)
/S

/P "Web Port"

/A
(Required when
assigning a
scenario)

Meaning
Specify the IP address of DPM Server or the DNS name of DPM Server.
Specify the IP address of DPM Server or the DNS name of DPM Server.
This option is for backward compatibility of script files to execute DPM
Command Line, which was created in the version earlier than DPM Ver6.0.
This option can be omitted for DPM Ver6.0 or later.
Specify the managed machine (client) or the MAC address.
The Identification Name or the machine name can be specified in the Managed
Machine (Client).
In the description about each command in this chapter, when Managed
Machine (Client) or /M "MAC Address" is specified, it is described as:
"Managed Machine (Client)" | /M "MAC Address". Specify MAC address with
hyphen.
Example)
/M "00-03-ff-00-65-11"
When the Identification Name of the managed machine is the same with the
machine name of another managed machine, the command is executed for the
machine that the Identification Name is matched.
When the machine name is duplicated, the command cannot be executed.
In that case, specify by the Identification Name or /M "MAC Address".
Specify the scenario name for the scenario registered on DPM Server.

Specify the password for the deployment_user registered on DPM Server. The
initial password is "dpmmgr".

Specify to communicate by HTTPS.
If this option is omitted, it is communicated by HTTP.
This option can be omitted.
Specify the http/https port (1 – 65535) used by DPM Server (IIS).
If this option is omitted, the following port is used.
・ If /S is not specified -> IIS default "80"
・ If /S is specified -> IIS default "443"
This option can be omitted.
Specify when assigning a scenario.
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/U
(Required when
removing scenario
assignment)
/W "Wait Time"

/NAME "Managed
Machine (Client)
Name"

/I "Identification
Name"

/IP "IP Address"

/D "Deploy-OS
ID"

/DNAME
"Deploy-OS
Display Name"

Specify when removing scenario assignment.

Specify to wait for scenario execution to complete.
The command exits if the scenario execution completes within the specified
time, or the scenario execution error occurs, or the specified time is exceeded.
Specify 0 – 360 (unit: minutes) for Wait Time.
If "0" is specified, the command waits until the completion of scenario execution.
If this option is omitted, the command does not wait for the completion of the
scenario execution and exits immediately.
This option can be omitted.
Specify the machine name of the managed machine (client) registered on DPM
Server.
Up to 63 single-bytes can be entered.
You cannot enter managed machine (client) names containing only numerals or
the following symbols and single-byte spaces:
.,;`~%!@#$^&*=+{}\|:'"<>/?[]
This option can be omitted.
When registering a machine, you can specify with /M "MAC Address".
Specify the Identification Name of the managed machine (client) registered on
DPM Server.
Up to 63 single-bytes can be entered.
You cannot enter the Identification Name containing only numerals or the
following symbols and single-byte spaces:
.,;`~%!@#$^&*=+{}\|:'"<>/?[]
This option can be omitted.
The Identification Name cannot be duplicated. An error occurs if you specify the
Identification Name, which is already registered.
Specify the IP address of the managed machine (client) registered on DPM
Server.
Single-bytes number can be entered. Enter by the format "xxx.xxx.xxx.xxx".
This option can be omitted.
IP address cannot be duplicated. An error occurs if you specify IP address,
which is already registered.
When there are multiple IP addresses on the managed machine, enter the IP
address communicating with DPM Server.
Specify the kernel ID of Deploy-OS to be used by the managed machine when
executing backup/restore/disk configuration check.
Up to 256 single-bytes can be entered.
This option can be omitted.
When you use this option, specify with /DNAME.
Specify the display name of the kernel of Deploy-OS to be used by the managed
machine when executing backup/restore/disk configuration check.
Up to 256 single-bytes can be entered.
This option can be omitted.
When you use this option, specify with /D.
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/G "Group Path"
(Required in the
option specifying
the group path)

/F

/GW "Default
Gateway"

/MASK "Subnet
Mask"

/ASSIGN
"Scenario Name"

Specify the full path of the group to which the specified managed machine
(client) belongs.
Maximum number of the layer of the group path is 20.
Describe "/"(single-byte slash) to separate the layer of the group.
1 - 64 single-byte characters can be entered for the group name of each layer.
The allowed characters are single-byte alphanumeric characters. The following
symbol cannot be entered:
;
If there is not a machine group in the specified path, a machine group is
automatically created. (*1)
Example)
/G "/Group1/SubGroup1"
Specify this option when you configure the gateway and the subnet mask of the
machine group, which is created automatically. The configuration of the group,
which is already created, is not modified. If you do not specify /F, the setting, that
the group is in the same network with DPM Server, is configured for created
group.
You can specify /F with /GW and /MASK. If you specify only /F and omit /GW
and /MASK, the configuration of the gateway and the subnet mask for created
group is inherited from the parent group. When you specify the group directly
under the root, the group will be one, which is in the same network with DPM
Server.
Specify when setting the default gateway of the group registered on DPM
Server.
・ If /F is not specified, you do not need to specify this.
・ If group network settings and DPM Server have the same subnet mask, you
do not need to specify this.
This option can be omitted.
Specify when setting the subnet mask of the group registered on DPM Server.
・ If /F is not specified, you do not need to specify this.
・ If group network settings and DPM Server have the same subnet mask, you
do not need to specify this.
This option can be omitted.
Specify the name of the scenario to assign to the machine when registering the
managed machine.
This option can be omitted.

(*1)
The way to specify the registered group is changed from DPM Ver6.02 and later.
(The version earlier than DPM Ver6.02)
The name of the machine group to which the machine belong directly
(DPM Ver6.02 and later)
The path name of the machine group to which the machine is registered
Therefore, when using the script (including the description of DPM Command Line) which was created in
the version earlier than DPM Ver6.02, re-examine the script as to describe the path name of the group. If
you specify only the group name, it is recognized as the group directly under the root. When the group is
not found, a group is created directly under the root.
To specify the option that includes spaces, such as a DPM Server name or scenario
name, enclose them in double quotation marks ("). When the option does not include
spaces, the double quotation marks (") can be omitted.
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 Options that do not need to be specified are enclosed by square brackets ("[" and
"]") in the command descriptions of this Section.
 If a command successfully executes, the return value is "0".

8.1.1.

Display DPM Server

Displays the specified DPM Server's IP address and machine name. Command details are listed in the table
below.
Command
Function
Results Display

8.1.2.

dpmcmd.exe "DPM Server" srvlist [/S] [/P "Web Port"]
Obtains and displays the DPM Server IP address and machine name.
Normal
Displays the DPM Server IP address and DPM Server name.
Abnormal
Displays error message.

Display Managed Machine List and Managed Machine Details

Display a list of information regarding the managed machine (client) registered to the specified DPM Server or
details about the specified managed machine (client). Command details are listed in the table below.
Command

dpmcmd.exe "DPM Server" ["DPM Server(2)"] clilist [/S] [/P "Web Port"]

Function

Displays all machine information (Identification Name or the machine
name/MAC address/power status/status/assigned scenario) under the
specified DPM Server.
Normal
Display managed machine (client) information in a list.
Abnormal
Display error message.

Results Display

Command
Function

Results Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] clilist [/S] [/P "Web Port"]
"Managed Machine (Client)" | /M "MAC Address"
Displays information (Identification Name/the machine name/OS name/
service pack/assigned scenario/the power status/status/UUID/MAC
address/IP address/Deploy-OS) for the specified machine.
When multiple managed machines (client) are registered by the same
machine name, all the corresponding machines are displayed.
If the specified managed machine (client) does not exist, an error is displayed.
Normal
The details for the specified managed machine (client) are
displayed.
Abnormal
Displays error message.
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8.1.3.

Display Scenario List

Displays a scenario list. Command details are listed in the table below.
Command

dpmcmd.exe "DPM Server" ["DPM Server(2)"] snrlist [/S] [/P "Web Port"]

Function
Results Display

Displays all scenario information under the specified DPM Server.
Normal
A scenario list is displayed.
Abnormal Displays error message.

Scenario configuration information is as follows:
・ HW -> HW image
・ OS -> OS clear install
・ SP -> Service pack/ HotFix/ Linux patch file
・ PP -> Application
・ BK -> Backup
・ RS -> Restore
・ DC -> Disk Configuration Check
For each scenario, "1" is displayed if setting items are specified, and "0" is displayed if not.
Example)
C:\>dpmcmd 192.168.32.1 snrlist
Scenario Name Specified Function
HW OS SP PP BK RS DC
---------------------------------------------------------

8.1.4.

Scenario 01

1

0

0

0 0

0

0

Scenario 02

1

1

1

0 0

0

0

Scenario 03

1

1

0

1 1

0

0

Scenario 04

0

0

0

0 1

0

0

Scenario 05

0

0

0

0 0

1

0

Scenario 06

0

0

0

0 0

0

1

Power On

Turns on the power of the specified managed machine (client). Command details are listed in the table below.
Command
Function
Results
Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] powon [/S] [/P "Web Port"] "Managed
Machine (Client)" | /M "MAC Address" "Password"
Turn on the power of a specified machine.
If the specified managed machine (client) or password is incorrect, an error is displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.
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Managed machines in the following statuses cannot be turned on. Please re-execute
after performing 8.1.10 Status Clear.
・ Scenario Execution Stop
・ Scenario Execution Error
・ Remote Power ON Error

8.1.5.

Shutdown

Shuts down the specified managed machine. Command details are listed in the table below.
Command
Function

Results
Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] shutdown [/S] [/P "Web Port"]
"Managed Machine (Client)" | /M "MAC Address" "Password"
Shuts down the specified machine.
If the specified managed machine (client) or password is incorrect, an error is
displayed.
Normal
Nothing is displayed.
Abnormal Displays error message.
 managed machines in the following statuses cannot be shut down. Please re-execute
after performing 8.1.10 Status Clear.
・ Scenario Execution Stop
・ Scenario Execution Error
・ Remote Power ON Error
For Scenario Executing, please wait until the scenario completes and then execute.
 On the Web Console, the power status of managed machines controlled by
DianaScope is on at the moment the power is turned on.
However, if a shutdown command is executed in the time after OS startup and before
DPM Client startup, an error occurs and shutdown fails.
Ensure the managed machine's OS is running before executing a shutdown
command.

8.1.6.

Assign Scenario/Remove Scenario Assignment

Assigns scenario and remove scenario assignment for the specified managed machine. Command details are
listed in the table below.
Command

dpmcmd.exe "DPM Server" ["DPM Server(2)"] assign [/S] [/P "Web Port"] /A
"Managed Machine (Client)" | /M "MAC Address" "Password" "Scenario"

Function

Assigns a specified scenario to a specified managed machine (client).
If the specified managed machine (client), scenario, or password is incorrect, an error
is displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.

Results
Display
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Command

dpmcmd.exe "DPM Server" ["DPM Server(2)"] assign [/S] [/P "Web Port"] /U
"Managed Machine (Client)" | /M "MAC Address" "Password"
Function
Removes the assigned scenario from the specified managed machine (client).
If the specified managed machine (client) or password is incorrect, an error is
displayed.
Results Display Normal
Nothing is displayed.
Abnormal
Displays error message.
managed machines in the following statuses cannot assign or remove a scenario. Please
re-execute after performing 8.1.10 Status Clear.
・ Scenario Execution Stop
・ Scenario Execution Error
・ Executing Remote Update
・ Remote Power ON Error
For Scenario Executing, please wait until the scenario completes and then execute.

8.1.7.

Execute Scenario

Executes scenario for the specified managed machine. Command details are listed in the table below.
Command
Function

Results
Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] snrexec [/S] [/P "Web Port"] [/W "Wait
Time"] "Managed Machine (Client)" | /M "MAC Address" "Password"
Executes the assigned scenario for the specified managed machine (client).
If the specified managed machine (client) or password is incorrect, an error is displayed.
If there is no scenario assigned to a specified managed machine (client), an error is displayed.
Normal
If /W option is specified, the scenario execution results are displayed on the
screen.
If /W option was not specified, nothing is displayed.
If results are not returned within the time specified in /W option, Scenario
Executing is displayed.
Abnormal Displays error message.
managed machines in the following statuses cannot execute scenarios. Please re-execute
after performing 8.1.10 Status Clear.
・ Scenario Execution Stop
・ Scenario Execution Error
・ Executing Remote Update
・ Remote Power ON Error
For Scenario Executing, please wait until the scenario completes and then execute.
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8.1.8.

Interrupt Scenario Execution

Interrupts execution of a scenario for a specified managed machine. Command details are listed in the table
below.
Command
Function

Results Display




dpmcmd.exe "DPM Server" ["DPM Server(2)"] snrstop [/S] [/P "Web Port"]
"Managed Machine (Client)" | /M "MAC Address" "Password"
Interrupts the execution of a scenario on the specified managed machine (client).
If the specified managed machine (client) or password is incorrect, an error is
displayed.
If the status of the specified managed machine (client) is not executing scenario, an
error is displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.

The managed machine that scenario execution stop was executed is powered off at
the timing of PXE boot after running scenario is stopped.
When a scenario is executed on the managed machine over Machines For
Simultaneous Execution, the processing of the scenario execution stop may be
executed, after the processing of the execution is started on the machine, depending
on the timing.

Scenario execution cannot be interrupted on managed machines in the following statuses.
・ The scenario is being not executed.
・ Scenario Execution Stop
・ Remote Power ON Error
・ Scenario Execution Error

8.1.9.

Display Scenario Execution Status

Displays scenario execution status for the specified DPM Server. Command details are listed in the table below.
Command
Function
Results Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] progress [/S] [/P "Web Port"]
Displays the machine name of the managed machine (client) executing a scenario,
the scenario name, and percentage rate of progress.
Normal
Displays the scenario execution status.
Abnormal
Displays error message.

8.1.10. Status Clear
Clears the specified managed machine error. Command details are listed in the table below.
Command
Function
Results Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] stsclear [/S] [/P "Web Port"]
"Managed Machine (Client)" | /M "MAC Address"
Clears the specified managed machine (client) error.
If the specified managed machine (client) is incorrect, an error is displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.
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An error status indicates one of the states below.
・ Remote Power ON Error
・ Scenario Execution Error
・ Scenario Execution Stop

8.1.11. Register Managed Machine
Registers the specified managed machine. Command details are listed in the table below.
Command

Function

Results Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] cliadd [/S] [/P "Web Port"] /M
"MAC Address" [/NAME "Managed Machine (Client) Name"] [/I "Identification
Name"] [/IP "IP Address"] [/D "Deploy-OS ID"] [/DNAME "Deploy-OS Display
Name"] /G "Group Path" [/F /GW "Default Gateway" /MASK "Subnet Mask"]
[/ASSIGN "Scenario Name"] "Password"
Registers the specified managed machine (client).
If the specified managed machine (client) or password is incorrect, an error is
displayed.
If the specified scenario is not registered on DPM Server, an error is displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.

8.1.12. Delete Managed Machine
Deletes the specified managed machine (client). Command details are listed in the table below.
Command
Function

Results Display

dpmcmd.exe "DPM Server" ["DPM Server(2)"] cliremove [/S] [/P "Web Port"]
"Managed Machine (Client)" | /M "MAC Address" "Password"
Deletes the specified managed machine (client).
If the specified managed machine (client) or password is incorrect, an error is
displayed.
Normal
Nothing is displayed.
Abnormal
Displays error message.

Machine Delete cannot be performed for clients in the following statuses:
・ Scenario Executing
・ Scenario Execution Stop
・ Remote Power ON Error
・ Scenario Execution Error
・ Automatic Update In Progress
・ Transferring Files(Automatic Update)
・ Setting Automatic Update Time
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8.1.13. Display License Information
Displays the list and the information of licenses which are registered on the specified DPM Server. Command
details are listed in the table below.
Command
Function
Results Display

dpmcmd.exe "DPM Server" liclist [/S] [/P "Web Port"] "Password"
Displays the list and the information of licenses which are registered on the
specified DPM Server.
Normal
Displays the list and the information of licenses.
Abnormal
Displays error message.

For SSC product, the license information is not displayed because DPM license is
included in the SSC product.

8.1.14. Help
Displays Help. Command details are listed in the table below.
Command
Function
Results Display

dpmcmd.exe ? | /? | /help
dpmcmd.exe "DPM Server" ["DPM Server(2)"] ? | /? | /help
Displays Help.
Normal
Displays Help.
Abnormal
--

Detailed help information for a command can be displayed if a help command is added to the
end of that command.
・ srvlist
・ clilist
・ snrlist
・ powon
・ shutdown
・ assign
・ snrexec
・ snrstop
・ progress
・ stsclear
・ cliadd
・ cliremove
・ liclist
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9.

Maintenance

This chapter explains the information about the maintenance of DPM.

9.1. Procedure to Change the IP Address of the
Management Server
Explains the procedure to change the IP address of the Management Server on which DPM Server is installed
while you operate DPM.
If procedures are not followed, DPM Server cannot work properly.
When changing the IP address and network configuration at the same time, see Section
3.5.1, "Edit Machine Group" and modify also the Network Setting of each group.
 If ANY is selected in IP Address of Management View -> DPM Server icon -> Detail Setting screen ->
General tab on the Web Console.
(1) End all DPM related processes.
(2) Change IP address of the Management Server.
(3) Restart the Management Server.
(4) Restart managed machines.
 If an option except ANY is selected
(1) End all DPM related processes.
(2) Insert the installation media in the DVD drive of the Management Server.
(3) Execute the following file in the installation media.
For SSC product:
<Installation media>:\DPM\TOOLS\IP\<Machine architecture>\RegSet1.reg
For DPM unbundled product:
<Installation media>:\TOOLS\IP\<Machine architecture>\RegSet1.reg
* The name of <Machine architecture> folder is as the following.
In the case of x86: IA32
In the case of x64: AMD64
Example)
<Installation media>:\DPM\TOOLS\IP\IA32\RegSet1.reg
(4) The following screen appears. Click Yes.
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(5) The following screen appears. Click OK.

(6) Change IP address of the Management Server.
(7) Restart the Management Server.
(8) Select the IP address to be used by the Management Server from Management View -> DPM Server
icon -> Detail Setting screen -> General tab -> IP Address on the Web Console and click OK.
(9) Execute the following file in the installation media.
For SSC product:
<Installation media>:\DPM\TOOLS\IP\<Machine architecture>\RegSet2.reg
For DPM unbundled product:
<Installation media>:\TOOLS\IP\<Machine architecture>\RegSet2.reg
* The name of <Machine architecture> folder is as the following.
In the case of x86: IA32
In the case of x64: AMD64
Example)
<Installation media>:\DPM\TOOLS\IP\IA32\RegSet2.reg
When you configure the cooperation of TFTP service between DPM Server and
MasterScope Network Manager, execute the following RegTFTP1.reg. About the screen
image in the following procedure, replace the description.
For SSC product:
<Installation media>:\DPM\TOOLS\TFTP\<Machine architecture>\RegTFTP1.reg
For DPM unbundled product:
<Installation media>:\TOOLS\TFTP\<Machine architecture>\RegTFTP1.reg
* The name of <Machine architecture> folder is as the following.
In the case of x86: IA32
In the case of x64: AMD64
Example)
<Installation media>:\DPM\TOOLS\TFTP\IA32\RegTFTP1.reg
(10) The following screen appears. Click Yes.
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(11) The following screen appears. Click OK.

(12) Restart managed machines.
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9.2. Procedure to Change the IP Address of the
Database Server
Explains the procedure to change the IP address of the Database Server while you operate DPM.
(1) End all DPM related processes.
(2) Stop all services whose names begin with "DeploymentManager" from Start menu -> Management Tools ->
Services on the Management Server.
(3) Change the IP address on the Database Server.
(4) Select Run from Start menu on the Management Server. Enter "regedit" in the name of the program to
execute and click OK.
(5) Registry editor is started. Change the value in the Name of the following registry to the changed IP address of
the Database Server .
・ Key:
- When OS is x86
HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager
- When OS is x64
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager
・ Name: DBSrvIPAddress
(6) Start ODBC Data Source Administrator screen following the procedure below.
- When OS is x86
From Start menu, select Management Tools -> Data Source(ODBC).
- When OS is x64
1) From Start menu, select Run. Enter "%WINDIR%\SysWOW64\cmd.exe" and click OK.
2) The command prompt appears. Execute %WINDIR%\SysWOW64\odbcad32.exe" on the
command prompt.
(7) ODBC Data Source Administrator screen appears. After selecting System DNS tab, select DPM from the
list of System Data Source and click Configure.
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(8) The following screen appears. Select the Database Server in Server of Which SQL Server do you want to
connect to? and change it to IP address.Port of the Database Server after changing\Instance name and
click Finish.

(9) Start all services which were stopped in (2) on the Management Server.

9.3. Procedure to Change the IP Address of the
Managed Machine
If a managed machine's IP address is changed, the Management Server is notified automatically. It is not
necessary to do further action.
However, when changing Management Server's IP address and managed machine's IP address at the same
time, the Management Server is not notified automatically. In this case, see "Upgrading DPM Client by
installation media" in Section 3.3.2, "Manually Upgrading the DPM Client" in Installation Guide to reconfigure the
Management Server's IP address in DPM Client.
Also, when DPM Client is not installed in the managed machine, the Management Server is not notified. In this
case, see Section 3.7.2, "Edit Managed Machine" to reconfigure IP address information of the managed
machine.
It is recommended that you execute the backup scenario after changing IP address of the managed machine. If
you restore the backup image before changing the IP address, the content of the disk is return to the original
when executing the backup and IP address will be one before changing it.

9.4. Data Backup Plan
9.4.1.

Procedure to Backup the Data

Explains the procedure to backup the data while you operate DPM.
(1) Log on to the Management Server as a user with Administrator authority.
(2) When you changed detailed settings of DPM Server after installing DPM Server, select Management view ->
DPM Server icon -> Detailed Setting on the Web Console and note the setting values.
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(3) End all DPM related processes.
Confirm the followings.
・ No scenario is running (If a scenario is running, wait until the scenario completes.)
・ DPM Web Console and DPM tools are not running
(4) From Start menu, select Administrative Tools -> Services and stop all services whose names begin with
"DeploymentManager".
(5) Backup the data.
Backup the following data.
・ All files under <DPM Server installation folder>\Datafile
・ All files under <DPM Server installation folder>\Linux
・ All files under <DPM Server installation folder>\Log
・ <DPM Server installation folder>\WebServer\App_Data\Data
- Encypted.dat
- DpmProfile.xml
The default installation folder of DPM Server is:
"C:\Program Files\NEC\DeploymentManager".
・ All files under Folder for Image
Select Management view -> DPM Server -> Detail Setting -> General tab on the Web
Console and confirm Folder for Image of Image Setting. The default of Folder for
Image is "C:\Deploy".
・ All files under Folder for Backup Image
Select Management view -> DPM Server -> Detail Setting -> General tab on the Web
Console and confirm Folder for Backup Image of Image Setting. The default of
Folder for Backup Image is "C:\DeployBackup".
・ The following folders under TFTP root(folders and all files under folders)
- backup
- DOSFD
- EFI64
- EFIBC
- EFIIA32
- gpxelinux
- HW
- HW64
- hwinfo
- kernel
- NBP
- probe
- pxelinux
- pxelinux.cfg
- nbprestvar.ini
- Port.ini
When you configure the cooperation of TFTP service between DPM Server and
MasterScope Network Manager, seeing Appendix F, "Configuring DPM Server and
MasterScope Network Manager on the Same Machine" in Installation Guide, TFTP
root is TFTP root folder of MasterScope Network Manager.
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The default of TFTP root is
"C:\Program Files\NEC\DeploymentManager\PXE\Images".
・ Others
Files or registries when you changed them manually
(6) Backup the database.
Enter the following backup command on the command prompt, and then extract the backup file
(DPM.bak).
When you configure the Database Server, execute the following on the Database Server.
sqlcmd.exe -E -S localhost\Instance name
BACKUP DATABASE DPM
TO DISK='DPM.bak'
WITH INIT
GO
Example)
sqlcmd.exe -E -S localhost\DPMDBI
BACKUP DATABASE DPM
TO DISK='DPM.bak'
WITH INIT
GO
 The database name is "DPM".(Fixed)
 A backup file (DPM.bak) is created in the following folder:
<Microsoft SQL Server installation folder>\Backup
The default of <Microsoft SQL Server installation folder> is
C:\Program Files\Microsoft SQL Server\MSSQL11.Instance name\MSSQL
(7) Backup the registry data.
・ DPM Server
By executing the following command on the command prompt, extract the backup file
(RegExportDPM.reg).
(The following command is described in two lines. Enter it by one line in the actual screen.)
・ When OS is x86
regedit /e RegExportDPM.reg "HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager"
・ When OS is x64
regedit /e RegExportDPM.reg "HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC
\DeploymentManager"
・ Database
By executing the following command on the command prompt, extract the backup file
(RegExportDPMDB.reg).
When you configure the Database Server, execute the following on the Database Server.
(The following command is described in two lines. Enter it by one line in the actual screen.)
・ When OS is x86
regedit /e RegExportDPMDB.reg "HKEY_LOCAL_MACHINE\SOFTWARE\NEC
\DeploymentManager_DB"
・ When OS is x64
regedit /e RegExportDPMDB.reg "HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC
\DeploymentManager_DB"
Backup files(RegExportDPM.reg and RegExportDPMDB.reg) will be created in
the folder where the command is executed.
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(8) Start all services that were stopped in step (4).
The backup of data updated while you operate DPM is completed.

9.4.2.

Procedure to Recover the Data

Recover the DPM environment by the data which were backed up in Section 9.4.1, "Procedure to Backup the
Data", following the procedure below.
(1) Log on to the Management Server as a user with Administrator authority.
(2) Install DPM Server and configure the detailed setting.
・ When you install DPM Server and recover
Install DPM server(and configure the detailed setting), following the description below.
- Installation Guide
- Setting values that you noted when you installed DPM Server
If there are setting values that you noted in (2) of Section 9.4.1, "Procedure to Backup the Data" about
the setting in Detailed Setting screen displayed when installing DPM Server, enter the values.
・ When you only recover by the data in the environment that DPM Server is already installed.
Configure the setting values that you noted in (2) of Section 9.4.1, "Procedure to Backup the Data", in
Management view -> DPM Server icon -> Detailed Setting on the Web Console.
If you have not changed the detailed setting after installing DPM Server, configure the setting that you
noted when installing DPM Server.
(3) From Start menu, select Administrative Tools -> Services and stop all services whose names begin with
"DeploymentManager".
(4) Overwrite the same folder or file path as when you backed up by the backup data that were collected in step
(5) of Section 9.4.1, "Procedure to Backup the Data".
Also, configure the noted setting when there are the setting that you noted in (5) Others of Section 9.4.1,
"Procedure to Backup the Data."
(5) Overwrite by the backup file of the database that had been collected in step (6) of Section 9.4.1, "Procedure
to Backup the Data", in the same folder path as when you backed up.
When you configure the Database Server, execute the following on the Database Server.
(6) Confirm the configuration of the database.
When you configure the Database Server, execute the following on the Database Server.
1) From Explorer and so on, display the property of DPM.bak and confirm whether there is a user whose
name begins with "MSSQL$Instance name" on Security tab.
2) Click Detailed Setting tab, and if there is a user whose name begins with "MSSQL$Instance name" in
1), confirm whether the Include inheritable permissions from this object's parent checkbox is
selected.
If there is not a user whose name begins with "MSSQL$Instance name" in 1), select the Include
inheritable permissions from this object's parent checkbox. (If this checkbox is selected, a user
whose name begins with " MSSQL$Instance name" will be added to the Security tab.)
(7) Start the command prompt, and then execute the following command.
When you configure the Database Server, execute the following on the Database Server.
sqlcmd.exe -E -S localhost\Instance name
RESTORE DATABASE DPM
FROM DISK = 'DPM.bak'
WITH REPLACE
GO
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Example)
sqlcmd.exe -E -S localhost\DPMDBI
RESTORE DATABASE DPM
FROM DISK = 'DPM.bak'
WITH REPLACE
GO
(8) Apply the backup file of the registry data extracted in (7) of Section 9.4.1, "Procedure to Backup the Data"
on the machine that you backed up. (Double-click from Explorer.)
(9) Start all services that were stopped in step (3).
(10) Start the command prompt and execute the following command.
iisreset /restart
The restoration of DPM data is completed.

9.5. Procedure to Change the Port Used by DPM
The section explains the procedure to change the port used by DPM.
 If you do not follow the procedure, the Management Server and managed machines
do not work properly.
 When you change the port used by ftsvc.exe (TCP:26508) following this procedure,
specify the same port in the Setting Connection screen of Image Builder (Remote
Console).
 When you install DPM Server of this version newly, DPM Client of the version earlier
than DPM Ver6.1 cannot be upgraded automatically.
Execute the either of the followings.
・ Before you install DPM Server newly, set the port, which was used before
upgrading, in Port.ini following the procedure in this section.
・ After you installed DPM Server newly, upgrade DPM Client by a scenario, seeing
Section 3.3.2, "Manually Upgrading the DPM Client" in Installation Guide. (It takes
about 20 minutes until the scenario is completed.)
 The master image for OS installation by disk duplication, created in the version earlier
than DPM Ver6.1, cannot be used in the environment that DPM Server of this version
is installed newly. Re-create a master image in this version, or set the port, which was
used before upgrading, in Port.ini following the procedure in this section, before you
install DPM Server newly.
The default values of the ports to be used differ in the version earlier than DPM Ver6.1.
For details of the port number, see Appendix D, "Network Port and Protocol List."
 The procedure to change the port before installing DPM Server newly.
(1) Copy the following file to %SystemDrive%(Default C:)\DPMPort\.
For SSC product: <Installation media>:\DPM\Setup\DPM\Port.ini
For DPM unbundled product: <Installation media>:\Setup\DPM\Port.ini
(2) Specify the port to use in the copied file and save the file.
(3) Install DPM Server newly.
When you upgrade DPM Server, the ports, which were used before upgrading, are taken
over.
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 The procedure to change the port after installing DPM Server.
Execute the following procedure in the Management Server.
(1) End the processing relating to DPM.
(2) Edit <DPM Server installation folder>\PXE\Images\Port.ini.
When you change the port for Web Service (Default:26500), modify the following line in
<DPM Server installation folder>\WebServer\App_Data\Config\MgrServerList.xml.
<Port>The port to change</Port>
(3) Restart the Management Server.
(4) Restart managed machines.

10. Precautions
This chapter explains precautions about DPM.

10.1. Notes for Device and Storage
10.1.1. The Module for the Machine Model
The module for the machine model is an update module that enables the machine model, not supported by
Deploy-OS bundled with the product, to be used as managed machines.
For notes about the module for the machine model, contact your sales or support representative.

10.2. Notes when You Change the Computer Name
(the Host Name) of the Management Server and
the Managed Machine
You can change the computer name (the host name) on the OS of the Management Server and the managed
machine at any timing.
When you use the host name in the URL on the Web Console, change it to match with the computer name of the
Management Server,
When you changed the computer name (the host name) of the managed machine, if you restore the backup
image before changing the computer name (the host name), the content of the disk is returned to the original
status when executing the backup and the computer name (the host name) will be one before changing it. It is
recommended that you execute the backup after changing the name.

10.3. Notes when You Change the User Name/the
Password on the OS of the Management Server
and the Managed Machine
When you change the user name/the password on the OS of the Management Server and the managed machine,
it does not affect the operation later.
However, if you restore the backup image before changing the user name/the password on the OS of the
managed machine, the content of the disk is returned to the original status when executing the backup and the
user name/the password will be one before changing it. It is recommended that you execute the backup after
changing the user name/the password.
427

10.4. Notes for OS Clear Installation
When you cannot set up NFS server, you can execute OS clear installation of Red Hat Enterprise Linux 6 by
setting up FTP/HTTP server on the Management Server.
This chapter explains notes about the case. Explains as the folder for image has the following configuration.
Management Server(IP address:192.168.0.1)
Folder for image
AnsFile\
Linux\
Boot parameter file
exports\
ks\
Install parameter file
Boot directory (Boot directory name: RHEL6)
Install image
daemon\
・ Seeing Section 3.5.1, "Creating and Registering an Image" in Operation Guide, create and register an image.
Replace as the following about Section 3.5.1.1, 'Setting up NFS Service".
Seeing manuals of FTP/HTTP server and so on, set "exports" folder under Folder for Image set on the Web
Console as the virtual directory of FTP/HTTP server after configuring FTP/HTTP server,
・ Perform the followings before the procedure of Section 3.5.2, "Creating a Scenario."
- Open the boot parameter file by text editor and so on and modify the description of the file
server(underlined) following the environment, seeing the following example.
Example)
Before modification:
append initrd= RHEL6/initrd.img ks=nfs:192.168.0.1:/exports/ks/ks.cfg ksdevice=eth0
After modification:
- In the case of FTP server
append initrd= RHEL6/initrd.img ks=ftp://192.168.0.1/exports/ks/ks.cfg ksdevice=eth0
- In the case of HTTP server
append initrd= RHEL6/initrd.img ks=http://192.168.0.1/exports/ks/ks.cfg ksdevice=eth0
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- Open the install parameter file by text editor and so on, modify the description of the file server(underlined)
following the environment, seeing the following example.
Example)
Before modification:
...
nfs --server 192.168.0.1 --dir /exports/RHEL6
...
#Mount /mnt/exports
mkdir /mnt
mkdir /mnt/exports
/bin/mount -o nolock -t nfs $NFSSERVER:/exports /mnt/exports
...
After modification:
- In the case of FTP server
...
url –url ftp://192.168.0.1/exports/RHEL6
...
#Mount /mnt/exports
mkdir /mnt
mkdir /mnt/exports
cd /mnt/exports
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagt
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagtd
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagtd.res
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depcancel
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst.res
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst.sh
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/dpmversion.inf
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/GetBootServerIP
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/getinfo.sh
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/server.inf
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/xdpmmsg
...
- In the case of HTTP server
...
url –url http://192.168.0.1/exports/RHEL6
...
#Mount /mnt/exports
mkdir /mnt
mkdir /mnt/exports
cd /mnt/exports
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagt
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagtd
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagtd.res
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depcancel
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst.res
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst.sh
wget http://192.168.0.1/exports/daemon/redhatall/ia32/dpmversion.inf
wget http://192.168.0.1/exports/daemon/redhatall/ia32/GetBootServerIP
wget http://192.168.0.1/exports/daemon/redhatall/ia32/getinfo.sh
wget http://192.168.0.1/exports/daemon/redhatall/ia32/server.inf
wget http://192.168.0.1/exports/daemon/redhatall/ia32/xdpmmsg
...
- Mount ISO file for installation of Red Hat Enterprise Linux 6 and copy all the contents in ISO to the boot
directory.

429

11. Troubleshooting
This chapter explains how to handle when the problem occurs on DPM.

11.1. Web Console
When you click Detail under HotFix/Application on the Machine Detail screen, the
HotFix/Application List screen items are not displayed.
To manage the managed machine in this version, DPM Client for this version must be
installed on the managed machine. If it is already installed, reinstall. About the installation, see
Section 2.2, "Installing the DPM Client" in Installation Guide.
From Start menu on the managed machine, select Administrative Tools -> Services, and
confirm that DeploymentManager Agent Service and DeploymentManager Remote
Update Service Client are running.
The screen Socket error has occurred. is displayed when you update information. Or, the following
message is displayed as detailed information:
No connection could be made because the target machine actively refused it. Management Server IP
address:26500
The Management Server may be shut down. From Start menu, select Administrative Tools
-> Services and confirm that all of the services listed in " DPM Server" in Appendix A,
"Services List" in Reference Guide are running.
If the service is stopped, start all of the services that are not running. Furthermore, try to
reconnect to Management Server after services started.
If you start the Web Console from the Web browser, error The Page cannot be displayed appears.
One of the following is possible:
The URL to start the Web Console may be incorrect. Confirm that the URL is correct.
The Web Server may not be running. From Start menu, select Administrative Tools ->
Internet Information Services (IIS) Manager, and confirm that Default Web Site is running.
The user authority of all Web Consoles on the same machine will be the same with the authority of
the user who logged in last.
This is because of the effect by the session sharing function of Internet Explorer.
When you have an access to the same site in multiple windows/tabs(In the case of Internet
Explorer 7, it is only tab), the authority of all sessions will be the same with one of the session
of the window(tab) which was opened last.
By the following method, separate the user authority on each window(tab).
・ In case of Internet Explorer 8/9(compatibility mode)
Select File -> New Session in DPM Web Console.
・ In case of Internet Explorer 7
Open another window.
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Start the Web Console on Windows Server 2003 and the following message is displayed each time
the screen switches.

Click OK.
Something is wrong with the display of the error message.
If you use an HTML tag (<xx>) for a computer name or group name etc, the entered text is
interpreted as HTML syntax and may not be properly displayed in the error message.
However, operations are not affected.
Even if you start the Web Console from the Web browser, nothing is displayed on the Web browser.
The following is possible :
・ From Tools menu -> Internet Options in Internet Explorer, select Trusted Sites on the
Security tab. After clicking Sites, add a URL which connects to the Management Server.
Example) If the Management Server IP address is 192.168.2.41
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If you start the Web Console on Windows Server 2003, the following message is displayed:

Confirm that the URL is not wrong, and then click Add and add the Web site to the Trusted
Sites zone.
You performed one of the following operations, but the File Download screen is not displayed, and
you could not download CSV files.
・ On the Monitor view -> Scenario Execution Result List -> Scenario Execution Result List
screen, click Save In CSV in Operation menu.
・ On the Monitor view -> Automatic Update Result List -> Automatic Update Result List
screen, click Save In CSV in Operation menu.
・ On the Operations view -> Group List screen, click Export Machine Data in Configuration
menu.
Check Internet Explorer's security settings.
Select the Internet Explorer Tools menu -> Internet Options, then click Security tab ->
Security
level for this zone -> Custom level button, and configure as follows:
・ Set Enable from Downloads – File download.
・ Set Enable from Downloads – Automatically prompting for file downloads.(Only
Internet Explorer 7/8.)
The Web Console cannot be started. In the screen, "Internet Explorer cannot display the webpage"
is displayed.
Web Server may not be running. From Start menu, select Administrative Tools -> Internet
Information Services (IIS) Manager and confirm whether Default Web Site is started.
Anonymous access of IIS may be disabled. Change the setting as following.
(1) From Start menu, select Administrative Tools -> Internet Information Services (IIS)
Manager.
(2) Internet Information Services (IIS) Manager screen appears. Click DPM directly under
Default Web Site in the left side of the screen.
(3) Select Authentication in IIS in the center of the screen and click Open Feature in
Actions in the right of the screen.
(4) Select Anonymous Authentication in Authentication screen in the center of the
screen and click Edit... in Actions in the right of the screen.
(5) Edit anonymous authentication qualification information appears. Confirm whether
Specific User is selected and the user name is "IUSR". If it is not "IUSR", click Setting
and set "IUSR" in the user name.
(6) Close the screen by clicking OK in Anonymous authentication qualification
information.
(7) Select Anonymous Authentication in Authentication screen and click Enabled in
Actions in the right of the screen.
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When you open the Web Console screen (such as Add Machine screen or Add Scenario screen)
the characters displayed on the screen are garbled.
This may be avoided by turning off Auto-Select of Encoding on Internet Explorer.
You can set OFF by clearing View menu -> Encoding -> Auto-Select.
On the Backup/Restore tab of the scenario, you click Browse on the Image File and a network
drive or USB hard disk is not displayed.
Only local disk is displayed as a drive. When you specify a network drive or USB hard disk,
enter the image file path on Image File text box directly.
See Section 3.13.4, "Backup/Restore Tab" for the detail.
The managed machine's MAC address is not displayed on the Web Console.
The MAC address may not be displayed temporarily because of replacing LAN board to
other machines and so on.
If such a phenomenon occurs, manually reboot the managed machine.
If the phenomenon occurs after reboot, delete the corresponding managed machine from the
Web Console and then reregister.
*If the managed machine's MAC address is not displayed, you cannot perform the following
operations:
・ Set the Automatic Update Time for the managed machine
・ Obtain the power status
・ Obtain the managed machine information
・ Execute Scenario
・ Power ON
・ Shutdown
The MAC address for a managed machine running on Linux OS and mounted with multiple
LAN boards may not be displayed during operation.
In such a case, the corresponding managed machine may be registered to a New Machine
group. Delete the corresponding managed machine from the New Machine group, and then
reboot DPM Client on the managed machine. If the phenomenon occurs after reboot, delete
the corresponding managed machine from the Web Console and then reregister.
After a certain amount of time passes without any operation, the display of the Web Console is
returned to Deployment Manager Login screen at the next operation.
If session timeout occurs on the Web Console, the display is returned to Deployment
Manager Login screen. Login again.
You can change the setting of timeout by the following procedure.
(1) From Start menu, select Administrative Tools -> Internet Information Services (IIS)
Manager.
(2) Internet Information Services (IIS) Manager screen appears. Click Application
Pools in the left side of the screen.
(3) Select DeploymentManagerPool in Application Pools in the center of the screen and
click Stop in Application Pool Task in the right side of the screen.
(4) Click Default Web Site in the left side of the screen and click Stop in Manage Web
Site in the right of the screen.
(5) Click DPM directly under Default Web Site in the left side of the screen and select
Session State in ASP.NET in the center of the screen. Click Open Feature in Actions
in the right side of the screen.
(6) Specify the value of timeout in Cookie Settings -> Time-out (in minutes)(O)(The
default is 20 minutes) in Session State screen in the center of the screen. Click Apply
in Actions in the right side of the screen.
(7) Click DPM directly under Default Web Site in the left side of the screen. Select
Authentication of IIS in the center of the screen. Click Open Feature in Actions in the
right side of the screen.
(8) Select Forms Authentication in Authentication screen in the center of the screen.
Click Edit... in Actions in the right side of the screen.
(9) Edit Forms Authentication Settings screen appears. Specify the value of timeout in
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Authentication cookie time-out (in minutes)(O)(The default is 30 minutes). Click OK.
(10) Click Application Pools in the left side of the screen. Select
DeploymentManagerPool in Application Pools in the center of the screen. Click
Advanced Setting in Edit Application Pools in the right side of the screen.
(11) Advanced Settings screen appears. Specify the value of timeout in the following 2
items. Click OK.
Process Model - Timeout in idle status(minute) (The default is 20 minutes)
Recycle - Periodic Interval (minute) (The default is 1740 minutes)
(12) Click Start in Application Pool Task in the right side of the screen.
(13) Click Default Web Site in the left side of the screen and click Start in Manage Web
Site in the right side of the screen.

11.2. Management Server
When you set different machines as DHCP server and the Management Server, you cannot obtain
the MAC address for the managed machine.
The DHCP service on the Management Server may still be running. On the Management
Server, from Start menu, select Administrative Tools -> Services, and confirm that Status
under DHCP Server is not Started. If it is Started, open the Properties screen, disable Startup
type, and stop the service.
In Detail Setting, the DHCP server is installed on an another machine checkbox may not
be checked. Select Management view -> DPM Server -> Detail Setting on the Web Console,
click the DHCP Server tab, and confirm that the DHCP server is installed on an another
machine checkbox is checked. If the checkbox is not selected, select it and click OK, and
then reboot the Management Server. (If the Management Server cannot be rebooted, stop all
services listed in Appendix A, "Service List" by selecting Administrative Tools -> Services
from Start menu, and then start all of the stopped services.)
DPM Server services are not running.
A service may terminate if an error occurs during scenario execution.
If a scenario is executing, wait until it completes and then perform the following operations.
From Start menu, select Administrative Tools -> Services on the Management Server, and
then restart the following services.
(If a service is stopped, please start it.)
DeploymentManager API Service
DeploymentManager Backup/Restore Management
DeploymentManager Get Client Information
DeploymentManager PXE Management
DeploymentManager PXE Mtftp
DeploymentManager Remote Update Service
DeploymentManager Schedule Management
DeploymentManager Transfer Management
By performing an overwrite installation of DPM Server, it will be recovered.
You cannot start the DeploymentManager API Service service.
Port (TCP:56050/26500) may be in use by other applications and so on.
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You cannot start the DeploymentManager Remote Update Service service.
Furthermore, the following error log is listed in <DPM Server installation folder>\Log\rupdssvc.csv :
"RUPDSSVC: FUNCTION: CreateSocket(): bind Failed, error code=10048"
Port (TCP:56024/26506, TCP:56028/26507) may be in use by other applications and so on.

If you uninstall and then install DPM Server, scenarios and groups existing before the uninstall still
remain.
The uninstallation may not be performed properly. Follow the procedure below to reinstall:
(1) Perform uninstall again.
(2) Reboot the machine installed with DPM Server.
(3) Delete the contents under the folder installed with DPM Server and the Folder for Image
(the defaults are C:\Program Files\NEC\DeploymentManager and C:\Deploy).
(4) Install again.
If you perform an overwrite installation after interrupting uninstall, an error message appears and you
cannot overwrite.
Install DPM Server newly after it is completely uninstalled.

There is no response even if you execute DPM Server silent installation.
The network connection may not have been detectable.
After confirming the network environment, install DPM Server again.
DeploymentManager PXE Mtftp service is not runnning.
When you do either of the following operations, the above service may not be started.
・ In the status that TFTP services of DPM Server and MasterScope Network Manager are
cooperated, you upgraded DPM Server to this version.
・ In the status that TFTP services of DPM Server and MasterScope Network Manager are
cooperated, you changed the IP address of DPM Server.
In this case, see "To install MasterScope Network Manager on a machine on which DPM
Server is installed, follow the procedure below" of Appendix F, "Configuring DPM Server and
MasterScope Network Manager on the Same Machine" in Installation Guide and do (4)-(7)
again.

11.3. Managed Machine
The standby function did not appear when you terminate the managed machine.
Check the following:
・ If the terminal service is enabled, you cannot use the standby function. From the control
panel, disable the terminal service.
・ Unless the device driver and so on are properly installed, the standby function cannot
be used.
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If you used remote desktop to perform installation, upgrading, or uninstallation of DPM Client, the
following message was displayed:
The following error occurred on the file, xxxxx\DepAgent.dll.
Access is denied.
(0x5)
* xxxxx is a (variable) file path.
If installation, upgrading, or uninstallation is performed while Event viewer on the managed
machine is open, the above message may be displayed.
To Install/Upgrade Install/Uninstall, after selecting the Ignore button and closing the above
message, reboot the managed machine and re-execute.
For Uninstall, the DepAgent.dll file is automatically deleted after the machine restarts, so it is
not necessary to re-execute.

You cannot start DeploymentManager Remote Update Service Client service.
Furthermore, the following error log is listed in rupdsvc.log.
* rupdsvc.log is located in the following folder:
・ For x86: %SystemRoot%\System32\
・ For x64: %SystemRoot%\SysWOW64\
"RUPDSVC: bind() failed, code = 10048"
Port (TCP:56000/26510, TCP:56025/26511) may be in use by other applications and so on.

You cannot start DeploymentManager Update Service Client service.
Furthermore, the following error log is listed in rupdsvc.log.
* rupdsvc.log is located in the following folder:
・ For x86: %SystemRoot%\System32\
・ For x64: %SystemRoot%\SysWOW64\
"RMulticast receive socket create error, code = 10048"
Port (UDP:56001/26529) may be in use by other applications and so on.

Joining a Windows Server 2008/Windows Vista/ Windows 7 managed machine to the domain will
initialize the Firewall's setting and enable it.
This happens when the domain security policy is undefined in the domain server.
Define the domain security policy before joining to the domain.

11.4. Scenario
You cannot assign a scenario to a managed machine.
A scenario cannot be assigned to a machine in the following statuses: Scenario Executing,
Scenario Execution Stop, Scenario Execution Error or Remote Power ON Error. Assign a
scenario either after scenario execution completes, or clear the machine status.
You want to change the scenario file name.
The scenario name cannot be changed. Please create a new scenario.
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11.5. Execute Scenario
11.5.1. General
You executed a scenario, but the managed machine Status is not Scenario Executing.
If you click Refresh from Operation menu, or refresh the screen by pressing the F5 key, the
status changes to Scenario Executing. Until the machine icon displays Running, do not
edit, delete or remove scenario assignment for any running scenario. The scenario may not
execute properly.
You checked the Forced Execution Of A Reboot Is Performed Before Execution checkbox on
the scenario Option tab, but the machine does not reboot.
When installing service packs, hotfixes, and applications, the machine does not reboot
before executing a scenario.
An error occurred while a scenario was running.
Use the following method to remove the error.
Next, check the error contents in the Event Viewer, confirm that the machine is in the correct
status on the Web Console, and then re-execute the scenario.
Example 1) Error Removal Method
(1) Click the machine in error status on the Machine List, and a machine detail screen
appears.
(2) Click Remove Error under Operation menu on the machine detail screen.
Example 2) Error Removal Method
(1) Click Monitor view - Scenario Execution List.
(2) In the tree view, click Scenario Execution List.
(3) In the Operation menu, click Batch Clear Status.
(4) On the Status Clear screen, select Scenario Execution Error.
(5) Click OK.
A Running Scenario does not complete.
Confirm the following:
・ Confirm that DPM Client is installed.
If DPM Client is not installed, interrupt the scenario, install DPM Client, and re-execute the
scenario.
・ Confirm that the IP address of the Management Server set when DPM Client was installed
on the managed machine is correct.
If it is incorrect, either change the following registry, or reinstall DPM Client and set the
correct IP address.
<Windows>
Key:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\depagent\Parameters
Key name: ServerIpAddress
<Linux>
Correct the following files in the /opt/dpmclient/agent/etc/ folder.
File Name: server.inf
Key name: dpmserverip=
・ At the time a scenario completes, the setting is that DPM Client can communicate with the
Management Server.
・ When the scenarios is running, if you change the configuration of Management view ->
DPM Server -> Detail Setting -> DHCP Server tab on the Web Console, PXE boot fails in
the managed machine and the completion of the scenario cannot be detected. After
stopping the scenario, re-execute the scenario after setting the item in DHCP Server tab
matching the proper environment.
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A scenario execution error occurred immediately after you executed a scenario.
The location of installation or settings of DHCP may be wrong, or the DHCP server may not be
operating properly. Check the current situation from the following:
・ Select Management view -> DPM Server -> Detail Setting -> DHCP Server tab on the
Web Console, and confirm that the settings are correct.
・ Confirm that the lease IP address in the DHCP scope is not inactive.
・ Confirm that the DHCP server is approved and the IP address can be leased.
・ Confirm that the DHCP address pool has not run out. If the pool has run out, please secure
a sufficient pool of addresses.
・ If using a DHCP server except Windows, confirm that fixed addresses are configured.
A remote update scenario may have been executed on a machine that exceeded the
Distribution Condition Setting - Maximum Targets configured in the scenario.
Reduce the number of machines to execute, or increase the value of Maximum Targets.
HW configuration, OS installation, disk configuration check, or a Backup/Restore scenario
may have been executed for a machine with power turned ON.
To re-execute with the machine's power turned OFF, or to force execute on a machine with
power turned ON, check the Forced Execution Of A Reboot Is Performed Before
Execution checkbox on the scenario's Option tab.
The command (execute file path + execute file name + setup parameter) of executed package
for a remote update scenario may exceed 259 single-bytes. Correct to make 259 single-bytes
or less using Image Builder and PackageDescriber.
An error occurred while a scenario was running.
If you check the Event Viewer, you see that error log information is registered.
Check the log information registered in the Event Viewer, and perform the processes for each
item.
A problem that still occurs after re-executing may cause incorrect behavior in related services.
If a scenario is executing, wait until it completes and then perform the following operations
from the Management Server. From Start menu, select Administrative Tools -> Services on
the Management Server, and then restart the following services. (If a service is stopped,
please start it.)
DeploymentManager API Service
DeploymentManager Backup/Restore Management
DeploymentManager Get Client Information
DeploymentManager PXE Management
DeploymentManager PXE Mtftp
DeploymentManager Remote Update Service
DeploymentManager Schedule Management
DeploymentManager Transfer Management
 Log Information 1
- Error: Timeout error and stop run scenario. No response from target:
Explanation
The scenario execution timed out because there was no response from the machine within
a given time. The machine may have stopped due to an awaiting input status, error display,
or other reason. After checking the machine, scenario content, setup parameter files and
other information, remove the error from the machine. Next, turn the machine power OFF
and then re-execute the scenario.
 Log Information 2
- Error cannot create thread (xxxxxxxxxxx)
- Error cannot allocate xxxxxxxxxxxxxxxx
Explanation
Failed to create the thread which processes machine requests and to allocate buffer
memory. There is the possibility that there are insufficient resources due to factors such as
the Management Server's high load state.
After checking the Management Server status, remove the error from the machine. Next,
turn the machine power OFF and then re-execute the scenario.
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 Log Information 3
- Error cannot read CLF
- Error cannot change CLF
Explanation
Failed to read/write managing machine information.
Remove the error from the machine, and then turn the machine power OFF. After waiting a
while, re-execute the scenario.
 Log Information 4
- Error cannot get xxxxxx path
- Error cannot read xxxxxx
- Error cannot open xxxxxx
Explanation
Failed to obtain the path for, open, and read file xxxxxx.
There may be insufficient resources or registry information may be damaged due to factors
such as the Management Server's high load state. After checking the Management Server
status, remove the error from the machine. Next, turn the machine power OFF and then
re-execute the scenario.
 Log Information 5
- Starting process of the computer failed MAC = XX-XX-XX-XX-XX-XX
Explanation
Failed to power on the machine remotely.
The network cable is not connected, or remote power ON is not configured. If the machine
is forcibly shut down while the POST screen is displayed, remote power ON may not
function the next time the machine boots up.
Please confirm HW settings and try again.
 Log Information 6
- Starting process of the computer failed when execute scenario MAC =
XX-XX-XX-XX-XX-XX
Explanation
Failed to power on the machine remotely.
The network cable is not connected, or remote power ON is not configured. If the machine
is forcibly shut down while the POST screen is displayed, remote power ON may not
function the next time the machine boots up.
Please confirm HW settings and try again.
 Log Information 7
- scenario start write shared memory MAC : error = XX-XX-XX-XX-XX-XX : XXX
Explanation
The service may have abnormally terminated.
(1) From Start menu, select Administrative Tools -> Services on the Management Server,
and then stop the following services:
DeploymentManager API Service
DeploymentManager Backup/Restore Management
DeploymentManager Get Client Information
DeploymentManager PXE Management
DeploymentManager PXE Mtftp
DeploymentManager Remote Update Service
DeploymentManager Schedule Management
DeploymentManager Transfer Management
(2) Start the services you stopped in (1).
(3) Execute the scenario again.
 Log Information 8
- scenario start update module copy MAC : error = XX-XX-XX-XX-XX-XX : XXX
- scenario start dir delete error MAC = XX-XX-XX-XX-XX-XX
Explanation
The Management Server Folder for Image may not be accessible.
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Confirm access rights for Folder for Image, and then execute the scenario again.
An error occurred while a scenario was running.
When you connected the display to the machine, the following errors were displayed.
Perform each process following the messages displayed.
 Message 1
Error: Partition is too small for install windows operation system.
Explanation
If you select Use Existing Partition during window installation, this message is displayed
when the existing partition is smaller than 4GByte.
If installing Windows in a partition smaller than 4GByte, perform the local setup manually.
 Message 2
Error: No partitions defined.
Explanation
If you select Use Existing Partition during Windows installation, this message is displayed
when there is no existing partition.
Select Create New Partition, and re-execute the operation.
 Message 3
Error: No disk found.
Explanation
This message is displayed if a hard disk drive is not connected during Windows installation.
Confirm that the hard disk is connected correctly, and then re-execute the operation.
The managed machine does not turn on when the power is turned on or a scenario is executed.
If the power is forced turned off during POST, the system may fail in Wake On LAN when
restarted.
Turn off the power after completion of POST or start the operating system and perform the
shutdown process.
The power was turned off during scenario execution by mistake.
On the Web Console, click Operations in the title bar to switch to the Operations view. In the
tree view, click Machines icon, and then select the group to which the machine which power
was turned off is registered. Select the specified machine, and then select Scenario
Execution Stop to interrupt the scenario. After the status returns to normal, execute the
scenario again.
The managed machine is not booted through the network, and the scenario cannot be executed.
The network boot priority in the BIOS settings may be lower than the hard disk boot priority.
Make the network boot priority higher than the hard disk boot priority, and re-execute the
scenario.
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When you execute DPM Command Line, the specified command does not run.
In addition, an error does not appear at the command prompt.
You may be using a previous version's DPM Command Line (Command Line for DPM). If you
are using DPM Command Line (Command Line for DPM) from a previous version, perform an
upgrade installation, see Section 3.5, "Upgrading DPM Command Line" in Installation Guide.
When you executed a scenario to multiple managed machines simultaneously, a Remote Power On
error occurred.
In the case of executing a scenario to multiple managed machines simultaneously, the default
timeout value of the Remote Power On, which is specified in the Management view -> DPM
Server -> Detail Setting - Network tab, may cause a timeout error.
As a guide, set the Remote Power On Timeout to the following value:
(Remote Power On Interval) multiplied by (the number of scenario executing machines) plus
(managed machine startup time).
When a scenario finishes or a running scenario is stopped, the following message appears on the
managed machine and the machine cannot be turned off:
ERROR: Failed to power down by calling APM BIOS. The system has halted.
A machine that does not support Advanced Power Management (APM) may not be
automatically turned off at shutdown. In this case, turn off the managed machine manually.
When you execute a command of DPM Command Line, the following message appears, and you
cannot execute the command:
The system cannot execute the specified program.
This message appears when runtime modules required for running DPM Command Line are
not properly installed.
Run the following file in the installation media to install the run-time modules:
• For SSC product: \DPM\Setup\VCRTL\vcredist_x86_2010SP1.exe
• For DPM unbundled product: \Setup\VCRTL\vcredist_x86_2010SP1.exe
To install the modules, Windows Installer 3.1 or later is required.
When you execute DPM Command Line, the following log is output to "System" in the [Event
viewer].
Source: SideBySide
Event ID:32
Explanation: The dependent assembly Microsoft.VC90.CRT could not be detected.
Error: The referenced assembly is not installed to the system.
This message appears when runtime modules required for running DPM Command Line are
not properly installed.
Run the following file in the installation media to install the run-time modules:
• For SSC product: \DPM\Setup\VCRTL\vcredist_x86_2010SP1.exe
• For DPM unbundled product: \Setup\VCRTL\vcredist_x86_2010SP1.exe
To install the modules, Windows Installer 3.1 or later is required.

11.5.2. Creating a Linux Install Parameter File
When you select Open under File menu from the installation parameter setting tools and when
reading the existing Linux installation parameter file, the following message appears:
A candidate host file cannot be read.
About the selected Linux installation parameter file, OS may not be supported in this version.
For details, see Section 3.9.1, "System Requirements" or Appendix A, "Function Tables" in
First Step Guide.
The Linux installation parameter file may be damaged.
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Check the contents of the Linux setup parameter file and Linux boot parameter file.
When you select Open under File menu from the installation parameter setting tools and when
reading the existing Linux installation parameter file, the following message appears:
The Linux OS install parameter file cannot be read.
About the selected Linux installation parameter file, OS may not be supported in this version.
For details, see Section 3.9.1, "System Requirements" or Appendix A, "Function Tables" in
First Step Guide.
The Linux installation parameter file may be damaged.
Check the contents of the Linux setup parameter file and Linux boot parameter file.

11.5.3. OS Installation by Disk Duplication
While you set up the OS by OS installation by disk duplication, the following message appeared on
the machine screen and processing stopped.
"The parameter file for this system is not prepared, or failed to be copied. Follow the wizard to setup
displayed after reboot. Press any key to reboot."
The number of machines trying to access the Management Server may exceed the
maximum number of machines concurrently accessible. Reduce the number of machines
concurrently accessing the Management Server concurrently.
During the Windows OS setup, performed by OS installation by disk duplication, the process
stopped under the condition of being logged onto the machine.
Furthermore, machine names and so on that were specified by parameters are not set correctly.
Individual reflection of OS installation by disk duplication may have failed, due to the time
taken to initialize Windows OS.
Open <Folder for Image>\Sysprep\Windows\DepConfig.ini by Text Editor and so on, and
change the following Timeout value (milliseconds). (Please use single-byte numeric
characters.)
DepConfig.ini can be edited after Copy-ExpressSysprep.vbs script is executed on the
master machine when the master image is created.
[SYSPREP]
Timeout=60000
Example)
[SYSPREP]
Timeout=300000

During the OS setup by OS installation by disk duplication of Windows Server 2008/Windows
Vista/Windows 7, one of the following message appeared and the process stopped.
・ "Windows could not parse or process the unattended answer file for pass [specialize]. The
settings specified in the answer file cannot be applied. The error was detected while processing
settings for component [Microsoft-Windows-Shell-Setup]."
・ "The computer restarted unexpectedly or encountered an unexpected error. Windows installation
cannot proceed. To install Windows, click "OK" to restart the computer and then restart the
installation."
The OS type and Product-Key of the disk duplication data file for the deploy target machine
may differ from the OS type and Product-Key of the master machine's setup parameter file.
Change the OS type and Product-Key of the disk duplication data file so that it matches the
settings of the setup parameter. Then, after restoring the master image, redistribute the disk
image.
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While you setup the OS by OS installation by disk duplication, the following message appeared on
the machine screen and processing stopped.
"The system registry contains invalid file paths. Installation cannot proceed. This system image was
applied without guaranteeing that drive-letter assignments would match across computers."
This error may be displayed if the system configuration of the master image is multiboot.
Confirm that the master image is not a system configuration of multiboot. OS installation by
disk duplication in the multiboot environment cannot be performed. (Be sure to construct the
master image as a single system.)
After you set up the OS by OS installation by disk duplication, the characters of the connection
name registered in Network and Dial-up Connections were garbled.
If this occurs, change the connection name manually.
When you execute Sysprep command on the master machine in setting up OS by OS installation
by disk duplication, Windows Security Alert dialog appears and the message that "Do you want to
keep blocking this program? Name: Microsoft Remote Desktop Help Session Manager" is
displayed.
In the case of Windows Server 2003 R2, this may be displayed. The processing continues
automatically after a while and there is no problem. Wait for a while.
During OS installation by disk duplication, a screen appeared that requested IMJPZP.DI_ file or
other files.
If IMJPZP.DI_ was requested, copy IMJPZP.DI_file from the location below to the
\SYSPREP\I386\LANG (for Windows XP/Windows Server 2003/Windows 2000,
\SYSPREP\I386\LANG\JPN) folder of master machine created in "Executing the tool in the
installation media manually" of Section 3.3.1.3, "Preparing for Creating the Master Image" in
Operation Guide. If LANG folder does not exist under I386, create one.
For Windows XP, Windows Server 2003: (CD-ROM) drive:\I386\LANG\IMJPZP.DI_
For Windows 2000: (CD-ROM) drive:\I386\LANG\JPN\IMJPZP.DI_
For Windows 2003 R2(x64): (CD-ROM) drive:\AMD64\LANG\IMJPZP. DI_
After the above file is copied, perform OS installation by disk duplication again, seeing
"Executing the tool in the installation media manually" of Section 3.3.1.3, "Preparing for
Creating the Master Image" in Operation Guide.
If other file was requested, use the same procedure to add the file to the master machine,
and perform OS installation by disk duplication again.
After OS installation by disk duplication, messages such as the following appear at Linux OS
startup. Or, X-Window does not start.
"Could not look up internet address for "Hostname" This prevents GNOME from operating correctly.
It may be possible to correct the problem by adding "hostname"* to the file /etc/hosts."
*"Hostname" is the host name of each machine after OS installation by disk duplication.
An error may occur at X-Windows startup because a host name is not registered to the file
/etc/hosts. Register the hostname in the /etc/hosts file. If the environment uses a static IP
address, register the line as the following.
Example) 192.168.0.1 servername
If the computer obtains an IP address from DHCP, register the hostname with a
loopback address as follows:
Example) 127.0.0.1 localdomain.localhost localhost servername
IP address conflict occurred after OS installation by disk duplication.
If an alias interface is configured in the master machine, IP address conflict occurs after OS
installation by disk duplication. Use the following procedure to delete the alias interface
configuration file, and then restart the machine.
# cd /etc/sysconfig/network-scripts
# rm -f ifcfg-eth*:*
# rm -f ifcfg-bond*:*
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If you perform backup of OS installation by disk duplication of a Linux-installed VMware ESX/ESXi
virtual machine as a master machine, the following error appears during POST process of the first
reboot after completing the backup process, and then the machine was shut down.
"Determining IP information for eth[]...failed; no link present. Check cable?"
Configuration described in "Executing the tool in the installation media manually" of Section
3.4.1.3, "Preparing for Creating the Master Image" in Operation Guide may not have been
done correctly in the preparation for OS installation by disk duplication on the master
machine.
Confirm the procedure and configuration, and then perform OS installation by disk
duplication again.
If you perform OS installation by disk duplication for a VMware ESX/ESXi virtual machine, the
following error appears during POST operations at startup after the individual settings are reflected,
and the network adaptor is not recognized.
"Determining IP information for eth[]...failed; no link present. Check cable?"
When the disk duplication data file was created, the script data listed in Section 5.4.3,
"Creating a Disk Duplication Parameter File (Linux)" may not have been properly configured.
Confirm the procedure and configuration, and then perform OS installation by disk
duplication again.
Though execution of scenarios for setting up of a master machine
(System_LinuxMasterSetup/System_WindowsMasterSetup/System_WindowsMasterSetupVM)
succeeded, OS installation by disk duplication fails.
DPM Client earlier than DPM Ver6.12 may be used. After upgrading DPM Client to this
version, perform OS installation by disk duplication again.

11.5.4. OS Clear Installation
After Distribution of floppy disk image for BIOS/firmware and an OS clear installation scenario was
executed, a scenario execution error occurs before you reboot the machine.
Is there a check-in on the Forced Execution Of A Reboot Is Performed Before Execution
checkbox on the scenario Options tab? If not, a scenario will not be executed for any
machine that has been turned ON. Modify the scenario or turn the machine OFF and
execute the scenario again.
Scenario execution has stopped and the following message appeared on the machine's screen
during the execution of an OS clear installation scenario.
"Cannot connect data server. Please stop running scenario on the Management Server and
press any key to reboot"
The maximum number of machines that accessing the Management Server simultaneously
may have been exceeded. Reduce the number of machines that are accessing the
Management Server simultaneously and execute again.
The OS installation has stopped due to an error.
OS installation will stop with error if you specified unusable character in the machine name.
For a list of unusable characters, see the manual of the OS you are using and so on.
During Linux installation, the following message appears, and the installation could not be
completed.
Could not allocate requested partitions; Partitioning failed:
Could not allocate partitions as primary partitions
The partition settings may be wrong. (For example, if the number of primary partitions on
one basic disk exceeds the upper limit (4))
While creating the Linux installation parameter file, select Disk Information Settings Partition Settings - Delete All Existing Partitions and execute the Linux installation again.
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During Linux installation, the following message appears, and the installation could not be
completed.
+--------------- Kickstart Error ------------+
Error opening: kickstart file
/tmp/ks.cfg: No such file or
directory
[OK]
+-----------------------------------------+
Confirm that the NFS shared folder is configured correctly.
See Appendix C, "Configuring NFS Server" in Installation Guide to configure the folder
correctly, and then install Linux.
If you uninstall DPM Server with the exports folder as an NFS shared folder as previously
mentioned in Setting Up the NFS Service, and then reinstall DPM Server, the NFS shared
property is configured in Explorer, but the above error may occur when you actually perform
the installation. In this situation, release and then reconfigure the NFS shared property.
Confirm that the install device you are using is configured to Installation Device of Linux
installation parameters.
See Section 5.4.5, "Creating a Parameter File for OS Clear Installation (Linux)" to configure
Installation Device correctly, and then install Linux again.

11.5.5. Installing Service Packs / HotFixes / Linux Patch Files /
Application
Perform the following operations if scenario execution errors continue to occur in remote update.
Restart the Management Server. (If the Management Server cannot be rebooted, stop all
services described in Appendix A, "Service List" by selecting Management Tools ->
Services from Start menu, and then start all of the services you stopped.)
When you executed the scenario of installing service packs, hotfixes, Linux patch files, and
applications, but the machine in the Status column of the Monitor view -> Scenario Execution
List remains in Running Scenario, and the scenario execution does not complete.
If the command option is not configured correctly, a confirmation dialog box appears on the
machine and the scenario execution does not complete. You can confirm the command
option by running the service pack or the hotfix with the option /h or -? , or refer to
distributor's homepage and so on. Make sure that you specify the command options to
execute silent installation and not to restart after installation.
Failed to create an image file during the registration of Installing service packs, hotfixes, Linux
patch files, and applications by Image Builder.
In installing service packs, hotfixes, Linux patch files, and applications, image file is saved in
ZIP file. If these ZIP files size exceed 2GByte, creation of the image file fails.

When you modified a package by Image Builder, the message "Failed to compress the file." or " Failed to
register in the Management Server." is displayed and package modification fails.
If the modification date is earlier than the package creation date, package modification fails. There
may be some reasons, such as, the date-time of the machine was changed after creating the
package, or that date-time of the Management Server is different from one of Image Builder
(Remote Console) machine. After the date that the package was created, modify the package, or
delete the package and create the package again.
The packages are stored in Management Server's Folder for Image \HotFix, or Folder for Image
\PP.
(The default of the Folder for Image is
C:\Deploy, and the package file name is "ServerID"-"PackageID".zip.)
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Even if applying a service pack/hotfix/Linux patch file fails, the Web Console displays that scenario
execution completed successfully.
When the execution of a service pack or hotfix fails, the failure may not be detected. In such case,
fix the cause of the execution failure, and then execute the scenario again.
You want to create a scenario that Distribution of floppy disk image for BIOS/firmware and Installing
service packs, hotfixes, Linux patch files, and applications are executed at the same time.
You cannot register a scenario with Distribution of floppy disk image for BIOS/firmware and
Installing service packs, hotfixes, Linux patch files, and applications. If you want to perform these at
the same time, register a scenario that executes the OS installation and add the settings for
BIOS/firmware update and service pack/hotfix/Linux patch file/application install to the scenario.
A scenario execution error occurs if you execute a scenario Distribution of floppy disk image for
BIOS/firmware or apply Installing service packs, hotfixes, Linux patch files, and applications install.
Confirm that the execution interruption processing is completed properly. If interruption is cancelled
before execution and then the scenario is executed, the scenario execution error may occur.
Furthermore, if you want to execute the same scenario simultaneously on multiple machines, set
the maximum target number of multicast distribution conditions to the number of machines you
want to interruption process is completed, and then execute the scenario.
A scenario execution error occurs if you try to execute multiple service pack/hotfix/Linux patch
file/application install scenarios at the same time.
See the Scenario Details screen and check whether the same multicast IP address is specified. If
the same multicast IP address is not being used, reduce the maximum transfer rate, or execute the
scenarios one by one. (If the scenario is the same, you may also execute the scenario on multiple
machines.)
A scenario of installing service packs, hotfixes, Linux patch files, and applications does not start.
If the maximum target is not configured, or is greater than the machine attempting to execute, the
scenario executes after the maximum wait time passes. (The default setting of the maximum wait
time is 10 minutes.)
The maximum transmission rate has been set higher, but the scenario execution time does not decrease.
Maximum transmission rate depends on varies widely with a customer's network environment. You
cannot obtain a transmission rate higher than the network environment's performance.
If you register an application or service pack/hotfix by Image Builder (Remote Console), the error Failed
to register to Management Server is displayed.
This error may occur when the size of the file to register is extremely large.
To prevent this error, edit the timeout value (number of seconds) that is specified by the following
registry:
Hive : HKEY_LOCAL_MACHINE
KEY : SOFTWARE\NEC\DeploymentManager
NAME : DIBReqTimeOut
Type : REG_DWORD
Value : 120
-> The default is 120 seconds. Set the timeout value.
Even if an error is displayed, registration is successful. Re-registration is unnecessary.
When you exit Image Builder, perform the following operations:
(1) Select Yes (Register) at batch registration.
(2) Select No (Delete) at the confirmation of overwriting.
If you register a service pack/hotfix/Linux patch file by Image Builder (Remote Console), the data creation
has succeeded. However, the registration to the Management Server fails.
This may occur if the path for the setup command name is extremely long.
If registering to the Management Server from the Remote Console, the upload process checks the
full path, including the Folder for Image path on the Management Server side as the maximum path
length. If the upper limit of the full path is exceeded, the registration fails. Register a shorter full
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path by moving the files to be registered to a location close to the drive root on the Remote
Console, and register the files again.
If you interrupt the execution of the scenario of installing service packs, hotfixes, Linux patch files, and
applications, and then cancel the interruption and execute the scenario again, a scenario execution error
occurs.
If the interruption occurs when communications with the managed machine is disrupted for some
reason, the interruption process cannot be completed, and the machine remains in an interrupt
status. In this status, even if a scenario is executed after the interruption is cancelled, a scenario
execution error occurs.
In this case, wait for a while (about 10 minutes) and before executing the scenario again.
If the scenario execution errors persist, perform the following operations.
On the managed machine, select Management Tools ->Services from Start menu, and restart
DeploymentManager Remote Update Service Client. (If the service is stopped, please start it.)
After executing DPM Client automatic upgrade scenario for a Linux managed machine, and then execute
another remote update scenario, which does not start.
When another remote update is executed within two minutes of executing DPM Client automatic
upgrade scenario and DPM Client service does not start properly. Restart DPM Client service or
restart the OS. To restart DPM Client service, start the Console and execute the following:
> service depagt stop
> service depagt start
If remote update is executed for a Linux managed machine, a scenario execution error occurs.
When installing service packs, hotfixes, Linux patch files, and applications in Image Builder, an
option that outputs to the console may be specified to Setup Parameters on the Execution
Configuration screen. The option may be specified.
See Section 5.5.3, "Create Linux Package," and confirm that relevant options are not specified.
If the relevant options are specified, delete scenarios including that packages, correct the
packages from which relevant options were removed. Recreate the scenario file with the corrected
packages, and then execute the scenario again.
If a remote update is executed by multicast for the x64 Linux managed machine, a scenario execution
error occurs.
The necessary libraries may not be installed. Confirm that /lib/libgcc_s.so.1 exists.
If /lib/libgcc_s.so.1 does not exist, install the following rpm package:
libgcc-3.4.5-2.i386.rpm
After the installation, restart DPM Client service or restart the OS.
To start DPM Client service, start the Console and execute the following:
> service depagt start
When the remote update scenario is distributed by multicast, the scenario execution to a part of the
managed machines fails.
If all of the following is applied and a remote update scenario is distributed by multicast, scenario
execution fails.
If managed machines are connected to multiple LAN boards on the Management Server, create
and execute different scenarios for each LAN board.
・ ANY is selected on the Web Console screen under Management View -> DPM Server icon ->
Detail Setting screen -> General tab -> IP Address.
・ The managed machines are connecting with multiple LAN boards on the Management Server.

11.5.6. Backup/Restore
The partition number specified when the scenario is created is different from the partition number
displayed on the machine screen.
A hidden partition may exist in the target hard disk. The hidden partitions will not be included
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in the total count if the check box was checked for Hidden Partition Is Disregarded in
partition specification Backup/Restore. Clear the check box, or enter a supported partition
number correctly.
Only several tens of MBs are transferred per minute during Backup/Restore operations.
The maximum transmission rate may be specified too low, such as 1-10MByte/minute.
Confirm the Maximum transmission Rate column on the Multicast Condition Setting panel
in Backup/Restore tab on the Scenario Edit screen. If you want to save time, clear the check
box. If you want to reduce network workload, select the check box and specify the appropriate
values.
Data may not be transferred smoothly due to a high network workload. Minimize use of the
network as much as possible during the scenario execution.
A scenario execution error suddenly occurred suddenly while data transfer was in progress during
backup.
Data transmission may not be possible due to sufficient free space on the Management
Server. Make sure there is insufficient free space on Management Server where the backup
data is to be saved. Backup will not operate properly if there is not enough free space.
Reconsider the backup file destination, or reserve sufficient free space.
When you start the OS on the machine that is restored, the disk image of another machine was
restored.
The image files that you backed up may have been overwritten with the backup image of
another machine. When performing a backup, make sure that you do not use a redundant
image file name. Otherwise, the previous data will be overwritten.
Furthermore, if the same scenario is assigned to multiple machines and execute backup
simultaneously, check whether machine name, MAC address, or UUID under the textbox on
the scenario file Backup/Restore tab is selected.
Even if restore is executed simultaneously, several of the managed machines do not execute
scenarios, and Waiting for Restore Execution is displayed on the Backup/Restore Execution List
screen.
The Maximum Targets set for the scenario file may be less than the actual machine number
you are trying to execute. In this case, after completing the execution of preceding scenario,
and then the scenarios for the rest machines start.
The restore operation has been in waiting for restore execution status and does not start.
The setting of the Maximum Waiting Time under the Distribution Condition Setting group
box on the Backup/Restore tab for the scenario file can not to be configured. If the column is
blank, the scenario will not execute until the number of machines ready to execute scenarios
reaches the Maximum Target value. Click Run Now on the Backup/Restore Execute List
screen, or interrupt the execution and specify an appropriate value for Maximum Wait Time
of the scenario file.
Even if you the maximum target number as 10 in the restore scenario, and then execute the scenario
on 10 machines simultaneously, the scenario executes on only 5 machines at once.
If the Management view -> DPM Server -> Detail Setting -> Network tab ->Machines For
Simultaneous Execution value is 5, the scenario executes on only 5 machines at once,
although the maximum target value is specified as 10. If you want to execute on 10 machines
simultaneously, change the value of Machines For Simultaneous Execution under Detail
Setting to 10.
The maximum transmission rate has been set higher, but the scenario execution time does not
decrease.
Maximum transmission rate depends on customer's network environment. You cannot obtain
a transmission rate higher than the network environment's performance.

448

Even through the execution of a backup scenario, a unicast restore scenario, or disk configuration
check scenario completed, the status of Scenario Execution List status remains Preparing.
If you executed a backup scenario, a unicast restore scenario, or disk configuration check
scenario on another machine before the same scenario execution has completed, the status
of Scenario Execution List on the Web Console may display Preparing from the time the
backup, restore, disk configuration check completes to the time that the execution of the
scenario completes. However, it does not affect the operation.
When checking scenario execution status on Backup/Restore Execution List while a multicast
restore scenario is executing, the scenario status is displayed as already complete although
execution was still in progress, or it may not be displayed.
Backup/Restore Execution List cannot be updated immediately, even when the scenario
was executed. The status is updated when reading or writing to the Backup/Restore disk
starts.
Until that time, the pre- execution status of the scenario is displayed. When the screen was
displayed before an update, wait a moment, and then reopen the screen, and click Refresh.
During backup, a scenario execution error occurs, but no error message is displayed.
If the OS did not shut down properly when the machine was power off, the delayed write to
disk process may not have been completed during shutdown, and the file system may be
damaged. Furthermore, if the machine was power off and shutdown was not performed while
the disk was accessing, physical damage on the disk may have occurred.
If a backup was performed on such a disk, a scenario execution error may occur.
In such case, reinstall the OS, or use a file system fix tool, etc to fix the file system, and then
perform backup again.
Furthermore, if there is a physical damage on the disk (bad sector), you cannot
backup/restore using a fix tool and so on. If there are bad sectors, change a new HDD and
recover it by physically formatting and then execute a restore from a previous backup image.
When multiple restore scenarios are executed simultaneously, a scenario starts on the first machine
booted up, but after getting Backup System image is displayed on the other machines, a scenario
execution error has occurred, and the error is displayed on the Scenario Execution List screen. On
the machine screen, the following error message was displayed:
"ERROR: Received the error from the PXE server.
Please contact your system administrator or support group."
The same multicast IP address is specified when the scenario was created may be specified
in all scenario files. Open the Edit Scenario screen, and check the value of multicast IP
address on the Distribution Condition Setting group box in the Backup/Restore tab. If the
specified IP address is the same to another restore scenario, one of the two scenarios may
not start properly. Enter a non-redundant IP address again on the Modify Scenario screen. If
Remove Scenario Execute Error is selected for the machine on which an error was
occurred, error display disappears, and the scenario can be executed again.
If you execute a restore scenario by specifying a partition, either of the following error messages is
displayed and the scenario execution error occurs.
Cannot restore the data to a partition of a different size than the size you backed up.
Specify a partition with the following size.
(required size of a partition to restore)
(size of the specified partition)
(XXXXX bytes)
(XXXXX bytes)
Cannot restore the data to a partition of a different type than the type
you backed up.
Specify a partition with the type same as you backed up.
(ID of the backed-up partition)
(ID of the specified partition)
(0xXX)
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(0xXX)
Confirm that the partition size and the type of file system are matched between the original
disk and the destination disk. Open the Edit Scenario screen, set the applicable partition, and
then execute the scenario again.
You may have specified a partition which is different from one that you backed up. Restore the
image file to the same partition when it was backed up. Open the Edit Scenario screen, set
the applicable partition and then execute the scenario again.
If the Hidden Partition Is Disregarded checkbox was selected and hidden partitions exist on
the managed machine, you may specify a partition that is different from when backup. In this
case, clear the Hidden Partition Is Disregarded checkbox, and then execute the scenario
again.
Processing without ending, while executing a backup/restore scenario, and the following messages
are displayed on the managed machine:
FS: Cannot open root device "" or xx:xx
Please append a correct "root=" boot option
Kernel panic: VFS: Unable to mount root fs on xx:xx
There may be a problem in the LAN connection between the Management Server and the
managed machine, or the workload on the Management Server may be high. Check the LAN
connection and the Management Server workload, and then turn off the machine and execute
the scenario again.
While executing a restore scenario, the following message is displayed on the managed machine,
and a scenario execution error occurs.
The size of the backup data to be restored is larger than that of the destination storage device. It
cannot be restored. Specify a destination device whose size is larger than or equal to the following
size.
(minimum required size of a destination device)
(the specified device: its size)
(XXXXX bytes)
(DeviceName: XXXXX bytes) .
Check the HDD sizes of the backup source and the restore destination.
If the HDD size of the restore destination is smaller, this message may be displayed.
Use a HDD with the same or larger size than the backup source
When you execute a backup scenario, the following message is displayed on the managed machine
and the scenario exectuion error occurs.
Failed to backup.
There is something wrong with the management information of the GPT disk.
Check and repair the disk by CHKDSK or other tools,
and re-execute the scenario.
When Hyper-V virtual disk is GPT type, this message may be displayed.
In this case, execute the full sector backup. Select Full Sector Option on Backup/Restore
tab of Edit Scenario screen and execute the scenario.
When you execute a restore scenario, the following message is displayed on the managed machine
and the scenario exectuion error occurs.
Failed to restore.
The data is not written to the destination storage device.
Invalid data in the backup image.
For this error, contact your sales or support representative.
When original Hyper-V virtual disk is GPT type, this message may be displayed if you restore
the backup image file created in the version earlier than DPM Ver6.2.
You cannot restore it because the backup image file includes invalid data.
In this case, recreate a backup image file by selecting Full Sector Option on
Backup/Restore tab when creating a scenario and executing the backup scenario.
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When the following error occurs and a process ends with error for some reason, you cannot execute
a shutdown or re-boot even if you press p or r (Key input cannot be recognized).
ERROR: <error message>
Press the p key to power off, and the r key to reboot:
Key input may not function on certain kinds of machines using a USB keyboard/mouse which
cannot be recognized.
Press (and hold down) the power button to turn off the power.
If you interrupted the execution of a restore scenario, the following message was displayed on the
managed machine:
Failed to read or write the data in the managed machine.
For this error, contact your sales or support representative.
This message is displayed when a scenario execution is interrupted. This message displays
because the data of the intended size could not be obtained due to a disconnected
communication between Management Server and the managed machine.
This is not problematic to the scenario execution interruption process.
While executing a restore scenario, the restore data cannot be read.
Confirm that the backup image is not damaged and there is no trouble on the network.
When a restore scenario is multicast distributed, the restore does not executed, and scenario
execution is interrupted.
Furthermore, the following message was displayed on the managed machine, and then the machine
restarted.
(After the restarting, a scenario execution error was displayed on the status of the managed machine
on the Web Console.)
Failed to read or write the data in the managed machine.
For this error, contact your sales or support representative.
This System is rebooted after XX seconds.
gzip: stdin: Unexpected end of file.
This phenomenon may occur when both ANY is specified for the IP address used by
Management Server and the restore scenario is distributed by multicast. Configure except
ANY for the IP Address used by Management Server (the IP address configured by the using
LAN board). For configuration method details, see Section 2.7.1.1, "General Tab."
When a scenario is running, "boot:" or "login:" is displayed on the manged machine, and the
processing does not proceed.
You may have entered the key to stop the processing, such as "Ctrl" + "C". Do not enter a key
on the managed machine when a backup or restore scenario is running.
PXE boot fails on the managed machine.
Is the Management view -> DPM Server -> Detail Setting -> DHP Server tab set to Do Not
Use a DHCP Server?
If Do Not Use a DHCP Server is selected, a PXE boot cannot be executed on the managed
machine.
If a PXE boot is necessary, configure a DHCP server, and select Use a DHCP server.
Furthermore, restart the Management Server after changing it since the configurations are
enabled after Management Server restarts.

11.5.7. Distribution of Floppy Disk Image for BIOS/Firmware
The managed machine does not boot by the network boot after a scenario that Distribution of floppy
disk image for BIOS/firmware is executed.
If BIOS is upgraded, the BIOS configuration may return to the default settings. Check whether
the priority order of the network boot is not changed. If the priority order is changed, set
network boot to the top priority.
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A scenario execution error occurs when you execute a Distribution of floppy disk image for
BIOS/firmware, Installing service packs, hotfixes, Linux patch files, and applications install scenario.
Confirm that the execution interruption processing is completed properly. If interruption is
cancelled before the process of the interruption completes and then the scenario is executed,
a scenario execution error may occur.
Are you trying to execute the same scenario which is being executed on another machine? If
you want to execute the same scenario on multiple machines simultaneously, specify the
maximum target number under Multicast Condition to the number of machines that you want
to execute, and then execute the scenario.
A scenario execution error occurs before the machine restarts after a scenario of Distribution of
floppy disk image for BIOS/firmware and a scenario of OS clear installation is executed.
Did you specify the Forced Execution Of A Reboot Is Performed Before Execution on the
scenario Options tab before execution? If not, a scenario is not executed for any machine that
is power on. Modify the scenario, or turn off the machine and execute the scenario again.

11.6. Registering a Managed Machine
Even if you turn on a managed machine, a new registration is not performed.
The DHCP configuration may be wrong, or the DHCP server may not operate properly. Check
the following items:
・ Select Management view -> DPM Server -> Detail Setting -> DHCP Server tab on the
Web Console, and confirm that the Use A DHCP Server configurations are correct.
・ Confirm that the lease IP address in the DHCP scope is not inactive.
・ Confirm that the DHCP server is approved and the IP address can be leased.
・ Confirm that the DHCP address pool has not run out. If the pool has run out, please secure
a sufficient amount of addresses.
・ If using a DHCP server except Windows, confirm that fixed addresses are configured.
The managed machine may be a model that does not support PXE boot, or the network
startup order may be set lower than the HDD.
On an x86 architecture machine, check the network startup order in the BIOS settings. For
methods to check the BIOS, contact your sales or support representative.
If operating without using the DHCP Server, and the Management view - DPM Server -Detail
Setting - DHP Server tab was changed to Do Not Use A DHCP Server, it is necessary to
restart the Management Server to enable the settings. Restart the Management Server, and
then restart the managed machine.
If multiple LAN boards are mounted on the managed machine, confirm that the LAN board
used for DPM communications is registered on DPM Server.
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11.7. Automatic Update
Open Monitor view -> Automatic Update Result List screen, and check the detailed information of
the corresponding machine and date/time, then registration of error log information can be confirmed.
Check the detailed information, and fix each problem.
If you perform automatic update after fixing the problem, reboot the managed machine.
<Detailed Information 1>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update begins
・ An error occurred while preparing for the automatic update.
・ ......
Description Management Server resource may be insufficient. Restart the Management
Server.
<Detailed Information 2>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update begins
・ A socket error occurred.
・ ......
Description WinSock initialization failed.
Check the network configuration of the Management Server (if TCP/IP protocol is installed).
If there is no problem, restart the Management Server.
<Detailed Information 3>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update begins
・ The connection to the client failed.
・ ......
Description: The Management Server could not connect to the managed machine.
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK. The
command prompt appears. Enter ping IP address or ping hostname and press
Enter. (Enter a space between ping and the IP address/host name.)
If there is no response, check whether there is a problem in the network configuration.
(2) If there is no problem in the network, restart the following services on the machine
side. (If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
<Detailed Information 4>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update begins
・ Search for the packages that are applicable to the client failed.
・ ......
Description Automatic update function may not be supported on the OS of the machine on
which the error occurred. Check the machine's OS and language. The following is the list of
OS that automatic update function is supported. The supported language is English only.
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OS Name
Windows 2000 Professional
Windows 2000 Server
Windows 2000 Advanced Server
Windows XP Professional
Windows Server 2003 Standard Edition
Windows Server 2003 Enterprise Edition
Windows Server 2003 Standard x64 Edition
Windows Server 2003 Enterprise x64 Edition
Windows Server 2003 R2 Standard Edition
Windows Server 2003 R2 Enterprise Edition
Windows Server 2003 R2 Standard x64 Edition
Windows Server 2003 R2 Enterprise x64 Edition
Windows Vista Business
Windows Vista Enterprise
Windows Vista Ultimate
Windows Server 2008 Standard
Windows Server 2008 Enterprise
Windows Server 2008 Standard x64
Windows Server 2008 Enterprise x64
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows Server 2008 R2 Datacenter
Windows 7 Professional
Windows 7 Ultimate
Windows 7 Enterprise
Windows 7 Professional x64
Windows 7 Ultimate x64
Windows 7 Enterprise x64
Windows 8 Pro
Windows 8 Enterprise
Windows 8 Pro x64
Windows 8 Enterprise x64
Windows Server 2012 Standard
Windows Server 2012 Datacenter
<Detailed Information 5>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update begins
・ Reconfirmation of the connection to the client failed.
・ ......
Description A communication error occurred with the machine.
(1)
Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK.
The command prompt appears. Enter ping IP address or ping hostname and
press Enter. (Enter a space between ping and the IP address/host name.)

(2)

If there is no response, check whether there is a problem in the network
configuration.
If there is no problem in the network, restart the following services on the machine
side.
(If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
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<Detailed Information 6>
・ Computer: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ Creating file in the client failed.
・ ......
Description The disk space of the machine may be insufficient.
Check the machine disk free space. Normally, it required free disk space that at least
three times the size of the package to send.
Example) To apply a 100MByte package, it is necessary that the free space of the
managed machine system drive should be at least 300MByte.
<Detailed Information 7>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ An error occurred while preparing for the file transfer.
・ ......
Description An error occurred in the process before the file is transferred.
The Management Server may have insufficient resources. Restart the Management
Server.
<Detailed Information 8>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ Creating file transfer control thread failed.
・ ......
Description Failed to call WindowsAPI (CreateThread()).
The resource on the Management Server may be insufficient. Restart the Management
Server.
<Detailed Information 9>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ Creating file transfer control thread failed.
・ ......
Description Failed to call WindowsAPI (CreateThread()).
The resource on the Management Server may be insufficient. Restart the Management
Server.
<Detailed Information 10>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ An error occurred during the transfer of xxxxxxxx.
・ ......
Description A communications error occurred when sending a file.
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK. The
command prompt appears. Enter ping IP address or ping hostname and press
Enter. (Enter a space between ping and the IP address/host name.)
If there is no response, check whether there is a problem in the network
configuration.
(2) If there is no problem in the network, restart the following services on the machine
side.
(If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
<Detailed Information 11>
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・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ File transfer to the client failed.
・ ......
Description A communications error occurred when sending a file.
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK. The
command prompt appears. Enter ping IP address or ping hostname and press
Enter. (Enter a space between ping and the IP address/host name.)
If there is no response, check whether there is a problem in the network
configuration.
(2) If there is no problem in the network, restart the following services on the managed
machine side.
(If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
(3) A file in transit may be in use by another process on the machine.
If virus scan or other such software is running on the machine, a file in transit may be
locked by the virus scan software, and transmission may fail. In such a case, when
the next automatic update is executed, the file is sent again and applied.
<Detailed Information 12>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ During the execution of xxxxxxxx package, an error occurred.
・ ......
Description The package was sent to the machine, but an error occurred during
execution.
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK. The
command prompt appears. Enter ping IP address or ping hostname and press
Enter. (Enter a space between ping and the IP address/host name.)
If there is no response, check whether there is a problem in the network configuration.
(2) The disk space may be insufficient.
This error occurs when the machine disk space is insufficient. Check the machine disk
free space. Normally, it requires free disk space that at least three times the size of
the package to send.
Example)
To apply a 100MByte package, it is necessary that the free space of the
managed machine system drive should be at least 300MByte.
(3) Uncompressing failed.
Check whether there is a problem in the package sent to the machine. Confirm
whether the package can be uncompressed on the machine.
<Detailed Information 13>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update Begins
・ "Automatic update completed" response could not be received from the client.
・ ......
Explanation
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK.
The command prompt appears. Enter ping IP address or ping hostname and
press Enter. (Enter a single-byte space between ping and the IP address/host
name.)
If there is no response, check whether there is a problem in the network
configuration.
(2) If there is no problem in the network, restart the following services on the managed
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machine side. (If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
<Detailed Information 14>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ automatic update notice begins
・ A socket error occurred.
No such host is known.
・ ......
Explanation
(1) Use the following procedures to execute ping for the machine.
From the Start menu, select Run, enter cmd in the name column, and click OK.
The command prompt appears. Enter ping IP address or ping hostname and
press Enter. (Enter a single-byte space between ping and the IP address/host
name.)
If there is no response, check whether there is a problem in the network
configuration.
(2) If there is no problem in the network, restart the following services on the managed
machine side. (If a service is stopped, please start it.)
DeploymentManager Agent Service
DeploymentManager Remote Update Service Client
<Detailed Information 15>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update time setting begins
・ Automatic update or scenario execution is in progress in the client.
Automatic update time setting will become valid after restarting the client.
・ ......
Explanation
The automatic update time configurations will be enabled when the machine is started
next time.
<Detailed Information 16>
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)
・ Automatic update time setting begins
・ Setting in the client failed.
Automatic update time setting will be valid after restarting the client.
・ ......
Explanation
Connection to the managed machine failed because the managed machine power
status is OFF, or the communications port is closed. The automatic update time
configurations will be enabled after the client is restarted.
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The same package is distributed repeatedly in automatic update.
Until the Management Server recognizes that the package has been applied, the distribution
is repeated at every automatic update. Check the following items, and perform the process for
each.
<When the package type is HotFix>
・ The MS number is wrong
Check the MS number and correct it.
・ The HotFix that cannot be discerned from the MS number
Set the ID information.
・ OS and language are not correct
Check the OS and language, and correct them.
・ ID information is wrong
If a file such as text format(*.txt) without file version is specified for ID information file path,
the applied status cannot be recognized if the file version is specified. If the file version is
need to be specified, make the item blank. Also, if it is specified to replace or version up
as the changed type using text format file, the applied status cannot be correctly
recognized. In the case of text format, specify new or delete for the changed type
<When the package type is service pack>
・ Major version and minor version are wrong.
Check major version and minor version and correct them.
・ OS and language are not correct
Check the OS and language, and correct them.
・ ID information is wrong
ID information is not necessary in the case of service pack. Set the correct values to for
major version and minor version.
<When the package type is application>
・ Display name, display version is wrong.
Check the display name and display version and correct them.
・ OS and language are not correct.
Check the OS and language, and correct them.
・ ID information is wrong
If a file such as text format (*.txt) without file version is specified for ID information file
path, the applied status cannot be recognized if the file version is specified. If the file
version is need to be specified, make the item blank. Also, if it is specified to replace or
version up as the changed type using text format file, the applied status cannot be
correctly recognized. In the case of text format, specify new or delete for the changed
type.
An automatic update error is displayed on the screen, and automatic update fails.
The disk capacity of the Management Server may be insufficient.
Check the disk capacity of the Management Server. If disk capacity is insufficient, secure the
necessary disk capacity, and then restart the Management Server.
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11.8. Automatic Download
An error occurred in automatic download. In Management view -> DPM Server icon -> Package
Download Settings screen -> Latest Download Information column, XXXX/XX/XX XX:XX:XX
Automatic Download Failed is displayed, and check the Event Viewer to find an error log
registered.
Check the log information registered in the Event Viewer, and perform the processes for each
item.
After the processes complete, execute the automatic download again.
<Log Information 1>
DownloadFile: Failed to create the download directory, Dir = XXX.
Explanation:
Failed to create directory.
This error occurs when the disk space of the managed machine is insufficient. Check the disk
free space.

・

<Log Information 2>
DownloadFile: Failed to parse URL, URL = XXX.
Explanation:
Unable to analyze address.
IP address of the Package Web Server may not be correct. Confirm items such as whether
only valid characters are used, or port configurations are correct. For details, see Section
2.7.3, "Package Download Setting."

・

<Log Information 3>
DownloadFile: Failed to connect proxy server, Serve Name = XXX.
Explanation:
Cannot connect to the proxy server.

・

Check the below items in the following order:
(1) The proxy server address may not be correct. Confirm items such as whether only valid
characters are used, or port configurations are correct.
(2) The network settings may not be correct.
Check whether user identification is set to the proxy server. Use an HTTP proxy if using
a proxy.
<Log Information 4>
DownloadFile: Failed to connect server, Serve Name = XXX.
Explanation:
Failed to connect to the Package Web Server.

・

Check the below items in the following order:
(1) IP address of the Package Web Server may not be correct. Confirm items such as
whether only valid characters are used, or port configurations are correct.
(2) The network settings may not be correct.
Check whether user identification is set in the proxy server. Use the HTTP proxy if
using a proxy.
<Log Information 5>
DownloadFile: Web server happened exception, Serve Name = YYY.
Refer to the following detailed message in the log information registered to the event viewer.
SendRequest: Http response error status = XXX.
(Possible values for XXX are: 500, 501, 502, 503, 504, 505)

・

An error code in line with RFC2616 is added to an error message indicated by error code
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XXX. For details, see RFC2616.
<Log Information 6>
・ DownloadFile: Failed to get response or response is error, URL = YYY.
Refer to the following detailed message in the log information registered to the event
viewer.
SendRequest: Http response error status = XXX.
(Possible values for XXX are: 400, 401, 402, 403, 404, 405, 406, 407, 408, 409, 410,
411, 412, 413, 414, 415)
An error code following RFC2616 is added to an error message displayed by error code
XXX. For details, see RFC2616.
Example) SendRequest: Http response error status = 404
->The specified URL does not exist.
<Log Information 7>
・ DownloadFile: The free disk isn't enough to download, URL = XXX.
Explanation:
This error occurs when the disk space of the Management Server is insufficient. Check
the disk free space.
<Log Information 8>
・ DownloadFile: The file cannot be refresh, Filename = xxx.
Explanation:
Failed to update the file. Check whether a file named xxx is in use.
If the file is in use, close it, and then download again.
<Log Information 9>
・ PmDlDownloadPackages: Failed to compress files, Web Server ID = xxx,
Package ID = xxx.
Explanation:
This error occurs when the disk space of the Management Server is insufficient. Check
the disk free space.
Automatic download is configured, but it is not executed even when the set time is reached.
Check the items below by the following order:
(1) In Management view -> Package Download Setting screen, check Latest Download
Information.
If XXXX/XX/XX XX:XX:XX Automatic Download Failed is displayed, see Log Information 1
through 9 of Section 11.8, "Automatic Download."
(2) Check if the Package Web Server is added as the target of automatic download on the
Package Download Setting screen. If none of the Package Web Servers are added,
automatic download is not executed. After adding a Package Web Server, perform an
automatic download again.
(3) Check whether the Perform Automatic Download checkbox is selected on the Package
Download Setting screen. If not, the automatic download cannot be performed.
If the above procedure does not solve the problem, confirm that automatic update is not in progress,
and then restart the Management Server.
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11.9. Power On
The machine cannot be turned ON when executing Power On or executing scenario.
When the machine was forcibly shut down on the POST screen, Remote Power On may not
function at the next time.
In this case, turn off the power after POST is completed, or start up the OS and then shut it
down.
Although the power is ON, the icon displayed on the machine is power OFF.
The screen may not be updated. Click Refresh on the Operation menu, or enter F5 to
refresh the screen.
The power is turned ON, but a remote power ON error is displayed on the machine list.
The managed machine may not support PXE boot, or the network boot order may be set
lower than the HDD.
For x86, check the network boot order in the BIOS settings. For methods to check the BIOS,
contact your sales or support representative.
The VMware ESX/ESXi virtual machine cannot be turned ON when executing Power On or
executing scenario.
The VMware ESX/ESXi virtual machine cannot be turned on because Remote Power On is
not support for these machines. Turn the power ON manually.

11.10.

Schedule Management

Although you set the power management schedule, the machine power is not turned ON/shut down at
the specified time.
The machine may have been running a scenario. If the machine is running a scenario at the
time set to Power ON/shutdown, the power will not be turned ON/shut down.

11.11.

Machine Information Import/Export

Although the machine information is imported, the machine is not displayed on the managed
machine list.
Click Refresh on the Operation menu, or refresh the screen by pressing the F5 key, and
then the machine will be displayed.
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11.12.

Network Settings

The following error message was displayed:
Failed to delete the computer name of the server.
Check the network environment, and restart.
The machine may not be connected to the network.
Check whether the network cable is connected to the machine, and then restart it.
Once DHCP server and the Management Server have been separately on the different machines, the
machine's MAC address cannot be obtained.
The DHCP server on the Management Server may be running. On the Management Server,
select Management Tools -> Services from Start menu, and confirm that "DHCP Server" is
stop. If it is running, disable Startup Type on the Properties screen, and stop the service.
On the Web Console, Management view -> DPM Server icon -> Detail Setting, -> DHCP
Server tab -> DHCP Server is installed on an another machine checkbox may be cleared.
Check if DHCP Server is installed on an another machine is checked. If the checkbox is not
selected, select it and click OK, and then reboot the Management Server. (If the Management
Server cannot be rebooted, stop all services listed in Appendix A, "Service List" by selecting
Management Tools -> Services from Start menu, and then start them.)
The scenario cannot be executed because the managed machine cannot execute network boot.
Network booting order may be set lower than the HDD in the BIOS configuration. Set the start
order of the PXE network boot higher than the HDD, and then execute the scenario again.
When you try to manage different network by using multiple LAN boards, the following errors are
displayed.
PXE-E51: No DHCP or proxyDHCP offers were received.
PXE-E55: proxyDHCP service did not reply to request on port 4011.
Please perform the following procedures (1) and (2).
(1) Change the IP address used by the DHCP server.
1) From Start menu, select Administrative Tools -> DHCP.
2) DHCP screen appears. Right-click the server name from the tree view, and then select
Properties.
3) Properties screen appears. Select the Advanced tab and click Binding.
4) Binding screen appears. Select only the IP address to be used and click OK.
5) From Start menu, select Management Tools -> Services, and then restart the DHCP
Server.
(2) Change the IP used by DPM.
1) From Management View -> DPM Server icon -> Detail Setting screen -> General tab ->
-> Server Information -> IP Address on the Web console screen, set the IP address
which was set in (1).
When DHCP Server and the Management Server have been separately on the different machines , the
following error was displayed at network boot execution.
PXE-E55: proxyDHCP service did not reply to request on port 4011.
A DHCP server may exist which is set to option 60(060 Class ID) in DHCP server options. Check
the DHCP server option settings, and delete the option 60(060 Class ID) setting.
If you execute a scenario, the following error is displayed.
PXE-E53:No boot filename received
The DHCP server installation location configuration is incorrect.
Open Management View -> DPM Server icon -> Detailed Setting screen on the DPM main
window screen, and check that the setting of DHCP server tab is correct.
Even if configuration is already correct, reconfigure the settings.
If an error is displayed despite correct settings, first change the current settings to different
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settings (if the actual environment is DHCP Server is installed on the machine, then change it
to DHCP Server is installed on an another machine, and if it is DHCP Server is installed on
an another machine, then change it to DHCP Server installed on the machine), and then
reconfigure the settings correctly.
Example) If DHCP Server is installed on the machine is selected::
(1) Select DHCP Server is installed on an another machine
(2) Click OK
(3) According to the message displayed on the screen to restart the services
(4) Select DHCP Server is installed on the machine
(5) Click OK
(6) According to the message displayed on the screen to restart the services
If you assigned IP addresses of the same segment to a machine with multiple LAN boards, power status
cannot be detected properly.
If static IP addresses are assigned to LAN boards which are not connected to LAN cables, the
machine may not be able to communicate normally. If any LAN boards are not connected to LAN
cables, either use DHCP settings without assigning static IP addresses, or set nothing for them.
During network boot, the following message is displayed on the screen of the managed machine, and a
scenario execution error occurs.
PXE-E32: TFTP open timeout
The TFTP port (port number: 69) may be blocked due to the port blocking functionality of
Windows Firewall, or other security software. Confirm that the TFTP port is not blocked on the
Management Server. It is necessary to unblock the TFTP port in order to perform operations on
DPM.
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11.13.

Operating Without DHCP Server

An error occurs in Power ON, or Add Machine.
Confirm if DPM Client is installed on the managed machine. See Section 2.2, "Installing the
DPM Client" in Installation Guide for the installation method.

Failed to execute Backup scenario/restore scenario/ disk configuration check scenario from
bootable CD.
Check the following:
Is the managed machine registered?
Is a scenario assigned to the managed machine?
Is the scenario assigned to the managed machine correct?
Is a Multicast Scenario assigned?
Does the scenario specify multiple tabs, such as specifying both the Backup/Restore tab
and the HW Setting tab selected?
An error occurs by scenarios excluding backup scenario, restore (unicast) scenario, or
disk configuration scenario.
If you insert a bootable CD into the managed machine and execute Backup/Restore Scenario
from the Web Console, the scenario executes on a machine except the machine specified and the
scenario completes properly, but a scenario execution error occurs on the machine specified in
Operation.
The machine may be mounted to multiple LAN boards which is executed the scenario, and
each of those boards may be registered to DPM. If there are multiple registrations for the
same machine, delete the unnecessary registrations, and then execute backup/restore
again.
Even if you set a bootable CD to start the machine, the backup/restore scenario does not start.
Is the CD the first in boot order?
If not, change the boot order so that CD boot comes first.

If you insert the bootable CD and start the machine, A state of communication was bad
condition is displayed on the screen.
Some kind of error may have occurred.
・ If timeout occurs before the managed machine connect to the Management Server:
Set a greater value for Remote Power ON Timeout on the Network tab of the Detail
Setting screen, and then run backup/restore again.
For details, see Section 2.7.1.3, "Network Tab."
・ If using a bootable CD and Do Not Use A DHCP Server is not selected on the DHCP
Server tab of the Management Server Detail Setting screen:
see Section 2.7.1.4, "DHCP Server Tab" and set the DHCP Server tab items which
correspond to the correct environment.
*The Management Server must be restarted after the configuration is changed.
・ If the MAC address of the LAN board on the managed machine is not registered to DPM,
which is in communication with the Management Server:
Register an appropriate MAC address to DPM, and execute backup/restore again.
・ If neither of the above apply:
For reasons such as the network being unconnected or influences from the network, the
Management Server and the managed machine may be under a condition where they
cannot connect with each other. Check the network status between the Management
Server and the managed machine, and then execute backup/restore again.
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If you insert the bootable CD and start the managed machine, the following message is displayed
on the screen, and processing is interrupted:
linuxrc: Cannot find CD-ROM Drives.
This error occurs when the bootable CD is unable to recognize a device.
If using a USB CD/FD drive, change the port which connects to the drive, and then try
again.
The CD drive used may not be supported by DPM.
The following CD drives of Panasonic are not supported by DPM.
KXL-840/RW11/RW20/RW21/RW31
If you are using these drives, prepare another CD drive, or execute backup/restore by
using Use A DHCP Server.
Backup/restore does not start, and the following message appears on the screen.
(The x below is a number. The following describes what to do if 5 is displayed for x.)
ERROR: Failed to read a file (x)
If backup target correspond to one of the following situation, error is displayed because the
following target must be recognized earlier than disk,
・ If a USB device is connected to backup target machine.
・ When interface is existing for backup target machine in order to connect USB device.
・ When CD-DVD drive is built in the chassis of BladeServer.
In this case, change the disk number of the scenario, and then execute the scenario.
Also, the recognized disk number depends on the device, so if the same error occurs after
changes, change the device numbers again and then execute backup.
If restore is interrupted, the following messages are displayed:
ERROR: Found the eof during the input of a binary stream.
gzip: stdin: unexpected end of file.
If restore is interrupted during data transfer, these messages may be displayed. If this
message was displayed after restore was interrupted, execute restore again, or setup the
OS.
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11.14.

PackageDescriber

If you try to start PackageDescriber on Windows Vista, the following error is displayed:
"Unable to access jarfile PackageDescriber.jar"
The configuration of Temporary Save Folder may not have been modified from the default.
Perform one of the following procedures:
・ Disable user account control (User Account Control: UAC), and use PackageDescriber.
To disable UAC, select Control Panel -> User Account -> Turn User Account Control on
or off from Start menu and clear Use User Account(UAC) to help protect your computer.
・ Run as Administrator.
(1) From Start menu, right-click All Programs -> DPM PackageDescriber, and then select
Properties.
(2) The DPM PackageDescriber Properties screen appears. Next, perform the following
configurations, and then click OK.
・ Shortcut tab
Edit the Target as follows.
[Before edit]
C:\Windows\system32\javaw.exe –jar PackageDescriber.jar
[After edit]
%ProgramFiles%\Java\jre7\bin\javaw.exe –jar PackageDescriber.jar
・ Compatibility tab
Check the Run this program as an administrator on the Privilege level.
(3) The Access Denied screen appears. Click Continue.
(4) Right-click DPM PackageDescriber shortcut icon on the desktop, select Properties,
and then perform configurations (2) to (3).
The User Account Controls screen appears when PackageDescriber is started first time
after the above configuration is performed. Click Allow.
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11.15.

Collecting the Data in Case of Trouble

 When you would like to inquire a failure while you use DPM, please send the following information:
・ Information of DPM version/the module for the machine
・ Managed machine information
- Machine model/Product number
- Configuration of optional products/Product number
- Machine name
- MAC address
- OS type
・ Date and time that the obstacle occurred
・ Failure information
- How to operate DPM, and what occurred.
・ Display on screen
- Management Server
- Managed machine
・ Repeatability
- Always occurs
- There is a case that it succeeds
- Succeeded in the past, but it began to fail one day
- On other managed machine, it occurred or not
・ DPM log collected by DPM Log tool
- Management Server
- Managed machine
*When the failure occurred, please collect log immediately
If a scenario is executed on the same machine again, the log file maybe overwritten.
After about 1 week since the failure occurred, the DHCP Server's log will be overwritten.
・ The figure of network configuration
The method to collect the DPM log is listed below.
Target machines of collecting logs are the Management Server and managed machines.
 Log collection Procedure (Windows x86/x64)
Collect logs on the Management Server, the Database Server(only when the database is configured on the
different machine from the Management Server), and the managed machine on which the error occurred,
following the procedure below.

(1) End all the processes related to DPM.
(2) Log on to the machine with Administrator right.
(3) When you collect logs on the Management Server, it is unnecessary to do this procedure.
Skip to (4). When you collect logs on the Database Server or the managed machine, copy the following
folder to the arbitrary folder.
For SSC products:
<Installation media>:\DPM\TOOLS\DpmLog
For DPM products:
<Installation media>:\TOOLS\DpmLog
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(4) From Start menu, select Run and enter "cmd", and click OK.
A command prompt is run. Move to the following folder.
・ On the Management Server: <DPM Server installation folder>\DpmLog
・ On the managed machine: The folder which was copied in the procedure (3).

Example) If the location of the folder copied is Step (3) is C:\ in Step 3
cd /d C:\DpmLog
(5) Add option -A, and execute DpmLog.exe. See the following message and send the collected log.

While DpmLog.exe is running, do not perform any DPM operation.
(6) Delete the saved log folder because it is unnecessary after sending logs.
 Log collection Procedure (Linux)
Collect the following files. When you collect the files, try not to change the time stamp (for example, -p
option of cp command and so on), then use a command such as zip or gzip to compress on Linux, and
then send.
- System Setting File
/etc/hosts
/etc/resolv.conf
/etc/sysconfig/network
/etc/sysconfig/clock
/etc/sysconfig/iptables
/etc/sysconfig/ipchains
/etc/rc.d/rc
/etc/sysconfig/network-scripts/ifcfg-*
- Version Information
In case of Red Hat Enterprise Linux: /etc/redhat-release
In case of SUSE Linux Enterprise: /etc/SuSE-release
- Files related to DPM Client
All files located in folder /opt/dpmclient/
/var/log/messages* (All files whose name begin with "messages")
All files located in folder /tmp/dpm/ (If existed)
- Network Information
Collect the execution results of the following command.
ifconfig -a
netstat -anp
route
ps -axm | grep depagtd
iptables -L
- System Information
Collect the execution results of the following command.
uname -a
lspci -vx
dmidecode
biosdecode
dmesg -s 65536
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Appendix A Service List
The followings are the DPM services and processes.
Processes for which service display name is noted as None or (Child Process), are those
processes which start at the time related functions are executed. They are not resident
services.
 DPM Server
Service Display Name

Process/File Name

Function

(Display number)*1
DeploymentManager API Service
(Child process)

mkParams.exe

Scenario execution and
Configuration of each item
Tool to create the Windows

(1 or more)

disk duplication data file

magicsend.exe(1)

Execution of Remote

apiserv.exe(1)

Power-on
ipconfig.exe (1 or more)

Network Configuration

nbtstat.exe (1 or more)

Network Configuration

bkressvc.exe(1)

Execution of backup/restore

DeploymentManager Get Client Information

depssvc.exe(1)

DeploymentManager PXE Management

pxesvc.exe(1)
ipconfig.exe (1 or more)

Receiving OS/service
packs/patches information
from a managed machine
Managing Network (PXE)
booting
Network configuration

nbtstat.exe (1 or more)

Network configuration

DeploymentManager PXE Mtftp

pxemtftp.exe(1)

TFTP server function

DeploymentManager Remote Update Service

rupdssvc.exe(1)

Execution of remote update

zip.exe(1)
unzip.exe(1)

File compressing command
File extracting command

schwatch.exe(1)

Managing schedule

magicsend.exe(1)

Execution of Remote

DeploymentManager Backup/Restore
Management

(Child process)

(Child process)
DeploymentManager Schedule Management
(Child process)

Power-on

DeploymentManager Transfer Management
(Child process)

ipconfig.exe (1 or more)

Network Configuration

nbtstat.exe (1 or more)

Network Configuration

ftsvc.exe(1)

File transfer service
Tool for acquiring information
of OS

CHKOS32.exe
(1 or more)

*1
The default installation folder is
C:\Program Files\NEC\DeploymentManager.
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 Database *1
Service Display Name

Process/File Name

Function

(Display number)
SQL Server (Instance name)
sqlservr.exe(1) *2
SQL database (DPM)
*1
This runs on the machine on which the database is configured.
*2
The default installation folder is
C:\Program Files\Microsoft SQL Server\MSSQL11.Instance name\MSSQL\Binn.
 Image Builder (Remote Console)
Service Display Name
Process/File Name
(Display number)*1
None
DIBuilde.exe(1)
(Child process ID)

Function
Image Builder

DIBPkgMake.exe(1)

Tool for creating a package

DIBPkgDel.exe(1)

Tool for deleting a package

mkParams.exe(1)

Tool for creating the Windows disk duplication
data file
Tool for creating the Linux install parameters

ExecLinuxIParm.jar(1)
ExecLinuxSysRep.jar(1)
winftc.exe(1)

Tool for creating the Linux disk duplication data
file
File transferring tool

zip.exe(1)

File compressing command

CHKOSCD.EXE(1)

OS CD-ROM check tool

*1
The default installation folder is C:\Program Files\NEC\DeploymentManager.
 DPM Command Line
Service Display Name
None

Process/File Name
(Display number)*1
dpmcmd.exe (1 or more)

Function
Scenario execution and so on from DPM
Command Line

*1
The default installation folder is C:\Program Files\NEC\DeploymentManager.
 DPM Client (Windows)
Service Display Name
DeploymentManager Agent
Service
DeploymentManager Remote
Update Service Client
(Child process ID)

None

Process/File Name
(Display number)*1
DepAgent.exe(1)

Function

rupdsvc.exe(1)

Execution of remote update
Sending OS/service packs/patches
information to DPM Server
Command for extracting
Compressed file

unzip.exe(1)

Execution of power off from DPM Server

Executable File (1)

Package Installer

GetBootServerIP.exe(1)

Searching the Management Server

DPMTray.exe
(1 or more )

Automatic update status display
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*1
The default installation folder is:
• In case of x86: C:\WINDOWS\system32
• In case of x64: C:\WINDOWS\SysWOW64
 DPM Client (Linux)
Service(daemon) Display Name
Depagt
(Child process ID)
Starts by system
function

Process/File Name
(Display number)
depagtd(1,2)*1

Function

depagtd(1)

rpm(1)

Power off from DPM Server
Remote update service
Sending OS and patch information of
the managed machine to DPM Server
rpm package installer

shutdown(1)

Shutdown command

mv(1)

Command for file transferring

echo(1)

Command for displaying messages

unzip(1)
touch(1)

Command for extracting compressed
files
Command for changing the time stamp

GetBootServerIP(1)

Searching the Management Server

DPM Client Service

*1
The install directory is fixed value /opt/dpmclient/agent/bin.

Procedure and Order of Starting and Stopping the
Service
DPM Server is linked to and dependent on each DPM related service. Therefore, if you start or stop services
manually, do in the following order.
About DPM Client services(daemon), there is no start/stop order.
•Start service order
(1) SQL Server (Instance name)
(2) Services that begin with "DeploymentManager"
•Stop service order
(1) Services that begin with "DeploymentManager"
(2) SQL Server (Instance name)

Appendix B Event Log
About the event log, contact your sales or support representative.

Appendix C Error Information
About error information, contact your sales or support representative
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Appendix D Network Port and Protocol List
 Communication Ports used by DPM



When you configure DHCP server and NFS Server on the Management Server, the
communication which is described in each table is done between the Management Server and a
managed machines.
About opening the communication port(Windows OS), which is used by DPM, automatically or
manually, see Section 7.1, "Port Opening Tool."

• Communications between the Management Server and managed machines
Item
Management Server
Protocol
Co
Address
nn
Specificati
Executable
Port
Availa
ecti
on
File Name
No.
bility
on
of
Dir
Modif
ecti
ying
on
Port
No.
DirectBroad
Power
magicsend.ex
*1
No
UDP
->
cast
On
e
*2
Shutdow apiserv.exe
*1
No
TCP
->
Unicast
n
schwatch.exe

Existenc
e
Confirma
tion
(Power
ON/OFF
Status
Check)
Network
Boot

apiserv.exe
schwatch.exe

- *3

No

apiserv.exe
schwatch.exe

0 *3

No

pxesvc.exe

67

No

pxesvc.exe

67

No

pxesvc.exe
pxesvc.exe
pxesvc.exe
pxesvc.exe
pxemtftp.exe

67
4011
4011
67
69

No
No
No
No
No

pxemtftp.exe

69

No

bkressvc.exe

26503
*10
26502
*10

bkressvc.exe

Managed Machine
Port
Avail Executable
No.
abilit File Name
y of
Modi
fying
Port
No.
5561
No

26509
*10

Yes

ICMP
Echo
request
ICMP
Echo
request

->

Unicast

8 *3

No

<-

Unicast

- *3

No

<-

68

No

68

No

->
<<->
<-

Broadcast
*4 *5
Broadcast
*4 *5
Unicast
Unicast
Unicast
Unicast
Unicast

68
68
4011
4011
*6

No
No
No
No
No

->

Unicast

*6

No

Yes

UDP
(DHCP)
UDP
(DHCP)
UDP
UDP
UDP
UDP
UDP
(TFTP)
UDP
(TFTP)
TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No
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->

For
Windows:
DepAgent.e
xe
For Linux:
depagtd

OS
installati
on by
disk
duplicati
on *7
Restore
(Multicas
t) *8

ftsvc.exe

26508
*10

Yes

TCP

<-

Unicast

*1

No

ftsvc.exe

26508
*10
26501
*10
26530
*10
26508
*10
26501
*10
26508
*10
26501
*10
26508
*10

Yes

TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No

Yes

UDP

->

Multicast

Yes

Yes

TCP

<-

Unicast

26530
*10
*1

Yes

TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No

rupdssvc.exe

*1

No

TCP

->

Unicast

26510
*10

Yes

rupdssvc.exe

*1

No

UDP

->

Multicast

26529
*10

Yes

rupdssvc.exe

26507
*10

Yes

TCP

<-

Unicast

*1

No

Acquisiti
on of
managed
machine
OS/HotFi
x
informati
on
Automati
c Update
Request

depssvc.exe

26504
*10

Yes

TCP

<-

Unicast

*1

No

rupdssvc.exe

Yes

TCP

<-

Unicast

*1

No

Yes

TCP

<-

Unicast

*1

No

Automati
c update
notice

rupdssvc.exe

26506
*10
26507
*10
*1

No

TCP

->

Unicast

Yes

26506
*10
26507
*10

Yes

TCP

<-

Unicast

26511
*10
*1

Yes

TCP

<-

Unicast

*1

No

bkressvc.exe
bkressvc.exe

Restore
(Unicast)
*9

ftsvc.exe

Backup
*9

ftsvc.exe

bkressvc.exe

bkressvc.exe
Disk
Configur
ation
Check *9
Installing
service
packs,
hotfixes,
Linux
patch
files, and
applicati
ons by
remote
update

ftsvc.exe

rupdssvc.exe

rupdssvc.exe
rupdssvc.exe
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No

No

For
Windows:
rupdsvc.ex
e
For Linux:
depagtd
For
Windows:
rupdsvc.ex
e
For Linux:
depagtd
rupdsvc.ex
e (Windows
only)
For
Windows:
rupdsvc.ex
e
For Linux:
depagtd

rupdsvc.ex
e
rupdsvc.ex
e
rupdsvc.ex
e
rupdsvc.ex
e
rupdsvc.ex
e

Operatio
n
without
using
DHCP
Server
Searchin
g the
Manage
ment
Server

Acquisiti
on of
file/folde
r list

pxesvc.exe

26505
*10

Yes

TCP

<-

Unicast

*1

No

pxesvc.exe

67

No

UDP
(DHCP)

<-

Broadcast
*4

68

No

pxesvc.exe

67

No

UDP
(DHCP)

->

Broadcast
*4

68

No

pxesvc.exe

4011

No

UDP

<-

Unicast

*1

No

pxesvc.exe

4011

No

UDP

->

Unicast

*1

No

pxemtftp.exe

69

No

<-

Unicast

*1

No

pxemtftp.exe

69

No

->

Unicast

*1

No

apiserv.exe

*1

No

UDP
(TFTP)
UDP
(TFTP)
TCP

->

Unicast

26520

Yes

Windows:
GetBootSer
verIP.exe
Linux:
GetBootSer
verIP
Windows:
GetBootSer
verIP.exe
Linux:
GetBootSer
verIP
Windows:
GetBootSer
verIP.exe
Linux:
GetBootSer
verIP
Windows:
GetBootSer
verIP.exe
Linux:
GetBootSer
verIP

For
Windows:
rupdsvc.ex
e
For Linux:
depagtd

*1
The port is automatically assigned.
*2
A machine on the same segments as the Management Server is addressed 255.255.255.255.
If the segments are different than those of the Management Server, the address specification is direct
broadcast.
Example) The segment 192.168.0.0(MASK=255.255.255.0) is addressed 192.168.0.255.
*3
With ICMP (Internet Control Message Protocol), communication specifying the port number is not performed,
but is routed using the value in the ICMP Type field value.
*4
A packet relayed by DHCP relay may be addressed as Unicast.
*5
Only if the DHCP and the Management Server are installed on different machines.
*6
Depends on the LAN board ROM of the machine.
*7
The protocols and port numbers listed in Restore are also required.
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*8
The protocol and the port number in the table of Network Boot are also needed. (You can restore by multicast
only when you use DHCP server.)
*9
If operations are performed using DHCP, the protocols and port numbers listed in Network Boot items are
also required.
If operations are performed without using DHCP, the protocols and port numbers listed in Operation without
Using DHCP Server are also required.
*10
The default values of the ports to be used were changed from DPM Ver6.1. When you upgraded from the
version earlier than DPM Ver6.1, the port numbers used before upgrading are taken over. Therefore, the port
numbers are different from them(Values in the above table) of when you install DPM Server newly. However,
the port for Web service(56050) is not taken over and new port(26500) is used. When you use the port which
was used before upgrading, modify it manually. The followings are the default ports when you install DPM
Server newly and when you upgrade DPM Server.
When you install DPM Server newly
When you upgrade DPM Server from the
version earlier than DPM Ver6.1

26500
26501
26502
26503
26504
26505
26506
26507
26508
26509
26510
26511
26529
26530

26500
56020
56022
56030
56011
56060
56024
56028
56023
56010
56000
56025
56001
56021
 When OS of managed machine is Windows Server 2008/Windows Server 2008 R2/
Windows Server 2012/Windows Vista/Windows 7/Windows 8, depending on the status
of the network used when DPM Client is installed, either of ports in public profile, private
profile or domain profile of Windows Firewall will be opened
When the managed machine joins domain and the Domain Profile is changed, the port
used by DPM will be blocked, and the machine cannot communicate anymore.
Open the ports or programs used by DPM in Domain Profile in advance on the
managed machine that joins domain or the master machine of OS installation by disk
duplication.
You can open the managed machine's ports or programs in Domain Profile, following
the procedure below.
- Setup by domain policy:
Specify in the domain policy of domain controller on Windows Server 2008 or later,
- Setup locally on the managed machine:
(1) On the managed machine, from Inbound Rules of Windows Firewall with
Advanced Security, right-click the following items and select Properties.
・ Common
DeploymentManager(DepAgent.exe)
DeploymentManager(rupdsvc.exe)
・ Windows Vista/Windows7
Network - Echo Request(ICMPv4-In)
・ Windows Server 2008/Window Server 2008 R2 /Windows Server 2012
/Windows 8
File and Printer Sharing (Echo Request – ICMPv4-In)
(2) In Advanced tab of Properties dialog, select Domain checkbox in Profiles.
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 In case of Windows Server 2003(SP1/SP2)/Windows Server 2003 R2, all connection
request are blocked by secirity update(Post-Setup Security Updates:PSSU) until latest
update program is applied.
Update the managed machine to latest status by Windows Update and so on, or
release PSSU manually. To release PSSU manually, log on by administrator and close
the security update window.
 When you set the firewall service on the managed machine to automatic start, all ports
are closed from when the machine is started to when the firewall service is started
regardless of that the firewall function is enabled or disabled. At this timing, if you
operate the following, the processing will fail.
・ If you execute a scenario or shut down, an error occurs because the Management
Server cannot communicate with the managed machine.
In this case, after confirming that the managed machine is powered on on the Web
Console, execute a scenario or shut down.
・ When the version and revision of DPM Client is not matched with that of DPM
Server, automatic upgrade of DPM Client will be done. However, the automatic
upgrade fails because the Management Server cannot communicate with the
managed machine at this timing.
In this case, upgrade by a scenario, seeing Section 3.3.2, "Manually Upgrading the
DPM Client" in Installation Guide.
•Communication between the Database Server and the Management Server
Item
Database Server
Protocol
Conne Address
ction
Specifica
Executa Port
Availa
Directi tion
ble File
No.
bility
on
Name
of
Modif
ying
Port
No.
Database
26512 Yes
TCP
<Unicast
*2

Management Server
Port
Availabili Executa
No.
ty of
ble File
Modifyin
Name
g Port
No.

*1

No

apiserv.
exe
bkressvc
.exe
depssvc.
exe
ftsvc.exe
pxesvc.e
xe
rupdssvc
.exe
schwatc
h.exe

*1
The port is assigned automatically.
*2
When you change the port number, do it before installing DPM Server newly. After that, you cannot
change it.
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•Communication between DHCP server and managed machines
Item
DHCP Server
Protocol
Conne Address
ction
Specifica
Executa Port
Availa
Directi tion
ble File
No.
bility
on
Name
of
Modif
ying
Port
No.
Obtaining
67
No
UDP
<Broadcast
the IP
(DHCP)
*1
address
67
No
UDP
->
Broadcast
(DHCP)
*1
*1
A packet relayed by DHCP relay may be addressed as Unicast.

Managed Machine
Port
Availabili
No.
ty of
Modifyin
g Port
No.

68

No

68

No

Executa
ble File
Name

• Communication between NFS Server and managed machines
Item
NFS Server
Protocol
Conne Address
Managed Machine
ction
Specifica Port
Executa Port
Availa
Availabili Execut
Directi tion
ble File No.
bility
No.
ty of
able
on
Name
of
Modifyin
File
Modif
g Port
Name
ying
No.
Port
No.
OS Clear
- *1
111
No
TCP
<Unicast
*2
No
*1
Installation - *1
111
No
UDP
<Unicast
*2
No
*1
- *1
1048 No
TCP
<Unicast
*2
No
*1
*3
- *1
1048 No
UDP
<Unicast
*2
No
*1
*3
- *1
2049 No
TCP
<Unicast
*2
No
*1
- *1
2049 No
UDP
<Unicast
*2
No
*1
*1
The file name is a Linux OS related module. (Not included in DPM products.)
*2
The port is automatically assigned.
*3
This port number may be dynamically changed. If communication fails, use the "rpcinfo -p" command to
check the port number used by mountd (NFS mount daemon) service, and then open the port. If the problem
is not solved by this method, turn off the Windows firewall.
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• Communication between the Web Console and the Management Server
Item
Machine used for Web
Protocol Conne Address
Console
ction
Specifica
Directi tion
Executa Port
Availa
on
ble File
No.
bility
Name
of
Modify
ing
Port
No.
Web
*1
No
TCP
->
Unicast
Console
(HTTP)

Management Server *2
Port
No.

Availabili
ty of
Modifyin
g Port
No.

Execu
table
File
Name

80 *3

Yes

Web
service
(IIS)

*1
The port is automatically assigned.
*2
Because the Management Server uses the port (TCP:26500) for the internal processing (the communication
between DPM Server and Web Service(IIS)), do not use this port by other applications.
*3
You can change the port to be used by the following procedure.
Example) For IIS 7.0
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start menu.
2) Internet Information Services (IIS) Manager screen appears. Right-click computer name -> Sites
-> Web Site name on the tree view, and select Edit Bindings... and change the port number.
• Communication between Image Builder (Remote Console) and the Management Server
Item
Machine used for Image
Protocol
Con
Address
Management
Builder (Remote Console)
necti Specifica Server
on
tion
Executa Port
Availabi
Port
Availabili Executa
Dire
ble File
No.
lity of
No.
ty of
ble File
ction
Name
Modifyi
Modifyin
Name
ng Port
g Port
No.
No.
Image
DIBuilde *1
No
TCP
->
Unicast
26508 Yes
ftsvc.ex
Builder
.exe
*2
e
(Remote
Console)
*1
The port is automatically assigned.
*2
When you upgrade DPM Server from the version earlier than DPM Ver6.1, the port before upgrading
(56023) is taken over.
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• Communication between DPM Command Line and the Management Server
Item
Machine used for DPM
Protoco Conne Addres
Management Server *2
Command Line
l
ction
s
Directi Specific Port No. Availabi Execu
Executa Port
Availabi
on
ation
ble File
No.
lity of
lity of
table
Name
Modifyi
Modifyi File
ng Port
ng Port Name
No.
No.
DPM
dpmcmd *1
No
TCP
->
Unicast
80 *3
Yes
Web
Command
.exe
(HTTP)
service
Line
(IIS)
*1
The port is automatically assigned.
*2
Because the Management Server uses the port (TCP:26500) for the internal processing (the communication
between DPM Server and Web Service(IIS)), do not use this port by other applications.
*3
You can change the port to be used by the following procedure.
Example) For IIS 7.0
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start menu.
2) Internet Information Services (IIS) Manager screen appears. Right-click computer name -> Sites
-> Web Site name on the tree view, and select Edit Bindings... and change the port number.
Depending on the type of OS, the DPM service may not be able to start if there is a port conflict
between the DPM service and other service or application causing by the Ephemeral port. For
methods of checking and handling problems with ephemeral ports, see "Regarding ports used by
DPM" of Section 2.2.1, "Regarding the Network Environment" in First Step Guide.
For router and switch configuration, see the manual of the network device or contact the vendor.
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Appendix E Log Files Output by DPM
 DPM Server
The following are logs which are output on the machine on which DPM Server is installed.
In the machine on which DPM Server is installed, Image Builder and DPM Command Line are
also installed. See also the description of Image Builder (Remote Console) and DPM Command
Line below.
Folder
File

Output Content
Recording Method

Folder

File
Output Content
Recording Method

<DPM Server installation folder>\Log
(Default: C:\Program Files\NEC\DeploymentManager\Log)
apiserv.csv
apitrace.log
bkressvc.csv
DepInit.csv
depssvc.csv
DIBPkgMake.csv
ftsvc.csv
pmdb.log
pminfo.log
pxemtftp.csv
pxesvc.csv
rupdssvc.csv
schwatch.csv
rupdssvc_managed machine MachineName_ managed machine
MACAddress.log
DPM trace log, monitor log, error information, database access log
The maximum size of apitrace.log is 1MByte. The maximum size of
pmdb.log and pminfo.log is 16KByte. The maximum size of the other files
is 10MByte.
If the size of apitrace.log exceeds the maximum file size, the file is
overwritten in order from the top location in the file.
The pmdb.log and pminfo.log and rupdssvc_manmaged machine
MachineName_managed machine MACAddress.log are managed by 2
generations. (If the size exceeds the maximum file size, the file is
renamed to *.log.bak, and the original *.log.bak is deleted.)
The *.csv files are managed by 5 generations.
(If the size of *.csv exceeds the maximum file size, the file is renamed to
*.csv.1, and each original *.csv.n file is renamed to *.csv.n+1, and *.csv.4
is deleted.)
Also, each file can be deleted manually. (Delete *.csv and
apitrace.log.manually after stopping the DPM services.)
<DPM Server installation folder>\Datafile\LogFile\SnrReport
(Default:
C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\SnrReport)
Scenario.rpt
Scenario Execution Results
There is no restriction for the file size.
Furthermore, you can delete it from the Web Console. (For delete
procedure details, see Section 4.5.2, "Delete Log.")
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Folder

File
Output Content
Recording Method

<DPM Server installation folder>\Datafile\LogFile\AuReport
(Default:
C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\AuReport)
Index.rpt
managed machine MACaddress.rpt
Execution log for automatic update (application automatic delivery) on a
managed machine
Each managed machine is individually managed by MAC address.
There is no restriction for the file size.
The maximum record numbers of the logs can be set from the Web
Console.
According to the setting of maximum number of logs, if the log number
exceeds it, the logs will be deleted from index.rpt file from the oldest in
order, or 10% of the logs will be deleted from the oldest.
For maximum number of log settings, see Section 4.7.2, "Maximum
Number of Logs Settings."
Furthermore, when the oldest log records from Index.rpt are deleted, the
related information is deleted from managed machine MACaddress.rpt.
Also, you can delete the log file from the Web Console. (For delete
procedure details, see Section 4.7.4, "Delete Log.")

Folder

File

Output Content
Recording Method

<DPM Server installation folder>\Datafile\JSLog
(Default:
C:\Program Files\NEC\DeploymentManager\Datafile\JSLog)
CmdUserJSLog_YYYYMMDD.csv
CmdSelfJSLog_YYYYMMDD.csv
MngUserJSLog_YYYYMMDD.csv
MngSelfJSLog_YYYYMMDD.csv
* YYYYMMDD is a date.
Monitor log (the user operations/DPM Server internal operations)
Each file is saved to a file dated to the current day.
There is no restriction for the file size.
The files dated to the current day cannot be deleted while DPM Services
are running. Only those files whose dates have already passed can be
deleted even if those services are running. Furthermore, a file is
automatically deleted when 30 days have elapsed from the file creation
date.
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Folder

File

Output Content
Recording Method

<DPM Server installation folder>\WebServer\Logs
(Default:
C:\Program Files\NEC\DeploymentManager\WebServer\Logs)
Browser.log
Error.log
JSOX-Event.csv
LibAPI.log
Polling.log
Trace.log
WebConsole.log
Web Console error notifications, traces, and monitor logs
The maximum size of Polling.log is 1MByte. The maximum size of the
other files is 10MByte.
Polling.log is increased in one file, and the JSOX-Event.csv file is
managed by 2 generations. (If the size exceeds the maximum file size,
the file name is renamed to JSOX-Event.csv.1, and the original
JSOX-Event.csv.1 is deleted.)
The other files are managed by 6 generations. (If the size of *.log
exceeds the maximum file size, the file name is renamed to *.log.1, and
each original *.log.n file is rename to *.log.(n+1), and *.log.5 is deleted.)
Each file can also be deleted manually.

Folder
File

Output Content
Recording Method

Folder
File

Output Content
Recording Method

<Folder for Image>\upload\dpmupload
(Default: C:\Deploy\upload\dpmupload)
managed machine MACaddress_B.zip
managed machine MACaddress_B.Error.zip
managed machine MACaddress_R.zip
managed machine MACaddress_R.Error.zip
managed machine MACaddress_P.zip
managed machine MACaddress_P.Error.zip
managed machine MACaddress.zip
managed machine MACaddress_Error.zip
managed machine-side results from execution of backup/restore/disk
format check
Each managed machine is individually managed by MAC address.
The maximum size of each file is approx. 50KByte, and the file is
overwritten each time a scenario executes. Furthermore, the file can be
deleted manually. When the managed machine is in UEFI mode, the
maximum size of each file is approx. 200KByte.
%SystemRoot%
(Default: C:\WINDOWS)
Inst_Dpm_Db.log
Inst_Dpm_Dbadmin.log
Inst_Dpm_Ports.log
Inst_DPM_Mng.log
DPM installation log
There is no limit for the file size.
Inst_Dpm_Db.log is overwritten each time DPM Server is installed, and
the size does not increase after installing. Other files increase
monotonically. Each file can be deleted manually.
When you configure the Database Server, Inst_Dpm_Db.log and
Inst_Dpm_Dbadmin.log are not created.
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 Database Server
The following are logs which are output on the machine on which the database is installed.
Folder

File
Output Content
Recording Method

<SQL Server installation folder>\MSSQL11.Instance name
\MSSQL\Log
(Default:
C:\Program Files\Microsoft SQL Server\MSSQL11. Instance name
\MSSQL\Log)
ERRORLOG
log_n.trc (n is a number)
SQL Server log
There are no file size restrictions on any of the files.
ERRORLOG is managed by 7 generations. (If SQL Server(Instance
name) restarts, the file name is changed to ERRORLOG.1, and each
original ERRORLOG.n file is changed to become ERRORLOG.(n+1),
and ERRORLOG.6 is deleted.)
log_n.trc is managed by 5 generations. (If SQL Server(Instance name)
service is restarted at a state in which log_1.trc to log_5.trc exist,
log_1.trc is deleted, and new log_6.trc is created.)
ERRORLOG cannot be deleted.
The log_n.trc cannot be deleted while SQL Server(Instance name)
service is running. Past logs can be deleted even if the service is
running.

 DPM Client (Windows)
The following are logs which are output on the managed machine on which DPM Client (Windows) is installed.
Folder
File

Output Content

Recording Method

Folder
File
Output Content
Recording Method

<DPM Client installation folder>
(Default: C:\Program Files\NEC\DeploymentManager_Client)
DepAgent.log
rupdsvc.log
DPMTray.log
GetBootServerIP.log
DPM Client service log
Logs of Automatic Update Status Display Tool
Logs of searching the Management Server by DPM Client
The maximum file size of DPMTray.log is 1MByte. The maximum file
size of other files is 2MByte.
If the size of DPMTray.log exceeds the maximum size of the file, all logs
are cleared and the log is recorded newly.
DepAgent.log, rupdsvc.log, and GetBootServerIP.log are managed by
2 generations. (If the size exceeds the maximum file size, the file name
is changed to *.log.bak, and the original *.log.bak is deleted.)
Each file can also be deleted manually.
%SystemRoot%\DeploymentManager\JSLog
(Default: C:\WINDOWS\DeploymentManager\JSLog)
CliSelfJSLog_YYYYMMDD.csv
* YYYYMMDD is a date.
Monitor log (DPM Client internal operations)
There is no restriction for the file size.
Saved to a file dated to the current day.
Files dated to the current day cannot be deleted while DPM Services
are running. Only those files whose dates have already passed can be
deleted even if those services are running. The file is automatically
deleted when 30 days have elapsed from the file creation date.
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Folder
File
Output Content
Recording Method

%SystemRoot%
(Default: C:\WINDOWS)
Inst_DPM_Win_Cli.log
DPM install log
There is no limit of the file size on each file. Each time DPM Client is
installed, the file size is increased monotonically. The file can be deleted
manually.

 DPM Client (Linux)
The following are logs which are output on the managed machine on which DPM Client (Linux) is installed.
Folder
File

Output Content

Recording Method

/opt/dpmclient/agent/log
depinst.log
depagtd.log
GetBootServerIP.log
Install log of DPM Client
Service log of DPM Client
Logs of searching the Management Server by DPM Client
There is no limit for the file size in depinst.log, and the file is overwritten
each time DPM Client is installed.
The depagtd.log and GetBootServerIP.log are managed by 2
generations. (If the size exceeds the maximum file size(2MByte), the file
name is changed to *.log.bak. Original *.log.bak is deleted.)
The file can be deleted manually.

 Image Builder (Remote Console)
The following are logs which are output on the machine on which Image Builder (Remote Console) is installed.
Folder
File

Output Content
Recording Method

<Image Builder (Remote Console) installation folder>\Datafile\JSLog
(Default: C:\Program Files\NEC\DeploymentManager\Datafile\JSLog)
ImgUserJSLog_YYYYMMDD.csv
ImgSelfJSLog_YYYYMMDD.csv
* YYYYMMDD is a date.
Monitor log (operations performed by the user/Image Builder internal
operations)
There is no limit for the file size, and each file is saved to a file dated to
the current day.
Files dated to the current day cannot be deleted while DPM Services are
running. Thus, only those files whose dates have already passed can be
manually deleted even if those services are running. The file is
automatically deleted when 30 days have elapsed from the file creation
date.

 DPM Command Line
The following are logs which are output on the machine on which DPM Command Line is installed.
Folder
File
Output Content
Recording Method

<DPM Command Line installation folder>\Log
(Default: C:\Program Files\NEC\DeploymentManager\Log)
DPM_Trace1.csv
Monitor log (operations performed by the user/DPM Command Line
internal operations)
The maximum file size of DPM_Trace1.csv is 10MByte.
It is managed by 5 generations. (If the size of DPM_Trace1.csv exceeds
the maximum file size, the file name is changed to DPM_Trace2.csv, and
each original DPM_Tracen.csv file is changed to become
DPM_Trace[n+1].csv, and DPM_Trace5.csv is deleted.)
Each file can also be deleted manually. Files cannot be deleted while
DPM Command Line is running.
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Appendix F

Procedure to Check the Version
of Each Component

 DPM Server
Check the bottom (footer) of the Web Console.
About starting the Web Console and logging into DPM, see from Section 5.1.1, "Starting the Web Console" to
Section 5.1.2, "Logging into DPM" in Installation Guide.
Example) DeploymentManager 6.2-XXXXX
* XXXXX is the number.
 DPM Client (Windows)
1) From the Start menu, click Control Panel -> Programs and Features.
2) Select Views menu-> Choose Details.
3) On the Choose Details screen, select the Version check box and click OK.
4) Check the Version displayed on DeploymentManager.
Example) 6.20.000
 DPM Client (Linux)
Execute the command below, and check the version displayed.
cd /opt/dpmclient/agent/bin
depagtd -v
Example) DeploymentManager Ver6.2
 Image Builder (Remote Console)
1) From the Start menu, click Control Panel -> Programs and Features.
2) Select Views menu-> Choose Details.
3) On the Choose Details screen, select the Version check box and click OK.
4) Check the Version displayed on DeploymentManager (Image Builder).
Example) 6.20.000
 DPM Command Line
1) From the Start menu, click Control Panel -> Programs and Features.
2) Select Views menu-> Choose Details.
3) On the Choose Details screen, select the Version check box and click OK.
4) Check the Version displayed on DeploymentManager (DPM Command Line).
Example) 6.20.000
 PackageDescriber
1) From the Start menu, click Control Panel -> Programs and Features.
2) Select Views menu-> Choose Details.
3) On the Choose Details screen, select the Version check box and click OK.
4) Check the Version displayed on DPM PackageDescriber.
Example) 6.20.000
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Appendix G Glossary
 Alphabetical order

A
Automatic Download

Function which automatically downloads a new package from the
Package Web Server to the Management Server at timing configured in
advance.

automatic update

The managed machine checks the Management Server at timing
configured in advance, if there has packages which has not been
applied. It will send distribution request and automatically apply those
packages.

automatic update notice

Notification that the Management Server issues to the managed
machine so that automatic update can be performed in real time when a
package of highest urgency is registered to the Management Server.

B
Backup/Restore

Function to backup or restore data contained on a disk by either disk unit
or partition unit.

D
Deploy-OS

A Linux OS (kernel) customized for DPM that runs on the managed
machine.
Deploy-OS is sent to the managed machine from the Management
Server, and is deployed on the memory of the managed machine during
backup/restore/disk configuration check.
Furthermore, if operating DPM without using a DHCP server, Deploy-OS
is included in the bootable CD.

DHCP server

DHCP (Dynamic Host Configuration Protocol) is a protocol that
dynamically modifies the IP address.
DHCP sever refers to the machine or network device which has the
functionality to provide configuration information by DHCP.
In DPM, the DHCP server is used when a managed machine performs a
PXE boot, or to assign an IP address during OS installation by disk
duplication.

Disk configuration check

Function to check disk configuration before backup/restore is executed.
You can confirm the disk number specified at the time of backup/restore.

DPM Client

DPM component. It runs on a managed machine and transfers data to
DPM Server. Also controls the managed machines (shutdown and so
on) and sends information such as package applied/not applied.

DPM Command Line

DPM component. It performs processing such as status check of the
managed machine and scenario execution from the command line.

DPM Server

DPM component. It performs processing to the managed machine
through Web Console operations or DPM Command Line.

E
Effective sector backup

Backup of the only effective sectors of a hard disk.
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ESX, ESXi

Virtualization software offered by VMware, Inc.

Express5800 Series

Business-oriented workstation server offered by NEC.

Full sector backup

Backup all sectors of hard disk.

G
Guest OS

The OS operating on the virtual machine.

H
Host OS

Indicates the OS which is the infrastructure on which virtualization
software runs.

Hyper-V

Microsoft virtualization software offered by Microsoft.

I
IIS

Abbreviation for Internet Information Services, software for internet
services offered by Microsoft.

Image Builder

Create packages, and disk duplication data files used by OS installation
by disk duplication, and then registers them to the Management Server.

Image Builder (Remote
Console)

Image Builder used on machine except the Management Server.

Installation media

Indicates the media bundled in DPM product.

L
LAN board

Board used to connect to a LAN (Local Area Network). Also called NIC
(Network Interface Card) or LAN adaptor.

M
MAC Address

Abbreviation for Media Access Control address, which is a fixed ID
number for each LAN board.

Managed Machine

Machine which managed by DPM. May be noted as Computer, Client, or
Client Computer.

Management Server

The physical server that DPM Server is installed.

Master Image

Disk image of the machine which is the master of OS installation by disk
duplication source.

Master Machine

The machine which is the master of OS installation by disk duplication
source.
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O
OS clear Installation

Function that installs Red Hat Enterprise Linux while setting detailed
configurations for the managed machine.

OS installation by disk
duplication

Machine cloning function using Sysprep tools (master image creation
tools) and DPM backup/restore functionality.

P
Package

The combination of patch, application or package application file.
Created by either Image Builder or PackageDescriber.

Package Information File

File that basic information, execution information, applicable OS
information, dependent information and identification information of a
patch or an application are stored.
Created by either Image Builder or PackageDescriber.

Package Registration

Upload a package created by PackageDescriber to the Package Web
Server.
Furthermore, the package needs to be re-uploaded if has been modified
by PackageDescriber to the Package Web Server.

Package Web Server

The web server which stores the packages. The Package Web Server
can share packages for multiple Management Servers. Access must be
allowed by HTTP protocol.

PackageDescriber

DPM component. A tool that creates packages and registers them to the
Package Web Server.

Patch

Windows OS service packs and hotfixes released by Microsoft.

PXE boot (network boot)

Abbreviation for Preboot eXecution Environment boot.
A boot method that using PXE (network booting standard) by the LAN
board to start a program through the network.
It is used by DPM to detect a managed machine, or to perform
backup/restore/disk configuration check or package distribution.

R
Remote update

Installing service packs, hotfixes, Linux patch files, and applications, and
applications

S
Scenario

A configuration used to execute processing such as Distribution of
floppy disk image for BIOS/firmware, OS clear installation, Installing
service packs, hotfixes, Linux patch files, and applications, and
backup/restore/disk configuration check.

SigmaSystemCenter

The management software of IT platforms including virtual environment.
DPM is bundled into SSC software suit.

SQL Server

Relational model database server provided by Microsoft. The data of
DPM is stored in SQL Server.

Sysprep

Windows OS deployment tool provided by Microsoft.

V
Virtual Machine

Indicates the machines virtually run on the virtual machine server.
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VirtualPCCenter

Software product that manages a virtual PC-type thin client.

VLAN

Technology which builds a logical network, and then divides the network
into multiple broadcast domains, unlike physically network configuration.

W
Web Console

Checks the status of a managed machine and executes processing to a
managed machine.

WOL(Wake On LAN)

Function which allows a machine connected to LAN to be turned on the
power from another machine via network.

X
XenServer

Virtualization software provided by Citrix.

489

Appendix H Procedure to Log in Web Console
Using LDAP Server
LDAP server is the server which is used to integrate the multiple systems for the user authentication on the
network. LDAP server is configured with the product of directory service which supports LDAP protocol.
You can log in Web Console of DPM by a user account which is registered in LDAP server by configuring as the
description in this chapter.
The followings are LDAP servers that DPM supports.
・ Windows Active Directory(Windows Server 2003/Windows Server 2008/Windows Server 2012)
・ OpenLDAP(LDAPv3)
When you use Windows Active Directory, the authentication from DPM fails if User must
change password at next logon option is selected.
(1) Configure LDAP server and create user accounts seeing the manual of LDAP server and so on in advance.
(2) Open the following file by text editor and so on and edit it following the environment.
<DPM Server installation folder>\WebServer\App_Data\Config\LdapConfig.xml
 Set values are as follows.
XML tag
Description
Enable
Set "true" when you use the user account of LDAP server for the
login of Web Console.
When "true" is set, the processing of authentication is done by
DPM Server and LDAP server in this order. The default is
"false"( the user account of LDAP server is not used.)
AccountAuthentication Set the authority of the user who logs in Web Console.
Set either of followings.
・ 7(Administrator)
・ 3(Operator)
・ 1(Observer)
The default is "1".
The same authority of the user is set for all user accounts.
See Section 2.2, "User Icon" for details of each authority.
LDAPType
Set the type of LDAP server.
Set either of followings.

・ 0(Windows Active Directory)
・1(OpenLDAP)
Host
Port
UserDnPattern

The default is "0".
Set the host name or IPv4 address of LDAP server.
The default is "127.0.0.1".
Set the port number to connect with LDAP server.
The default is "389".
Set by the following format.
・ In the case of Windows Active Directory:
Domain name\{0}
・ In the case of OpenLDAP:
uid={0},ou=Organization Unit,dc=Domain Component
Example)
・ In the case of Windows Active Directory:
dpm.com\{0}
・ In the case of OpenLDAP:
uid={0},ou=user,dc=dpm,dc=com
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When you log in Web Console by the user account of LDAP server, the user is not displayed
in Management view –> User icon -> User List group box.
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DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. THE EFI SPECIFICATION AND ALL OTHER INFORMATION ON THIS WEB SITE ARE
PROVIDED "AS IS" WITH NO WARRANTIES, AND ARE SUBJECT TO CHANGE WITHOUT NOTICE.
You may not reverse-assemble, reverse-compile, or otherwise reverse-engineer any software provided solely in
binary form.
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The foregoing license terms may be superseded or supplemented by additional specific license terms found in
the file headers of files in the EFI Application Toolkit.
GNU GENERAL PUBLIC LICENSE Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA 02110-1301
USA.
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software--to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this service
if you wish), that you receive source code or can get it if you want it, that you can change the software or use
pieces of it in new free programs; and that you know you can do these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the
recipients all the rights that you have. You must make sure that they, too, receive or can get the source code.
And you must show them these terms so they know their rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.
Also, for each author's protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that
redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at
all.
The precise terms and conditions for copying, distribution and modification follow.
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND
MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The "Program", below, refers to any
such program or work, and a "work based on the Program" means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".
Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.
1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that
you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of
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any change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this
License.
c) If the modified program normally reads commands interactively when run, you must cause it, when started
running for such interactive use in the most ordinary way, to print or display an announcement including an
appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty)
and that users may redistribute the program under these conditions, and telling the user how to view a copy of
this License. (Exception: if the Program itself is interactive but does not normally print such an announcement,
your work based on the Program is not required to print an announcement.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived
from the Program, and can be reasonably considered independent and separate works in themselves, then this
License, and its terms, do not apply to those sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based on the Program, the distribution of the
whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole,
and thus to each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather,
the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a work based
on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope
of this License.
3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:
a) Accompany it with the complete corresponding machine-readable source code, which must be distributed
under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more
than your cost of physically performing source distribution, a complete machine-readable copy of the
corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This
alternative is allowed only for noncommercial distribution and only if you received the program in object code or
executable form with such an offer, in accord with Subsection b above.)
The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need not include anything that is normally
distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source code,
even though third parties are not compelled to copy the source along with the object code.
4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such parties remain in full
compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you
do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.
6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and
conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to this License.
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7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations,
then as a consequence you may not distribute the Program at all. For example, if a patent license would not
permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you,
then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the
Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to
contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free
software distribution system, which is implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed through that system in reliance on consistent
application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through
any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this
License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of this License
which applies to it and "any later version", you have the option of following the terms and conditions either of that
version or of any later version published by the Free Software Foundation. If the Program does not specify a
version number of this License, you may choose any version ever published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be
guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.
NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION.
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM
TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
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If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to
achieve this is to make it free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file
to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.
<one line to give the program's name and a brief idea of what it does.>
Copyright (C) <year> <name of author>
This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your option)
any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License for more details.
You should have received a copy of the GNU General Public License along with this program; if not, write to
the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:
Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with ABSOLUTELY NO
WARRANTY; for details type 'show w'. This is free software, and you are welcome to redistribute it under certain
conditions; type 'show c' for details.
The hypothetical commands 'show w' and 'show c' should show the appropriate parts of the General Public
License. Of course, the commands you use may be called something other than 'show w' and 'show c'; they
could even be mouse-clicks or menu items--whatever suits your program.
You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright
disclaimer" for the program, if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the program'
Gnomovision' (which makes passes at compilers) written by James Hacker.
<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice
This General Public License does not permit incorporating your program into proprietary programs. If your
program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Library General Public License instead of this License.
・ Copyright (c) 1989 The Regents of the University of California.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:
1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:
This product includes software developed by the University of
California, Berkeley and its contributors.
4. Neither the name of the University nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ''AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
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NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
•

This is version 2004-May-22 of the Info-ZIP copyright and license. The definitive version of this document
should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.
Copyright (c) 1990-2004 Info-ZIP. All rights reserved.
For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals:
Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter
Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul
Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller,
Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave
Smith, Christian Spieler, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White
This software is provided "as is," without warranty of any kind, express or implied. In no event shall
Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential
damages arising out of the use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the following restrictions:
• Redistributions of source code must retain the above copyright notice, definition,
disclaimer, and this list of conditions.
•

•

•

Redistributions in binary form (compiled executables) must reproduce the above
copyright notice, definition, disclaimer, and this list of conditions in documentation and/or
other materials provided with the distribution. The sole exception to this condition is
redistribution of a standard UnZipSFX binary (including SFXWiz) as part of a
self-extracting archive; that is permitted without inclusion of this license, as long as the
normal SFX banner has not been removed from the binary or disabled.
Altered versions--including, but not limited to, ports to new operating systems, existing
ports with new graphical interfaces, and dynamic, shared, or static library versions--must
be plainly marked as such and must not be misrepresented as being the original source.
Such altered versions also must not be misrepresented as being Info-ZIP
releases--including, but not limited to, labeling of the altered versions with the names
"Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations),
"Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such
altered versions are further prohibited from misrepresentative use of the Zip-Bugs or
Info-ZIP e-mail addresses or of the Info-ZIP URL(s).
Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ,"
"Pocket UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.

・ This product includes Zip which has been modified from Pocket Zip (Info-Zip).
・ This product includes software (Xerces-C++ Version 3.1.1) distributed free-of-charge from Apache Software
Foundation. We ask that you use these products upon agreement with the respective license agreements. For
details regarding copyrights and proprietary rights, refer to the license files below:
Xerces-C++ Version 3.1.1: The Xerces-C++ Version 3.1.1 is available in both source distribution and binary
distribution. Xerces-C++ is made available under the Apache Software License, Version 2.0.
http://www.apache.org/licenses/LICENSE-2.0.html
・ This product includes Microsoft SQL Server Express distributed for free by Microsoft Corporation.
We ask that you use these products upon agreement with the license agreement.
For details regarding copyrights and proprietary rights, refer to the LICENSE file below:
<Folder in which Microsoft SQL Server Express is installed>\License Terms
・ This product includes software distributed for free (log4net for .NET Framework 2.0 Version 1.2.10.0) by
Apache Software Foundation.
For details regarding copyrights and proprietary rights, refer to the files below:
For SSC product, <Installation media >: \DPM\License\log4net for .NET Framework 2.0\
For DPM unbundled product, <Installation media>:\License\log4net for .NET Framework 2.0\
・ This product includes software distributed for free (Spring.Net Core functionality Version 1.2.0.20313) by
SpringSource.
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For details regarding copyrights and proprietary rights, refer to the files below:
For SSC product, <Installation media>:\DPM\License\Spring.Net Core functionality\
For DPM unbundled product, <Installation media>:\License\Spring.Net Core functionality\
・ This product includes software distributed for free (Prototype JavaScript framework, version 1.6.0.3) by
Prototype Core Team.
For details regarding copyrights and proprietary rights, refer to the below:
==========================================================================
Prototype is freely distributable under the terms of an MIT-style license.
For details, see the Prototype web site: http://www.prototypejs.org/
==========================================================================
・ This product includes software distributed for free (Tree Container Library(TCL) Version 5.0.6) by Datasoft
Solutions.
-

It was downloaded from
ftp://ftp.ie.u-ryukyu.ac.jp/pub/software/kono/nkf171.shar
ftp://ftp.iij.ad.jp/pub/NetNews/fj.sources/volume98/Nov/981108.01.Z
Subject: nkf 1.7 (Network Kanji Filter w/Perl Extenstion)
Message-ID: <29544.910459296@rananim.ie.u-ryukyu.ac.jp>

Copyright:
Copyright (C) 1987, Fujitsu LTD. (Itaru ICHIKAWA)
(E-Mail Address: ichikawa@flab.fujitsu.co.jp)
Copyright (C) 1996,1998 Kono, COW
(E-Mail Address: kono@ie.u-ryukyu.ac.jp)
Everyone is permitted to do anything on this program
including copying, modifying, improving.
as long as you don't try to pretend that you wrote it.
i.e., the above copyright notice has to appear in all copies.
You don't have to ask before copying or publishing.
THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE.
-

ORIGINAL LICENSE:
This software is
(c) Copyright 1992 by Panagiotis Tsirigotis
The author (Panagiotis Tsirigotis) grants permission to use, copy,
and distribute this software and its documentation for any purpose
and without fee, provided that the above copyright notice extant in
files in this distribution is not removed from files included in any
redistribution and that this copyright notice is also included in any
redistribution.
Modifications to this software may be distributed, either by distributing
the modified software or by distributing patches to the original software,
under the following additional terms:
1. The version number will be modified as follows:
a. The first 3 components of the version number
(i.e <number>.<number>.<number>) will remain unchanged.
b. A new component will be appended to the version number to indicate
the modification level. The form of this component is up to the
author of the modifications.
2. The author of the modifications will include his/her name by appending it
along with the new version number to this file and will be responsible for
any wrong behavior of the modified software.
498

The author makes no representations about the suitability of this software for any purpose. It is provided "as is"
without any express or implied warranty.
Modifications:
Version: 2.1.8.7-current
Copyright 1998-2001 by Rob Braun
Sensor Addition
Version: 2.1.8.9pre14a
Copyright 2001 by Steve Grubb
This is an excerpt from an email I received from the original author, allowing
xinetd as maintained by me, to use the higher version numbers:

I appreciate your maintaining the version string guidelines as specified
in the copyright. But I did not mean them to last as long as they did.
So, if you want, you may use any 2.N.* (N >= 3) version string for future
xinetd versions that you release. Note that I am excluding the 2.2.* line;
using that would only create confusion. Naming the next release 2.3.0
would put to rest the confusion about 2.2.1 and 2.1.8.*.
•
•

•
•
•
•

Some icons used in this program are based on Silk Icons released by Mark James under a Creative
Commons Attribution 2.5 License. Visit http://www.famfamfam.com/lab/icons/silk/ for more details.
The Cygwin DLL and utilities are Copyright © 2000, 2001, 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009,
2010, 2011 Red Hat, Inc. Other packages have other copyrights.
UNIX® is a registered trademark of the Open Group in the United States and other countries.
Copyright (C) 2001-2003 Hewlett-Packard Co.Contributed by Stephane Eranian eranian@hpl.hp.com
Copyright 1994-2008 H. Peter Anvin - All Rights Reserved
All other company names and product names mentioned in this document are trademarks or registered
trademarks of the respective companies.
Each source and binary file stored on the installation media is affiliated with the respective source and binary
file license.
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